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Integrated Team Care
You can use Communicare to record Integrated Team Care (ITC) activity.

Tip:

To use the ITC dataset in Communicare, arrange for Communicare Support  to enable 

the Integrated Team Care  dataset. You can then use any of the ITC  clinical items 

to record ITC information and capture the data required for reporting.

The dataset can be customised to suit the needs of your health service. If your dataset does 

contain local modifications, you may see differences from the information described here or 

additional items.

This dataset is based on the initial requirements of Murrumbidgee PHN as interpreted by 

Riverina Aboriginal Medical and Dental Corporation who funded the initial development in 

2016.

Recording ITC activities
If you receive a referral for a patient who requires integrated team care activities, you can 

assess and enrol the patient into ITC and record ITC activities using specific clinical items.

Before you begin
To display and use the ITC dataset, you must belong to a user group with the Common  viewing 

right.

Procedure
To record ITC activities:

1. When you receive an internal or external ITC referral for a patient, assess the patient. 

Add the ITC Assessment  clinical item to the patient's clinical record. Ensure that the 

performed date is that of the actual assessment.

Tip:

The referral may come from an external source such as an incoming 

referral letter, or one of the two internal referral items for ITC: 

Referral;INTERNAL;Coordinator ITC  or Referral;INTERNAL;Outreach 

Worker; ITC.
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Complete an assessment even if the client is not eligible or if the client declines.

This clinical item captures the date of the referral (to report on waiting times), the 

source of the referral (if self or carer referred, a document or a formal referral does not 

need to exist), smoking status, primary diagnosis (that is, the reason for referral) and 

the outcome. The outcome is required: if the response is Eligible, you are prompted 

to add a recall for enrolment; if the response is Ineligible  or Client decline, no 

further action is required.

2. In the patient's clinical record, enrol the patient in ITC. Add the ITC Enrolment 

clinical item to the patient's clinical record, recording if care coordination or 

supplementary services or both are approved. Ensure that the performed date is that 

of the actual acceptance into the program.

3. For each support event, record the type of service provided, using a specific clinical 

item. If a single service comprises more than one service, the items can be added 

multiple times. Each supplementary service item captures the type of item and 

whether the service was brokered or purchased. These items must have a performed 

date of the actual date of support.

◦ For care coordination, use ITC Care Coordination.

◦ For supplementary services, use one of the following clinical items:

▪ ITC Supplementary Services;Medical Aids

▪ ITC Supplementary Services;Allied Health

▪ ITC Supplementary Services;Specialists

▪ ITC Supplementary Services;Transport

◦ For outreach worker activity, use ITC Outreach Worker

4. Periodically record a client evaluation using the ITC Client Evaluation 2  clinical 

item.

5. If the patient no longer receives ITC support services, add the ITC Exit  clinical item 

and include a reason for leaving. Ensure that the performed date is that of the actual 

exit from the program.

Results
Record activity during the formal enrolment period.

Tip:

You cannot add activity items until after a patient has been enrolled in a program. 

However, you can still add activity items after a patient has been exited from a 

program. This allows for genuine backdating of clinical items. For example:
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• If you are using an offline client and your clinical program enrolments and 

exits have got out of step, you can backdate an exit.

• If items are out of sequence, correct the items.

• For a patient who exited last week, record an action from two weeks ago.

What to do next
Run the internal management reports weekly to assess progress and reporting accuracy.

If a client needs further integrated team care in future, repeat these steps to enrol the client 

in ITC again.

ITC reports
Communicare provides ITC reports that you can run to monitor progress and separate 

reports suitable for reporting to your local primary health network.

To run an ITC report, select Report  > Integrated Team Care.

Run the following internal reports regularly to monitor progress:

• Client Evaluations

• Client List

• Demographics and Outcomes

Run the reports titled Report -  to send to your Primary Health Network. These reports break 

the reporting requirements into sections as described in the following table.

Table  1. ITC reports

Report Covers

Report – Miscellaneous A
• New clients assessed/enrolled in the reporting period 

by referral source
• New clients assessed/enrolled in the reporting period 

by locality
• New clients assessed/enrolled in the reporting period 

by indigenous status
• New clients assessed/enrolled in the reporting period 

by sex
• New clients assessed/enrolled in the reporting period 

by primary diagnosis
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Table  1. ITC reports  (continued)

Report Covers

Report – Miscellaneous B
• New clients assessed/enrolled in the reporting period 

by smoking status
• Clients discharged in the reporting period by smoking 

status

Report – Miscellaneous C
• Clients assessed with current COPD plan
• Clients assessed with other current plan
• Clients assessed with current GPMP/TCA

Report – Miscellaneous D
• Clients discharged with current COPD plan
• Clients discharged with other current action plan
• Clients discharged with current GPMP/TCA

Report – Miscellaneous E
• New clients assessed/enrolled in the reporting period 

by client survey response
• Clients discharged in the reporting period by client 

survey response
• Clients assessed/enrolled following a previous exit

Report – Care Coordination A
• Patients enrolled to receive care coordination
• Eligible patients not yet enrolled
• New patients assessed/enrolled in the reporting 

period
• Patients discharged in the reporting period

Report – Care Coordination B
• Unique services in the reporting period/Care 

coordination services
• Unique services in the reporting 

period/Supplementary services
• Unique services in the reporting period/Outreach 

worker services
• Unique services in the reporting period/Other 

services
• Breakdown of Outreach Worker Services

Report – Supplementary Services
• Allied Health Services
• Specialist Services
• Transport Services
• Medical Aids

Report – Outreach Worker
• Outreach Worker Services
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Support
If you run into problems using Communicare, you can always get help from us.

For help and support, go the Communicare User Portal - Help and Support  tab for general 

information and further links.

If you still need help, create a support request  and we'll get back to you.

Include as much information in the request as you can and follow these guidelines:

• If you include patient information, for patient confidentiality, use the Patient ID 

instead of the patient’s name.

• If you include screenshots, ensure that you conceal both the patient’s name and date-

of-birth.

Fastpath:

For urgent problems or issues with using the portal, call 1800 798 441  to speak to a 

support team member.

If reporting a problem, before contacting us, try to replicate the problem. It also helps to 

write down the problem and the circumstances under which it occurred.

Release Notes
The main improvements for this version are listed in the release notes. Minor improvements 

and cosmetic changes are not listed for the sake of brevity.

Previous release notes are also included.

V22.1 Release Notes
Communicare V22.1 includes ePrescribing support and integration with virtual health 

monitoring applications. It also includes minor enhancements and bug fixes.
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Updates in V22.1.21.205

Bug fixes

• We've fixed a bug where for patients with an unknown age, you could not add 

medication history, repeat or represcribe medications, or add a new patient with EMPI 

search enabled.

Testing:

1. In Patient Biographics, for a test patient with some medications 

already prescribed, remove their date of birth.

2. In Communicare, open the clinical record of the same test patient.

3. Repeat medication:

a. From the Medication Summary, for an existing medication, click 

Repeat.

b. Click Save.

c. Observe that you can save the medication without error.

d. If required, repeat the above steps but select Represcribe to test 

that repeating multiple medications saves without error.

4. Add a medication history:

a. Select Medication  > Add Medication History.

b. In the drug browser, select a medication.

c. In the Add Medication History  window, complete the required 

fields, and click Save.

d. Observe that you can save the medication history without error.

5. Add a new patient:

a. In a system with EMPI Search  enabled, in Patient 

Biographics, click New Patient.

b. In the EMPI Patient Search  window, enter a new test patient and 

include a valid date of birth, for example, 01/01/2000.

c. Click Search.

d. Observe that a search is completed without error.

• We've fixed a bug that was stopping the MIMS importer from successfully updating 

MIMS.
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Testing:

1. Download the most recent MIMS drug data from Communicare User 

Portal - Help and Support  and extract it to a local drive on which 

Communicare is installed.

2. Select File  > Reference Tables  > Import MIMS Pharmaceutical Data 

and follow the instructions to import the drug data.

3. Observe that your local MIMS data is successfully updated without error.

Updates in V22.1.19.198

Enhancements

• For ePrescribing:

◦ A patient must have a date of birth recorded in biographics.

◦ The Dosage Instructions  field specifies that Directions must include dose 

and frequency.

◦ The Route of Administration  is now mandatory for WA sites. If there is no 

value available from MIMS, As Directed  is added.

◦ For WA customers, the Authority Number for Controlled Substances  has 

been changed to CPOP Authority Number.

◦ The confirmation when prescribing Schedule 8 medications has been moved to 

when the medication is saved.

◦ Additional logging has been added for changes to system rights for user groups.

• Changes made to users and user groups in File  > User Groups  are now logged.

• For Extemporaneous Preparations:

◦ Renamed the Volume/Amount  fields to Strength.

◦ Added a Schedule 8  field, for preparations that contain S8 ingredients.

• We've added more SNOMED terminology settings so that your organisation can 

use any of the following SNOMED terminology servers to validate SNOMED codes 

assigned to clinical items:

◦ National Clinical Terminology Server (NCTS) provided by Australian Digital 

Health Agency (ADHA). Register at https://www.healthterminologies.gov.au/

◦ A terminology server provided by Telstra Health

◦ A terminology server hosted by your organisation or a third party

For more information, see Web Services > SNOMED Terminology  (on page ).
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New features in V22.1

ePrescribing

In V22.1 and later, Communicare supports ePrescribing for registered providers who have 

opted in to ePrescribing.

Because ePrescribing relies on the prescriber's identity within the prescribing system to 

replace a signature on paper, ADHA has imposed additional requirements on system security 

and user authentication. To meet these requirements, we have made the following changes:

• Enable a provider to prescribe using ePrescribing in File  > Providers. The following 

information must be included:

◦ Logon User Name

◦ Full name

◦ PBS Prescriber Number

◦ A validated HPI-I Number

◦ Qualifications  recorded

◦ Enable ePrescribing  set

For more information, see Providers  (on page ).

• Communicare is locked and users must log in again after 10 minutes of system 

inactivity, by default. This requirement helps prevent a prescriber having drugs 

prescribed under their identity if they leave their computer unattended.

• If you are prescribing a Schedule 8 medication, or repeating or represcribing 

that medication, you must enter your password before you can proceed with the 

prescription.

• User passwords must now be eight characters long and contain at least one number 

and one letter.

• In addition to user log on, log off, reauthentication and change of password are 

now logged and can be audited if required. To audit this activity, use Audit Logs  > 

Username Activity.

For ePrescribing, record information that you might have previously written on prescriptions 

by hand to communicate with the dispenser of the medication. Use the new fields described 

in Table 1  (on page ). This information is included in electronic scripts, printed scripts 

unless otherwise specified and medication requests where applicable.

The following changes also support ePrescribing:
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• Communicare now validates a patient's IHI automatically using either their Medicare 

number or DVA number.

• For each patient, on the  Patient Biographics  > Personal  tab, you can set a 

default for how they prefer to receive their prescriptions. This format will be set 

automatically when a prescriber finalises a medication. For more information, see 

Contact details  (on page ).

• If there is no codified clinical item available that matches your reason for prescribing, 

you can now type a reason as free text.

• We've added support for unlisted repatriation authority, so that an authority script 

can be issued for a medication that is not listed on the PBS or RPBS for patients with 

a DVA (Department of Veterans' Affairs) number. The prescriber needs to provide an 

RPBS approval number. For more information, see Unlisted repatriation authority  (on 

page ).

• When you add a medication, we've renamed some fields to make their application 

clearer:

◦ No. of Packs  to Number of Packs

◦ PBS Authority Number  to PBS/RPBS Authority Number

◦ PBS Approval Number  to PBS/RPBS Approval Number

◦ Comments  to Internal Comments

◦ Reason  to Reason (Clinical Item)

• When you add a medication, we've also added or updated the following fields:

◦ Interval Between Repeats  - depending on your jurisdiction, for Schedule 8 and 

Schedule 4D drugs, add the interval required between repeats.

◦ Regulation 49 (Regulation 24)

◦ Script Retained by Pharmacy

◦ Route of Administration  - when you add a medication, the default route of 

administration is included. Customise the route when prescribing if required. 

Default administration routes for a medication are provided by MIMS and 

updated when MIMS is updated if applicable.

Not all medications will have a default route of administration. Prescriptions 

written before Communicare is upgraded to V22.1 will not have a value and 

the default value will be added only when the medication is repeated or 

represcribed. Any custom routes of administration set by the prescriber are 

persisted when repeating or represcribing medications.
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Accept the default or select an alternative route from the Route of 

Administration  list when:

▪ Prescribing, repeating or represcribing medications

▪ Adding medication orders

▪ Administering medications - the route specified in the medication order is 

copied into the administration event automatically, but you can select an 

alternative route during administration

The medication's route of administration information is included on the 

Medication Summary, in the column with a header of Route.

◦ Unusual Dosage

◦ Dispensing Pharmacy

◦ Urgent Supply (Script Owing)

◦ Exclude from Active Script List

◦ For NSW, Dispensing Pharmacy

◦ Note to Pharmacist (ePrescriptions only)

◦ Authority Number for Controlled Substances

For more information, see Table 1  (on page ).

• When you finalise a medication:

◦ The Finalise  window has been updated for ePrescribing and the behaviour has 

been changed. For more information, see Finalise Prescriptions  (on page ).

◦ If ePrescribing is enabled, you can choose from one of three additional 

prescription formats to deliver an ePrescription token to a patient:

▪ SMS ePrescription

▪ Email ePrescription

▪ Printed ePrescription Token

◦ You must now review the information that will be included in ePrescriptions 

before they are finalised. Step through the prescriptions in the Preview 

Prescription  window.

◦ The transmission status of ePrescriptions is displayed in the ePrescription 

Summary, giving you the opportunity to cancel sending the ePrescription, 

resend the ePrescription, or print the prescriptions as paper prescriptions where 

the ePrescription failed to be created. Where a paper prescription is created 

because the ePrescription failed, the medication is still sent to the ETP service 
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as a paper prescription and a barcode is printed on the paper prescription. The 

paper prescription is not an ePrescription so the prescriber must sign the script.

◦ For ePrescribing, the email address format is validated before it is sent to the 

ETP service and only the digits entered for SMS are sent.

• When you finalise a medication, if you have medication requests enabled:

◦ Medications can be selected only in either the printed or electronic 

prescriptions table, or the medication requests table. Deselect a medication in 

one table to make it available in the other.

◦ Regular medications are displayed in the medication requests table and selected 

by default, if Create Medication Request by Default  is set on the File  > 

System Parameters  > Prescription Forms  tab.

◦ Medications are sorted by name.

◦ Any medication selected in either table is finalised.

• Details about ePrescriptions are included on the Detail  tab. For more information, see 

Example ePrescription on the Detail tab  (on page ).

• The most recent status for an ePrescription is also listed on the Medication Summary 

in the ePrescription Status  column. For more information, see ePrescription Status 

(on page ).

• When you repeat or represcribe a medication:

◦ A new PBS Authority Number is generated and if a medication had a PBS 

Authority Number, Previous Authority  is set.

◦ Enter a new PBS Approval Number.

◦ When represcribing multiple medications, prescriptions that require a new PBS 

Authority Approval number are flagged and you can enter a new number in the 

Bulk Represcribe Medication  window.

◦ When a regular medication is represcribed we no longer send a cancel message 

to the ETP service for the previous prescription to ensure that the RTPM status 

correctly reflects the continued therapy.

• If you stop or delete a medication prescribed using a token-based ePrescription 

format, the medication is cancelled on the ETP service and can no longer be 

dispensed. Deleted medications are removed from the patient's My Health Record.

• Printed prescriptions sent before your Communicare system was upgraded to use the 

new ETP service can still be stopped or deleted. These prescriptions are cancelled 

on the ETP service. Deleted medications are removed from the patient's My Health 

Record.
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• If a patient loses an ePrescription token, you can request that the ETP service resends 

it to the patient. For more information, see Resending ePrescriptions  (on page ).

• New system parameters to connect Communicare to your ETP service, such as eRx. For 

more information, see Script Exchange system parameters  (on page ).

• When a medication is prescribed by brand we now send both generic and brand names 

to the ETP service, so that the information displayed on the dispensing system at the 

pharmacy complies with AIP guidelines.

• In the Medication Summary  and Detail  tab, we've changed the prefix for medications 

that have been represcribed to <Represcribed date>. We've also updated 

theMedication Summary  legend to show that the  icon applies to both stopped 

and represcribed medications.

Integration with MCM

Communicare  can be configured to integrate with My Care Manager  (MCM), the virtual 

health monitoring application solution provided by Telstra Health. Results from My 

Care Manager  are displayed in Communicare  and patient biographic updates made in 

Communicare  are sent to the monitoring application. For more information, see Virtual 

health monitoring  (on page ).

Minor enhancements

• We've updated the logos in Communicare from the Telstra brand to our very 

own. You might notice a new desktop shortcut, splash screen, About page and the 

icons in each window. Can you see two people embracing and Australia in our new 

Communicare logo?

• In addition to the Gender Information  clinical item, we've added Gender  and 

Pronouns  fields to biographics, the Patient Summary, and patient data objects 

available to add when writing a letter or referral. The selected data is displayed in a 

patient's clinical record with their name and date of birth, and also in a tooltip in the 

clinical record if you hover over the patient's name. We've also updated the language in 

the user interface to use the term sex  where it was incorrectly using gender.
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The default gender values are:

◦ Brotherboy

◦ Cisgender

◦ Gender non-binary

◦ Other

◦ Questioning

◦ Sistergirl

◦ Transgender Female to Male

◦ Transgender Male to Female

Gender values can be customised for your health service.

The default pronouns are:

◦ He/Him/His

◦ She/Her/Hers

◦ They/Them/Theirs

Pronoun values can be customised for your health service.

If you want the new fields enabled or customised for your health service, contact 

Communicare Support.

For guidance on use at your health service, see RACGP Standards for general practices 

(5th edition) fact sheet: Collecting and recording information about patient sex, 

gender, variations of sex characteristics and sexual orientation

• You can now specify the order in which qualifiers are displayed in the Qualifier 

Summary. For more information, see Create and Edit Qualifiers  (on page ).

• Changes to medications:

◦ You can now reorder  (on page )  the columns on the Medication Summary 

and reset the order to the default as required. For more information, see 

Medication Summary  (on page ).

◦ We now support the National Data Exchange (NDE) and the state-based real 

time prescription monitoring (RTPM) systems for all states and territories 
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except WA. For more information, see Real time prescription monitoring  (on 

page ).

▪ The patient's Medicare number and individual reference number, if one is 

recorded, are sent to RTPM so that the patient can be identified.

▪ AMT codes are sent to RTPM to identify the medication being prescribed.

◦ Anyone who belongs to a user group with a medication view system right can 

now reprint a medication request.

◦ When repeating a medication or represcribing multiple medications, 

Communicare no longer checks for drug interactions against the currently 

prescribed medication that is being repeated.

• For scheduled reports saved in the CSV format, we've added an Include Header  option 

which when set, adds column headings to the data extracted for context. For more 

information, see Report Scheduler  (on page ).

• You can now delete Immunisation clinical items even if they have already been sent 

to the Australian Immunisation Register (AIR). For more information, see Deleting 

immunisations uploaded to the AIR  (on page ).

• We've added another filter to the File  > Online Claiming  > AIR Claims  tab. Set Hide 

Given Elsewhere  to display only those immunisations administered at your health 

service. Immunisations given overseas or at another health service are not displayed. 

For more information, see Filtering the immunisations list  (on page ).

• For SMS appointment reminders, you can now filter templates based on booking 

requirements and include the provider's first name and speciality in the messages sent 

to patients if required. For more information, see SMS reminder templates  (on page 

).

• For investigation results, Communicare now supports lab IDs assigned to the result 

by the laboratory of up to 250 characters. The lab ID, such as the Lab Reference No, 

is displayed in the header information for a result in the Match and Review Result 

window.

• The Australian Nurse-Family Partnership Program (ANFPP) dataset has been updated 

in line with the 2022 updates by the College of Nursing & Midwifery at Charles Darwin 

University.

• We've added the following new data objects to the Letter  writer. Add these fields to 

your templates or use them in a blank document when writing a letter or referral.

◦ Addressee, values are sourced from the address book:

▪ Department

▪ Speciality
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◦ Patient, values are sourced from Patient Biographics

▪ Personal  tab:

▪ Gender

▪ Pronouns

▪ Social  tab:

▪ Interpreter Language

▪ Interpreter Required

▪ NDIS

▪ Occupation

• We've improved the performance of the Medication Summary  when a medication has 

a linked supply or administration event.

• We've increased the size of the font used in plain text fields in clinical items to make it 

more legible.

• We've changed the logic so that disabled encounter places and related items are still 

included in reports.

• We've removed the DVA number validation check from patient biographics.

• We've updated the way in which kin information is displayed on Patient 

Biographics  > Social  tab when using structured contacts. Inactive  is now the 

first column, and active kin are displayed in bold and listed before inactive kin. For 

example:

• If you use online condition decision support, we've changed the database used by 

default for drug to pregnancy and drug to condition interaction checking to the 

embedded MIMS database that you have downloaded and installed locally.

Central Data changes

You can review new clinical items and reports using these reports:

(c)Telstra Health | Communicare 19



• Report  > Reference Tables  > Clinical Item Types Added  - enter the days since the 

upgrade and choose Central.

• Report  > Database Consistency  > Central Reports

For a list of new and modified items, see Central Data changes since V21.3  (on page 26).

Bug fixes

• We've fixed a memory leak that was causing the Firebird database to crash with an out 

of memory error. This error occurred at larger sites under certain conditions and is 

difficult to reproduce.

Testing:

If the memory leak is still present it will consume all of the server's RAM, then 

Firebird will fail. Try running some large reports such as:

◦ Healthy for Life  reports

◦ National KPI  reports

◦ APCC  reports

◦ NSW KPI  reports

◦ NT KPI  reports

◦ Population analysis  > Population Breakdown

◦ Drug and Alcohol Treatment  > Residential Occupancy by Age

◦ HACC  reports

◦ OSR  reports

◦ DATS NSW  > Monthly Episodes Export

• We've fixed a bug where investigation results received from AUSLAB displayed No 

supported result format...  in the result.

Tip:

For RIVeR systems, AUSLAB messages are handled by the integration, 

not Communicare and display HL7 file from QHPS  in the first line. The 

following testing notes do not apply.
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Testing:

1. In Documents and Results, on the Investigation Results  tab, 

open a result from AUSLAB.

2. Note that the result details are displayed correctly and that the format 

of the result is Text.

• We've fixed the alignment of the result text message returned from Medicare Online.

Testing:

1. In a Communicare environment that links to Medicare Online for MBS 

claims, go to the File  > Online Claiming  > Bulk Bill Claims  tab.

2. Click through your claims to one that has a long message displayed in 

the Result Text Message  field.

3. Observe that the text in the Result Text Message  field is aligned to 

the top of the message and that you can scroll through the rest of the 

message.

• We've fixed a bug that was preventing a patient record from being deleted if it included 

transport management. The following error was displayed:

ISC ERROR CODE:335544466

ISC ERROR MESSAGE:

violation of FOREIGN KEY constraint "FK_TRNSPRT_BK_PAST_ID" on table "TRANSPORT_BOOKING_ORG"

Foreign key references are present for the record...

Testing:

1. In Communicare, click Patient Biographics, New Patient and add a 

new test patient.

2. Open the clinical record for the new patient and click Transport to 

add and save transport arrangements.

3. Close the clinical record.

4. Select Patient  > Delete  and select the test patient.

5. Observe that you can delete the patient's record without error.

(c)Telstra Health | Communicare 21



• We've fixed a bug that resulted in duplicates of medications that had been 

administered or supplied being displayed in the Resprescribe Medications  window 

when attempting to represcribe multiple medications.

Testing:

1. In a test patient's clinical record, select Medication  > Add 

Medication  and create a regular medication order for drug A.

2. Select Medication  > Administer & Supply  and administer drug 

A. Do this in two separate services.

3. Create a regular medication order for drug B.

4. Select Medication  > Administer & Supply  and supply drug B. 

Do this in two separate services.

5. In a new service, in the Medication Summary, click Represcribe 

Medications.

6. Observe that drugs A and B are listed only once instead of multiple 

times.

• We've fixed a bug with selecting an alternative provider for a service.

Testing:

1. Open a test patient's clinical record, and add an item.

2. Close the clinical record and select Yes the service is now complete.

3. In the Service Record, on the Detail  tab, in the Locate  field, start 

typing an alternative provider's name.

4. Observe that the alternative provider's name is highlighted in the list 

and you can select it.

• We've fixed a bug that was stopping you updating a patient's IHI if the patient was 

flagged as a duplicate.

Testing:

1. In Patient Biographics, add a new test patient and include an IHI.

2. Create a second test patient with the same family name, first name, date 

of birth and sex, but without an IHI.
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3. In the Is patient already on the system?  window, click No.

4. In the Patient duplication  error, click OK.

5. Observe that in the Add New Person  window, you can add an IHI and 

update any other details.

• We've fixed a bug which was preventing you from merging patients with NCSR alerts.

Testing:

With NCSR enabled, using a provider who has access to the NCSR:

1. Set up two separate patients in Communicare with details that will 

match to the NCSR record but with different enough information that 

they can be added to Communicare. For more information, see Access 

NCSR  (on page ).

2. Open patient A and ensure that the banner shows an NCSR alert.

3. Open patient B and ensure that the banner shows an NCSR alert.

4. Merge patient A into patient B.

5. Observe that the patient's are merged with no errors.

• We've fixed a bug that was stopping legacy prescriptions sent to eRx using ETP before 

ePrescribing was introduced from being cancelled after upgrade to V22.1.

Testing:

If your site has legacy prescriptions sent to eRx using ETP before you 

upgraded to V22.1 that need to be deleted:

1. For a patient with a legacy prescription, open their clinical record.

2. From the Medication Summary, right-click the legacy medication and 

select Delete Medication (prescribed in error).

Remember:

Delete a medication only if it was prescribed in error. If you no 

longer want a patient to take a prescribed medication, stop that 

medication instead.

3. Observe that the medication is removed from the Medication 

Summary  and the prescription is cancelled.
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• We've fixed a bug that was stopping prescriptions from being printed for patients who 

don't have a sex recorded in patient biographics.

Testing:

1. For a test patient, delete their sex from the Patient Biographics.

2. Add a medication.

3. Finalise the prescription:

a. In the Finalise Prescriptions  window, from the Patient 

Prescription Format  options, select Printed Prescription.

b. Click Finalise.

4. Observe that the prescription is printed.

• We've fixed a bug where for medications with long names, the quantity and number of 

repeats were not printed on the printed prescription.

Testing:

1. In a patient's clinical record, add a medication with a long name.

2. Finalise the prescription:

a. In the Finalise Prescriptions  window, from the Patient 

Prescription Format  options, select Printed Prescription.

b. Click Finalise.

3. Observe that the prescription is printed and that QTY  and Repeats 

values are displayed after the dosage.

• We've fixed a bug which meant that Communicare could not print to a default printer 

that had been redirected to a remote session.

Testing:

1. Run Remote Desktop Connection and on the Local Resources  tab, set 

Printers  so that your default printer is redirected to the remote session, 

then click Connect.

2. Select File  > Printer Assignments  and ensure that Windows Default 

is set for Communicare Default  and Letter Writing.
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3. Write a new letter either from a patient's Clinical Record  or from 

Documents and Results.

4. Click Print & Save. Observe that the letter is printed to the default, 

redirected printer.

• We've fixed a bug which meant that S8 medications with no repeats and no interval 

between repeats could not be repeated or represcribed after upgrade to V22.1.

Testing:

1. For a patient with a prescription for an S8 medication with no repeats 

and no interval between repeats specified, repeat the medication.

2. Observe that the medication can be saved and finalised as usual.

• We've fixed a bug with the Communicare Demo which was preventing you from 

opening an external service with which Communicare is integrated, such as the AIR 

Portal or NCSR Hub.

Testing:

1. In the Communicare Demo, open an NCSR test patient's clinical record, 

such as Anna Lau. For other test patients, see Table 5  (on page ).

2. In the toolbar, select Go To  > NCSR Hub

3. Observe that the NCSR Hub is launched and you can access the patient's 

information on the hub.

Installation Requirements

• Communicare V22.1 is supported on Windows 10 and later and Windows Server 2016 

and later. Security and other updates from Microsoft must be installed as they become 

available.

• .NET 6 is required for the Communicare server

• .NET 4.8 is required for the Communicare client

• Java Runtime Environment 1.8.0_202 for uploading to the AIR

• HQBird 2.5.9 is now an external dependency. Firebird 2.5 and earlier is no longer 

supported.
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Central Data changes since V21.3

New and modified clinical items are summarised here.

New and modified clinical items

Table  2. New and modified clinical items

New clinical items Modified clinical items

ANFPP Contact with Service Agency ANFPP ASQ Result Form

ANFPP DANCE ANFPP ASQ SE Result Form

ANFPP Domestic and Family Violence ANFPP Client Change of Status Form

ANFPP Edinburgh Postnatal Screening Tool ANFPP Client Contact Form

ANFPP FPW Home Visit Form ANFPP Client Feedback Survey

ANFPP Growth and Empowerment Measure ANFPP Demographic Details Form (Intake)

ANFPP Kimberley Mum's Mood Scale ANFPP Demographic Details Update Form

ANFPP PLUM and HATS Result Form ANFPP Health Habits Form

ANFPP Program End ANFPP Home Visit Encounter Form

Sexual Orientation ANFPP Infant Health Care Form

Xpert POC test;Respiratory Infections ANFPP Language Assessment (21 months)

Aspirate;nasal sinus ANFPP Maternal Health Assess (Intake)

Dandy Walker syndrome ANFPP Pregnancy Outcome Form

Diabetes;exocrine pancreatic ANFPP Relationship Assessment

Goldenhar syndrome ANFPP Telephone Encounter Form

Nail patella syndrome Referral;ANFPP

Osteoma Investigation Result

Immunisation;ACAM2000 Check up;Aboriginal & TSI adult

Immunisation;AstraZeneca COVISHIELD Check up;Aboriginal & TSI adult NO MBS

Immunisation;Bharat Biotech Covaxin Check up;Aboriginal & TSI over 55 NO MBS

Immunisation;Gamaleya Sputnik V Check up;Aboriginal & TSI over 55s

Immunisation;Jynneos 0.1ml Intradermal Check up;over 75s

Immunisation;Jynneos 0.5ml Subcutaneous Cycle of care;annual;diabetes

Immunisation;Moderna Spikevax 25 mcg Exam;pre-consult

Immunisation;Novavax NUVAXOVID Immunisation;Moderna Spikevax

Immunisation;Pfizer Comirnaty Paediatric Perinatal Depression Assessment

Immunisation;Sinopharm BBIBP-CorV Xpert POC test;SARS-CoV-2

Immunisation;Sinovac Coronavac i-STAT;CG4+

i-STAT;Troponin I

Alcohol/Drug treatment enrolment (NSW)

Alcohol/Other Drug treatment enrolment

HACC/CHSP Allied Health Care
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Table  2. New and modified clinical items  (continued)

New clinical items Modified clinical items

Headspace;Assessment

Alcoholism;acute

Angioma

Delay;developmental

Illegitimacy

Immunisation;Oral Polio (Polio Sabin)

Immunisation;Panvax (H1N1 Influenza)

Immunisation;Zostavax

Check up;Aboriginal & TSI Annual Health

Check up;Aboriginal & TSI Annual NO MBS

Version 21
Release notes for version 21 releases.

V21.3 Release Notes

Communicare V21.3 includes new integrations with Services Australia. It also includes 

minor enhancements and bug fixes. This version is a mandatory upgrade for all users who 

make online claims to Medicare or who upload immunisation records to the AIR.

Prerequisites

Because of the schema changes associated with the medications changes made in V20.1 and 

later, all customers upgrading from V19.2 and earlier should run the following report before 

upgrading and resolve any issues: Unprescribed Regular Medications.

Note:

If you are upgrading from V19.2 and earlier and have any custom reports that use 

medications tables or views directly, ensure you check Database Schema changes  (on 

page 94)  in the V20.2 release notes. If you are affected, discuss migration options 

with Communicare Support.
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Updates in V21.3.48.109

Bug fixes

• We've fixed a bug where health services could not access the NCSR from Communicare.

Testing:

For health services that are integrated with the NCSR:

1. In Communicare, open the clinical record of a patient who you know has 

a record in the NCSR database.

2. In the clinical record, either:

▪ In the patient banner, click NCSR

▪ In the toolbar, select Go To  > NCSR Hub

3. Observe that the patient's NCSR record opens in the NCSR hub in your 

default browser.

Updates in V21.3.47.108

Enhancements

• We've updated the Government Reporting Tool for Specification V13.2 of the National 

Key Performance Indicators and On-line Services Reporting, June 2022. Changes include:

◦ For PI18 and PI19:

▪ Changes to age groupings

▪ Negative ACR and eGFR values are now reported as not recorded

◦ New indicator, PI25  (on page )  (STI result recorded)

• Information from medication orders is now uploaded to a patient's My Health Record 

by eRx if the Upload medication order to eRx  option is set in File  > System 

Parameters  > Clinical  tab. If a patient does not want the medication information 

uploaded, deselect Consent to send to My Health Record  when creating medication 

orders. For more information, see Create Medication Orders  (on page ).

• We've updated the Communicare Demo version to use the new test environment (SVT) 

for My Health Record.
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Bug fixes

• We've fixed a bug where Communicare required an encounter place to be set when 

running an OPV check, instead of using the organisation settings.

Testing:

For health services that use organisation-level rather than individual 

encounter place settings:

1. In Communicare, in Patient Biographics, select a patient whose 

Medicare card details have not been recently checked.

2. On the Personal  tab of their patient record, click Check Card Online.

3. Observe that the OPV check happens without the Provider, Place and 

Mode selection  window first being displayed or requiring that you 

enter an encounter place.

• We've fixed a bug that was causing a data sync problem between the offline client and 

the Communicare server, where the following error was displayed:

Uploading changes to the server FAILED with:

Out of memory

Testing:

Preferably test this fix with a database that has experienced this problem.

1. In the Communicare offline client, for multiple test patients, open a 

patient's record and make a change. Update any of the following areas:

▪ Patient Biographics (excluding patient status changes)

▪ Clinical Items

▪ Care Plans

▪ Prescriptions

▪ Documents

▪ Progress notes

▪ HIC claims

▪ Investigation requests

2. In the same offline client, for a few other patients, open a patient's 

clinical record and close it without making any changes.

3. Synchronise the offline client with the Communicare server.
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4. Observe that the data is synchronised from the offline client to the 

Communicare server without error and that a summary of the number 

of records updated is displayed.

• We've fixed a bug where for patient's whose Medicare details had been validated using 

OPV by Services Australia but with suggestions, the Incomplete Medicare details 

icon was displayed incorrectly in some patient lists such as Service Recording.

Testing:

1. In Communicare, for a test patient with a validated Medicare card, open 

their Patient Biographics  and on the Change Person Details  > 

Personal  tab, in the Medicare  section, change their Medicare number.

2. Click Check Card Online.

Communicare will send the information to Services Australia using 

OPV. Services Australia should validate the Medicare details but with 

suggestions.

3. Close the patient record.
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4. Open Patient Biographics  again and search for your test patient.

5. Observe that there is no Medicare icon displayed in the results listed or 

other patient lists, such as the Service Recording.

• We've fixed a bug where an incorrect date (30/12/1899) was displayed in the 

appointment service list for patients who do not have any future appointments 

booked.

Testing:

1. In Communicare, open the Appointments Book.

2. Click

Services  and select a patient who does not have any upcoming 

appointments.

3. In the Service List  window, when Future Only  is set, observe that there 

is no date displayed in the Sequence Date  column.

• We've fixed a bug with advanced patient search which returned the following error: 

Field " has no dataset .

Testing:

1. Log into Communicare using any user.

2. Open Patient Biographics.

3. Click Advanced.

4. Run any query.

5. In the Add or change patient biographic details  window, click 

New Search.

6. Observe that in the Add or change patient biographic details 

window, you can search for another patient without error. If you cancel 

the search and open Patient Biographics  again, there is no access 

violation and you can search for another patient.
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• We've fixed a bug where the SNOMED CT-AU Import failed to run on Communicare 

clients if you had a custom SYSDBA password set or from outside Communicare.

Testing:

With a custom SYSDBA password set for the Communicare server:

1. On the Communicare server, run 

Communicare_install/SnomedImport.exe  and select and import 

an existing SNOMED release bundle.

2. Repeat step 1 on a Communicare client.

3. Observe that the SNOMED CT-AU Import completes successfully on 

both server and client from outside Communicare.

4. Download the latest SNOMED update from the Communicare portal.

5. On the Communicare server, select File  > Reference Tables  > Import 

SNOMED CT-AU Data  and import the new bundle.

6. Repeat step 5 on a Communicare client.

7. Observe that the SNOMED CT-AU Import completes successfully on 

both server and client from within Communicare.

• For WACHS customers, we've fixed a bug that was preventing the AIR Claims tab from 

being displayed.

Testing:

In a WACHS environment:

1. Select File  > Online Claiming  > AIR Claims  tab.

2. Observe that you can access the AIR Claims  tab and review 

immunisation uploads to the AIR.

• For customers who receive emails from Communicare containing the daily service 

logs, we've fixed a bug introduced in V21.3.27.59 that was preventing the emails being 

sent.
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Testing:

1. In your Communicare environment, select File  > System Parameters  > 

System  tab, and in the Error Logging  section, ensure that Send Error 

Logs  is set and that your email address is included.

2. Select File  > Organisation Maintenance  > Email Server  tab, and 

check that your email infrastructure values are correct. For more 

information, see Organisation Parameters - Email Server  (on page 

).

3. Wait for CCareQueue_SendLog  to run overnight, or manually run it 

from Communicare_install/CCareQueue_SendLog.exe.

4. Check that you receive an email from Communicare to the address 

specified in step 1 and that it contains the daily service log information.

• We've fixed a bug for health services using the new Communications  module, where 

the patient records for a patient who has received an SMS could not be merged into 

another record.

Testing:

1. In Communicare, ensure that the Communications  module is enabled.

2. Create patient records for two test patients. Give patient A a mobile 

phone number that you can access.

3. In patient A's record, click Send SMS.

4. Enter a message and click Send SMS.

5. After you have received the SMS, in the main toolbar, select Patient  > 

Merge.

6. Select patient A as the source patient and patient B as the destination 

patient and complete the merge. For more information, see Patient 

merge  (on page ).

7. Observe that the patient records are merged and that the SMS records 

are moved from patient A to patient B. For patient B, the SMS Message 

clinical item is displayed in the clinical record on the Detail  tab.

• We've added some extra logic to the MBS incentive item changes made in V21.3.31.71. 

Now if you need to exclude a category by adding 0  for the MBS item, for example, for 
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Radiology, you are not prompted to add an MBS Item of 0 when you complete a service 

recording.

Testing:

1. In Communicare, in File  > Organisation Maintenance  > health service 

> Medicare Claims  tab, enter Medical  and Pathology  Incentive Items 

for a region of MM3-7. For Radiology  enter 0. For more information, see 

Organisation Parameters - Medicare Claims  (on page ).

2. For an eligible patient (child under 16, or CentreLink, or Health Care 

Card), start a service and enter a medical clinical item, a pathology 

request and a radiology request.

3. Complete the service.

4. In the Service Record  > Medicare  tab, select a standard item and click 

Claim now.

5. Observe that you are prompted to add the additional MBS items 

recorded as incentive items for your region.

• We've fixed a bug which meant that bulk bill claims with an error that were 

resubmitted to Medicare were stuck in a claim status of Sending claim for 

processing. For example,
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Testing:

1. In Communicare, in File  > Providers  > test provider, change the 

provider number.

2. Complete a service for a patient using that provider and claim the 

service.

3. On the File  > Online Claiming  > Bulk Bill Claims  tab, observe that 

the claim cannot be sent and the claim status changes to Error: Claim 

not sent - please retry.

4. If you correct the error and resubmit the claim from the Bulk Bill 

Claims  tab, it should be successfully sent.

Updates in V21.3.39.90

Enhancements

• Using the new SMS Administration  system right, you can now restrict who can 

create, edit and manage SMS appointment reminder templates to users who belong to 

a particular user group. For more information, see SMS reminder templates  (on page 

).

• When sending SMS messages, Communicare now validates that the mobile phone 

number included in the Mobile Phone  field in a patient's biographics is 10 or 11 digits 

after all other characters and letters have been removed. If a number is invalid for a 

patient, the SMS is not sent.

• For Drug and Alcohol Treatment Service  (DATS) and other datasets where there 

is an enrolment process governed by clinical items, you can now enrol patients in the 

program and exit them from it on the same day. You can then enrol them again on that 

day if required.
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Bug fixes

• We've fixed the way in which claims with a status of Sending claim for processing 

are displayed in Communicare.

Testing:

1. In Communicare, complete a service and claim one or more MBS items.

2. For a claim that has not yet been processed by Services Australia and 

on File  > Online Claiming  > Bulk Bill Claims  tab has a claim status of 

Sending claim for processing, verify the following:

▪ In the Service Recording  window, services with a Medicare 

claim status of Sending claim for processing  display the 

Claim sent icon. For example:

▪ In the Service Recording  window, click Filter  and in the 

Service Record Filter Selections  window, set Claim Status.

▪ Set  Claimed. Claims that have a status of Sending for 

Processing  are included in the filtered list, provided they 

meet the other filter criteria.

▪ Set  Not claimable. Claims that have a status of 

Sending for Processing  should not be included in the 

filtered list.
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▪ In the Service Recording  window, double-click a patient 

whose service has a Medicare claim with a status of Sending 

claim for processing  and click Edit Service Details. On the 

Service Record  > Medicare  tab, verify that the MBS items are 

selected and that the  Claim sent icon is displayed.

▪ In a patient's clinical record, click Claims. In the History of 

MBS Items  window, verify that claims with a status of Sending 

Claim for Processing  are listed but there is no value for these 

claims in the Payment Status  column. For example:

• Immunisations for patients who did not have a valid postcode were causing an error 

when Communicare attempted to upload them to the AIR. Now, if a patient does not 

have a valid postcode, immunisations are no longer uploaded to the AIR.
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Testing:

1. In Communicare, in the Patient Biographics  for a test patient, on 

the Personal  tab, set All Localities  and from the Locality  list, select 

Other/elsewhere.

2. Add an immunisation to the test patient's clinical record and complete 

the service.

3. After CCareQueue_ServicesAustralia  runs, by default 12-2pm 

daily, in File  > Online Claiming  > AIR Claims  tab, observe that the 

immunisation claim has not been submitted to the AIR.

4. To upload the immunisation, correct the patient's postcode and wait for 

the AIR upload to run.

• Immunisations for patients who did not have a valid sex recorded in Communicare 

were causing an error when Communicare attempted to upload them to the AIR. Now, 

if there is no sex recorded, a patient's immunisations are uploaded to the AIR.
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Testing:

1. In Communicare, in the Patient Biographics  for a test patient, on 

the Personal  tab, delete the value in the Sex  field.

2. Add an immunisation to the test patient's clinical record and complete 

the service.

3. After CCareQueue_ServicesAustralia  runs, by default 12-2pm 

daily, in File  > Online Claiming  > AIR Claims  tab, observe that the 

immunisation claim has been successfully submitted to the AIR.

• We've fixed a bug which meant that you could enter invalid characters into the Service 

Text  field when completing a service and claiming MBS items, causing Services 

Australia to return an error. When completing a service, in the Service Record 

window, Service Text  field, you can now enter only alphanumeric characters and 

the following special characters: @ # $ % + = : ; , . -. All duplicate and leading or 

trailing spaces are also removed.

Testing:

1. In Communicare, open a test patient's clinical record and then complete 

the service.

2. In the Service Record  window, select some MBS items.

3. In the Service Text  field, attempt to add a test message with extra 

spaces and characters that are not allowed. For example,  / service 

text with invalid characters.!

4. Observe that you cannot add any special characters other than those 

listed.

5. Click Claim now.

6. On the Bulk Bill details  tab, observe that any duplicate and leading 

or trailing spaces have been removed, leaving a valid comment. For 

example, "service text with invalid characters."

7. After CCareQueue_ServicesAustralia  runs, by default 12-2pm daily, 

in File  > Online Claiming  > Bulk Bill Claims  tab, observe that the 

claim has been successfully submitted.
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• For customers who have enabled reasons for a patient's visit to be added manually in 

progress notes, we've fixed a bug which was preventing the Reasons for Visit  window 

from opening.

Testing:

1. In Communicare, open a test patient's clinical record.

2. On the Progress Notes  tab, click Manage Reasons.

3. Observe that the Reasons for Visit  window is displayed and that you 

can select one or more reasons from the lists.

• We've fixed a bug with the shortcut key used to display the Documents and 

Results  window.

Testing:

1. In Communicare, from the main toolbar, press CTRL + D.

2. Observe that the new Documents and Results  window is 

displayed.

• We've fixed a bug which meant that in the Australian Immunisation Register Portal, 

you could not edit a vaccine which did not have a serial number, either because it 

never had one or because you removed it.

Testing:

1. In Communicare, ensure that you can access the AIR portal. For more 

information, see Australian Immunisation Register portal  (on page 

).

2. In the clinical record of a test patient who has been identified by the 

AIR, add an immunisation and complete the service.

3. After CCareQueue_ServicesAustralia  runs, open the patient's 

clinical record again and select Go To  > Australian Immunisation 

Register portal.
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4. On the Vaccine history  tab, edit a vaccine: change the vaccine code 

and delete the serial number or leave it blank and click Save. For more 

information, see Updating vaccine history  (on page ).

5. Observe that you can save without error.

• Communicare integrates with a number of SMART apps such as NCSR and the 

Australian Immunisation Register Portal. We've fixed an intermittent problem for 

users using Remote Desktop Server or Citrix in multiple concurrent sessions where the 

SMART app host was not handling sessions correctly.

Testing:

Use two login sessions on a remote server using Remote Desktop Connection.

1. Session 1 - in Remote Desktop Connection, connect to the remote 

Communicare server and log into Communicare as provider 1.

2. Session 2 - in a separate Remote Desktop Connection session, connect 

to the remote Communicare server and log into Communicare as 

provider 2.

3. Session 1 - open a clinical record and select Go To  > NCSR Hub.

4. Session 2 - open a different clinical record and select Go To  > NCSR 

Hub.

5. In the NCSR hub, observe that the patient and provider details are 

correct for session 2.

• Communicare integrates with a number of SMART apps such as NCSR and the 

Australian Immunisation Register Portal. We've fixed a problem for users using Citrix 

where after launching a SMART app, the following error is displayed: Your user 

name and password are not defined. Ask your database administrator to set up a 

Firebird login.

Testing:

1. Using a non-default SYSDBA password, login to Communicare on a 

remote client.

2. Open a clinical record and select Go To  > NCSR Hub  or another 

SMART app.

3. Observe that the app is launched and displayed without error.
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• We've fixed a bug with data synchronisation for the offline client.

Testing:

1. In the Communicare offline client, for a test patient, in Patient 

Biographics  > Addresses  pane, click Add and add a new home 

address for a the patient.

2. Synchronise the offline client with the Communicare server.

3. Note that the home address of the patient in step 1 has been updated in 

the Patient Biographics  > Addresses  fields in Communicare.

4. Also in the Addresses  pane, click Back and observe that the previous 

address is preserved.

• We've fixed a bug in the Documents and Results  window which meant that some 

providers weren't included in the filter and were listed as Unknown.

Testing:

For incoming investigation results, ensure that new providers are listed in the 

Doctor  column of Documents and Results  > Investigation Results.

• To fix a bug where features that use asynchronous communication, such as online 

claiming, AIR uploads and SMS using Telstra Health's SMS gateway (TH Messaging), 

failed to restart after interruption, we've updated our message framework (Mass 

Transit).

Testing:

Use online claiming, AIR uploads or SMS with Telstra Health's SMS gateway 

(TH Messaging)  to test that this problem is resolved. For example:

1. From a patient's clinical record, send an SMS message using Telstra 

Health's SMS gateway (TH Messaging). For information about set up, 

see SMS messages and reminders  (on page ).

2. Check that the message is successfully sent and received.

3. Use your firewall to block Communicare's access to the internet.

4. Remove the block.

5. Repeat steps 1-2.
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Updates in V21.3.33.78

Enhancements

• In the Documents and Results  window, you can now open the Provider 

Reassignment  window from anywhere in the Investigation Results  tab using a 

keyboard shortcut: simply press r.

• To support users using more than one monitor, all windows opened from 

Documents and Results, are displayed on the same monitor as the Documents 

and Results  window, instead of the main Communicare toolbar.

Bug fixes

• We've fixed a bug where if authentication to the Communicare database failed because 

of Windows authentication, no results were displayed in the Documents and 

Results  window, Investigation Results  tab.

Testing:

1. In Communicare, go to Documents and Results  > Investigation 

Results  tab.

2. Note that investigations are displayed.
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Updates in V21.3.32.72

Bug fixes

• We've fixed a bug where emails from Communicare sent using the blat email tool 

included an incorrect from  address.

Testing:

1. In your Communicare environment, take note of the sender set for 

emails. For more information, see Organisation Parameters - Email 

Server  (on page ).

2. In an email sent from Communicare, such as a scheduled report, check 

that the sender specified in step 1 is accurately displayed in the email 

From  field.

Updates in V21.3.31.71

Enhancements

• We've made changes to Communicare to support the new bulk billing MBS incentive 

items you can claim based on your location, introduced by Services Australia and 

effective 1 January 2022. Based on your location, set the Medical, Radiology and 

Pathology incentive items for your organisation  (on page )  and encounter place 

(on page )  if required.

• We've rewritten the Documents and Results  window and each of the tabs:

◦ Investigation Results

◦ Scanned and Attached Documents

◦ Received Documents

◦ Outgoing Documents

The new Documents and Results  user interface provides performance improvements. 

However, it is functionally equivalent to the old, with minimal changes to appearance 

and behaviour. For more information, see Documents and results  (on page ). You 

may notice the following changes:
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◦ The look & feel of the Documents and Results  tabs has been updated.

◦ All filters except the date range are now saved and restored when you next open 

the window. Previously only the selected provider was saved.

◦ There is a new Default Date Range  option, which allows you to set the amount 

of the data loaded when you first open the tab, and nothing more. The default 

range is 6 months. Set the Default Date Range  to the smallest value that 

makes sense for your typical viewing needs. This setting has no impact on the 

date range filter.

◦ On the Result  tab, abnormal results are displayed in red text.

◦ On the three document tabs, the Error Message  column has been replaced 

with an Error  column. If the document has an error, a red triangle with an 

exclamation mark is displayed in this column. To view the full error message, 

select the row and look at the footer.

◦ The context menu displayed when you right-clicked on a row has been removed. 

Options related to a row have been moved to be buttons at the top of tab, after 

the navigation buttons.

◦ The ability to toggle hidden columns on the Results  tab has been moved to the 

...Ellipsis button at the bottom of the screen.

◦ The size of the scrollbar thumbnail now gives a proper indication of the quantity 

of data in the grid.

◦ You can now change the width of the columns automatically to fit the data. To 

adjust an individual column, right-click on the column header and select Best 

Fit. To adjust all columns, select right-click on any column header and select 

Best Fit (all columns).

◦ If you change the order of the columns, the default order is restored at the next 

session.

◦ Communicare remembers the size of the window and its position and restores it 

when you next open the window, except for maximised windows, which are not 

restored.

◦ If you maximise the window, it will fill the screen, without leaving space for the 

Communicare toolbar.

• We've updated our database to include the latest AIR reference dataset from Services 

Australia, which adds the following COVID-19 vaccines: Gamaleya Sputnik V 

(GAMSPU), Novavax NUVAXOVID (NOVNUV), Bharat Biotech Covaxin (BHACOV).
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Bug fixes

• In SMS appointment reminders sent to patients, the appointment date was being 

displayed using the American format, mm/dd/yyyy. This has now been corrected to use 

the Australian format, dd/mm/yyyy.

Testing:

1. Add a new test patient to Communicare or edit an existing test patient, 

and include a mobile phone number that you can access.

2. In the Appointment Book, add an appointment for the 13th or later in 

the month for this patient.

3. In Tools  > Manage SMS Appointment Reminders, check that you 

have an SMS template that will send an appointment reminder for the 

appointment, typically a day before or a week before, and on the Create 

your template  tab, check that this reminder has not already been sent 

today.

Tip:

If the reminder that would include the appointment has already 

been sent today, you will either need to make an appointment 

for the following day or create a new template to run later 

today.

4. When you receive the SMS appointment reminder, check that the date 

format uses the Australian format, dd/mm/yyyy.

• In the clinical record, Detail  tab, we've reinstated the alphabetical filter on the Item 

Description  column.

Testing:

1. In a patient's clinical record, go to the Detail  tab.

2. Click Item Description  and observe that the items are now sorted 

alphabetically, rather than by date.
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• In the clinical record, we've corrected a problem where the qualifier for a clinical item 

was showing No previous values  if a new, incoming, matched result was processed 

today, instead of showing the correct value.

Testing:

1. Identify a patient who does not have any previous values recorded for an 

incoming pathology result. In a patient's clinical record, check the Main 

Summary  for the relevant qualifier such as Hb. Also check a relevant 

clinical item, for example, in Test;Haemoglobin  check that there are no 

previous Hb values listed.

2. Wait for CCareQueue_Results  to run and the results to appear in 

Documents and Results. This process runs every 3 minutes and 

imports pathology results into Communicare.

3. Open the newly imported result and note the qualifier and value in 

the result. Match the result to the patient from step 1 who did not 

previously have any values recorded.
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4. In the patient's clinical record, check that the newly imported qualifier 

value is accurately recorded in the clinical item.

• We've fixed a bug that was preventing access to advanced biographics search queries 

for users who do not have administrator access.

Testing:

1. In Patient Biographics, click Advanced.

2. Double-click a search query.

3. Note that you can access the search query and that it runs.

• We've fixed a bug where if the email infrastructure settings in Communicare were 

incorrect for authenticated email, an error was displayed. If the email authentication 

settings are incorrect, users will not receive emails from Communicare using the blat 

email tool.

Testing:

1. In your Communicare environment, ensure that the settings in 

Communicare for your email infrastructure are correct. For more 

information, see Organisation Parameters - Email Server  (on page 

).

2. Check that you receive an email from Communicare to the address 

specified in step 1, for example, a report from the Communicare Report 

Scheduler.

48 Integrated Team Care

unique_40
unique_40
unique_40


Updates in V21.3.27.59

Enhancements

• Immunisations that failed to upload to the AIR because of an error that meant that 

the claim was not completed, is not waiting on confirmation and for which the 

immunisation details or patient biographics have been updated during the configured 

interval are now resent to the AIR.

• We've added support for TLS to blat, a third party utility which is used to email 

scheduled reports and PRODA expiry notifications.

Bug fixes

• We've fixed a bug which meant that you couldn't add a new imprest for an encounter 

place.

Testing:

1. Select File  > Imprest Management  > Manage Imprest.

2. In the Imprest Management  window, click Add.

3. Observe that the Imprest Details  window is displayed and that you can 

now create a new imprest.

• We've fixed a bug where investigation results were not being displayed in the Match 

and Review Result  window.

Testing:

1. In the main toolbar, select Documents and Results.

2. In the Documents and Results  window, on the Investigation  tab, 

double-click an unreviewed result to open it.

3. In the Match and Review Result  window, observe that the results are 

displayed in the Result  pane.
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Updates in V21.3.21.45

Bug fixes

• We've fixed a bug with online claiming using the Services Australia web services where 

rejected Medicare claims that had been marked This service is not claimable  in the 

service record, were still listed in the Claims Status (Online Claiming)  window with 

a status of Claim discarded.

Testing:

When your health service is first switched over to Services Australia web 

services, on the File  >  Online Claiming  > Bulk Bill Claims  tab, check 

that claims that were previously rejected and for which you've then set This 

service is not claimable  in the related service are not listed. Also check that 

there are no claims listed with a status of Claim discarded.

• We've fixed a bug with online claiming using the Services Australia web services where 

paid claims were being sent to Medicare Online with unpaid legacy claims.

Testing:

When your health service is first switched over to Services Australia web 

services, on the File  >  Online Claiming  > Bulk Bill Claims  tab, check 

that legacy claims previously submitted using the client adapter update 

successfully.

• We've fixed a bug with online claiming using the Services Australia web services where 

incorrect legacy claims that generated an error were preventing a claim from being 

processed.

Testing:

When your health service is first switched over to Services Australia web 

services, on the File  >  Online Claiming  > Bulk Bill Claims  tab, check 

that legacy claims previously submitted using the client adapter update 

successfully.
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• We've fixed a bug with online claiming using the Services Australia web services where 

legacy claims with a lodgement date older than 6 months were being sent to Medicare 

Online.

Testing:

When your health service is first switched over to Services Australia web 

services, on the File  >  Online Claiming  > Bulk Bill Claims  tab, observe that 

legacy claims older than 6 months are not submitted.

• We've fixed a bug with online claiming using the Services Australia web services where 

legacy claims were being sent to Medicare Online more than once per day.

Testing:

When your health service is first switched over to Services Australia web 

services, on the File  >  Online Claiming  > Bulk Bill Claims  tab, check 

that legacy claims previously submitted using the client adapter update 

successfully.

• We've fixed a bug with automatic Medicare card validation where names containing 

hyphens and spaces could not be submitted.

Testing:

In the Patient Biographics for patients with hyphenated names, check that the 

Medicare Card has been successfully validated automatically.

• We've fixed a bug where the user help was not displayed when logging in.

Testing:

When you run Communicare, in the login window, click Help. Observe that 

the user help is displayed.

• We've fixed a bug with submitting immunisation information to the AIR using 

the Services Australia web services, where if a serial number was added to an 

immunisation clinical item and then deleted, the immunisation claim was not sent to 

the AIR.
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Testing:

1. Start a service for a patient and add an immunisation clinical item that 

includes a serial number and save the item.

2. From the Progress Notes  or Detail  tab, open the same immunisation 

clinical item, delete the serial number and save the item.

3. Complete the service.

4. After CCareQueue_ServicesAustralia  runs, by default 12-2pm 

daily, in File  > Online Claiming  > AIR Claims  tab observe that the 

immunisation claim has been submitted to the AIR and has a status of 

AIR Immunisation sent.

• For health services that use the offline client, we've fixed a bug which was causing 

duplicate medications to be displayed on the Medication Summary  and Detail  tab.

Testing:

1. On the Communicare server:

a. Start a service for a patient and add two regular medications to a 

patient.

b. Complete the service.

2. On a computer with the offline client installed:

a. Synchronise Communicare.

b. In the offline client, start a service for the patient from step 1 and 

represcribe the medications that you added.

3. On the Communicare server, synchronise the data from the offline 

client to the server.

4. Observe the following:

▪ If all actions occur on the same day, on the Medication 

Summary  and Detail  tab, you will see four records:

▪ Two regular medications added in step 1 that have been 

stopped.

▪ Two current, represcribed, regular medications from step 2.

▪ If you synchronise the data a day or more later, you will see the 

two current, represcribed, regular medications from step 2.
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• We've fixed a bug where if your health service included patients with the correct 

Medicare number, but a given name different to that held by Medicare, the EPV service 

would fail instead of automatically validating the card details and creating new aliases 

for those patients.

Testing:

When your health service is first switched over to Services Australia web 

services, EPV should run automatically in the background without error and 

add new aliases for valid patients where required.

• We've fixed a bug where completed services for which a Medicare item was claimed 

and for which an additional claimant and claim item were subsequently added were 

causing the CCareQueue_ServicesAustralia  service to crash.

Testing:

When your health service is first switched over to Services Australia web 

services, in Communicare:

1. Open a patient's clinical record and record some information.

2. Close the clinical record and in the Service exit  window, click Yes - 

This service is now complete.

3. In the Service Record, select an item to claim and click Claim now.

4. From the Service Recording  window, open the same service again 

and click Edit Service Details.

5. On the Service Record  > Detail  tab, select another provider and set 

Claimant  for that provider.

6. On the Medicare  tab, select another claim item, click Claim now  and 

accept the Medicare claim summary.

7. On the File  >  Online Claiming  > Bulk Bill Claims  tab, check that the 

claim is successfully submitted to Medicare Online.
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Updates in V21.3.13.35

Enhancements

• We've updated the colour scheme in the patient banner in patient clinical records:

◦ We've reverted the pregnancy alert colour to a yellow similar to that used 

in V19.2 and earlier. This colour is also used in the pregnancy banner in 

medication warnings.

◦ In the actions list, red indicates that attention is required and grey indicates 

that no action is required. Grey with an icon indicates further information is 

available.

◦ For adverse reactions, the adverse reaction panel displays one of three statuses 

depending on what is recorded: none recorded, recorded or nil known.

For more information, see Action required banner  (on page ).

• In the patient banner, we've renamed the Investigations  link to Results. Previously, 

this link displayed a count of open investigation requests plus unreviewed pathology 

and radiology results. It now displays a count only of unreviewed pathology and 

radiology results. For more information, see Action required banner  (on page ).

• To make it easier for those with a vision impairment to differentiate the PBS states for 

medications, in the Drug Browser, we've changed the colour of authority medications 

to crimson and the colour of streamlined authority medications to brown. For more 

information, see Drug Browser  (on page ).

• The following information has been deprecated.

◦ RxE  - in V19.2 and earlier, used to indicate medication that was prescribed 

elsewhere

◦ OTC  - in V19.2 and earlier, used to indicate over-the-counter medication

You can request that Communicare Support  hide this information in Communicare, so 

that it is no longer displayed in a patient's clinical record in the following locations:

◦ Medication Summary, RxE  and OTC  columns and legends

◦ Details  tab, RxE  and OTC  information

For some health services, this information is hidden by default.

• In the Medication Summary, we've renamed the Current/Regular Medication 

column to Medication. In the Letter Writer, when you add a medication table by 

selecting Clinical Record  > Current/Regular Medication  or Regular Medication, 

we've also renamed the Current/Regular Medication  column to Medication.
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• In Documents and Results, the Encounter Place  filter is now available on all 

tabs. For more information, see Documents and results  (on page ).

• Clinicians can now add comments to verbal orders and reassign the verbal order to 

an alternative clinician if it has been incorrectly assigned. For more information, see 

Reviewing verbal orders  (on page ).

• If your health service would prefer to use another term for Medication History, 

Communicare Support  can now configure this for you. For example, you might prefer 

Medication Elsewhere. Only the second word can be customised and the new term 

is limited to 10 characters. The term you select will be used throughout the clinical 

record.

Bug fixes

• We've fixed a bug where if the authority approval number for authority and 

streamlined authority medications was longer than five characters, it was not printing 

on PBS Scripts.

Testing:

1. In a patient's clinical record, add an authority or streamlined authority 

medication which has an authority number that is longer than 5 

characters.

2. Finalise and print the prescription.

3. Observe that the authority number is printed on the PBS Script.

Updates in V21.3.11.22

Enhancements

• The dataset for Real Time Prescription Monitoring (RTPM) has been updated.

• We've added debug logging for SOAP requests and responses for the HI Service and My 

Health Record APIs.
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Updates in V21.3.10.18

Bug fixes

• We've fixed a bug with rejected claims that were subsequently marked as not claimable 

being displayed in the Claims Status (Online Claiming)  > Bulk Bill Claims  tab with 

a status of Claim discarded. These claims are no longer displayed.

Testing:

1. In Files  > Online Claiming  > Bulk Bill Claims  tab, select a rejected 

claim and click Encounter  to open the associated service record.

2. In the Service Record  window, set This service is not claimable  and 

click Claim now.

3. On the Claims Status (Online Claiming)  > Bulk Bill Claims  tab, 

observe that the rejected claim is no longer listed.

New features in V21.3

Medicare Services Australia

Communicare V21.3 continues to interact with Medicare's client adapter when it is first 

installed. Before 13 March 2022, you will need to switch over to the Services Australia web 

service for online claiming instead. The transition can happen only once and the process 

cannot be reversed.

Tip:

Until you switch over to Services Australia web services, for information about using 

Communicare with Medicare, refer to the V21.2 Knowledge Centre.

When you are ready to transition to Services Australia web services for online claiming, 

complete the following steps:

1. Register your device with PRODA. For more information, see PRODA  (on page ).

2. Within 7 days of step 1, provide the Device Activation Code that you receive from 

Services Australia to Communicare Support  who will activate your device and swap 

your system over to the new web service.
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Communicare Support will liase with you to manage the transition to web services. 

The update will include configuring Communicare for online claiming  (on page ) 

and integration with the AIR  (on page )  and any customisations you require.

Tip:

You can continue to submit Medicare claims to Medicare Online and 

immunisations to the AIR during transition.

3. Communicare Support will inform you when the switch to web services is complete.

The following changes are part of the switch to web services:

• Communicare now authenticates to Services Australia using PRODA for access to 

Medicare Online and the Australian Immunisation Register (AIR). Your PRODA device 

ID is recorded in Communicare. An encounter place can override the global device ID 

if required. A warning email is sent to Administrators when a PRODA device is due to 

expire. For more information, see PRODA  (on page ).

• New fields in System Parameters  > Web Services  for Services Australia.

• Changes to the Patient Biographics  > Personal  tab, Medicare  pane, both to the UI 

and when you click Check Card Online. For more information, see Medicare  (on page 

).

• Changes to the Tools  > Medicare Card Eligibility  window to limit the validation to 

a single patient. For more information, see Check Medicare Card Eligibility  (on page 

)

• Changes to the bulk bill claims statuses and the information returned from 

Medicare Online displayed on the File  > Online Claiming  > Bulk Bill Claims 

tab. The processing report and Medicare report for bulk billing contain additional 

information and error messages from Medicare. A DB4 form may also be returned. 

For more information, see Bulk Bill Claims (Online Claiming)  (on page )  and 

Troubleshooting online claims to Medicare  (on page ).

• As part of the transition process, Communicare Support will enable legacy bulk bill 

claims already submitted to Medicare Online using the Client Adapter, that have not 

yet been paid when your system is switched over to use web services, to continue to be 

submitted until they are paid or rejected. The Bulk Bill Legacy Claims settings in the 

CCareQueue_ServicesAustralia  service treat existing claims in the following way:
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◦ If a claim has an error status, it will be marked as rejected.

◦ If a claim has been assessed, but it has a payment error, it will be marked as 

rejected.

◦ If a claim has been assessed but not paid, it will be processed.

◦ If a claim has been assessed and paid, it is marked as paid.

If legacy claims aren't processed, contact Services Australia.

• Changes to the list of immunisations recorded in Communicare and sent to the AIR. 

On the File  > Online Claiming  > AIR Claims  tab  (on page ):

◦ You can now confirm immunisations that have been queried by the AIR, see 

Confirming immunisation claims  (on page ).

◦ New statuses are displayed and error codes returned, see Troubleshooting AIR 

uploads  (on page )  and AIR error messages  (on page ).

• A new Australian Immunisation Register portal  (on page )  user interface which 

displays the immunisation and personal information included in the AIR for a patient, 

including vaccines due and vaccination history. You can also:

◦ Add natural immunities

◦ Add medical contraindications

◦ Add planned catch ups

◦ Update vaccine history when required

◦ Update a patient's indigenous status or apply a special risk group for patient's 

who require additional vaccines and extra follow up

◦ Download an Immunisation History Statement

Also included are new system access rights for viewing a patient's immunisation 

recorded in the AIR. For more information, see Australian Immunisation Register 

portal  (on page ).

• Changes to the Service Record  to include Self Deemed  information and a Hospital 

override type for referrals. For more information, see Submit a claim to Medicare  (on 

page ).

• Changes to online patient verification. For more information, see Online Patient 

Verification  (on page ).

• Changes to enterprise patient verification, including verification of card numbers 

in Communicare before they are sent to Medicare Online for validation. For more 

information, see Enterprise Patient Verification  (on page ) .

• New settings and data included in the V21.3 Demo for Services Australia web services.
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Minor enhancements

• Communicare uses NASH certificates issued by the Digital Health Agency, which 

contain the HPI-O used for HI Service, My Health Record, secure messaging and 

so on. Communicare now supports NASH certificates using either SHA-1 or SHA-2 

encryption.

• In Patient Biographics, the Medicare card status and date last validated are now 

displayed. For more information, see Patient Biographics  (on page ).

• In Intramail, you can now open the Groups Editor  from either the Intramail  window 

or the address book. For more information, see Intramail Groups Editor  (on page 

).

• If you add medications to a letter using Clinical Record  > Current/Regular 

Medication, medication history items are also included if they are still current. For 

these items, a prefix of Source: source selected in medication history;  is 

added to any comments that may have been included when the medication was added 

to the patient's record. For example, Source: Advised by Patient; comments.

• Health services can now specify a default NCSR Provider for an encounter place for 

whom nurses and medical practice or lab staff can act as a delegate when accessing the 

NCSR. This means that Communicare users without a Medicare provider number can 

access patient details in the NCSR portal.

• You can now print or reprint a medication label for a medication order from a patient's 

Medication Summary.

• When checking for duplicate patients, Communicare now also checks patient IHI 

numbers.

• When prescribing a medication or adding a medication order, you can now add a 

shortcode to the Dosage Instructions with a single click.

• For WACHS only, PAS alerts are now displayed in the Alerts section on the Patient 

Summary.

Central Data changes

You can review new clinical items and reports using these reports:

• Report  > Reference Tables  > Clinical Item Types Added  - enter the days since the 

upgrade and choose Central.

• Report  > Database Consistency  > Central Reports
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Bug fixes

• We've fixed a bug that was preventing you from adding test details to investigation 

results added manually.

Testing:

1. In a patient's clinical record, add a new pathology request.

2. On the Detail  tab, right-click the new pathology request and select Add 

Manual Investigation Result.

3. In the Match and Review Result  window, add test details to the left 

pane.

• We've fixed a bug that prevented secure messages being received when 

PDS was enabled but the FHIR server couldn't be contacted. Now if PDS 

is enabled but the FHIR server cannot be reached, an error is logged in 

Communicare_installation/Logs/CCareQueue_Smd.log.

Testing:

Ensure that secure messages are received.

• We've fixed a bug that meant that for checkboxes added to letters, edits were not 

saved.

Testing:

1. In a patient's clinical record, create a new, blank letter, add a checkbox 

and some text and save it.

2. From the Progress Notes, reopen the letter, set the checkbox and save 

it.

3. From the Progress Notes, reopen the letter and observe that the 

checkbox is set.
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• We've fixed a bug that was causing a delay in opening letters which included Current/

Regular Medication  or Regular Medication.

Testing:

In a patient's clinical record, open a letter which includes information added 

using the Clinical Record  > Current/Regular Medication  or Regular 

Medication  variables. Verify that the letter opens in a reasonable time.

Installation Requirements

• Communicare V21.3 is supported on Windows 10 and later and Windows Server 2016 

and later. Security and other updates from Microsoft must be installed as they become 

available.

• .Net 4.8 or later is required

• Java Runtime Environment 1.8.0_202 for uploading to the AIR

• HQBird 2.5.9 is now an external dependency. Firebird 2.5 and earlier is no longer 

supported.

V21.2 Release Notes

Communicare V21.2 includes new integrations with the Provider Directory Service and 

The George Institute. It also includes changes to secure messaging and My Health Record 

uploads to comply with new ADHA standards. V21.2 also includes minor enhancements and 

bug fixes.

Prerequisites

Because of the schema changes associated with the medications changes made in V20.1 and 

later, all customers upgrading from V19.2 and earlier should run the following report before 

upgrading and resolve any issues: Unprescribed Regular Medications.

Note:

If you are upgrading from V19.2 and earlier and have any custom reports that use 

medications tables or views directly, ensure you check Database Schema changes  (on 

page 94)  in the V20.2 release notes. If you are affected, discuss migration options 

with Communicare Support.
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New features

ADHA Provider Directory Service integration

You can now search the Provider Directory Service (PDS) for an individual or organisation 

listed with the ADHA and create a record in your local address book which remains 

synchronised with the PDS.

To use the PDS search, your clinic must configure the PDS service and enable the Address 

Book Integration - ADHA PDS  module. For more information, see Modules. Any users 

must belong to a user group that has the Address Book Maintenance  system right.

For more information, see Provider Directory Service  (on page ).

Secure messaging enhancements

We've made a number of changes to the handling of secure messages for ADHA compliance:

• You can now generate and send a letter or referral as a PDF.

• Support for incoming documents and results in CDA (MDM V2.3.1) and PDF (REF 

V2.4) formats.

• Support for incoming imaging and pathology results sent by the investigation provider 

as HL7 ORU (HL7, HTML, PDF).

• Acknowledgements are sent for every message received.

• Outbound documents are sent using HL7 V2.4 REF messages.

• Acknowledgements are processed for messages we send and any errors are displayed 

in Documents & Results  for practice managers to review.

You can now also generate a list of installed certificates with unknown expiry dates, or that 

will expire in the next 60 days. Run the NASH Certificate Expiry  report.

My Health Record integration changes

For ADHA compliance, we've changed the IHI validation. When Communicare starts, 

connectivity with the My Health Record is no longer tested and functions that might have 

been disabled if there was no connectivity are not affected. Patient IHI numbers are instead 

validated when Communicare uploads the documents to the My Health Record, so if a 

patient does not have an IHI, you will not be able to upload their documents.
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You can now also generate My Health Record documents in the Offline Client. These 

documents are then uploaded to the My Health Record after Offline Clients are synchronised 

to the online client.

The George Institute integration

Communicare can be integrated with The George Institute HealthTracker™, a tool that 

provides a "clinically validated decision support system for cardiovascular diseases, diabetes 

and kidney diseases".

Clinicians can use the Communicare HealthTracker to generate an interactive health risk 

assessment which shows recommendations based on guidelines. They can demonstrate to 

patients how reducing a risk factor such as smoking can affect that patient's risk and provide 

tailored advice to patients to assist with the management and prevention of cardiovascular 

disease, diabetes and chronic kidney disease.

The interactive report uses the qualifiers and measurements recorded in the George 

Institute HealthTracker  clinical item.

For more information, see HealthTracker  (on page ).

NCSR integration

Communicare now integrates with the National Cancer Screening Register (NCSR).

If a patient has any alerts in the NCSR database, an alert count and link are displayed in 

the banner in the patient record. The link takes clinicians to the NCSR hub where further 

information is available.

To display the NCSR alerts in Communicare, your clinic must configure the NCSR integration 

and enable the NCSR Integration  module. Any clinicians who want to see the NCSR 

information must belong to a user group that has the NCSR Integration  system right.

For more information, see National Cancer Screening Register  (on page ).

Minor enhancements

V21.2 includes the following minor enhancements:
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• DAA values are now included with the dosage instructions in the Patient Summary 

report, care plans and in letters when you add Clinical Record  > Current/Regular 

Medication  to a letter in the Letter Writer.

• Clinical Decision Support is now available in the Communicare Demo V21.1 and later 

by default.

• In response to MIMS changes we now support active unit names of up to 50 

characters. For example, billion viral particles.

• The Communicare installer now checks what version of .Net is installed and warns if it 

is not .Net 4.8.

• We've added some extra fields to templates:

◦ Dispense Label template - if a patient's date of birth is available, it is now 

displayed next to the patient's name

◦ Medication Request template:

▪ Added medication type with text of either Once off  or Regular

▪ If the medication is expired, text of Expired  is added, otherwise this field 

is left blank

• We've added an index to patient_adverse_reaction to improve performance when 

querying the table.

• When you represcribe multiple medications (bulk represcribe), if your health service 

is set up for Real-Time Prescription Monitoring (RTPM), and the medication is a 

controlled medicine, Communicare sends information to the Safescript  service on 

the internet. Safescript results are then displayed for each drug prescribed. For more 

information, see RTPM  (on page ).

• You can now choose to display a child's height/length and weight on Centile Charts 

that use either the Centre for Disease Control and Prevention (CDC) or World Health 

Organisation (WHO) reference data. Head circumference is available only with the 

WHO reference data. For more information, see Centile Chart  (on page ).

• Documents exported as part of the Patient Summary now have more descriptive 

filenames so that they can be more easily identified. For more information, see Patient 

Summary  (on page ).

• In patients' clinical records, we've updated the AIR  link in the clinical record to 

jump to the new PRODA website.

• For RIVeR systems, allergies recorded in a patient's clinical record are now 

automatically printed in the Clinical Details  section on the medical imaging request 

form. For more information, see Investigation requests  (on page ).
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• When creating an imaging investigation request, you can now indicate if the patient 

is breastfeeding or is an infection risk and add infection details. This information is 

automatically transferred to the request form. For more information, see Investigation 

requests  (on page ).

• For most clients, clinical notes only up to 145 characters are printed in the Clinical 

Notes  field on the investigations template. Any additional notes are printed on a new 

page. For some enterprise customers, the Clinical Notes  field has been extended 

to 200 characters. If your health service requires more than 145 characters for 

theClinical Notes  field, contact Communicare Support.

• For decision support, we've changed when CDS service  availability warnings are 

displayed when you add a pregnancy or condition clinical item to a patient's clinical 

record. Warnings are no longer displayed if the CDS service  is unavailable when 

you add procedure and history clinical items, unless the items have a full ICPC-2 

PLUS  code. For condition clinical items, a warning is displayed if the CDS service 

is unavailable or if the item does not have a full ICPC-2 PLUS  code. For more 

information, see Decision Support  (on page ).

• Communicare now uploads results received in HTML format to MeHR, in addition to 

PDF and plain text.

• In V21.1, to address inconsistent timestamps, we changed to 24-hour time format 

wherever a timestamp is used, regardless of the system setting on your workstation. 

The only exception to this is the content of SMS texts sent to patients from 

Communicare, which display 12-hour format. We've also removed seconds from the 

timestamp where it is not needed, such as:

◦ Session selection start and end times

◦ In the clinical record, assessment date for adverse reactions

◦ Appointment book

◦ Imprest management

Central Data changes

You can review new clinical items and reports using these reports:

• Report  > Reference Tables  > Clinical Item Types Added  - enter the days since the 

upgrade and choose Central.

• Report  > Database Consistency  > Central Reports
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Bug fixes

V21.2 includes the following bug fixes:

• We've fixed the error that occurred when a new user attempted to login with an 

inactive user login.

• For MeHR-registered patients, when you end a service, the appropriate MeHR options 

are set by default in the Service exit window.

• Measurements in the Observations Summary in letters are now displayed in the same 

order as in the Qualifier Summary in the clinical record.

• If you add an adverse reaction for the medication you are prescribing from the Add 

Medication  window, a reaction warning is now displayed.

• We've corrected the medication data passed to eRx.

• We've fixed a problem that occurred if you deleted a medication which was part of an 

active medication request.

• We've fixed a column size issue with the database consistency check

• We've fixed a problem where the Qualifier Type window remains open after closing a 

care plan.

• We've added error messages to handle when users try to repeat regular medications 

that are included in the current medication request and have been supplied. Regular 

medications that have been created, a medication request raised and the medication 

supplied in the current service cannot be repeated or represcribed.

• We've fixed a bug where the Medication Order you created from a prescription and 

edited after saving showed a duration of 0 days.

• We've fixed a problem that was stopping you from searching the EPD.

• We've fixed a bug where previous measurements weren't being displayed for clinical 

items with a qualifier of type memo.

• We've added support for long medication names so that the database can be upgraded.

• We've fixed a problem with the MIMS importer so that it handles MIMS double-quotes.

• We've fixed a problem with the Letter Template printing with incorrect patient details.

• We've fixed a problem where the wrong RTPM alert was displayed for high quantities 

of a medication.

• We've removed the age scaling information from the Help, which was incorrect.

• We've fixed a bug that prevented secure messages being received when 

PDS was enabled but the FHIR server couldn't be contacted. Now if PDS 

is enabled but the FHIR server cannot be reached, an error is logged in 

Communicare_installation/Logs/CCareQueue_Smd.log.
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• We've fixed a bug with the Documents and Results  window being slow to load for 

larger organisations with a number of encounter places and many documents matched 

to providers. The window now opens quickly and we've removed the 100 results display 

limit that we previously set.

• We've fixed a bug with the Letter Writer being slow to open for letters using the 

Clinical Record  > Current/Regular Medication  or Regular Medication  option.

Installation Requirements

• Communicare V21.2 is supported on Windows 10 and later and Windows Server 2016 

and later. Security and other updates from Microsoft must be installed as they become 

available.

• .Net 4.8 or later is required

• Java Runtime Environment 1.8.0_202 for uploading to the AIR

• HQBird 2.5.9 is now an external dependency. Firebird 2.5 and earlier is no longer 

supported.

V21.1 Release Notes

Communicare V21.1 includes the major changes to medication management made for 

enterprise users in V20.1 and V20.2 and makes them available for our other users. V21.1 also 

includes new features, and maintenance updates and bug fixes.

Prerequisites

Read the V20.2 release notes  (on page 82).

Because of the schema changes associated with the medications changes, all existing 

customers should run the following report before upgrading to V21.1 and resolve any issues: 

Unprescribed Regular Medications.

Note:

If you have any custom reports that use medications tables or views directly, ensure 

you check Database Schema changes  (on page 94)  in the V20.2 release notes. If 

you are affected, discuss migration options with Communicare Support.
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Medications management changes

Communicare V21.1 consolidates major changes to the way medications are recorded and 

handled in Communicare. Ensure that you check the V20.2 release notes  (on page 82) 

first.

Consolidated Orders

If you stock your patient's prescription medications at your health service, or are the health 

provider for a remote site that stocks prescription medications for your patients, you can use 

medication requests to help manage the patient's medications and consolidated orders to 

manage the inventory.

Consolidated orders are groups of medication requests that can be sent to an external 

pharmacy for supply. For example, after a clinician has reviewed and updated a patient's 

medications and created and submitted a medication request, the Imprest manager can use 

consolidated orders to manage the inventory and order medication requests for multiple 

patients from a supplier. When the clinic receives the order, the Imprest manager can 

note the quantities received in the order. A health worker can then supply the patient's 

medication to them and the inventory is adjusted.

Note:

Medication requests replace Health Centre Prescriptions, Rural Prescribing and S100 

Prescribing.

Tip:

Consolidated orders are part of the Medications Management  module. To use 

consolidated orders, both medication requests and consolidated orders must 

be enabled and you must belong to a user group which has the Consolidated 

Order - Manage  system right set. For more information, see System Parameters - 

Prescription Forms  (on page ).

To display the Consolidated orders  summary window, select File  > Imprest Management 

> Manage Patient Consolidated Orders.

For more information about using consolidated orders, see Consolidated Orders  (on page 

).
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COVID-19 Immunisation changes

To allow COVID-19 immunisations to be uploaded to the AIR, we've added two new fields to 

the Immunisation  clinical item. Clinicians can:

• Use the Serial Number  field to record the serial number of the vaccine. For COVID-19 

immunisations you can make inclusion of a serial number mandatory. For more 

information, see Clinical Item Type Properties  (on page ).

• Use the Administered overseas  field instead of the Performed at current encounter 

place  field to indicate historical immunisations that were performed overseas.

The following patient and provider identifier information is now also uploaded to the AIR:

• The patient's IHI

• Information about who administered the immunisation and who entered the data, for 

both the individual, using the HPI-I, and organisation, using the HPI-O

For more information, see Recording immunisations  (on page )  and Australian 

Immunisation Register uploads  (on page ).

Medication labels

If you don't use the Administer and Supply feature, and your health service supplies 

medication from a medication order, you can print medication labels to adhere to the 

medication.

Tip:

If your health service uses this approach for supplying medications, the 

Medications Management  module is not enabled in File  > System Parameters 

>  System  tab and Enable label printing  is set in File  > System Parameters  > 

Clinical  tab.

SMS

In Communicare V21.1 and later, you can send appointment reminders to patients using 

Telstra Health's SMS gateway (TH Messaging)  and a new interface. You can:
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• Send SMS messages or reminders directly to individual patients from their biographics 

or clinical record

• SMS multiple patients manually

• Set up appointment reminder templates to automatically send SMS messages to 

patients with an appointment on a particular day

• Receive SMS replies from patients

• If enabled, automatically cancel appointments if a patient rejects an appointment by 

SMS

For more information, see SMS messages and reminders  (on page ).

You can continue to use the old SMS system with Burst until your credit expires, or use both 

messaging services together.

Contact Communicare Support  if you want to enable this feature.

Clinical Decision Support

In Communicare V21.1 and later, for pregnancy and condition interaction checking, 

Communicare links to the current MIMS database online using the CDS service  instead of 

using the MIMS databases that you have downloaded and installed locally.

The CDS service  is cloud-based so will always access the most recent MIMS data available.

Communicare continues to use the MIMS databases installed locally for drug to drug 

interaction checking, product and consumer information and other warnings.

CDS is enabled in the Communicare Demo by default.

For more information, see Decision Support  (on page ).

My Health Record integration enhancements

We've improved the performance and logging of CDA documents, including the Event 

Summary, Shared Health Summary, eReferral and Discharge Summary. These documents 

should now be generated and upload faster. We've also changed the way you select 

information to include or exclude in the documents: if you select a child topic, the parent is 

also selected; if you deselect all child topics, the parent topic is also deselected.

CDA documents now also support extemporaneous preparations.
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DataSync

The offline client now supports medication requests. For more information, see Data 

Synchronisation  (on page ).

Minor enhancements

V21.1 includes the following minor enhancements:

• When supplying medication requests, we added the option to show or hide 

medications included in a medication request for which there is no inventory. For 

more information, see Supply Medication Requests  (on page ).

• We changed the medication values used in V20.1 so that after a medication is added 

to a record, it maintains the record of what was prescribed at the time, even if the 

medication details are changed in MIMS.

• We added the Script No.  column to Bulk Represcribe, Stop Medications, Add 

Medication Request Finalise, Patient inventory, so that the script number, Order  or 

History  are included.

• We've limited viewing medication requests to only those providers who belong to 

a user group with Prescribing Full  or Prescribing Once Off/Short Course 

system rights.

• In the Requested medications  section of the Administer and Supply Medication 

window, we've added a Request status  field, so you know which medications are part 

of an active medication request.

• We've reinstated the option for a username and password check if prescribing to a 

patient who has had an adverse reaction. To enable this option, set Require password 

on adverse reaction prescribing  on the System Parameters - Clinical  (on page ) 

tab.

• We've improved the UI for when you're prescribing a medication using a DAA, so that 

its clear that you can't also add dosage instructions.

• We've added the ability to customise the name of Medication Requests  and related 

fields to System Parameters - Prescription Forms  (on page ).

• If you add a drawing to a clinical item that includes a drawing qualifier, such as 

Exam;skin, and then add that drawing to a letter, the drawing key is now also 

included. For more information, see Add drawings to clinical items  (on page ).

• We've added support for qualifier values to be recorded with both time and date to 

support the increase in point-of-care tests and medical devices which record the same 

test or observation more than once per day. The most recent value is displayed in the 
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Qualifier Summary, and all values are displayed in the Previous measurements 

table and chart.

• We've added a new setting to the System Parameters  > Clinical  tab. Set Always 

record date and time  to override the Date Only  option for existing clinical item 

types so that you don't have to update each type manually.

• The following documents have been removed from the Help  > Forms  menu, because 

there is a more recent version on the Communicare Client Portal  or because the 

document is no longer required:

◦ Communicare eLearning Request Form

◦ Reset Administrator Password Form

◦ Telephone Training Request Form

◦ Hearing Services Program Information

◦ My Health Record  > Assisted Registration Essential Information

• If you add medications to a letter using Clinical Record  > Current/Regular 

Medication, current medication history items are included with a comment prefix of 

[External Medication History].

• You can test CDS service  in the Communicare V21.1 Demo where it is enabled by 

default.

• In the Administer and Supply Medication  window, we've improved the message 

displayed when you set Remove from inventory.

• The medication request template now supports fields needed for Health Centre 

Prescriptions.

• If you're represcribing multiple medications at once (in bulk), a warning is now 

displayed if MIMS has deleted a medication. Medications deleted by MIMS cannot be 

represcribed and are not listed in the Represcribe Medications  window.

• We've added the following templates for prescribing, which you can select on the File 

> System Parameters  > Prescription Forms  tab.

◦ For Health Centre Prescribing, select one of the following templates from 

the Medication Request Template  list. Ensure that you also set Use Health 

Centre Prescription defaults  on the File  > System Parameters  > Clinical  tab.

▪ Health Centre Prescription with Dispense Record  - use this 

template for medication requests if you'd previously had Use rural 

prescription form  > Don't Print Dispensing Record on form  selected 

on the File  > System Parameters  > Clinical  tab.

▪ Health Centre Prescription - no Dispense Record  - use for 

medication requests.
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◦ Medication Request - Default  - use for medication requests. Select from the 

Medication Request Template  list.

◦ Consolidated Order - Default  - use for consolidated orders. Select from the 

Consolidated Order Template  list

• We've added the following new care plan templates. To add a care plan to a patient's 

clinical record, click New Care Plan  on the Summary  > Care Plan  tab.

◦ Cancer Screening Care Plan Female

◦ Cancer Screening Care Plan Male

• To address inconsistent timestamps, we've changed to 24-hour time format wherever 

a timestamp is used, regardless of the system setting on your workstation. The only 

exception to this is the content of SMS texts sent to patients from Communicare, 

which display 12-hour format.

• We've updated the following reports to use both date and time:

◦ Patient Measurement History

◦ Patient Multiple Qualifier History

• We've updated the Colonoscopy Referral Form Template (Clinical Care Standards) to 

the latest version.

Central Data changes

You can review new clinical items and reports using these reports:

• Report  > Reference Tables  > Clinical Item Types Added  - enter the days since the 

upgrade and choose Central.

• Report  > Database Consistency  > Central Reports

For a list of new and modified items, see Central Data changes since V19.2  (on page 77).

Maintenance items

• Fixed documents and results provider filtering

• Added annual scheduled report to send licence usage to Communicare if scheduled 

reports are configured

• Migration performance improvements related to the Med_Supply table and regular 

medications view
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Bug fixes

The following bugs have been fixed in V21.2:

• Fixed bug where stopped medication in offline client doesn't sync to online client

• System settings values are not saved in demo releases

• Able to make changes in system parameters with incorrect access code

• Remove MIMS markup from medication details

• Extend CDA document generation to correctly classify extemporaneous medications

• Fix documents and results provider filtering to ensure all providers can be selected

• Finalise screen is truncated when resolution is under 1920x1080

• Increase column size of email fields to be consistent

• An exception occurred when user clicked on "Medication Overview" button from 

Administer and Supply screen

• Status tag not displayed in Clinical Record detail tab

• Fix saving medication as default throws error if a medication has large name

• Communicare no longer tries to upload immunisations performed prior to 01 January 

1996 to AIR

• Show printer dialog doesn't work

• Expanded the address field validation rules to recognise most legitimate email 

addresses in scheduled reports

• Scheduled reports do not support parameters of the type FUNCTION="...

• Create medication request by default  option is still set even when medication 

requests are not set.

• We've fixed an error that occurred if you added a medication to the letter writer longer 

than 120 characters

• NWHHS HBCIS: handle active null in names

• Care plan data not rendered on first page of care plan document

• Modifying incoming referrals causes error

• We've fixed the Not HL7 V3 Clinical Document  error which may occur when 

receiving some CDA documents

• We've fixed an error that caused Communicare to crash when opening a clinical item 

from the Detail  tab when the clinical record contains a medication history item

• We've fixed an error that occurred if you opened the medication overview after a 

medication was supplied but MIMS deleted the record for that medication

• Communicare no longer uploads immunisations for fictitious patients to AIR, which 

resulted in calls from Services Australia about invalid data.
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• On Investigation request forms, we've moved the Indigenous Status  field to after the 

clinical notes so that the information prints correctly

• You can no longer add executable files, or shortcuts or links to executable files, to 

Communicare. For more information, see Adding custom forms  (on page ).

• The buttons displayed in the Medication Warnings  window are now consistent 

regardless of whether you are reviewing a prescription or a medication order.

• We've added an indicator to show that Communicare is working when opening the 

Administer and Supply Medication  window, so that you know what's happening 

when opening records with lots of medications.

• For MIMS-related decision support, we've fixed a bug where drug to pregnancy 

category interactions were displayed incorrectly. Where only non-specific category 

interactions are included, they are now displayed in descending order of category 

severity.

• We've fixed an error that stopped you printing a medication request for a patient if the 

sex of the patient was not recorded.

• We've updated the Healthcare Identifier Service (HI Service) certificate in the 

demonstration versions of Communicare so that you can test Medicare interactions in 

the demos.

• We've fixed a time out error that was introduced with the recent AIR updates which 

stopped the MeHR integration from working.

• Related to the timestamp work, we've removed the seconds displayed in the following 

places:

◦ Clinical record, Adverse Reaction Summary  > Assessment Date

◦ The Session Selection  window

◦ Appointment Book

◦ Service list for a patient

• In the Letter Writer, when you add Clinical Record  > Latest Qualifier  it now correctly 

displays the most recently recorded value for the selected qualifier.

• We've fixed the validation that was occurring when you added or represcribed a 

medication.

• We've fixed a bug for MeHR users, where the MeHR upload options weren't selected by 

default when you closed a service.

• We've fixed an issue with a column size in the Database Consistency Check.

• We've fixed a bug where the Medication Order you created from a prescription and 

edited after saving showed a duration of 0 days.

• We've fixed a problem that was stopping you from searching the EPD.
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• We've fixed a bug where previous measurements weren't being displayed for clinical 

items with a qualifier of type memo.

• We've added support for long medication names so that the database can be upgraded.

• We've reinstated old release notes in the Help for reference.

• We've fixed a problem with the Letter Template printing with incorrect patient details.

• We've fixed a bug with the export of patient data from Communicare for import to 

ISOH /Titanium. Ensure you are running .Net 4.5.2.

• We've fixed a problem where the wrong RTPM alert was displayed for high quantities 

of a medication.

Deprecated features

The following features have been deprecated:

• Health Centre Prescriptions (HCP)

HCP and rural prescribing are now included in the medication requests workflow. To 

enable HCP in medication requests:

1. Contact Communicare Support for assistance with this update.

2. Enable medication requests and ensure you set Print S8 prescriptions on a 

separate page. For more information, see System Parameters - Prescription 

Forms  (on page ).

3. On the File  > System Parameters  > Clinical  tab, set Use Health Centre 

Prescription defaults. For more information, see System Parameters - Clinical 

(on page ).

Installation Requirements

• Communicare V21.1 is supported on Windows 10 and later and Windows Server 2016 

and later. Security and other updates from Microsoft must be installed as they become 

available.

• .Net 4.5.2 or later

◦ If you want to use Telstra Health's SMS gateway (TH Messaging), .Net 4.8 or 

later is required

• Java Runtime Environment 1.8.0_202 for uploading to the AIR

• HQBird 2.5.9 is now an external dependency. Firebird 2.5 and earlier is no longer 

supported.
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Central Data changes since V19.2

New and modified reports and clinical items are summarised here.

New and modified reports

Table  3. New and modified reports

New reports Modified reports

Appointments Appointment Details Appointments Missed appointment letter

Appointments Requirement Details Appointments Reminder letters list

Appointments Reschedule Queue Details Appointments Transport Requirements

Database_Consistency Current Version Numbers Audit_Logs Biographics Reviewed on Service Date

Patients NDIS Status Clinical_Record Adverse Reactions Audit

Procedures WA RHD Monthly Bicillin Report Clinical_Record Conditions and Qualifiers 
Analysis

Reference_Tables Qualifier Type Usage Clinical_Record INR Chart

Clinical_Record Kidney Disease Outcomes

Clinical_Record Patients with Dx but no Rx

Clinical_Record Patients with Rx but no Recall

Clinical_Record Progress Notes

Database_Consistency Fictitious Patients

Database_Consistency Scheduled Reports

DATS_NSW Monthly Episodes Export

DATS_NSW Monthly Other Drugs Export

DATS_NSW Monthly Other Services Export

DATS_NSW Monthly Pharmacotherapy Type 
Export

DATS_NSW Monthly Previous Services Export

DATS_NSW Monthly Service Contacts Export

Documents Added Between Two Dates

Electronic_Claims Bulk Bills Status Report

Electronic_Claims CDM Summary for Selected 
Patient

Electronic_Claims CDM Summary Patients with 
current 723

Electronic_Claims Partially paid with error 
message

Electronic_Claims Service Activity Report

Encounter_Analysis Average Waiting Time in 
Minutes

Encounter_Analysis Contacts by Place and Mode 
and Program

Encounter_Analysis Frequent Patient Analysis
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Table  3. New and modified reports  (continued)

New reports Modified reports

Encounter_Analysis Provider Data Audit Details

Encounter_Analysis Provider Data Audit

HACC Quarterly extract (Victoria)

HACC Time Analysis

Immunisations ACIR Electronic Claims

Immunisations Annual Fluvax List NT

Immunisations Annual Fluvax List

Immunisations Fluvax performed this year

Immunisations Summary

Investigations Results Received

Medications Dosette Label for Selected Patient

Medications Locality medication list

Medications Medication Summary for Selected 
Patient

Medications Outstanding Verbal Orders

Medications Patients with expired Regular 
Medications

Medications Patients with Multiple Same 
Medications

Patients Address Details

Patients Biographics for Selected Patient

Patients Chronic Disease Clients (Default)

Patients Group Members

Patients Invalid Mobile Phone Numbers

Patients With Selected Clinical Item

Population_Analysis Added to Communicare by 
Month

Population_Analysis Count by Aboriginality

Population_Analysis Count by Status

Pregnancy Current Antenatal List

Pregnancy NT Diabetes in Pregnancy Clinical 
Register

Private_Billing Claims Between Two Dates

Private_Billing Outstanding Balances

Private_Billing Payments Between Two Dates

Procedures Performed by date with qualifiers 
(export)

Qualifiers Selected Qualifier (numeric)

Recalls Health Check Management
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Table  3. New and modified reports  (continued)

New reports Modified reports

Recalls Recalls Due

Recalls Reminder Letters for Selected Provider

Recalls Reminder Letters

Reference_Tables Address Book

Reference_Tables Clinical Item Groups

Reference_Tables Clinical Item Types Added

Reference_Tables Encounter Places

Reference_Tables Formularies

Reference_Tables ICPC SNOMED Mappings

Reference_Tables Numeric Qualifiers - Central

Referrals Patient Referrals by Organisation and 
Provider

Referrals Reminder Letters

SMS Batch Report Details

Transport Daily Work Tally Sheet

Transport_Management Daily Transport Itemised

Transport_Management Daily Transport 
Requirements

Transport_Management Missed Bookings

User_Groups System Rights Grid

Workstations Client List - Five Fortnights User 
Median

Workstations Client List selected date range

Workstations Client List

New and modified clinical items

Table  4. New and modified clinical items

New clinical items Modified clinical items

Advice/education;COVID-19 Alcohol/Drug treatment enrolment (NSW)

Aniridia Check up;Aboriginal & TSI adult

At risk;COVID-19 Check up;Aboriginal & TSI adult NO MBS

Augmentation;breast Check up;Aboriginal & TSI child

Bruit;arterial Check up;Aboriginal & TSI child NO MBS

COVID-19 Check up;Aboriginal & TSI over 55 NO MBS

COVID-19;suspected Check up;Aboriginal & TSI over 55s

Chondral loss Check up;HU5K child health check 8 wks

Concern (about);COVID-19 Check up;HU5K child health check 4 mths
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Table  4. New and modified clinical items  (continued)

New clinical items Modified clinical items

Dense;breast(s) Check up;HU5K child health check 6 mths

Elastography;liver Check up;HU5K child health check 9 mths

Gastrectomy;partial Check up;HU5K child health check 12 mths

Immunisation;rotavirus Check up;HU5K child health check 18 mths

Implant;cardiac monitor Check up;HU5K child health check 2 yrs

Ischaemia;mesenteric Check up;HU5K child health check 2.5 yrs

Lymphoedema;postmastectomy Check up;HU5K child health check 3 yrs

Otitis media;acute;no perforat Check up;HU5K child health check 3.5 yrs

Otitis media;acute;perforation Check up;HU5K child health check 4 yrs

Palsy;progressive supranuclear Check up;HU5K child health check 4.5 yrs

Pancreatectomy Check up;HU5K;Child Hx & Risk Assessment

Pancreatectomy;partial Check up;HU5K;First Assessment

Phalloplasty Check up;KICA cognitive check

Pseudophakia Check up;RHD and acute rheumatic fever

Referral;elastography;liver Check up;alcohol;AUDIT-C

Referral;fever clinic Check up;child development

Renal supportive care Check up;over 75s

Salpingo-oophrectomy Cycle of care;annual;diabetes

Salpingo-oophrectomy;bilat Drawing

Tumour;mixed parotid Exam;general

Vaginoplasty Exam;genitourinary;female

Vulvoplasty Exam;pre-consult

ASQ-TRAK Ages & Stages Questionnaire Exam;pre-consult;child

Assessment;Indigenous Risk Impact Screen George Institute HealthTracker

Check up;HU5K child health check 4 wks HACC/CHSP Allied Health Care

Check up;HU5K;GP Follow Up HACC/CHSP Allied Health care at centre

Gender Information HACC/CHSP Allied Health care at home

Immunisation;COVID-19 Vaccine AstraZenec HACC/CHSP Assessment

Immunisation;Fluad Quad HACC/CHSP Carer Counselling/Support

Immunisation;Flucelvax Quad HACC/CHSP Carer Information

Immunisation;Fluzone High-Dose Quad HACC/CHSP Carer Respite Care

Immunisation;Pfizer Comirnaty HACC/CHSP Case Management

Immunisation;Vaxigrip Tetra HACC/CHSP Centre-based day care

NationaI Indigenous Bowel Cancer Screen HACC/CHSP Client Care Coordination

National Cancer Screening Register Pt ID HACC/CHSP Counselling/Support, etc.

Opt Out of Cancer Screening HACC/CHSP Domestic Assistance

Results;bowel cancer screening HACC/CHSP Enrolment
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Table  4. New and modified clinical items  (continued)

New clinical items Modified clinical items

Results;breast cancer screening HACC/CHSP Enrolment (Vic)

Results;prostate cancer screening HACC/CHSP Exit

Smokerlyzer® Reading Adult HACC/CHSP Formal Linen Service

Smokerlyzer® Reading Maternity HACC/CHSP Functional Assessment

Xpert POC test;SARS-CoV-2 HACC/CHSP Functional Assessment (Vic)

HACC/CHSP Goods and equipment

HACC/CHSP Home Maintenance

HACC/CHSP Home Modification

HACC/CHSP Meals Provided

HACC/CHSP Nursing Care

HACC/CHSP Other Food Services

HACC/CHSP Personal Care

HACC/CHSP Planned activity group

HACC/CHSP Social Support

HACC/CHSP Transport

Immunisation;ADT vaccine

Immunisation;ActHIB

Immunisation;BCG vaccine

Immunisation;Comvax

Immunisation;Dukoral

Immunisation;Fluad

Immunisation;Hepatitis B Immunoglobulin

Immunisation;Hexaxm

Immunisation;Hiberix

Investigation Result

Remote Emergency Warning Score (REWS)

Results;cervical screening

Review;GP;RHD and ARF

TTANGO;STI POC Test

Urinalysis

i-STAT;CG4+

i-STAT;CHEM8+

i-STAT;INR

i-STAT;Troponin I
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Version 20
Release notes for version 20 enterprise releases.

V20.2 Release Notes

V20.2 is a limited release for enterprise customers, containing major changes to medication 

management, new features, and extensive maintenance updates and bug fixes.

Prerequisites

Because of the schema changes associated with the medications changes, all existing 

customers should run the following report before upgrading to V20.2 and resolve any issues: 

Unprescribed Regular Medications.

Note:

If you have any custom reports that use medications tables or views directly, ensure 

you check Database Schema changes  (on page 94). If you are affected, discuss 

migration options with Communicare Support.

Medications changes

Communicare V20.2 consolidates major changes to the way medications are recorded and 

handled in Communicare.

Prescribing has been split into three new actions:

• Write a Prescription - use when you want to print a prescription and give it to a patient 

to fill outside your health service

• Create a Medication Order - use when you want to administer or supply medication 

from within your health service

• Record Medication History - use when you want to record any medication the patient 

may have taken, but that was not provided by your health service

Write a Prescription

Write a Prescription  is the new workflow for recording a medication that can be printed 

and given to the patient.
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To write a prescription, in the clinical record, select Medication  > Add Medication  > Write 

a Prescription  tab.

The user interface has been streamlined to make adding a medication much easier. For 

example, to reduce the number of clicks when adding a medication, the PBS authority details 

section is now in the main window.

For more information, see Write Prescriptions  (on page ).

Create a Medication Order

Create a Medication Order  is a new workflow that streamlines the process of adding 

a medication that will be supplied or administered within the health service under 

circumstances that don't require a printed prescription form.

To create a medication order, in the clinical record, select Medication  > Add Medication  > 

Create a Medication Order  tab.

When Medication Management  is enabled in System Parameters, medication orders are 

required to administer or supply a medication.

Because a written prescription is not required, the user interface is greatly simplified and 

only contains the information required. For example, there is no requirement to select 

the payment scheme and enter any PBS details as medications orders are considered to be 

private.

Medication orders also contain the verbal or written telephone order workflow which is now 

displayed in the main window when appropriate.

For more information, see Create Medication Orders  (on page ).

Record Medication History

We've added the ability to create Medication History items for a patient, so that you can add 

medications provided by another health service to a patient’s clinical record.

To record medication history, in the clinical record, select Medication  > Medication 

History.

Certain actions, like prescription printing and repeating, are not available for Medication 

History items. Users for whom the Medication View  module is enabled and who belong to 

a User Group with Medication History  system rights can use this option. When recording 
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a medication history item, all users can browse medications, regardless of their Scope of 

Practice.

For more information, see Medication History  (on page ).

Administer & Supply

With the introduction of Medication Orders, dispensing a medication is no longer required 

to record the administration or supply of medication.

We have merged the Supply  and Administration  windows into a single window called 

Administer & Supply, which shows all administration and supply actions performed in a 

single service. This makes it easier for customers who typically supply medication but may 

administer a single dosage before the patient leaves.

To administer or supply a medication, in the clinical record, select Medication  > 

Administer & Supply.

Imprest recording has been separated from the recording of administration and supply 

quantity. We have introduced the concept of Open Stock  which refers to an item of 

medication that has been opened and had some of its contents removed. You can now record 

New Open Stock  when you open a pack or bottle of medication to administer or supply 

some of the contents and have stored the medication back in the drug cupboard or fridge. 

You can also record Open Stock Finished  when the provider finishes off a bottle or pack of 

medication that was previously opened.

Administration now allows you to record multiple administration attempts and reasons 

for failure, such as if the patient reacted to the medication and vomited. Administration 

attempts over the last 24 hours are always shown to give you an insight into how much 

medication is currently in a patient's system.

For both administer and supply records, you can now record decimal quantities and units.

For more information, see Administer and Supply Medication  (on page ).

Finalise Prescriptions

Instead of printing prescriptions, prescribers can now finalise prescriptions to generate a 

script number. If required, prescribers can then print the prescriptions. Non-prescribers 

cannot finalise prescriptions.
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To finalise medications after you have added them, in the clinical record, on the Summary  > 

Medication Summary  tab, click Finalise Prescriptions.

For more information, see Finalise Prescriptions  (on page ).

Medication Requests

Medication requests combine a patient's medications into a bulk-order prescription 

specifically for sending to a pharmacy for dispensing.

Medication requests can be used to request the filling of a patient's prescriptions. Once 

dispensed, they are returned to the health service for supply to the patient directly. Instead 

of printing individual prescriptions, you can print a medication request which is the 

equivalent of a single batch prescription.

If you stock your patient's medications at your health service, or are the health provider for 

a remote site that stocks medications for your patients, you can use medication requests 

to help manage the patient's medications. This is particularly useful for rural and remote 

health services who operate under the S100 scheme.

Medication requests are not enabled by default. Enable medication requests on the File  > 

System Parameters  > Prescription Forms  tab.

For more information, see Medication Requests  (on page ).

Active Ingredient Prescribing

To meet the Active Ingredient Prescribing legislation (2019), mandatory from 1 February 

2021, generic prescribing is now mandatory in Communicare by default.

The legislative changes require the inclusion of active ingredients on all Pharmaceutical 

Benefits Scheme (PBS) and Repatriation PBS (RPBS) prescriptions, except for handwritten 

prescriptions, medicinal items with four or more active ingredients and a number of other 

specified items included in LEMI and LMBC.

Prescribers may continue to include a brand name on prescriptions wherever clinically 

necessary for their patient. When you prescribe by brand, the format of the medication 

displayed in and printed from Communicare is now as follows:

generic strength form  (BRAND_NAME)
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The list of excluded medicinal items (LEMI) and list of medicines for brand consideration 

(LMBC) lists are also observed.

Prescriptions created before the introduction of active ingredient prescribing are displayed 

according to the new rules if doing so does not change the original intent of the prescriber.

For those medications on the LEMI, prescriptions created before the upgrade are displayed 

as intended by the original prescriber. However, if a prescription is represcribed or reprinted, 

the format abides by the new rules for prescriptions, except for medications that are 

represcribed in bulk. For these medications, if they were prescribed by active ingredient 

before the upgrade and are on the LEMI, they are represcribed by active ingredient.

For more information, see Active Ingredient Prescribing  (on page ).

To meet the requirements of the legislation, set your Prescribing Options  to Generic 

Prescribing. For more information, see Prescribing options in System Parameters - Clinical 

(on page ).

COVID-19 Immunisation clinical item changes

To allow COVID-19 immunisations to be uploaded to the AIR, we've added two new fields to 

the Immunisation  clinical item. Clinicians can:

• Use the Serial Number  field to record the serial number of the vaccine. For COVID-19 

immunisations you can make inclusion of a serial number mandatory. For more 

information, see Clinical Item Type Properties  (on page ).

• Use the Administered overseas  field instead of the Performed at current encounter 

place  field to indicate historical immunisations that were performed overseas.

Adjusting Medications

We've added the ability to change the duration or until date of a medication and the 

comments. This feature is useful when a provider tells the patient to take more or less of a 

medication they have already been prescribed as a reminder to review the medication at an 

appropriate time.

For more information, see Adjust Medications  (on page ).

86 Integrated Team Care

unique_121
unique_121
unique_121
unique_108_Connect_42_prescribing_options
unique_108_Connect_42_prescribing_options
unique_108_Connect_42_prescribing_options
unique_108_Connect_42_prescribing_options
unique_99
unique_99
unique_99
unique_122
unique_122
unique_122


Bulk Stop

If you have full or once-off prescribing rights, you can stop multiple current or expired 

regular and once-off medications simultaneously.

To stop multiple medications, in a patient's clinical record, on the Summary  > Medication 

Summary  tab, click Stop Medications.

For more information, see Stop Multiple Medications  (on page ).

Medication Confirmation message

We have introduced a new feature that allows a message to be displayed before recording 

a medication in Communicare. This message is useful for displaying a disclaimer or other 

information that a practitioner must confirm before adding a medication. It appears once per 

clinical record session. Set the message in File  > System Parameters  > Appearance  tab.

For more information, see System Parameters - Appearance  (on page ).

(V20.1) Scope of Practice changes

In previous releases, Communicare had two ways for determining if a verbal telephone order 

was required when adding a medication: either by configuring the provider and selecting 

the drug schedules that required verbal orders; or by marking the provider as Exempt if 

Standing Order  and publishing a single standing order formulary. Any medications on that 

Standing Order formulary would not require a verbal order for the configured provider.

We have made the following changes in this release:

• Renamed Standing Order  to Scope of Practice

• Added the ability to have multiple Scope of Practice formularies. Each user group 

can be configured to use only the Scope of Practice formularies as required for their 

roles. Set the Scope of Practice for a user group on the File  > User Groups  > Scope of 

Practice  tab.

• The VTO drug schedules now work in combination with the Scope of Practice 

formularies. For example, you could select everything except S2 and S3, then configure 

a Scope of Practice formulary with a single S8 drug. This would allow the provider to 

order all S2 and all S3 medication as well as the single S8 drug without requiring a 

verbal order.
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For more information, see Scope of Practice  (on page ).

Regular medications

Regular medications now support program rights.

Medication Summary changes

The changes to medications management have resulted in slight changes to the medications 

included in the Medication Summary:

• All active, regular medications are displayed, even if they are duplicates

• All stopped, regular medications are displayed until their stopped date, even if they 

are duplicates

• Expired regular medications are displayed if they are the most recent regular 

medication by product, form, and pack

• All once-off medications and medication history items are displayed until their 

stopped or expiry date

• Deleted medications are not displayed

Clinical decision support

In Communicare V20.2, we've extended clinical decision support.

Pregnancy interactions

When you add a new pregnancy to a patient, Communicare checks the patient's active 

medications for interactions with a pregnancy and warns of any possible interactions. Any 

resulting interactions are displayed in the interactions window and require the clinician to 

note the warnings. For more information, see Pregnancy Interactions  (on page ).

When adding a medication to a patient who is marked as pregnant, Communicare now 

checks for any interactions with the generic components of that medication. Any resulting 

interactions are displayed in the interactions window and require the clinician to note the 

warnings. For more information, see Medication Warnings  (on page ).

Pregnancy interaction checking only applies to female patients.
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Note:

Each interaction has its own pregnancy category. It is possible for a medication to 

have a different pregnancy category to its specific interactions. It is also possible for 

a medication to have a high pregnancy category, but not have a pregnancy category. 

It is the clinician's responsibility to check the pregnancy category of the medication 

as well as any specific interactions.

Clinical record changes

(V20.1) Patient banner

We have enhanced the patient banner at the top of the Clinical Record to better emphasise 

important clinical information and allow clinicians to have this information follow them 

wherever they are in the clinical record screen.

The patient banner now includes the following information:

• Patient name

• Date of birth

• Age

• Sex

• Communicare's Patient ID

• Medical Record Number (where provided and configured)

• Health Care Homes status (where enabled)

• Pregnancy status - click to go to the Obstetrics summary

• Medication Alert status - displayed if the patient has alerts. Click to go to the 

Medications Alerts  section of the Clinical Record summary.

• Allergies and Adverse reactions - lists as many allergies as possible. Click to go to the 

Adverse Reactions section of the Clinical Record summary.

• Actions List:

◦ Active verbal orders

◦ Unreviewed documents

◦ Open investigation requests and unreviewed results

◦ Whether or not the patient has immunisations recorded
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(V20.1) Structured alerts

Medical alerts have traditionally been stored as free text against a patient’s clinical record 

and there has been no way to easily report on alerts or control the data entered in them. 

In V20.1 we introduced a new Clinical Item class type of Alert  to allow health services 

to control what information they capture for an alert. This new clinical item can be used 

to capture any data that a health service may like and can be used in recall rules to create 

clinical workflows within your practice. Alert clinical items have an additional status 

property used to track the state of the medical alert for the patient. These statuses are:

• Active - the alert is current and requires consideration by the health service.

• Inactive - the alert is no longer current but may have an impact on future encounters.

• Resolved - the alert is closed and no longer requires consideration by the health 

service.

• Entered In Error - the alert was documented in error, either because the history was 

reported incorrectly or it was entered in error.

In addition to the clinical item type, health services can now enable the Structured Alerts 

module in System Parameters to replace the free text alerts area with a pane that lists all 

Alert  clinical items and their current state.

Note:

If you enable structured alerts, the alerts already entered in free text are not 

migrated to the new alert clinical items. If you would like to migrate your 

existing alerts, please give us a call and we can discuss the best approach for 

your implementation. Communicare's Professional Services team will scope and 

implement this feature as a separate, paid service.

The Alerts and Other Information Control  system module has been renamed to 

Security on Alerts  to clearly state what it does. This option continues to allow users to 

restrict access to view the Medical Alerts section of the clinical record.

For more information, see Alert information  (on page ).

(V20.1) Reasons for Visit

We have introduced Reasons for Visit  to support our customers varied reporting needs. 

This new functionality is visible on the Progress Notes  tab of the Clinical Record and allows 
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the practitioner to record up to four reasons for visit for the encounter. The practitioner can 

use any combination of the following options within the same encounter:

• Clinical items - any condition clinical items recorded against the patient, and any 

other clinical items that were created during the current service.

• General lookup values - using custom datasets. Discuss with Communicare Support if 

you want to use the option.

• Free text

Enable Reasons for Visit  on System Parameters  > Clinical  tab, Clinical Record Features 

section.

For more information, see Reasons For Visit  (on page ).

(V20.1) SNOMED Codification for Clinical Item Types

You can now map a SNOMED concept to a clinical item type.

To map a SNOMED concept to a clinical item type, in the Clinical Item Type Maintenance 

window, click Advanced  and enter the SNOMED concept you want to use. Concepts are 

validated after entry and return the Concept Name, Version and Code system using FHIR.

To make it easier to find the correct SNOMED concept, you can open SHRIMP, a free online 

browser of SNOMED terms provided by the CSIRO.

We've also updated the Central Clinical Items to include the SNOMED concept. If you have 

cloned these items, the concept will not be updated against your cloned item. In these cases 

it is best to copy the concept over from the item that was cloned, however if you have a large 

volume of cloned clinical items that you would like to update, please contact us to discuss 

how to proceed.

Minor enhancements

V20.2 includes the following minor enhancements:

• In the Documents and Results  window, we've added a new filter for selecting 

providers. The Select Provider  window captures all providers with results in the 

selected date range.

• You no longer need to manually enable Appointment Session Templates after you have 

created them.
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• The Letter Writer  now has three additional Latest Qualifier options: Label Only, Value 

Only, Label and Value (available in earlier releases).

• The Speciality Type description now includes and TSI.

• When recording a patient's death, you can now indicate that you have verified the 

patient's death.

• Investigation results now display OBX-8 abnormal flags.

• You can now jump to the Medication summary  from the Medications  button menu.

• You can now create a once-off medication for supply from a regular medication. In the 

Medication Summary, right-click a regular medication and select Create once-off 

medication order.

• In the Medication Summary, you can now see the Medication History icon in the 

legend bar.

• If you don't have Administration Rights, you can no longer access System Parameters.

• We've updated the message displayed when a document has been removed from a 

patient's record to make it clearer.

• The medical record identifier from the lab is now included in the investigation results.

• Your Communicare password is now limited to 8 characters.

• On the patient banner, we've renamed gender to sex.

• For the Offline Client, we've included the Patient Consent table and added support for 

medications with verbal orders.

• For Medical Objects, we now show clinical information in the result header, support 

FT indenting and handle HL7 escape.

• If medication requests are enabled, you can supply medication request patient-specific 

inventory to a patient.

• On the Medication Summary, you can now see what type a medication is, a 

prescription (#script_number), medication order (Order) or medication history 

(History).

• Inventories, medication requests and medication grouping are included when patient 

records are merged or unmerged

V20.1 includes the following minor enhancements:

• You can now mark clinical items as read-only to prevent them from being edited in 

Communicare. This feature is useful for integrations where the record may belong to 

an external system.

• Enterprise customers can record additional patient identifiers for a patient, such as an 

extra MRN or identifiers from other systems. Use these identifiers in the Patient search 
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to find a patient. For enterprise customers, Enable Extended Identifiers  is set on the 

File  > System Parameters  > Patient  tab.

• If you have integrated with an Enterprise Master Patient Index, you can now search for 

patient details in the EMPI before adding the patient to Communicare. This feature 

is enabled with the EMPI Search module in System Parameters. If you would like to 

integrate your EMPI, please contact our Communicare Support.

• We've split Printer Assignments for investigations into two settings Investigations 

- Pathology  and Investigations - Imaging. This means that you can use different 

printers or trays when printing investigation requests for pathology or investigation 

requests for imaging. To use this feature, in File  > Printer Assignments, set the 

printer and tray for each option.

• We've added new options to File  > Appointments. Appointments now include: 

Appointment Facilities, Requirements  and Public Holidays.

• You can now modify the message displayed when a user logs into the Communicare. 

Select File  > System Parameters  > Appearance  tab and in the Login Message  field, 

enter the message displayed in the Important  text area in the Communicare login 

window.

• We've added 7 new kin types and the ability to record extra kin information in Patient 

Biographics. To enable extra kin information, select File  > System Parameters  > 

System  and set Structured Contacts.

Note:

Do not enable this option without first contacting Communicare Support. 

Existing data may be lost if it is not first migrated. If your health service would 

like to use structured contacts, contact Communicare Support. Communicare's 

Professional Services team will scope and implement this feature as a 

separate, paid service.

• Also in Patient Biographics, you can have custom fields added to the Additional  tab. 

If you would like custom fields, please contact Communicare Support. Communicare's 

Professional Services team will scope and implement this feature as a separate, paid 

service.

• We've added 33 new specialty types.

• We've been working with Medical-Objects to improve incoming results.

• We've added a new central clinical item: Assessment;Indigenous Risk Impact 

Screen  known as IRIS.
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• For AIR upload changes:

◦ Extend immunisation clinical items to support serial number capture

◦ Extend AIR upload to include serial number

◦ Extend AIR upload to include identifier details

◦ Extend AIR upload to include overseas administered fields

◦ Update logic pack for client adapter and end to end test

◦ Make Serial no mandatory false for two COVID-19 vaccines

◦ Investigate how to stop clinical item closing on carriage return for serial 

number>

Central Data changes

The following changes have been made to Central Data items:

• Healthy Under 5 Kids (HU5K) checks updated for 2019 specifications: 4 week check 

introduced, GP follow up introduced, new ASQ TRAK item included.

• Cervical screening - enhancements to the dataset as recommended by IRIS Education

• Addition of Results;bowel cancer screening, Results;prostate cancer screening 

and Results;breast cancer screening to complement the existing Results;cervical 

screening items. Recall protocols can be set up with the existing ICPC2-PLUS terms of 

Screening;bowel cancer, Screening;prostate cancer and Screening;breast cancer.

• Two new drawing qualifiers of odontograms for adults and children have been added 

and can be attached to local clinical items as desired.

• The options for the Pulse rate assessment and Pulse rhythm qualifiers have been 

adjusted.

• All hyperlinks from central clinical item definitions have been reviewed and updated 

or removed if appropriate.

Database Schema changes

The schema for medications has changed to support the new streamlined approach to 

regular medications as well as support for different types of medications.

Note:

If you have any custom reports that use the following tables or views directly, 

discuss migration options with Communicare Support.
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Table  5. Database schema changes

Schema Description

PAT_PRESCRIPTION
• MEDICATION_TYPE

◦ 1 = Medication Prescriptions
◦ 2 = Medication Orders
◦ 3 = Medication History Items

• REGULAR_MEDICATION
◦ True or False to indicate if the medication is a 

regular medication
◦ Also applies to Medication History items

PAT_REGULAR_MEDICATION_V
IEW • This view still displays the latest active regular 

medications

• Regular medications are now just normal 
PAT_PRESCRIPTION  records and can be identified by 
REGULAR_MEDICATION  = T

• The view now includes all the columns from 
PAT_PRESCRIPTION

PAT_REGULAR_MEDICATION Renamed to PAT_REGULAR_MEDICATION_DEPRECATED  to 
prevent access to stale data.

PAT_REG_MED_PRESCRIPTION_
VIEW

Deprecated and will be removed in a future release. If you use 
this view, contact Communicare Support.

FORMULARY IS_STANDING_ORDER  has been renamed to 
IS_SCOPE_OF_PRACTICE

PROVIDER EXEMPT_STANDING_ORDER  seems has been renamed to 
USE_SCOPE_OF_PRACTICE

PROVIDER_ORG_VIEW EXEMPT_STANDING_ORDER  seems has been renamed to 
USE_SCOPE_OF_PRACTICE

MED_SUPPLY PACKAGE_TYPE_ID  has been removed

Bug fixes

The following bugs have been fixed in V20.2:

• Test WACHS performance fixes

• Modifying incoming referrals causes error

• Fix performance related issue on joining PAT_REGULAR_MEDICATION_VIEW

• Error on adding medication of greater than 120 length in letter writer

• Fix migration script V20.2 branch

• AIR claims fail on using Other Vaccination Provider

• Fix issue when delete Immunisation Progress Note

• Serial number with invalid characters saved in Detail  tab

• Fixed the status tag missing from the Detail  tab
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• Fixed error when saving medication as default because of long names

• Extended CDA document generation to correctly classify extemporaneous medications

• In medication details, printed prescriptions, CDA documents and so on, we've fixed a 

problem with the display of MIMS data that contains superscript or subscript text. This 

text is now displayed in square brackets. For example, B[12].

• For CDA documents, such as Event Summary, we've fixed a problem with the way in 

which extemporaneous medications were encoded in the XML file.

• We've fixed an error that occurred when you attempted to open the Patient Summary 

report if you had prescribed medications with very long names.

• We've fixed an error which caused incorrect matching of the provider for investigation 

results. The error occurred for results and documents received via HL7 if the recipient 

was not in the preferred location in the message. The provider was typically returned 

as unknown.

• We've fixed an issue with investigation results, which resulted in errors if long 

comments were added to the results when they were reviewed before they were sent to 

QRIS.

• Fixed issues causing the clinical item definition editor not to work

• Fixed issue that allowed users to undecease a patient without removing contribution 

factors list

• Fixed issue that allowed encounter program numbers to be editable in Encounter 

Programs user interface

• Fixed issues in service recording where the patient arrived date is cleared under some 

circumstances

• Fixed issues with 'Bring to Front' toolbar not working when letter template is focused

• Fixed issues with provider created recalls being deleted when editing a recall rule

• Medical imaging request form launched from clinical item now respects default 

imaging configuration

• Fixed issue where Extemporaneous Preparation name allowed duplicate values

• Fixed issue with care plan size checking limit being calculated incorrectly.

• Fixed issue with inappropriate timestamp being used for service provider times shown 

in progress notes tab investigation.

• Fixed issue with referrals with comment not appearing as 'Referrals - Reason'.

• Fixed issue with verbal orders allowing the same provider to be used for both 

Authorising Clinician & Checking Person.

• Fixed issue with 'Bring to Front' toolbar not working when Adverse Reactions open.

• Fixed error when entering large Extemporaneous Preparation names.
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• Fixed issue where status <Reviewed> appears for attachment even though 'Reviewed' 

checkbox is not set.

• Fixed issue where Patient kin grid does not support double-click to open.

• Fixed issue with medications missing in Formulary Maintenance when deleted from 

MIMS.

Deprecated features

The following features have been deprecated:

• Reform Prescriptions - reform prescriptions are not in use by any Communicare 

customers and will be unavailable for use in V20.2 and later. The options in system 

parameters will be removed in future releases.

• (V20.1) Organisation management (i.e. multiple organisations) - each customer must 

have only a single organisation. Adding and deleting is also disabled.

• (V20.1) Dispensing a Medication

Installation Requirements

• .Net 4.5.2 or later

• HQBird 2.5.9 is now an external dependency. Firebird 2.5 and earlier is no longer 

supported.

V20.1 Release Notes

Release notes for V20.1.

V20.1 is a limited release for enterprise customers, containing major changes to 

medications, new features, and extensive maintenance updates and bug fixes.

Prerequisites

Because of the schema changes associated with the medications overhaul, all existing 

customers should run the Unprescribed Regular Medications report before upgrading to 

V20.1.

Major updates to medications

V20.1 contains major changes to the way medications are recorded and handled in 

Communicare.
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The prescribing screen has been split into three new actions:

• Write a prescription - use when you want to print a prescription and give it to a patient 

to fill outside your health service. See Write a Prescription  (on page )  for more 

information.

• Create a Medication Order - use when you want to Administer or Supply medication 

from within your health service. See Create a Medication Order  (on page )  for 

more information.

• Record Medication History - use when you want to record any medication the patient 

may have taken, but it was not provided by your health service. Users for whom the 

Medication View module is enabled and who belong to a User Group with 'Medication 

History' system rights can use this option. See Medication History  (on page )  for 

more information.

Also updated are:

• Administer &amp; Supply - with the introduction of Medication Orders, dispensing a 

medication is no longer required to record the administration or supply of medication. 

We have merged the Supply and Administration screens into a single screen called 

'Administer &amp; Supply' that shows all administration and supply actions 

performed in a single service, to make it easier for customers who typically supply 

medication but may administer a single dose before the patient leaves. See Administer 

and Supply Medication  (on page )  for more information. Other changes include:

◦ For both Administer and supply records, you can now record decimal quantities 

and units.

◦ Imprest recording has been separated from the recording of administration and 

supply quantity. We have introduced the concept of 'Open Stock' which refers 

to an item of medication that has been opened and had some of its contents 

removed. You can now record 'New Open Stock' when you open a pack or bottle 

of medication to administer or supply some of the contents and have stored the 

medication back in the drug cupboard or fridge. You can also record 'Open Stock 

Finished' when the provider finishes off a bottle or pack of medication that was 

previously opened.

◦ You can record multiple administration attempts and reasons for failure, such as 

if the patient reacted to the medication and vomited. Administration attempts 

over the last 24 hours are now always shown to give you an insight into how 

much medication is currently in a patient's system.
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• Scope of Practice - we've changed the way Communicare determines if a verbal 

telephone order is required when adding a medication. You can still configure the 

provider and select the drug schedules that require verbal orders. You can also use the 

Scope of Practice which replaces the Standing Order functionality. See Verbal Orders 

(on page )  for more information. We have made the following changes in this 

release:

◦ Renamed 'Is Standing Order' to 'Use Scope of Practice'.

◦ Added the ability to have multiple Scope of Practice formularies.

◦ Each user group can be configured to use only the Scope of Practice formularies 

required for their roles.

• Drug to Pregnancy interactions - Communicare now supports pregnancy-based 

interaction decision support when you're adding a medication for a pregnant patient.

◦ When adding a medication for a patient who is marked as pregnant, 

Communicare will now check for any interactions with the generic components 

of that medication. Any resulting interactions are displayed in the Drug 

Interactions warning window and require the clinician accept the warning.

◦ The categories used are defined by the Australian Drug Evaluation Committee 

(ADEC) which oversees the Australian categorisation system for prescribing 

medicines in pregnancy (https://www.tga.gov.au/australian-categorisation-

system-prescribing-medicines-pregnancy).

◦ Note: Each interaction has its own Pregnancy Category. Therefore, it is 

possible for a medication to have a different pregnancy category to its specific 

interactions or for a medication to have a high pregnancy category but not 

produce a pregnancy interaction warning. It is the clinician's responsibility 

to check the pregnancy category of the medication as well as any specific 

interactions.

Structured alerts

We've added a new Clinical Item class type of Alert to allow health services to control 

what information they capture for an Alert. Structured alerts can be used in Recall rules to 

create clinical workflows within your practice. Alert clinical items have an additional status 

property used to track the state of the medical alert for the patient. These statuses are:

• Active - the alert is current and requires consideration by the health service.

• Inactive - the alert is no longer current but may have an impact on future encounters.
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• Resolved - the alert is closed and no longer requires consideration by the health 

service.

• Entered In Error - the alert was documented in error, either because the history was 

reported incorrectly or it was entered in error.

In addition to the clinical item type, health services can now toggle the Structured Alerts 

module in System Parameters to replace the free text alerts area with a grid that lists all 

Alert clinical items and their current state. If you toggle to Structured Alerts, the alerts 

entered in free text are not migrated to the new alert clinical items. If you would like to 

migrate your existing alerts, please give us a call and we can discuss the best approach for 

your implementation.

The Alerts and Other Information Control system module has been renamed to Security 

on Alerts to clearly state what it does. Continue to use this option to restrict access to the 

medical alerts section of the clinical record.

SNOMED Codification

You can now map a SNOMED concept against a clinical item type: in the 'Clinical Item Type 

Maintenance window, click 'Advanced' and enter the SNOMED Concept you want to use.

To make it easier to find the correct SNOMED concept, we have also linked to SHRIMP, a free 

online browser of SNOMED terms provided by the CSIRO. Concepts are validated after entry 

and will return the Concept Name, Version and Code system using FHIR.

Central Clinical Items have also been updated and clinically coded to include the SNOMED 

concept. If you have cloned these items, the concept is not updated against your cloned item. 

In these cases it is best to copy the concept over from the item that was cloned, however 

if you have a large volume of cloned clinical items that you would like to update, please 

contact us to discuss the best way to proceed.

Integration Events

For our enterprise customers, in this release we've introduced pseudo-realtime events to 

better integrate Communicare data with other systems. These events are lightweight data 

contracts that are used to bring data into, and take data out of Communicare. This release 

includes the following events:

• Adding and Updating a Patient's Biographics

• Adding and Updating a Clinical Item
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• Adding, Updating and Cancelling an Investigation Result

• Finishing a Service

More events will be added in future releases.

To enable this feature, in File  > System Parameters, 'Integration' tab, set 'Enable 

Integration Events'.

Note: To use integration events, you must have an nServiceBus licence.

Other new features

• Patient banner - now includes action required information comprising an actions list 

and important clinical information. See Action Required Banner  (on page )  for 

more information.

• Reasons For Visit - record up to four reasons for visit for the encounter, selected from 

clinical items, general lookup values or free text. See Reasons For Visit  (on page ) 

for more information.

Updated features

The following features have been updated:

• Regular medications now support program rights.

• CDA - instead of sending CDA documents like the Event Summary and Shared Health 

Summary to My Health Record directly, large health services can now use a private 

repository. See CDA Third Party Storage  (on page )  for more information.

Minor enhancements

• Clinical items can be marked as read-only to prevent them from being edited in 

Communicare. Use for integrations where the record may belong to an external 

system.

• Patient search now filters across multiple search fields.

• You can now store additional patient identifiers against a patient, which can also 

be used in the Patient search to find a patient. This is useful when you have more 

than one MRN or want to use identifiers from other systems to find patients within 

Communicare. To enable this feature, in File  > System Parameters, 'Patient' tab, set 

'Enable Extended Identifiers'.
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• We've changed patient search in the Patient Payer Management window, to use the 

standard Patient Search when you add a new payer.

• If you have integrated your Enterprise Master Patient Index (EMPI) with 

Communicare, you can now search the EMPI for patient details before adding them 

to Communicare. To enable this feature, in File  > System Parameters, 'System' tab, 

set 'EMPI Search'. If you would like to integrate your EMPI with Communicare, please 

contact Communicare Support.

• We've split Printer Assignments for investigations into two settings 'Investigations 

- Pathology' and 'Investigations - Imaging'. This means that you can use different 

printers or trays when printing investigation requests for pathology or investigation 

requests for imaging. To use this feature, in File  > Printer Assignments, set the 

printer and tray for each option.

• We've added new options to File  > Appointments. Appointments now include: 

'Appointment Facilities', 'Requirements' and 'Public Holidays'.

• We've added a new 'Death Notification Source' field to 'Patient Death' so that you can 

record how you were notified of a patient's death.

• We've added two new telehealth encounter modes in addition to Telehealth Video, 

used to record services where the contact between the Communicare provider and the 

patient was by using video conferencing.

◦ Telehealth - Provider - use to record remote telehealth consultations during 

the COVID-19 pandemic, between a Communicare provider and a patient, 

using a telephone or another device such as a computer, with or without video. 

Services recorded using this mode are included in OSR and nKPI reports and for 

automated patient status updates. Use instead of Telephone.

◦ Telehealth - Recipient - use where a consultation happened between a provider 

elsewhere and a patient, such as between a specialist and patient at a hospital, 

and the Communicare provider facilitated the contact by providing a room and 

remote conferencing equipment. Services recorded using this mode are included 

in OSR and nKPI reports and for automated patient status updates.

• You can now modify the message displayed when a user logs into the Communicare. 

Select File  > System Parameters, 'Appearance' tab and in the 'Login Message' field, 

enter the message displayed in the 'Important' text area, in the Communicare login 

window.

• We've added 7 new kin types and the ability to record extra kin information in Patient 

Biographics. To enable extra kin information, select File  > System Parameters, 

'System' tab and set 'Structured Contacts'.
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• Also in Patient Biographics, you can have custom fields added to the 'Additional' tab. If 

you would like custom fields, please contact Communicare Support.

• We've added 33 new specialty types.

• We've been working with Medical-Objects to improve incoming results.

• New central clinical item: Assessment;Indigenous Risk Impact Screen known as IRIS.

• We've added the ability to backdate a clinical program exit item if the enrolment and 

exit clinical program items have got out of step.

• For FNQ:

◦ We've made additional biographics fields mandatory:

▪ Sex

▪ DOB

▪ Family Name

▪ Title

▪ Indigenous Status

▪ Address Line 1

▪ Usual GP

▪ Preferred Language

▪ Country of Birth

▪ Marital Status

▪ Interpreter Required

▪ Medicare Expiry - when a Medicare number is provided

▪ Medicare Reference Number - when a Medicare number is provided

◦ We've updated pathology and radiology request forms.

• For WACHS, in the Incoming Referral window, when documents are attached, the user 

can now cancel a cancellation.

• On official documents, a patient's 'Medicare' name is now printed instead of 'Preferred' 

name.

• For Clinical Item Type maintenance and Recall Type maintenance windows, a 'Hide 

Disabled' option is now included.

• In patient biographics, a prompt for birth weights 5-10kg is only displayed if the birth 

weight has been added or changed.

• We've updated Pathology and Diagnostic Imaging CDA-Based overviews to the 

latest style sheet so that Pathology and Diagnostic Imaging Overviews are rendered 

correctly.

• In the Documents and Results window, we've improved keyboard support for date 

range selection and improved performance by limiting the number of documents listed 
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to 100. If more than 100 documents are included in the search the message "More than 

100 records returned, please refine your filters" is displayed.

• You can now paste text from Microsoft Word into Progress Notes. Formatting is 

automatically removed because only plain text is supported.

• We've added extra logging details for Argus calls.

• If IHI validation fails, a message is displayed to the user.

• For data errors, we've added extra details to error message.

• We've renamed organization.name in EPD search code (also included in V19.2).

• We've improved Imprest and related screens.

• We've added in the time when editing clinical items.

• SafeScript now supports TLS 1.1 & TLS 1.2.

• You can no longer add new organisations.

• For the new Integration Events functionality, allow the caller to specify whether an 

event is raised when an API command is completed.

Disabled in this release

The following features have been disabled in this release, with plans to be reinstated in 

future releases:

• For medications:

◦ Batch repeat functionality

◦ Medication summary shortcuts to toggle between Once Off and Regular 

medications

◦ Health Centre Prescribing (HCP)

• Data Synchronisation Client

• Real Time Prescription Monitoring and SafeScript

Deprecated

The following features have been deprecated:

• Support for multiple organisations. Each customer must now have only a single 

organisation. Adding and deleting organisations has also been deprecated.

• Printing labels from windows other than from the Prescribing and Administer and 

Supply windows is no longer supported.

• Dispensing a medication.
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Database schema updates

The schema for medications has changed to support the new streamlined approach to 

regular medications and different types of medications. If you have any custom reports that 

use these tables or views directly, contact Communicare Support  to discuss your migration 

options.

Table  6. Database schema updates

PAT_PRESCRIPTION MEDICATION_TYPE

• ◦ 1 = Medication Prescriptions
◦ 2 = Medication Orders
◦ 3 = Medication History Items

• REGULAR_MEDICATION
◦ True or False to indicate if the medication is a 

regular medication
◦ Also applies to Medication History Items

PAT_REGULAR_MEDICATION_VIEW
• This view still displays the latest active regular 

medications.
• The view also now includes all columns from 

PAT_PRESCRIPTION
• Regular medications are now normal 

PAT_PRESCRIPTION records and can be identified by 
using REGULAR_MEDICATION = T

PAT_REGULAR_MEDICATION Renamed to PAT_REGULAR_MEDICATION_DEPRECATED to 
prevent access to stale data

PAT_REG_MED_PRESCRIPTION_V
IEW

Deprecated, to be removed in a future release

Bug fixes

We've fixed the following bugs:

• Investigation requests with more than one page of investigation items missing some 

items.

• Users without clinical access can view investigation results in Progress Notes. Viewing 

rights are now respected.

• Birth Notifications failing to be processed because of long names or addresses. We've 

increased the maximum field length to 255 characters.

• No indication on the Queue that a Birth Notification has been matched. We've 

added two columns 'Mother Matched' and 'Child Matched' which show when a birth 

notification has been matched.
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• Duplicate patients being added to Communicare when babies are being registered 

from import from HL7 messages received to HBCIS.

• Reports failing because of invalid characters. A warning is now displayed when an 

invalid character is are entered in the Subject of a Scheduled Report.

• Clinical Item missing when editing. Qualifiers for the DateTime and Time types are 

now saved and can be reopened displaying the correct values. These values still remain 

after the clinical item has been edited and saved.

• Two entries appearing in the Outgoing Documents tab. Now only the Care Plan is 

displayed, instead of both the care plan and the care plan template.

• Documents and Results  > Investigations, 'Results Arrived' column not sorted in 

descending order by default. Now sorted correctly.

• Ordering in 'Documents and Results' window. The ordering set by the user now 

persists between sessions, for example, by 'Received Date'.

• When a clinical item type with a rule code also has a summary qualifier, the summary 

is updated and committed before any message that the item cannot be added: when 

the item is rolled back, the summary update is not. The qualifier summary is no longer 

updated.

• In the Clinical Record, removed the problem causing the error message "Cannot make 

a visible window modal" to be displayed.

• Service Record window does not appear for the services marked as not claimable. For 

WACHS, the Service Record window is now displayed for all services.

• When checking Medicare numbers if there is no Internet connection the application 

doesn't display an error message. An error message is now displayed.

• Services created at a timed encounter place are missing from the Patient Summary 

report. In the Patient Summary report, when you click 'Customise' and on the 

'Consultations' tab, specify a date in the 'To' field, the report now includes all 

consultations on that date until midnight.

• Letter item for investigation results has no ordering. The Investigation Result selector 

now behaves the same as the Progress Notes selector with the latest result at the top 

by default, then alphabetic ordering.

• Verbal orders appear in the unreviewed verbal order list when the medication has been 

deleted. Deleted medications are no longer displayed in the unreviewed verbal order 

list.

• Display deceased status on patient details for S100 Orders and Inventory.

• For MeHR, on slow network connections, in the Clinical Record, when the user clicks 

'MeHR Profile', the MeHR window freezes. The MeHR window no longer freezes.
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• For MeHR, an error is displayed when the user clicks 'Send CHP' for dual registered 

patients. The error has been resolved.

• Nightly backup fails when weekly backup generated. Now, backups are created for 

every day, including when the weekly file is created.

• Approval Number Conversion error when calling Safescript. Authorisation codes 

containing alphanumeric values are now accepted.

• Factor Windows spooler issues. Users who were unable to open clinical records, or use 

printer redirection can now do so.

• Care plans lost if they exceed the maximum configured document size. Users can now 

edit care plans after exceeding the maximum size rather than losing their work. Only 

BMP, JPG and TIF images can be attached.

• Fix incorrect number formatting on qualifier previous values in V19.2. Trailing zeroes 

are no longer displayed.

• Fix "Cannot make a visible window modal" error. The cause of this error has been 

addressed.

• Clinical item definition editor is broken.

New Central Clinical Items and Reports

You can review new clinical items and reports using these reports:

• Report  > Reference Tables  > Clinical Item Types Added  - enter the days since the 

upgrade and select 'Central'.

• Report  > Database Consistency  > Central Reports  - enter the date of the upgrade.

Installation Requirements

• .Net 4.5.2 or later

• HQBird 2.5.9 is now an external dependency. Firebird 2.5 and earlier is no longer 

supported.

Version 19
Release notes for version 19 releases.

V19.2 Release Notes

Release notes for V19.2.
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V19.2, March 2021 - COVID-19 Immunisation clinical item changes

To allow COVID-19 immunisations to be uploaded to the AIR we've added two new fields to 

the Immunisation clinical item. Clinicians can:

• Use the Serial Number  field to record the serial number of the vaccine. For COVID-19 

immunisations you can make inclusion of a serial number mandatory. For more 

information, see Clinical Item Type Properties  (on page ).

• Use the Administered overseas  field instead of the Performed at current encounter 

place  field to indicate historical immunisations that were performed overseas.

V19.2, December 2020 - Active Ingredient Prescribing update

Communicare V19.2 released in December 2020 meets the requirements of the Active 

Ingredient Prescribing legislation (2019), mandatory from 1 February 2021.

Generic prescribing is now mandatory in Communicare V19.2 by default.

The legislative changes require the inclusion of active ingredients on all Pharmaceutical 

Benefits Scheme (PBS) and Repatriation PBS (RPBS) prescriptions, except for handwritten 

prescriptions, medicinal items with four or more active ingredients and a number of other 

specified items included in LEMI and LMBC.

Prescribers may continue to include a brand name on prescriptions wherever clinically 

necessary for their patient. When you prescribe by brand, the format of the medication 

displayed in and printed from Communicare is now as follows:

generic strength form (BRAND_NAME)

The list of excluded medicinal items (LEMI) and list of medicines for brand consideration 

(LMBC) lists are also observed.

Prescriptions created before the introduction of active ingredient prescribing are displayed 

according to the new rules if doing so does not change the original intent of the prescriber.

For those medications on the LEMI, prescriptions created before the upgrade are displayed 

as intended by the original prescriber. However, if a prescription is reprinted, the format 

abides by the new rules for prescriptions.

For more information, see Active Ingredient Prescribing  (on page ).
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To meet the requirements of the legislation, set your Prescribing Options to Generic 

Prescribing. For more information, see System Parameters - Clinical  (on page ).

Updates since Feb 2020

• We've fixed a bug with the script that added vaccines where a locally-

created vaccine already existed. For example, if you a have a local clinical 

item Immunisation;COVID-19 Vaccine AstraZenec, it will be renamed to 

Immunisation;COVID-19 Vaccine AstraZenec[1] when V19.2 is updated.

• We've added a tip to Medication Details  (on page )  about how to display all 

options for equivalent active ingredient medications that have slightly different 

packaging or formulation.

• We've fixed a bug that stopped you adding medications with names longer than 120 

characters to a letter or care plan.

• We've fixed a bug that stopped the Print window being displayed when the 

Communicare default printer was set to anything other than Windows default and the 

HCP printer assignment was set to the Communicare default.

• We've updated relevant letter templates and reports.

• We've fixed an SQL issue that occurred on login under some circumstances relating to 

specific database structures.

• We've fixed a bug that stopped the 'Bring to Front' toolbar working when using Adverse 

Reactions or the Letter Template.

• We've fixed a bug which meant that medications in a group where one medication was 

deleted from MIMS were missing from the drug browser.

• We've fixed a bug where if a booking was made on the same day as the service, when 

a doctor saved the progress notes, the timestamp of the progress notes was the 

timestamp of the booking. The timestamp of the progress notes is now the timestamp 

of when the service is started, not the timestamp of the booking.

• We've fixed a bug where there was problem on startup when the HI certificate was 

empty which gave an access violation error.

• We've fixed a bug in private billing where you couldn't add a new payer to the patient 

record.

• We've fixed a bug in care plans where the file size became too large if there were 

embedded images and the plans were lost.

• We've fixed a bug with the HI Service which occurs when you have many clinical 

records open and may result in a "Parameter is incorrect" error.
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• We've fixed a bug where recalls created by a provider were being deleted when a recall 

rule was edited.

• We've added support for PathWest's new HL7 structured numeric (SN) type for their lab 

results.

• We've fixed a bug where not all medications were printing under certain 

circumstances.

• We've updated the database validation routine to account for identical clinical items.

• We've fixed a bug where Communicare didn't support authority numbers containing 

alphabetical characters.

• We've fixed a bug where the nightly backup fails when the weekly backup is generated.

• If a patient is deceased, we now display their deceased status in the patient details of 

S100 orders.

• We've fixed a bug where users couldn't change their password, even though this option 

was enabled in user groups settings.

• For MeHR, we've fixed an error that was displayed when a provider tried to Send CHP 

for a dual registered patient.

User Lock Conflicts

There is a new form under the Tools menu to resolve user lock conflicts. Users with systems 

administrator rights can access this form. The form will list all the users that are connected 

to Communicare to allow the user with the lock conflict to be disconnected. See User Lock 

Conflicts  (on page )  for more details.

Clinical Record

• The Care Plan tab now shows when active care plans are present by changing the 

background colour of the icon.

• The Progress Notes audit details have been adjusted so that they only record changes 

to the content or viewing right of the progress note.

• An issue caused by closing new investigation requests with the 'X' button instead of 

the Save button has been resolved.

Clinical Item Types

The TTANGO clinical item now has a viewing right of Maternal and Sexual Health.
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Service Recording

• A progress note icon is displayed in the Service Recording window indicating whether 

any information is attached to the service that will prevent this service being 

deleted. The information can be a clinical item, prescription, adverse reaction, result, 

investigation request, progress note, lock conflict, Medicare or private billing claim, 

etc. A missing icon indicates that no information has been recorded for that service 

yet.

• The Locate text box used to search for a provider in the Service Recording window is 

now fixed to search all providers and not just those following any selected provider.

• An issue with the provider list scroll bar has been fixed.

• Medicare claims with associated specialist services details no longer allow referral 

issue dates in the future.

Documents and Results

• HL7 pathology results that are received containing a PDF document will now display 

correctly in the documents and results window.

• Secondary ordering of documents and results by date has been restored when other 

columns are ordered.

• An issue preventing the matching of specific types of incoming CDA documents to a 

patient has been resolved.

• Ordering Provider column added to Investigation Results tab.

Patient Summary Report

The Patient Summary report can now also export all documents related to a patient. Use 

the Customise button to include or exclude documents. When printing you will be asked to 

specify a folder in which to place the documents. See Patient Summary  (on page )  for 

more details.
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Scheduled reports

• Date parameters now resolve the date correctly when configuring a new scheduled 

report.

• Dropdown box values that were not appearing because the report defined the 

parameter not in uppercase are now working correctly (this affected scheduled nKPI 

reports).

• Scheduling options that stopped working after the upgrade to version 18.3 (e.g. 

reports scheduled for 31 day of the month that failed to run when the month had fewer 

than 31 days) are now working correctly.

Prescribing

• Prescribers can no longer record a medication with a date after a patient’s date of 

death. Medication Dispense, Supply, Administer options are disabled for deceased 

patients.

• The Health Centre Prescription messages on closing the clinical record have further 

been refined to exclude messages to regenerate the HCP when a patient no longer has 

any regular medications.

MIMS Interaction Warnings

A new graphical representation of drug interaction severity ratings has been added to 

the Medications Warnings window and is displayed if there are any interactions when 

prescribing or dispensing. See Medication All Warnings  (on page )  for more information 

and descriptions of the severity warnings.

eRx SafeScript Integration

eRx SafeScript Integration or Real-time Prescription Monitoring (RTPM) is now available. A 

check box added to the Clinical tab of System Parameters for Prescribing options, to activate 

the feature. See Real-Time_Prescription_Monitoring  (on page )  for more details.

Currently, Safescript is only required for Victoria. See the website  for further details.

EPD Integration

The existing HSD (Human Services directory) Address Book integration module is replaced 

with the EPD (Enterprise Provider Directory) Address Book integration. To use EPD 
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integration, the EDP URL and API Key must be entered under File \> System Parameters \> 

Web services tab. There are slight changes in Address Book Search filter criteria in EPD.

Titanium HL7

A change has been made to patient details sent from Communicare to the Titanium dental 

software program to identify the patient details as coming from Communicare. This is to 

support health services where other software is interfacing with Titanium.

My Health Record

• The document list in MyHR now defaults to view all documents rather than just 

Shared Health Summary Documents

• Defaulting patients with MyHR to consent to upload unless revoked is now working 

correctly.

Reference Tables

• The Session Template Repeat Value now appears as 'Weekly', 'Fortnightly', etc. rather 

than 1, 2, etc. when browsing.

• Applying a template to the appointments book now uses the previously set date 

correctly.

Data Synchronisation

An issue whereby the Last Synch Upload date time label was updated when there was 

nothing to upload has been corrected.

Stability

A wide range of enhancements to improve stability of the program have been implemented. 

These improvements include better handling of unforeseen errors as well as defect fixing 

and various mitigation strategies. The include:

• Fix out of memory error message appearing under some conditions when merging 

patients

• Improve Appointments Generator stability

• Improve Intramail performance

• Improve performance of MyHR at end of service
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System Passwords

The Communicare administrator may request changes to the password used to protect the 

backup zip files. See System Passwords  (on page )  for more information.

New Central Clinical Items and Reports

You can review new clinical items and reports using these reports:

• Report  > Reference Tables  > Clinical Item Types Added  - enter the days since the 

upgrade and choose 'Central'.

• Report  > Database Consistency  > Central Reports  - enter the date of the upgrade.

.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

V19.1 Release Notes

Release notes for V19.1.

Argus

There have been improvements to the error-handling of outgoing Argus messages. 

Enhanced logging will also enable us to make future improvements to secure messaging in 

Communicare.

Appointments

Session Type is now displayed in the patient services list. This is to assist the providers and 

other service employees to know the role of the service provider for which the service is 

booked

Imaging Request Forms

WA Health plain paper radiology has been removed from the list of Imaging Printing Format 

options.

System Parameters

The Auto Logon option has been removed from the system parameters.
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Reporting

• Some additional Dialect 3 errors with reports have been addressed. Note that local 

reports may still have issues - contact the helpdesk for advice.

• Reminder letter reports have been updated to place the patient's address in the 

window of standard DL envelopes to better support displaying the address.

Biographics

Two new kin types of Caseworker and Foster Carer have been added

Features for Western Australian Country Health Service (WACHS)

S100 Management

• A new feature to manage the consolidated ordering of S100 Medications for an S100 

certified encounter place is now supported. Currently, this feature is only available to 

WACHS.

• Users can now generate a consolidated order for all patients who have medications 

that are ordered and collected from eligible S100 Encounter Places/ Sites. This feature 

produces a consolidated order report that can be sent to a selected S100 pharmacy, 

using the Address Book.

• Once the pharmacy processes the order and delivers the medications to the encounter 

place, staff can acknowledge the receipt of the order and update the S100 inventory 

in Communicare to monitor the stock levels for the Patient. Users can also record the 

supply of these medications to the patient without the need for dispensing. This S100 

Supply is separate to the existing Supply feature in Communicare.

Referral Management

• Performance improvements have implemented into producing the list of referrals. 

The list no longer auto-populates allowing the user to select the desired filter settings 

prior to selecting the ‘Search' button that retrieves the lists of referrals

• Documents attached to the referral are now displayed in a (modeless) second active 

window, allowing to user to easily transpose information from the attachment to the 

referral. Please note that only one attachment can be displayed at a time.
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.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

Historical Release Notes
The main improvements in each legacy version of Communicare are listed. Minor 

improvements and cosmetic changes are not listed for the sake of brevity.

These release notes are included for reference only. These versions of Communicare are no 

longer supported.

Version 18

Release notes for version 18 releases.

Version 18.4

Release notes for V18.4.

Appointments Book

• Ordering of providers: The Appointments Book can now be ordered (sorted) by the 

Provider Speciality Type. This option (Order by Speciality Type) is found in the popup 

menu (right-click anywhere in the Appointments grid). The option setting is saved to 

the user's profile and reapplied whenever Communicare is started. Use this option to 

group doctors together, for example.

• Saving column widths: Column Widths in the Appointments Book are now saved for 

each individual Provider. There is also an option (Enforce Same Column Widths) in 

the popup menu that will replicate changes in one column's width to all the other 

columns. These settings are saved to the user's profile and reapplied whenever 

Communicare is started. Use this option when you need to fit all the available sessions 

onto your screen.

• Changes to the Appointments Book's top panel of filter components: For consistency 

the place and mode filter has been moved to the left, next to the date and status filter. 

The free appointment search (which is not a filter) has moved to the right.

• Operator Initials: As these are now optional, the username will be displayed when no 

initials are recorded. If the operator initials are used they will also be displayed.

• Appointment Book Slip report: The font size has been increased for legibility.
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Progress Notes

A new option to exclude non-contact services has been added to the filter for Progress Notes. 

If the Exclude non-contact services checkbox is ticked, the Encounter Mode dropdown list 

will automatically display (All Client Contact Modes) and the Integrated Progress Notes 

will be filtered to only display those created with an Encounter Mode that involves client 

contact. Unticking the checkbox returns the selected Encounter Mode dropdown list to (All 

Encounter Modes). Any changes to the filter are reflected in the filter text at the top of the 

filter, however the option to exclude non-contact services isn't saved when Communicare is 

shutdown in order that upon next startup all progress notes are visible again by default. This 

is a design decision to minimize the chance of any progress notes being overlooked.

Clinical Record

Adverse Reaction Summary: All details of clinical manifestations are displayed when the 

adverse reaction is opened for viewing - previously the display was limited to one line.

Central Data

All central #keywords that create the central clinical record shortcut buttons have been 

removed from the central distribution. During the upgrade to 18.4 all these central keywords 

are converted to local $keywords to allow the local administrator to add or remove these 

from central clinical items as desired. The effects of this are:

• All the shortcut buttons now order strictly alphabetically so users will notice that the 

Check up button may not be the first button on the left (previously the Central buttons 

ordered before the local buttons).

• The local administrator can remove items (e.g. immunisation types) from a button 

without the need to disable the item or clone the item to achieve this).

The central Otoscopy dropdown qualifiers (right and left) used in the child health check, 

HU5K checks and other clinical items have been modified. Descriptions have been clarified 

and two new options added. This is a summary of the changes:
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Existing data is retained as per the links in the diagram above.

All Flinders Care Plan dataset qualifiers have had the square brackets removed (for example, 

[CR] Tobacco 1: my score has become CR Tobacco 1: my score). This overcomes a searching 

issue when applying qualifiers to clinical items.

Two new clinical items with calculating qualifiers have been added to the Communicare 

Value Added dataset: Fagerstrom Test for Nicotine Dependence and Assessment;PROMIS 10 

Global Health.

Documents and Results

Documents and Results Performance Improvement: To improve efficiency the Provider 

dropdown box, the new Include Unknown Provider checkbox and the Encounter Place 

selector now filter the data in memory, rather than re-running queries on the database. 

Also, date range can now be explicitly set using a pair of date selectors, instead of the old 

checkbox that toggled a filter on the past 180 days.

Biographics

Spaces are stripped from Medicare Card numbers when copying the number. You can use the 

right click menu to copy a number.

User Access Rights

Three new Access Rights have been created:
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• Patient Status Administration controls the ability of the logged-in user to change the 

patient status in the Administration tab of Patient Biographics. It controls access to 

the Patient Status dropdown list and the Advanced button. This right is granted by 

default to all existing users that already had the Patient Edit right but can be removed 

by a system administrator.

• Appointments Administration controls the ability of the logged-in user to access the 

Appointments menu option in the File menu. This menu option used to be a submenu 

within the Reference Tables submenu, but has been moved to the File menu. Please 

note the old Facilities... menu option has been renamed to Appointment Facilities... 

and is now an option in the Reference Tables submenu. All existing users that already 

had the Reference Tables right have been granted this new right by default.

• Provider Administration controls the ability of the logged-in user to access the 

Provider menu option in the File menu. This menu option used to be in the Reference 

Tables submenu, but has been moved to the File menu. All existing users that already 

had the Reference Tables or the Billing Administration right, and members of the 

System Administrators group, have been granted this new right by default. This right 

gives the user the ability to modify any Provider details for any Provider.

Reporting

There is a new report at  Report  > National KPI  > Version. Run this report prior to 

generating nKPI reports for upload to the Health Data Portal to make sure you have the 

latest reports. You will need to confirm that the reports you have are the latest by checking 

the Communicare portal (https://portal.healthconnex.com.au/) or contacting the Helpdesk. 

At the time of writing the latest reports satisfy Specification V8.2 and the Communicare 

distribution version is 20181010.

Report Scheduling

The report parameters section has been enlarged to display all or most of a report's 

parameters.

SMS Bulk Messaging

Users without the Report Administration right will only see SMS templates (reports) that are 

marked both Enabled and Public when accessing the Send Batch SMS... option in the Tools 

menu.
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Private Billing

DVA details are now included on the generic invoice template.

Medicare Service Text is now displayed on the Invoice.

Items marked with an asterisk (*) indicate Inpatient Service.

Medicare Claiming

Services can now be flagged as Inpatient Services. MBS Items within the Service will be 

claimed as an Inpatient claim.Note: this requires that the new "Hospital Facility ID" be 

populated for the associated Encounter Place.

Transport Management

Where the Transport List used to display the initials of the user who created a given entry, it 

now displays the username and optionally displays the initials if they were provided.

Performance Improvements

Significant performance improvements have been made to improve performance. These have 

been applied to documents and results, service recording, reports and the clinical record.

Logging

Communicare now uses two settings in System Parameters that specify whether error 

logs (with no clinical information) may be sent by e-mail, and to whom (defaults to 

Communicare).

Also, daily scheduling now generates logs that show what scheduled processes ran and 

whether they were successful. A new schedulable item called CCareQueue_SendLog.exe will 

e-mail the logs using the System Parameters in Communicare.

Birth Notifications

A new Birth Notifications module has been added into Communicare to enable the user to 

receive and manage birth notifications. This functionality is currently only compatible with 

Western Australian Country Health Service and requires a specific file format to be delivered 

using specific integration software.
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Users having the Birth Notifications system right can assign an encounter place to a birth 

notification and can change the birth notification status. Communicare tries to match the 

mother's patient record and child's patient record. For a matched patient, the system inserts 

a birth notification record into patient's Clinical Record.

Note:

In Communicare offline mode, all the functionality related to Birth Notifications 

module will be disabled.

PDF Pathology Results

Communicare now supports Pathology Results sent in PDF format via HL7.

Titanium

Updates to Titanium for HL7 PID3.5 segment.

Argus

Argus integration improvements and stability fixes.

Stability Fixed

Several bug fixes to improve stability of Communicare.

.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

Version 18.3

Release notes for V18.3.

Patient Sex

The following new Sex values have been added (supplementing the existing Male, Female 

and [blank]):

• Indeterminate

• Intersex

• Not Stated

• Unknown / Inadequately Described
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Note that some external bodies do not yet recognise sexes other than Male or Female. 

For example, attempts to verify Medicare cards online will fail if a patient has a sex that 

is neither Male nor Female. In Communicare, recall rules and qualifier definitions have 

been adapted to allow rules to be set up for patients with a recorded sex other than Male or 

Female.

Encounter Place Multi-Level Hierarchy

If an encounter place hierarchy has been configured then Encounter Places are displayed in 

an hierarchical structure instead of a flat list on the following windows:

• Appointment Book filter

• Service recording filter

Split Encounter Place and Encounter Mode

Encounter Place and Encounter Mode are now displayed in separate fields instead of 

displaying together, preserving existing business rules on the following windows:

• Provider, Place and Mode Selection, including Main Toolbar and Data Entry Wizard

• Service Record

• Match and Review Result

Location Code and Facility Code

Location Code and Facility Code fields are added into Encounter Place.

Clinical Record

If system is configured to have multiple customized URL links then in the Clinical record, the 

AIR button is replaced by a "Go To" button and the list of URL links appear in a popup menu.

MIMS Pharmaceutical Database

• Special warnings are now highlighted on the Product Information window.

• Duplication of some information is removed from the Drug interaction warning 

window when regenerating a health centre prescription.

• The Communicare disclaimer now includes the MIMS End User Licence Agreement 

(2014).
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Data Synchronisation

Refreshing the database has been made easier by adding a new 'Wait for new backup and 

download when available' button. Other improvements have been made to deal with server 

reboots and network errors. See Data Synchronisation.

Intramail

• Opening the Select Recipients window in Intramail will set the focus on the Search 

field.

• Discard button on the Intramail New Message window renamed to Cancel.

• Help button added to the Intramail New Message window.

User Group Maintenance

The User Group Maintenance window has been revamped to facilitate the mapping of Active 

Directory groups to Communicare user groups.

Administrator role

All 'Administrator only' tasks now can be performed by any user in the System 

Administrators user group.

Firebird Database Server

This Communicare database has moved from SQL Dialect 1 to SQL Dialect 3. What this 

means for you is improvements in performance when running queries but it also means 

that some of your local reports may fail due to the stricter nature of how the queries are 

written. You may run a report and see an error message that contains the words 'dialect 3' or 

'ambiguous fieldname' or 'field not found'. If this happens, contact your local administrator.

Note:

Administrators - if you write your own reports then this simple guide may help 

you, otherwise contact the Communicare helpdesk for assistance. In most cases the 

report can be adjusted straight away:

• Strings must be delimited by single quotes as double quotes are no longer 

allowed.

• Some values may need casting, e.g. 'TODAY' should be 'cast(('TODAY' as 

timestamp)' if you are going to subtract 1 from this.
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• All fieldnames must reference the table if the query joins two or more tables 

with matching fieldnames.

• Each field in a UNION statement needs to be matched to the same datatype.

• There are some new reserved keywords (see https://github.com/FirebirdSQL/

firebird/blob/master/doc/sql.extensions/README.keywords).

• In the PARAMETERS section all constants returned as fields need an alias (e.g. 

'select cast('Yes' as varchar(3)) from rdb$database' should be 'select cast('Yes' 

as varchar(3)) DISPLAY_FIELD from rdb$database').

• Dividing two integers now as an integer always rounds down whereas before it 

would round to the nearest integer.

</table>

Workstation Location

The Workstation Location field has been removed from the login screen.

Features for Western Australian Country Health Service (WACHS)

Active Directory Integration

• Windows Trusted Authentication can be used when Communicare connects to the 

database if Trusted Authentication / Single Sign-on is enabled. Connections to 

the Firebird database support mixed mode security. Automatic synchronisation of 

Communicare user groups can be mapped to Active Directory groups.

• There is an option to set Single Sign-on feature during installation. User verification 

within Communicare will continue to work the same when the user records a 

medication for which an allergy is recorded and for recording My Health Record 

consent.

• See User Maintenance for details. Note that this feature will be available for all 

Communicare users in a future version.

Note:

WACHS users - Some changes detailed above were made available in version 15.2 

and are not new for you. They are documented here because they are new features 

now available to all users of Communicare.
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.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

Version 18.2

Release notes for V18.2.

Intramail

• Intramail can now be accessed from the Main Toolbar using shortcut keys. To open the 

Inbox use Ctrl-O and to add a new message use Crtl-M.

• On the Intramail message window, the '...' buttons that access the To, Cc and Patient 

list have been replaced with new buttons.

MIMS

• The MIMS version date text on the Drug Browser window has been updated.

• The Drug Browser window now displays the MIMS icon along with the MIMS Version 

details

Login Screen

The Workstation Location dropdown box has been removed from the Communicare Login 

screen to avoid confusion with the default encounter place recorded on the Main Toolbar.

Clinical Record

• Preterm Centile charts can be zoomed in/out similar to other charts.

• The 'Display description not found' issue when filtering the detail tab for dispense, 

administer or supply records has been fixed.

• The incorrect date on some reprints of Health Centre Prescriptions has been fixed.

Health Care Homes

Health Care Homes (HCH) Tier details are displayed for HCH registered patients on Patient 

Search, Clinical Record, Service Record and Online Claiming windows.

CAT Export

The CAT Export tool now supports Health Care Homes (HCH) Tier and Cervical Screening 

tests. Additionally, an error with previously imported medications has been resolved.
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Reporting

This version has updated reports for the National KPIs, OSR, NT AHKPIs and NSW KPIs 

ready EOFY 2018 reporting.

• nKPIs are now updated to the 2015-2017 definitions (METeOR identifier 686315)

• NT AHKPIs are now updated to version 2.4 (September 2017)

• OSR reports now include telephone, court, hospital and other modes when counting 

episodes

• NSW reports are not included in Communicare but are extracted using the Launchbar

Performance Improvements

Clinical items with many qualifiers that were taking a long time to save now save quickly. 

The daily reboot of the server can now be configured to include database housekeeping tasks 

that would otherwise be performed periodically during business hours.

.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

Version 18.1

Release notes for V18.1.

Clinical Record

• The Medication Summary tab on the Summary tab of the Clinical Record now has 

an icon that changes according to the content of the Medication Summary. If there 

are no medications on this tab then the icon has a white background . If there are 

records on the tab and there are expired regular medications then the icon has a red 

background . If there are medications on the tab but no expired regular medications 

then the icon has a green background .

• Recall expiry - this functionality can now be configured for specific clinical item types 

only. If no types are allowed then the functionality is effectively disabled. Where a 

recall rule has previously specified this functionality then the clinical item will inherit 

this behaviour. See Clinical Item Type Properties for details.

• The cursor flickering encountered in version 15.0 when the mouse was above the 

progress notes has been addressed.
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• The cursor position and scroll bar position are now retained when adding clinical 

items from the Progress Notes tab and when switching services within this tab.

• Double-clicking the Add Investigation Request button in the clinical record no longer 

presents an error message.

• The issue that sometimes caused Progress Notes filtering to reset in some situations 

has been resolved.

• An issue with progress notes that arose when merging two patient records with the 

source patient's clinical record still open has been resolved.

• When selecting the Edit Investigation Request option for an investigation result in the 

Detail tab that has no request then a message is displayed as 'There is no request for 

this result'.

Central Data

• The adult and over-55s Aboriginal health checks now contain the alcohol AUDIT-C 

qualifiers to allow the audit to be completed as part of the annual health assessment.

• There are four new i-STAT items available with the Communicare Value-added 

dataset which can record results from the CG4+, CHEM8+, INR and Troponin i-STAT 

machines.

E-Health

Medications dispensed, administered or supplied now show as such clearly in progress 

notes uploaded to MyHR (such actions are now documented with the prefix of <Dispense>, 

<Supply> or <Administer>).

Prescribing

• Lengthy approved indications are trimmed automatically to fit on a script. There is 

an option to expand the description if required. Note that if there is more than one 

streamlined authority number then the text is not trimmed until one streamlined 

authority number is selected.

• A prescriber can now decide to print labels even after a prescription has been printed.

• Drug interaction warnings are now not repeated when generating a new Health Centre 

Prescription. Previously, interactions between drug A and drug B were repeated as 

interactions between drug B and drug A.
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• The prompt to regenerate the Health Centre Prescription on closing the clinical 

record, if the user stopped or deleted any regular medications.

• Prescribers can now review verbal orders for expired medications from Details tab in 

the Clinical Record.

Medications Management

• The requirement to enter initials when adding a new dispense, supply or administer 

has been removed. This is now optional but the username of the person creating the 

record will now be shown.

• When dispensing and administering, the comment field will now appear in the 

progress note.

• Extemporaneous preparations cannot be included in Imprest lists. Previously an error 

was displayed when a user attempted to do this.

• The standard generic dispense label used with Medications Management has been 

modified to satisfy all the Poisons Regulations requirements.

Report Scheduling

Report scheduling functionality has now been extended to support secure delivery by Argus. 

The maintenance window at Tools  > Scheduled Reports  has been improved to facilitate 

this.

Note:

Administrators - Reports scheduled for delivery to Communicare Support  have 

been disabled in this release as this e-mail address is no longer monitored. Note 

also that some databases are using unsecured_email@amnet.net.au (server at 

mail.amnet.net.au) to schedule reports - this e-mail address should not be used as 

it was intended for demonstration purposes only. Please check File  > Reference 

Tables  >  Organisation Maintenance  (Email Server tab) and if you wish to 

continue to send scheduled reports replace the details with an internal e-mail 

address provided by your organisation. In due course this e-mail address will expire 

and scheduled reports using this address will cease.

Offline Client

The Offline (Data Synchronisation) Client now displays the date and time of the last upload 

and last download on:
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• the Splash Screen

• the Login Screen

• the Main Communicare Toolbar

Patient Biographics

• On the Patient Search window, the Invalid Medicare Number icon is not displayed for 

deceased patients when the filter allows deceased patients to be shown.

• The Patient Alert popup note will now preserve any formatting of text when editing 

from outside the Biographics window.

Service Recording

• The Service Recording window will now remember each user's tab selection (Detail, 

Providers, Medicare, Private or Requirements), even after the user has logged off.

• The Service Recording window can now be ordered by the Requirements column if 

required.

Appointments

• The requirement to enter initials when adding a new appointment has been removed. 

This is now optional but the username of the person creating the appointment will 

now be shown.

• Patients can now be checked in when they arrive from the Appointments Book 

window.

• When adding a new session to the Appointments Book the default ordering is now 

the provider name, although all columns can be ordered (e.g. session type, start time, 

facility, etc.

Reference Tables

Reference tables that allowed deletion prior to version 15.0 now allow such deletion (if it has 

not been used or if it does not relate to patient data), such as keywords for clinical items and 

investigation request terms.
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• Three new fields can be have been added to the Provider window: Indigenous Status, 

Date of Birth, Cultural Awareness Training Given

• The Provider reference table now shows the logon user name in the grid and, when 

ordered by this column, the Locate box can be used to search for a provider by their 

logon user name.

• Only encounter places with enabled modes are visible in the Ix Claimant grid for 

recording provider numbers on the Provider reference table.

• There is now a free text area for each provider to record notes relevant to that provider 

on the Provider reference table.

• The ability to add keywords to clinical item groups has been restored - see File | 

Reference Tables | Clinical Item Group Keywords.

• Certificates Store issues - some small inconsistencies when entering incorrect 

passwords have been resolved.

• Some changes of Value Type, Aboriginality and Gender are now allowed when 

editing a qualifier type on the Qualifier Type reference table (for example, changing 

a Checkbox to a Yes/No type is now allowed and removing Aboriginality and Gender 

limitations is allowed).

• Long qualifier descriptions no longer overwrite the Max Value text box in the Qualifier 

Types reference table.

• There is now a search box on the Groups tab of the Clinical Item Types reference table 

to allow easy addition of groups associated with a clinical item type.

Address Book

Both the Address Book Search and Address Book Maintenance windows now show the 

Comments field in the grid. This will allow address book entries to be 'flagged' with useful 

information for providers searching for suitable recipients for referrals, for example.

Intramail

If an Intramail recipient is absent (recorded at  File  > Reference Tables  >  Appointments 

> Appointments  > Provider Planned Absences), then the sender will see an alert message 

with the details of absent recipients as soon as they send the message.

The label on the main toolbar that shows unread messages now shows in red and bold if 

there are any.
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Billing

• Users with no Billing rights will be able to change the Claim Type (Medicare or 

Private) and be able to select items for a service. This behaviour is now consistent with 

the earlier behaviour of Electronic Claims (bulk billing). Such users cannot generate 

invoices or claim for the service, neither can they accept payment.

• The Amount Claimed is no longer removed when a Medicare item is deselected from 

the Medicare claim tab.

• The Claims (MBS Items History) button now shows the MBS group as well as the MBS 

item to allow sorting by type of claim as well as specific item.

Transport Management

• The requirement to enter initials when adding a new transport booking has been 

removed. This is now optional but the username of the person creating the transport 

requirement will now be shown.

• There is now a driver selection dropdown box on the Transport Management window's 

Print Transport List button. This will allow drivers to print only their list easily, 

without having to go through the reports menu.

Documents and Results

• The action of reviewing an investigation result from the Documents and Results 

window now creates content in the progress note when the administration service is 

created. Previously, empty progress notes were created.

• From the Documents and Results window, when attaching or scanning a document, 

the Add Recall button is disabled until the document is reviewed.

• Re-sizing columns in the Documents and Results window has been made easier.

• An issue that prevented some incoming document types, particularly discharge 

referrals, from being manually matched to a patient has been resolved.

System Parameters

The Name of Practice field in Organisation Parameters has been extended from 40 characters 

to 200 characters. This will allow health service names that have previously been abbreviated 

to now reflect the full name.
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.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

Version 15

Release notes for version 15 releases.

Version 15.2

Release notes for V15.2.

Workstation Location

The Workstation Location field has been removed from the login screen.

Patient Sex

The following new Sex values have been added (in addition to Male and Female):

• Indeterminate

• Intersex

• Not Stated

• Unknown / Inadequately Described

Encounter Place Multi-Level Hierarchy

Encounter Places are displayed in an hierarchical structure instead of a flat list on the 

following windows;

• Appointment Book filter

• Service recording filter

Split Encounter Place and Encounter Mode

Encounter Place and Encounter Mode are displayed in separate fields instead of displaying 

together preserving existing business rules on the following windows;

• Provider, Place and Mode Selection including Main Toolbar and Data Entry Wizard

• Service Record

• Match and Review Result
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.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

Version 15.1

Release notes for V15.1.

Encounter Places

The availability of a multilevel hierarchical structure has been introduced to the Encounter 

Place reference table which means an encounter place can be recorded as a parent or a child 

of another encounter place. What this means is that you will be able to filter and report on 

groups of encounter places. For example, where a single physical clinic comprises more than 

one encounter place, an administrative encounter place can now be added to report on all 

the encounter places that 'belong' to that physical clinic.

• An encounter place can be recorded as either an Administrative Encounter Place or a 

Service Encounter Place.

• A Service Encounter Place can be a free standing encounter place or can be a child of 

an Administrative Encounter Place.

• No activity can be recorded against an Administrative Encounter Place which will used 

primarily for management and reporting purposes.

• Existing encounter places will be marked as Service Encounter Places so that there is 

no impact on the existing functionality.

• Service or Administrative Encounter places cannot be deleted but can be disabled.

The encounter place hierarchical structure change has been applied to the Service 

Recording, Appointments Book and Investigation Results filters. Some reports have been 

modified to incorporate the new structure.

A new field "Establishment Code" also added to the Encounter Places.

Patient Biographics

The following new fields are added on the Social tab of the patient biographics window:

• Interpreter Required - new fields on the Social tab to record whether a patient requires 

an interpreter or not and the interpreter language required.

• Residential Status - a new field on the Social tab to record the Residential Status of a 

Patient.
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• NDIS Status - a new field on the Social tab to record the National Disability Insurance 

Scheme (NDIS) registration status of a patient.

• Multiple Birth Indicator and Birth Order - new fields on the Social tab to record 

whether the patient was part of a multiple birth (Multiple Birth Indicator) and the 

patient's birth order if patient was part of a multiple birth (Birth Order).

Patient Search

• IHI Number - a new field on the patient search window to allow searching for a patient 

against their IHI number.

There is a new System Parameter setting that allows a System Administration the ability to 

disable the automatic patient search option. There is a new System Parameter setting that 

gives a System Administration the ability to disable the phonetic patient search option.

Appointment Type

A new field has been added to the Appointment Details window to indicate the type of 

appointment it is, e.g. new or follow up.

Patient Summary Report

• The data displayed in the Patient Summary Report can now be sorted by date in 

Ascending or Descending order (default is Descending).

• Investigation Results can now be displayed in the Patient Summary Report.

• The number of last investigation results to be included in the Patient Summary can be 

configured. By default, the last 5 investigations are included.

• Saving of customised Patient Summary reports is now limited to users with Report 

Administration system rights.

Central Clinical Items and Qualifiers

There is now an Assessment;Kessler 5 (K5) clinical item to complement the K10.

A new clinical item SLK Generator introduces a new qualifier, Statistical Linkage Key 

(SLK-581), that will build the SLK with the click of a button. The SLK may be required 

for reporting to some funding bodies, especially for drug and alcohol and mental health 

programs.
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The 'Peak flow' qualifier has been renamed 'PEF (peak expiratory flow)' and there are new 

qualifiers for 'FVC (forced vital capacity)', 'FEV1 (forced expiratory flow in 1 s)' and 'FEV1/

FVC'. These are attached to ICPC clinical items of ICPC code R39 (e.g. 'Test;spirometry'). 

Also added are 'FVC (% predicted)', 'FEV1 (% predicted)' and 'FEV1/FVC' (% predicted)'.

Prescribing

On the Medication Summary window, the title of the column for medications that are 

prescribed elsewhere is changed to RxE from Rx Elsewhere and a legend is displayed at the 

bottom.

Adverse reactions

On the Main Summary window of the clinical record, under the Adverse Reaction Summary 

section, the following new fields have been added:

• Assessment Date as an optional field. Assessment date is used to identify the most 

recent date that the patient was assessed for adverse reactions.

• Severity can be recorded against each reaction manifestation.

Data Synchronisation

The following functions are not supported on offline clients:

• Imprest Management functionality is disabled.

• Adding, editing or deleting of Dispense, Supply and Administer records is disabled 

though users can view the existing records.

• Adding or Editing of Verbal Orders is disabled though users can view existing verbal 

orders.

• Private Billing is disabled.

• Sending, replying or forwarding of Intramail is disabled though users can view existing 

Intramail.

User can, however, still add, edit or delete Adverse Reactions in an offline client.

Demo installation

The requirement for an activation code when installing the demo has been removed.
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Features for Western Australian Country Health Service (WACHS)

• System Module - A new system module has been introduced for WA Country Health 

Service - WACHS Features. All WACHS specific functionality will be controlled via 

this module (for example functionality to search for a patient in the DoH WA database 

using the HIH Service).

• PAS Alerts - The alerts received from PAS via EMPI integration are displayed as read 

only text in the Main Summary of the clinical record.

• Adverse reactions - On the Main Summary window of the clinical record, under the 

Adverse Reaction Summary section, the following new field has been added (also, see 

Adverse Reactions above): Assessment Status

• New Kin Type functionality

◦ Additional information can be recorded in the additional kin information area of 

the social tab in the patient biographics.

◦ Emergency Contact information recorded in this area is copied automatically to 

the emergency contact fields.

• Patient Merge / Unmerge

◦ Patients can be unmerged if the WACHS module is enabled and the patient 

record has not been modified since the merge.

◦ A new PatMergeUnmerge.exe allows patients to be merged / unmerged from a 

command line executable.

• Incoming Referrals (Referrals Management) - The existing functionality of recording 

incoming referrals using clinical item is replaced with a dedicated enhanced incoming 

referrals functionality though outgoing referrals will continue to be recorded via a 

clinical item. The new incoming referrals functionality is controlled via the Referral 

Management system module. If the module is disabled, incoming referrals can be 

recorded via existing clinical items.

• Billing - Communicare does have a comprehensive patient billing module but this 

has been disabled in version 15.1 as all CHIS patient billing will be managed by the 

WA Health Department Patient Billing Revenue Collection system. Users will be able 

to record billing details but submission of Medicare and patient claims (including 

generating invoices and receipts) and the Transaction History for private billing is 

disabled.

.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

136 Integrated Team Care



Version 15.0

Release notes for V15.0.

Medications Management

Medications Management is for use in combination with the existing Prescribing Module 

and can be enabled only if the Prescribing Module is enabled. "Medication Management" in 

Communicare describes the following functionality:

Dispense, Supply and Administer

Dispense: Users can now record the dispense/redispense details for current medications. 

To record a dispense/redispense, the user needs to have Medications Dispense system rights. 

Please refer to Medications Management - Dispense section in the Help notes for further 

details on Dispense/Redispense business rules.

The default brand selected for Dispense takes imprest stock levels into account (if it is not 

an external dispense). The following information is included in the Dispense form - Stock 

Location, Duration and Type of Medication.

External Dispense: When the dispense is recorded as External Dispense then the dispense 

quantity is not deducted from the imprest stock.

Printing dispense labels: A new dispense label entry is added in the Printer Assignment 

Form. This has the ability to set the dispense label template from the drop down list.

 Supply: Users can now record the supply details for the medications which are dispensed 

in Communicare. To record a supply, the user needs to have the Medications Supply system 

right. Please refer to Medications Management - Supply section under the Help for further 

details on Supply business rules.

 Administer: Users can now record the administer details for the medications which are 

dispensed in Communicare. To record an administer, the user needs to have the Medications 

Administer system right. Please refer to Medications Management Administer section under 

the Help for further details on Administer business rules.
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Imprest Management: Medication Stock Control

Development of Imprest Management is now complete. Users with appropriate system 

rights can now manage the clinic imprest using Communicare. A new system right 

'Imprest Management' is added to the User Group Maintenance. To access this system 

right the 'Medications Management module ' should be enabled. Please refer to System 

Administration - Imprest Management section under the Help for further details.

<u>Manage Imprest</u>: Manage Imprest is a new data entry form to manage the Imprest 

details. This form manages the list of all the Imprest available. It allows you to search, 

add, edit, delete, print and clone the imprest available. A new menu item for 'Imprest 

Management' is added under 'File' main menu option, with the following sub menu 'Manage 

Imprest'.

<u>Manage Orders</u>: Manage Order is a new data entry form to create orders of Imprest 

medications and update stock levels when orders are received. The user can search, add, 

finalise, print, receive or cancel existing orders.

Added functionality to pre-fill the suggested Order Quantity and Received Quantity for each 

medication. A new menu item for 'Imprest Management' is added under 'File' main menu 

option, with the following sub menu 'Manage Orders'.

Imprest order documents can be sent securely through Argus.

Verbal Orders and Standing Orders

Verbal Orders is available when the Medication Management module is enabled.

The new Verbal Order functionality allows a System Administrator to configure permission 

for an individual Provider to give verbal orders for particular medications according to the 

Schedule classifications (e.g. S1, S2, S3, S4, S5, S6, S7, S8, S9 and Unscheduled). This is done 

in the Provider Reference table. An Administrator can enable the verbal order settings for 

different classifications of medication and different encounter places for Providers. If a 

particular Schedule is selected then any medications of that Schedule that are added by the 

Provider will prompt for a Verbal Order. To access this the Medications Management module 

needs to be enabled.

Verbal Orders functionality in the Prescribe section of the Clinical Record has a popup that 

prompts the person making a Verbal Order to select an Authorising Doctor and Checker 

when saving a prescription. This is based on a combination of the MIMS Drug Schedule and 
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medication standing orders. Once the prescription has been saved, the Authorizing Doctor is 

notified of the Verbal Order waiting approval via a notification that appears in the bottom-

right of the Communicare toolbar.

Unreviewed Verbal Orders: An Unreviewed Verbal Order is a Verbal Order which is awaiting 

approval from the Authorising Doctor. The Medications Management module needs to be 

enabled to view the Unreviewed Verbal Orders. An icon with the number of Unreviewed 

Verbal Orders is displayed on the Communicare Main Toolbar status bar. Clicking on the icon 

on the Main Toolbar will open the Unreviewed Verbal Orders window with the list of Verbal 

Orders to be reviewed.

Formularies

A new option has been added in version 15 to mark whether a formulary is a standing order. 

There can be only one published Formulary which is marked "Is Standing Order". Also added 

is a new option to link an encounter place with a formulary.

Prescribing

* Communicare now supports the electronic transfer of PBS reform prescriptions via eRx.

* The ability to repeat all medications by selecting 'Repeat Medications' button in Clinical 

Record has been added.

* When a Prescription is listed in the Medications Summary it is able to be edited (unless it 

has been printed). It can now also be edited from the Prescription Details window.

* The "Once Off Medication" caption is renamed as "Once Off / Short Course" whereever it is 

used.

* It is now possible to select the DAA type while prescribing rather than having to change 

the DAA type on the Patient's Clinical Record before hand.

* A DAA type of "Packet" and "Bag (OP)" has been added to the list of available DAA types.

* Dosage instructions and DAA details have been visually separated to prevent potential 

misinterpretation of dosage instructions.

* When DAA is in use for a Patient, the DAA details are displayed first followed by the dosage 

instructions.
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* <u>Rural Prescription Form</u>: If the 'Use Rural Prescription Form' is turned on in the 

system parameters then a new prompt is added when the Clinical Record is exited at the end 

of a service for unprinted regular medication to generate HCP.

Clinical Record

Pause Button

A pause button  has been added to close a clinical record and pause the service without 

displaying the usual service exit prompts. Use this button to quickly check another patient's 

clinical record. Paused services can be found in the Service Recording window.

Care Plans

Communicare now allows multiple active care plans for a single patient. To facilitate 

concurrent care plans the care plan templates must have different topics (for example, to 

allow a mental health plan and a diabetes care plan to co-exist one could have the topic of 

Psychological and the other the topic of Endocrine, Metabolic and Nutritional).

Preterm Centile Charts

New charts displaying preterm child growth information based on the Fenton 2013 Preterm 

charts are now included. See Preterm Centile Chart for more details.

Medication Summary

* In version 15 there is a new option to record that a medication is OTC ("Over the Counter") 

or "Prescribed Elsewhere" and provide a comment. If "Prescribed Elsewhere" is selected then 

a Comment is mandatory. These details will appear in the Medications Summary in the 

Clinical Record.

* Prescription and Labels cannot be printed for OTC and "Prescribed Elsewhere" medications.

* "Over the Counter" and "Prescribed Elsewhere" information will also appear in the Details 

tab section, Progress Notes and Medication Summary tab. Comments for the prescription are 

accessible wherever the medication is accessible like letter templates. When a medication 

is recorded as OTC or Prescribed Elsewhere then wherever that medication is displayed 

then it indicates clearly whether it is an OTC or Prescribed Elsewhere medication (eg in 

letters, reports, discharge \summary). Under the Details tab a 'Make Once Off' or 'Make 
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Regular' context menu has been added depending upon whether the selected Prescription 

was recorded as Once Off or Regular.

Details Tab

* The dispense, supply and administer details are now shown in the Details Tab.

* In the View Clinical Record by Class, three new tabs are created for displaying dispense, 

supply and administer.

* In the View Clinical Record by Topic, the dispense, supply and administer details are 

shown in Medication tab.

* In View Clinical Record by Date, dispense, supply and administer details are updated 

according to the date. Edit and Delete functionality is implemented accordingly.

Adverse Reactions

A new field has been added to record date of onset. Date of onset is not the date when the 

user recorded the adverse reaction but the date when the adverse reaction occurred or 

started showing symptoms or signs.

Reaction Type selection has been updated to use SNOMED CT-AU terminology.

Non-Drug substances/agents list all the active non-medicinal concepts from the SNOMED 

CT-AU terminology.

Central Clinical Items

Aboriginal Health Checks: Three new clinical items have been added to the central dataset 

for use at health services where Medicare claims for item 715 are not normally done or are 

associated with a complementary item type. These items are:

• Check up;Aboriginal & TSI adult NO MBS

• Check up;Aboriginal & TSI child NO MBS

• Check up;Aboriginal & TSI over 55 NO MBS

These items will not appear on the Check up button and have no associated recall rules but 

are otherwise identical to the equivalent clinical items that have the associated Medicare 

claim for item 715.
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Note:

To avoid confusion, Communicare administrators should disable these three items 

immediately after the upgrade.

Check up;Aboriginal & TSI adult: The centrally distributed Check up;Aboriginal &amp; TSI 

adult item has three new reference qualifiers:

• AUDIT-C offered

• STI test offered

• CV risk assessment offered

All the three reference qualifiers listed above have four responses: Accepted, Declined, Not 

offered and Not applicable. Local administrators should consider the following:

• If desired, create 'on qualifier' recall rules that trigger a suitable recall based on a 

response of 'Accepted'. For example, if you use the CARPA CV risk item then trigger 

such a response from the 'CV risk assessment offered' qualifier to recall immediately 

for the CARPA CV risk item. If you prefer to use the Framingham item then make your 

rule trigger that item.

• If you use a local adult health check, add these qualifiers to your item and set up 

suitable recall rules if desired.

The centrally distributed Check up;Aboriginal & TSI adult item also has two new 

investigation request qualifiers:

• Adult Health Check test request

• Adult Health Check STI test request

These two buttons generate suitable pathology test requests but <color Red>must be 

configured locally</color> before they will work, by adding an investigation code of 'AHC' 

or 'STI-AHC' to existing investigation test request terms. An administrator should go 

to File | Reference Tables | Investigations | Investigation Keywords and locate or add the 

keyword 'AHC'. Review and add tests in the grid at the bottom so that the list contains the 

desired tests (e.g. Lipids, Full Blood Examination, Glycated haemoglobin, etc.). Repeat 

for the keyword 'STI-AHC' and add suitable STI tests (e.g. Syphilis serology, HIV serology, 

Gonorrhoea, Chlamydia and Trichomonas NAAT, urine, etc.). This should be done before 

upgrading to this version of Communicare.

142 Integrated Team Care



Other Central Clinical Items:

• A DASS21 assessment with qualifiers that calculate the scores for depression, anxiety 

and stress has been added to the Communicare Value Added dataset.

• Changes have been to Photography;retinal - This central item now has qualifiers 

to capture visual acuity, preparation for retinal screening and outcomes of retinal 

screening. These are coded to support the NT AHKPI retinopathy indicator.

• Changes have been to STI screening;NT - This item has been modified following 

feedback from STRIVE and AMSANT.

Central Qualifiers

The qualifier 'Rhesus factor' has been renamed 'Blood group: rhesus factor' to allow it to 

appear adjacent to Blood group in the qualifier summary.

Progress Notes

Customers using their own configuration of the progress notes print option have the options 

available on the current service as well as historic services.

Pathology Requests

A new printing format has been added (Standard HSSA).

Immunisation Review Recalls

In line with changes and advice regarding the two month child immunisation review, 

the central dataset "Immunisation Age Based Reviews" has been adjusted so that the 

two month review is now due at six weeks rather than two months. It is still named 

“Review;immunisation;2 month age”. The birth review now has a maximum age of 6 weeks 

rather than two months for consistency.

Recall Expiry

New functionality has been added to specify the automated expiry of recalls. For example, a 

postnatal check up recall can be set up to expire six weeks after its planned date. If the recall 

is not completed after six weeks, it will be cancelled automatically in a nightly cleanup.
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ACIR to AIR

The Australian Child Immunisation Register became the Australian Immunisation Register 

(AIR) in September 2016. This version of Communicare includes the additional codes 

required for submitting adult immunisation information to AIR.

Patient Biographics

Personal tab

* A button has been added to send an SMS from the Biographics Personal tab.

* The Aboriginality dropdown box has been updated as Indigenous Status and now uses the 

AIHW descriptions: This change may affect some local reports. If you find any issues and 

need help contact the Helpdesk. 

* Two new patient name options 'Medicare' and 'HI' have been added to Biographics - 

Personal. These options indicate which name should be used for Medicare and IHI Number 

verification

My Health Record and MeHR

PCEHR has been renamed to My Health Record (MyHR)

Assisted registration:

• Assisted registration can be done if the guardian is on a different Medicare card than 

the patient.

• After registering a patient for My Health Record the "Patient Consents to Upload to My 

Health Record" checkbox will be ticked.

• The Print and Scan buttons have been removed from the assisted registration form as 

this is no longer a requirement.
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There is a new option in the system parameters to select all "Event Summary" clinical data 

items by default. If it is ticked then all the clinical data items will be selected by default 

when the Event Summary is generated for My Health Record/MEHR for the first time in the 

service.

Event Summary: When the user generates the Event Summary for the first time in a service 

then the clinical information in the tree view will be default to either Ticked/Unticked state 

based on the 'Select all Event Summary clinical data items by default' system parameter 

value. For the subsequent Event Summary documents, the items in the tree view default 

to ticked or unticked based on whether they were ticked or unticked in the previous Event 

Summary for the same service. User can't save and upload the document if it contains no 

data.

Shared Health Summary: When a user is generating a Shared Health Summary and there is 

no data in a data section (Medication, Problem/Diagnosis, Procedures and Immunisations) 

then the user will get an option to set the exclusion statement for that section. Once the 

document is generated, if the user excludes all the clinical information using the right hand 

side tree in the document, then it will default to the "None Supplied" exclusion statement.

Viewing MyHR: Users without a HPI-I can now view a patient's Health Record Overview 

(HRO) but cannot generate or upload documents to MyHR or supersede existing CDA 

documents. Users with a HPI-I can continue to access, upload or supersede CDA documents.

MeHR:

• The latest GPG keys are part of the install to allow correct encryption with MeHR.

• The consumer registration form has been updated to the latest version.

Social tab

A new 'Occupation' field has been added to the Social tab. By default the new Occupation 

field is hidden. It can be turned on via System Parameters in the Patient tab.

Other Modules

Data Synchronisation

The offline client does not currently support the Medications Management module. This 

means that: • the Dispense, Administer and Supply functions are disabled on the Offline 

Client, although existing data can be seen. • Imprest management is disabled on the Offline 
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Client. • Verbal Orders cannot be created on an Offline Client. The details within a Verbal 

Order can be viewed on an Online Client, however they cannot be formally 'reviewed' on 

an Offline Client. The offline client does not currently support the Private Billing module. 

This means that: • Private Billing functionality is disabled on an Offline Client. • At the 

end of a service only Medicare schedule items can be selected. • Private Billing Account 

Administration is disabled on Offline Clients. The offline client does not currently support 

the Intramail module. This means that: • New intramails cannot be sent. • Unread intramails 

can be read but not marked as 'read'.

Appointments

The rule that prevented a user from changing the place, mode or program of a service that 

started as an appointment has been relaxed. It is now possible to change these values (for 

example, to change the mode of an appointment from Aboriginal Health Service to Client's 

Home if the appointment was held at the client's home). The only restriction is that the 

place cannot be changed once a Medicare claim or private claim has been saved.

Service Recording

* Paused services now show the time since the last pause - similar to the waiting time shown 

for waiting services. After one hour the time is presented in bold text.

* A new filter has been added on Service Recording to include or exclude deceased patients.

Documents and Results

* Incoming Investigation Results can now be allocated to a provider other than the recipient. 

Right click on the incoming result in the Documents and Results window and select Reassign 

to another Provider.

* It is now possible to add recalls whilst reviewing a document without opening the patient's 

Clinical Record.

Transport Management

The ordering date will now default to the pickup date/time. New buttons on the Transport 

Requirement List window allow the user to sort the records either by Pickup or Dropoff date/

time. If the Pickup date is selected and available, then the records are ordered by the pickup 

date/time otherwise dropoff date/time.
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SNOMED CT-AU Terminology

* The ability to import SNOMED CT-AU terminology has been added to Communicare. This 

change is intended to facilitate the standardised recording of non-medicinal substances/

agents pertaining to adverse reactions.

* Reaction Description has been supplanted by a searchable list of Clinical Manifestations 

defined by SNOMED CT-AU terminology.

* All CDA documents will record non-medicinal substance/agents, reaction-types and 

clinical manifestations using SNOMED CT-AU.

* Medication information in CDA documents will include a supplemental translation to 

AMT.

* Shared Health Summary - CDA Implementation Profile Upgrade to Version 1.6.

* Event Summary - CDA Implementation Profile Upgrade to Version 1.4.

Secure Messaging

HealthLink Acknowledgements: Communicare can now send acknowledgements to 

HealthLink for HL7 results received in the Results folder. To facilitate this HealthLink needs 

to be configured to place results in a subfolder of the results folder called 'HealthLink'. 

Contact the helpdesk for assistance.

Intramail

* When a sender ticks the checkbox to save a message to a patient’s progress notes then a 

label "This message is saved in Progress Notes" appears on the recipient’s intramail message.

* There is now direct link from the intramail message to the patient Clinical Record.

* The ability to change topic and viewing rights in Details tab/Intramail in the Clinical 

Record.

HPI-I Searching and Validation

* HPI-I searching and validation has been enhanced so that a complete directory is now 

referenced. This means no more false negative searches/validations.
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* Providers can now have their HPI-I retrieved using their AHPRA registration number and 

surname.

HBCIS Interface

Communicare Server Windows Service now accepts incoming HL7 message from HBCIS.

Reporting

Patient Summary Report: The Patient Summary Report has been added to the Reports menu 

in the Clinical Record. A new option to limit the 'To' date of Clinical Items or Consultations 

in this report has also been added to this report.

nKPI and OSR reporting: some changes have been implemented following feedback from 

AIHW:

• The business rules for counting episodes for inclusion in the OSR CS-01 report and for 

assessing the three visits in two years for AIHW regular client status have changed in 

line with other vendors following advice from AIHW:

1. Where there is more than one service on a single day this will be counted as a 

single episode (OSR Episodes report only).

2. The following contact modes are excluded from counting: 'Administration - 

client contact', 'Court', any 'Hospital' mode, 'Other' and 'Telephone'.

These two changes will reduce the count of episodes (for OSR) and the count of regular 

clients (for nKPI) for the next reporting period:

• OSR substance use indicators now do not report all non-residential services as such 

but look evidence of substance use issues. Only services that satisfy at least one of the 

following criteria are included:

1. Services associated with an encounter program containing the words 'DRUG' 

and/or 'ALCOHOL' and/or 'AOD'.

2. Services associated with an encounter place containing the words 'DRUG' and/or 

'ALCOHOL' and/or 'AOD'.

3. Services provided by a 'Drug and alchohol counsellor' or a 'Substance misuse 

worker'.

4. Services having at least one procedure or referral that is not a recall or 

a cancelled recall having a keyword containing the words 'DRUG' and/or 

'ALCOHOL' and/or 'AOD'.
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• National KPI reports now include patients who died before the end of the reporting 

period if they had three visits in the previous two years. This only affects reports run 

with the AIHW Regular Client option as the Communicare Current Patient option 

excludes deceased patients by definition. Also, some minor tweaks to address the 

categorisation of patients whose latest BP was exactly 130/80 and those whose latest 

HbA1c was recorded as exactly 7% (rather than 53 mmol/mol) have been made.

SQL Reports: The SQL Report Editor now allows reports to be:

• Enabled/Disabled

• Restricted to users based in System Rights

• Restricted to users based on Viewing Rights

Medicare Billing

A new filter in Online Claiming - Bulk Bill Claims for 'Minor ID' has been added. This allows 

you to filter the list for a specific minor location ID.

Medicare Claim Version upgrade: Communicare has upgraded to use Medicare client adaptor 

version June 2014.

Patient claims: New patient claims functionality has been added. Patient claims are 

Medicare claims lodged by patients who have received professional medical services, but 

have not assigned their rights to Medicare benefits to the Servicing Practitioner. This 

functionality supports interactive patient claims which allows real-time processing of 

a single claim and is available during Medicare operating hours. A real-time processing 

follows a cycle of:

• transmit

• assessment

• returns an outcome to the sending location

• same day delete

A new Patient Claims tab has been added to the Online Claiming window to go through all 

the private billing patient claims.

Batch claim: A new organisation parameter setting has been introduced under Medicare 

claim-Batch claim to enable Medicare batch claims. By default this parameter is turned off. 

If a user needs to use this functionality, please talk to the Communicare service desk for 

(c)Telstra Health | Communicare 149



more details. A new option 'Enable Batch Claims' has been added. If using Batch claims for 

the organisation then select the 'Enable Batch Claims' checkbox.

All Medicare functions including bulk billing, patient claims and ACIR have been upgraded 

to send a single Medicare claim for multiple medical services by the same provider for the 

same patient at the same encounter place.

Bulk billing: If batch claim is enabled, then there can be only one active batch claim for a 

patient per provider per encounter place. A User can submit the claim for any of the services 

which are batched together. Multiple providers are not allowed if the service is marked for 

batch claim.

Patient claim: If batch claim is enabled, then the selected invoice can be grouped together 

with other the invoices for the selected patient and the provider and the claimant/payer and 

can be sent as a single claim. Only one batch can exist per patient per provider per payer. 

The next batch can’t be created unless the existing batch is claimed.

ACIR claim: If batch claim is enabled, then all immunisations created by a single 

provider will be grouped in batches with a maximum of 20 Services and a maximum of 5 

immunisations per visit, and can be sent under a single Medicare claim.

Private billing

* New optional fields for private billing fee items have been added to support specialist 

services and override categories.

* There is an added capability to choose the invoice template from the Printer Assignments 

window. The invoice will be printed with the chosen template. If there is only \one template, 

then this will be chosen as the default.

* Private billing Invoice documents can be sent securely through Argus.

* A new payment method 'Direct Debit' has been added.

* Private billing now allows selection of multiple providers. A default claimant needs to be 

selected.

* Private billing does not allow linking of a private item to two different MBS items any 

more.
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National Diabetes Service Scheme (NDSS)

The Help menu of Communicare now has a section under Help | Forms | NDSS containing 

registration and application forms for NDSS and NDSS products. These forms are also 

available at https://www.ndss.com.au/the-ndss. They can be printed and offered to patients 

for completion.

Note for administrators: If you have already configured these documents to appear on the 

Help | Forms menu you may choose to remove your copies to avoid confusion. See Printable 

Forms for details.

Remote Assistance

The legacy remote assistance option has been removed from the Help menu and the Team 

Viewer option has been merged into the Request Remote Assistance option.

Licencing

* Users of Communicare are no longer locked out due to too many licences being used

* The number of licensed users is no longer displayed on the login screen

* Licensing information is now displayed in the About screen

* Licensing numbers are now displayed on the main screen only for administration users

Icon Change

The Communicare icon has changed to the Telstra Health icon.

Firebird

The Firebird database has been upgraded to version 2.5.7

.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

Version 14

Release notes for version 14 releases.
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Version 14.8

Release notes for V14.8.

Service Record

Added a new option to set the Claim type i.e. Medicare or Private.In private tab we added a 

new option to select the Billing type for the service. Based on the Billing Type selected the 

payer list and the Item Fee will change.

Patient Merge

The rule for merging Recalls, when patients are merged, has been reversed in response 

to user request and following confirmation from the Communicare Clinical Improvement 

Group (CCIG).

The new rule is: “If the same recall exists in the source and destination patients then the 

earlier recall is deleted and the later one is retained. In other words, where recalls are 

duplicated in the two records the recall is effectively moved to the later recall date.”

Private Billing Administration

Void Invoice : Invoice cannot be voided if there is any Amount Paid (part or full) against the 

selected invoice. Amount Paid needs to be refunded before the invoice can be voided.

Edit Invoice : Edit Invoice allows to edit the invoice by recording the reason for edit. Invoice 

cannot be edited if there is any Amount Paid (part or full) against the selected invoice. On 

Edit, original invoice become void &amp; new invoice will be generated.

Refresh : Window can be refreshed manually or automatically after an interval (30 secs).

Refund : A refund amount facility is added into Private billing Administration function. Any 

over payment accepted by the service can be refunded to the payer.

Write Off : Allows to write off any Balance Due amount. The write off amount is deducted 

from the Balance Due and the Amount Paid remains same.

Transaction History : The full transactions history for the patient can be accessed using 

Transaction history page.

Gap Amount : Total MBS Amount and Gap amount are calculated.
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Prescribing Once Off

In addition to renaming the existing Prescribing system right to Prescribing - Full, a new 

Prescribing - Once Off system right is introduced. The users with Prescribing - Once Off 

system rights can prescribe only once off medications. But they can still view regular 

medications in a read only mode. The Progress Notes has been updated accordingly.

Intramail

A new window to read and send Intramail messages has been created. The main 

Communicare toolbar has been updated to display the current number of unread messages, 

and the label can be double-clicked to open the Intramail window. In addition to this, a 

button has been added to the main toolbar to quickly create a new Intramail message. It is 

now possible to reply to or forward Intramail messages.

Formularies

Added the option to set a default formulary to use for a user group in User Group 

Maintenance.

Private Billing Types

Private Billing Types is a new lookup window to add/update/delete the private billing types. 

This lookup will have "Private" and "Other" billing types by default.

Fee Schedule Details

Fee Schedule Details is a new data entry form to add/update/delete the fee schedule details 

like billing types and associated fee related information.

Pathology Request Form

New pathology request form for Pathology Queensland is available.

.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.

Version 14.7

Release notes for V14.7.
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Patient Biographics

A new option to record a patient's photo on the Biographics form has been introduced. If the 

Enable Patient Photo option is enabled in the system parameters then the user can record 

patient's photo. If no photo has been associated with the patient a default photo will be 

displayed.

This functionality can be disabled from System Parameters. Contact helpdesk for the daily 

code if you wish to do this.

Central Data

This version of Communicare introduces two new central clinical items:

* CV Risk Calculator (CARPA STM)

* CV Risk Calculator (Framingham) Administrators should decide which calculator is most 

appropriate for their health service and optionally disable the other and place the preferred 

calculator on the Check up button or another suitable button in the Clinical Record. Details 

of each calculator are displayed at the top of the clinical item. Briefly, the CARPA STM 

version of Framingham adds 5% to the risk for Aboriginal patients and also calculates risk 

for Aboriginal patients from the age of 20 years (Framingham applies only to Aboriginal 

patients from the age of 35 years and non-Aboriginal patients from the age of 45 years).

New Central dataset

A dataset for the management of rheumatic heart disease and acute rheumatic fever is now 

available. There is an accompanying document to help the administrator enable local recall 

protocols, available from https://portal.healthconnex.com.au/.

Ordering of lateral qualifiers on Central items

Please note that where Central clinical items such as the Aboriginal health checks have 

qualifiers that refer separately to a 'left' and 'right' (e.g. ear or eye checks) these have been 

reviewed for consistency so that the 'right' qualifier always precedes the 'left' qualifier. 

Administrators may wish to review any local clinical items to reflect this convention. 

Clinicians should be alerted to this change to avoid confusion at the point of data entry.

Drawing Qualifier
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There is now a qualifier called Drawing;blank canvas that can be used to add to local clinical 

items. This allows a clinician to create a drawing from a blank canvas. This supplements the 

existing list of 44 drawing qualifiers that feature selected body parts.

Recall Cancellation

'Attended another health service' has been added as a formal reason for cancelling a recall.

Letter Writing

Medicare expiry date has been added as a letter item for use in templates.

User Maintenance

A new option has been added to make usernames active or inactive. Only active users can 

log in to Communicare. This allows the administrator to temporarily disable a username (for 

example, a locum doctor who periodically accesses the database for short periods) without 

the need to delete and recreate.

Uploading Documents to a PCEHR in Communicare

This version of communicare has introduced a facility to upload documents to PCEHR in a 

delayed manner. When we click on " Save and Upload to PCEHR" button then the documents 

will be queued and will upload to PCEHR in a delayed manner.

Resending documents after failure

This version of Communicare introduces the facility to resend a document that has an error 

status. The document will be queued again or sent via Secure Messaging.

Administrator note: this functionality requires Argus version 6.0.15 or higher so please 

contact the Communicare helpdesk to arrange an upgrade if needed.

Argus API

Communicare is upgraded to Argus V2 API.

.Net Requirements

In order for Communicare to run .Net 4.5.2 or greater needs to be installed.
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Version 14.6

Release notes for V14.6.

Central Data

A new clinical item 'Check up;alcohol;AUDIT-C' has been introduced as part of the 

Communicare Value Added dataset. This has the first three questions of the existing, longer 

'Check up;alcohol;AUDIT' item. The calculated qualifier that totals the score has also been 

added to the latter item between questions 3 and 4. Note that a new National KPI indicator 

PI-17 will need to count and disaggregate scores for the AUDIT-C.

A new clinical item 'Check up;Mental Health APHQ-9' has been introduced as part of the 

Communicare Value Added dataset. The original PHQ-9 tool was developed by Drs. Robert 

Spitzer, Janet B.W. Williams, Kurt Kroenke and colleagues, with an educational grant from 

Pfizer Inc. Adapted by Dr. Alex Brown, Baker IDI Heart and Diabetes Institute.

System Parameters

A new option 'Enforce choice of once off or regular medication' to force the user to make a 

selection for Once Off / Regular prescription.

A new option 'Make Once off prescription duration mandatory' to force the user to enter the 

duration for Once Off prescriptions.

Formularies

A new module 'Formularies' has been added to manage medication lists that can be used to 

constrain prescribing for particular user groups.

A new tab 'Formulary Rights' has been added to User Group Maintenance.

A 'Formulary' drop-down menu has been added to the Drug Browser.

Private Billing

A new module 'Private Billing' has been added. And 'Electronic Claims Admin' module has 

been removed. Electronic claims module is untouched.

Two new system rights has been added 'Billing' and 'Billing Administration'. When Billing 

and Billing Administration system rights are enabled Then these system rights are applied to 

both Private Billing and Electronic Claims functionality if enabled.
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The Electronic Claim functionality remains unchanged with these new changes.

Prescribing

• Editing a Prescription - The prescription can only be edited by the prescriber who 

prescribed it and the prescription is not printed yet and the service in which it is 

prescribed is still open. The user cannot edit a prescription if it is printed or if it is 

created in a different service or if the same service is reopened or if the prescription is 

written by a different provider.

• Health Centre Prescriptions now display a script number. Reprinting a Health Centre 

Prescription will print it with the original script number, and it is not possible to 

change the contents of a Health Centre Prescription after it has been printed. You will 

be warned when changing a regular medication that a new Health Centre Prescription 

will need to be generated to include the latest changes.

• Each time a new Health Centre Prescription is generated:

◦ The latest regular medication details are used.

◦ A new script number is created.

◦ Any previous unexpired prescriptions existing for the regular medications will 

be stopped. If they were created in the current service by the same provider, they 

will also be logically deleted.

◦ Extra options are now provided to align all medications on the prescription to 

have the same expiry date, or leave the expiry dates as they were previously. See 

HCP Expiry Date Selection.

• Each time a Regular Medication is repeated, any previous unexpired prescriptions 

existing for the regular medication will be stopped. If they were created in the current 

service by the same provider, they will also be logically deleted.

Appointment Session Templates

Users can now 'clone' a session template to make it easier to add similar templates to the 

reference table. This functionality is found on the right click menu.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• Communicare Licencing

• SMS Messaging
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• Intramail

• Attaching PDF Documents

• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Messaging

• Reports outputting to the ANFPP web service, see Edit SQL Reports

• Dosage Instructions

• Private Billing

• Formularies

Version 14.5

Release notes for V14.5.

Appointment Session Templates

This screen has been enhanced to allow the user hide disabled session templates.

PDF Attachments

PDF documents can now be added to the shared results folder and these will be 

automatically imported into Communicare for patient matching and review.

PCEHR Health Record Overview

A patient's PCEHR Health Record Overview can now be viewed from the clinical record.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• Communicare Licencing

• SMS Messaging

• Intramail

• Attaching PDF Documents

• National Prescription and Dispense Repository (NPDR)

158 Integrated Team Care



• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Messaging

• Reports outputting to the ANFPP web service, see Edit SQL Reports

• Dosage Instructions

Version 14.4

Release notes for V14.4.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• Communicare Licencing

• SMS Messaging

• Intramail

• Attaching PDF Documents

• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Messaging

• Reports outputting to the ANFPP web service, see Edit SQL Reports

• Dosage Instructions

Version 14.3

Release notes for V14.3.

SMS Messaging

As part of the practice management suite of features, Communicare offers short messaging 

service (SMS). Patients can have SMS sent to them individually, directly from the clinical 
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record, or SMS can be sent to entire distribution lists. Communicare centrally distributes 

three reports for use immediately once your site has been activated. The first is the 

appointments report, assist practice staff with optimal management of appointment 

bookings. With the rights enabled you will be able to write reports and SMS templates to 

send any preformatted message you choose to your patient list.

Contact Communicare Support to discuss pricing options, and activate SMS for your health 

service. For more information, see SMS Messaging.

IntraMail

It is possible to send internal messages between users via the IntraMail facility. IntraMail 

messages can be sent to any registered user or to a user defined group of users. Messages 

can be created and viewed from the Documents &amp; Results window. Received messages 

will be displayed in the 'Received Messages' tab and Sent messages in the 'Sent Messages' 

tab. Messages can also be created from the patient's Clinical Record. An Address Book and 

Groups Editor allow the user to identify users and create user specific groups. Messages 

can only be sent to users within the Communicare application; it’s also possible to send 

IntraMail to yourself, as a reminder, either related to a patient, or not. The IntraMail is all 

kept securely within the Communicare system. For more information, see IntraMail.

Progress Note Auditing

An audit trail is now kept of changes made to a progress note when a service is changed 

retrospectively.

• When viewing the progress notes list, at any detail level, the service banner (where 

provider name and time is displayed) will be have the word “<Amended>” appended 

for any progress note that has been changed.

• The original version of the progress note will also appear in the progress note list 

when the detail level is 5. It will show as grey and the service banner will have the 

word “<Deleted>” appended.

• If the note has been amended multiple times, every earlier (non-current) version will 

be displayed below the current version, in the order of modification, with username 

and timestamp.
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• The Patient Summary report now has an option to include deleted progress notes in 

the progress note list.

• The letter item, Clinical Record | Progress Note, now allows you to select deleted 

progress notes to insert into a letter. Progress notes inserted into a letter will have 

<Amended> or <Deleted> in their title as appropriate.

NOTE: The above auditing described for amended progress notes only applies to progress 

notes that were changed in Communicare version 14.3  (on page 159)  or later.

Validation of Patient Identifiers

Validation of patient identifiers is performed every day, automatically, on the server.

• HI Service

• PCEHR

• MEHR

This allows for faster and more reliable access to external electronic health records from a 

patient's Clinical Record and Biographics.

Patient Biographics

More than two family members can now be added to a patient's Biographics. Family 

members can be selected from the database or added manually. The family member records 

can be linked to other patient records to allow formal linking of related patients, or entered 

as free-text for family that are not Communicare patients.

NOTE: Administrators should review any locally made reports that use the kin type details of 

a patient’s Biographics and contact Communicare to arrange an update. These reports may 

report no data or misleading data following the upgrade.

• It is now possible to record that a patient is confirmed as having no phone via a check 

box in Patient Biographics. At some sites the phone number '00' is used when a patient 

does not have a particular type of phone. On upgrade to this version, patients with 

work, mobile and home phone numbers all recorded as '00' will have these values 

cleared; this will only be the case if all three are '00'.

• It is now possible to record the fact that a patient's biographics have been reviewed 

and confirmed as being up-to-date. The new Review &amp; Save button on Patient 

Biographics will record the username of the reviewer and the date of the review. This 
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information will then be visible on the Personal tab the next time the biographics are 

opened and also on the information panel on the Patient Search screen.

• The system rights 'Patient Add' and 'Patient Edit' have been added to allow greater 

control over which users can add patients and edit patient biographics. Upon upgrade 

to this version all users who previously had the right to add patients and edit patient 

biographics will automatically be granted these new rights. See System Rights for 

more details.

Prefer No Contact (Opt-Out)

The preferred contact dropdown in Patient Biographics has been updated to include two new 

options: 'Letter' and 'No Contact'.

‘No Contact’ is intended as a patient opt-out of direct marketing material. The ‘No Contact’ 

option will clear the patient phone number fields when selected after upgrade.

NOTE: It is not intended to prevent contact being made with a patient where a clinician 

is following-up on medical treatment. When a patient requests no contact, the extent to 

which ‘no contact’ will be respected should be discussed with the patient's provider first, and 

according to the organisation's privacy practices.

Service Recording

A phone field has been added to the three Services reports available from the the Service 

Recording window. It will show either the patient’s mobile phone number, home phone 

number, or work phone number in that order. If the patient has no phone number recorded it 

will say ‘No Phone’.

PDF Attachments

Review details may now be added against PDF attachments. In the Clinical Record, when 

you add a PDF attachment you are now able to view the attached PDF document as part 

of the Document Viewing form. When opening the attachment you can now view it in the 

Document Viewing form rather than using external PDF software.
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Incoming Documents

• The option to create a new document based on an incoming document when 

opening the document from within the clinical record has now been removed. 

These documents will now open immediately with no prompt. For other read-only 

documents this functionality will remain.

• PDF Attachments

◦ Review details may now be added against PDF attachments. All attachments 

added before the upgrade to this release will default to reviewed with the 

reviewer being the provider that added the document. Newly attached 

documents will default to unreviewed.

◦ In the Clinical Record, when you add a PDF attachment you are now able to 

view the attached pdf document as part of the Document Viewing form. When 

opening the attachment you can now view it in the Document Viewing form 

rather than using external PDF software.

◦ Documents and Results: The Scanned Documents tab is now called Scanned 

Documents and Attachments, and has a new button to allow adding PDF 

attachments. As in the Clinical Record, when adding or viewing an attachment 

you can now see it as part of the Document Viewing form.

• HL7 PDF Support

◦ HL7 embedded PDF is now supported for documents that are received via 

Secure Messaging. The document (e.g. Discharge Summary) will be available 

in Documents and Results, Received Documents tab and can be viewed 

in Document Editor. This applies only to incoming documents and not to 

investigation results. See Documents for more details.

Adverse Reaction Warning when Prescribing

When prescribing, the warning that the patient has no adverse reaction information 

recorded will now appear before the drug selection rather than after.

Central Data Updates

• Diabetes Cycle of Care

◦ The centrally distributed diabetes cycle of care is no longer linked to MBS item 

2517. This means that any completed item will not automatically select this item 

for claiming. This is in response to providers who routinely select alternative 
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item numbers for this procedure. If a health service has a local variation of this 

item the administrator should consider this change for that item also.

◦ Note that the only centrally distributed items that have this behaviour of 

selecting a suitable Medicare item for claiming are the three Aboriginal health 

checks (child, adult and over 55s) which will, on completion, select item 715 for 

claiming.

• KICA cognitive check

◦ Communicare now distributes a clinical item 'Check up;KICA cognitive check' 

as part of the 'Communicare Value Added' dataset. This is a validated cognitive 

screening tool for older Indigenous Australians living in rural and remote areas. 

See http://www.wacha.org.au/kica.html  for further details.

NT KPI Reports

This version of Communicare introduces version 2.0.4 of the NT Aboriginal Health Key 

Performance Indicators. See NTKPI for more details.

Reporting

• SQL Report Editor and Reports Search windows now have options to Import and 

Export reports. Reports may only be exported in XML format.

• The Query Builder Import and Export Options have been moved from the File | Queries 

submenu to a new Tools | Query Builder | Manage Query Builder Reports option. The 

current Tools | Query Builder option has also been moved into this submenu.

Clinical Item Maintenance

Clinical Items can also be configured to record a date and time, or time only, as opposed to 

date only.

Qualifier Types

The qualifier type 'Dropdown List with text box' has been removed and the functionality 

of the 'Dropdown List' qualifier type has been expanded to include the option to specify 

additional text when certain values are selected. All existing 'Dropdown List with text box' 

qualifiers have been converted to 'Dropdown List' qualifiers. See Dropdown List Qualifiers for 

more information.
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Transport Requirements

In version 13.6  (on page 174), a rule was introduced that limited transport requirement to 

only having either a pickup date or a dropoff date, and not both. This has now been reversed, 

although a message will be displayed to the user when both dates are entered to confirm that 

they have left enough time between the two. Likewise, if the dropoff is on a different day to 

the pickup and message will be displayed to the user to confirm that this was intentional.

A new transport cancellation reason has been added for occasions when then transport 

requirement has been cancelled due to the rescheduling of an appointment. The new 

reason is called 'Appointment rescheduled'. This reason will be automatically used as the 

cancellation reason for transport requirements cancelled after an associated appointment is 

cancelled and the reason chosen for the cancellation of the appointment was 'Rescheduled' 

or 'Queue for rescheduling'.

ACIR Claiming Provider

A new field has been added to the Encounter Place Edit form, called ACIR Provider No. This 

will be used as the default provider number on all ACIR claims. The way that the provider 

number against ACIR claims is calculated has changed. For any ACIR Claim, the provider 

number is selected as follows:

• ACIR Provider number against the encounter place of the service.

• If no ACIR Provider number has been entered against the encounter place, then the 

provider number of the Default ACIR Claimant recorded against the encounter place.

• If there is no Default ACIR Claimant recorded against that encounter place, then the 

provider number of the provider who recorded the immunisation.

• If this provider doesn't have a valid provider number for this encounter place, then the 

provider number of any other claiming provider that was on the same service is used.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• Communicare Licencing

• SMS Messaging

• Intramail

• Attaching PDF Documents
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• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Messaging

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 14.2

Release notes for V14.2.

Personally Controlled Electronic Health Record (PCEHR)

• The PCEHR document list has been redesigned to have a look and feel similar to 

Microsoft Office.

• The Users preferences (how they view the PCEHR document list) may be stored by 

user, or health service. Giving organisations control of how they see PCEHR data.

• Access to PCEHR has been updated, with one central entry-point into all PCEHR 

functions from the Clinical Record; such as: viewing CDA documents, viewing 

Prescriptions, generating Event Summaries and Shared Health Summaries, and 

registering for PCEHR.

• The PCEHR document list has also undergone significant changes to satisfy NEHTA’s 

Clinical Usability Program, Release One (CUP R1). This includes the following areas;

◦ PCEHR document lists support sorting, grouping and filtering and contain more 

data

◦ Clinical documents contain consistent exclusion statements and remember 

previous data inclusion/exclusion settings.

◦ Shared Health Summaries no longer prompt for attestation.

◦ Patient PCEHR validation occurs on the server-side, in the background, nightly 

within 24 hours of last validation; for the User this means you will no longer see 

the wait dialog upon opening a patients Clinical Record, unless the background 

process did not run. This will greatly improve the responsiveness and usability 

of the application. The validation only occurs for patients who do not have a 

PCEHR status recorded within the system.
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Individual Health Identifier (IHI)

The Individual Health Identifier (IHI) validation and search occurs on the server-side, similar 

to PCEHR (above).

MeHR to PCEHR Transition (M2N)

Several changes have been made in order to transition MeHR Users into the National PCEHR 

record. These include:

• Changes to the Service Exit window checkbox for sending documents to PCEHR or 

MeHR (below).

• Changes to a PCEHR Event Summary to include a 'level 3' detail view of Progress Notes 

(below).

• Event Summaries can now be generated before a Service is completed.

• Changes to the way Users can access MeHR.

There are several complex business rules to determine whether MES or CHP documents are 

still sent to MeHR, whether dual send is enabled, whether CDA documents are sent to MeHR, 

or whether MeHR document submission is turned off and only PCEHR document submission 

is supported.

Service Exit Window

When closing a clinical record, the ‘Send Shared Health Summary to PCEHR’ checkbox is 

ticked by default if

• the patient has consented to upload documents to the PCEHR; and

• data has been recorded or changed during the encounter that is relevant to the Shared 

Health Summary.

If the ‘MeHR to PCEHR Transition’ module is turned on then the ‘Send Shared Health 

Summary to PCEHR’ checkbox is ticked by default if:

• the patient has not declined to upload documents to the PCEHR; and

• data has been recorded or changed during the encounter that is relevant to the Shared 

Health Summary.

If the ‘MeHR to PCEHR Transition’ module is turned on and the patient has an MeHR but not 

a PCEHR then the ‘Send to the MeHR’ checkbox will be replaced with two new checkboxes: 
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‘Send Event Summary to MeHR’, and ‘Send Shared Health Summary to MeHR’. These will 

create these PCEHR documents as normal, but instead of there being an option to send them 

to the PCEHR, there will be an option to send them to the MeHR.

PCEHR Event Summary

The PCEHR Event Summary document now includes the progress notes recorded for the 

encounter. Only the equivalent of a level 3 detail view of each progress note will be included 

(i.e. free text and the summary line for each clinical item).

Patient Service Report

The Patient Service Reports: 'Print Current Service Details' from report button in Clinical 

Record form; and 'Details of Selected Service' and 'Details of Selected Contact' from popup 

menu in Progress Notes are now customisable and it can be replaced with a local variation of 

the report. Contact Communicare to make changes to these reports (see Reports).

Fluvax central clinical item

The central item Immunisation;Fluvax has been renamed Immunisation;bioCSL Fluvax 

in response to a request from the Department of Health to do this. The reason is to try to 

stop users using the Fluvax item when delivering an alternative influenza vaccine such 

as Vaxigrip. Users should be aware that using the wrong clinical item when recording an 

influenza immunisation will cause erroneous data to be submitted to ACIR. Users should 

also be aware that giving a child the wrong vaccine may result in adverse effects such as 

febrile convulsions. <color Red>NOTE TO ADMINISTRATORS: You should review any 

local items that refer to Fluvax and consider the request from the Department of Health to 

rename the item as bioCSL Fluvax.</color>

Preferred Contact

In the Patient's Biographics a drop down list is added to allow the User to record a patient's 

preferred contact method.

Medicare Card Issue Number

In the Patient's Biographics, on the Social tab, the Issue number of the family member's on 

same Medicare Card is now visible.
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Investigation Requests

The 'WA Health plain paper radiology' investigation request form has been updated to the 

latest format specified by WACHS (Approved 07/11/2013).

Investigation Results

The comments field available when reviewing investigation results has been expanded. It 

now supports multiple lines and unlimited text.

New Letter Writing Items

When using the ‘Save &amp; Write Letter’ item from a Referral type clinical item there 

are now letter items that can be used to enter ‘Referred to provider’, ‘Referral reason’ and 

‘Appointment date’. These data are only available when a letter is generated from a Referral 

clinical item.

Printer Assignments

(Default) has been changed to (Windows Default) to clarify any confusion sites may be 

having with Printer Assignment defaults.

Discharge Summaries

Communicare can now create NEHTA compliant Discharge Summary documents. These may 

be uploaded to the PCEHR or sent via SMD (if you have these modules enabled). For more 

detail, see Discharge Summaries.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are: o National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Messaging

• Reports outputting to the ANFPP web service, see Edit SQL Reports
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Version 14.1

Release notes for V14.1.

Reviewing Documents

A new field has been added to the 'Details' section of the document form to allow the user 

to specify the program a document is reviewed under. The logic associated with reviewing 

documents has also been modified. See Reviewing Documents for more details.

Central and Local Reports

Central reports are those which are part of the standard Communicare report set, and are 

now denoted by the <image Central Report> icon. These are overwritten with the latest 

version every time Communicare is upgraded. When a central report has been edited on 

site it will be shown as ‘local’, as denoted by the  icon, along with reports that have been 

created on-site. When you edit a central report you must change the report name (unless you 

are a System Administrator) as this ensures that the report will not be overwritten the next 

time Communicare is upgraded.

New Qualifier Type

We have introduced two new qualifier types: 'Date Time' and 'Time'. Creating a qualifier of 

this type presents the user with a date time picker control to enter date and time or time 

only.

New Qualifier Option

A new option 'Highlight Blank' is added to Clinical Item Type - Qualifiers. Use this if you 

wish to draw attention to qualifiers that are important to fill out.

MeHR to PCEHR Transition Module

The MeHR to PCEHR Transition module can be enabled in System Parameters and should be 

used to aid the transition of patients from the MeHR to the PCEHR. For more information 

please see: MeHR to PCEHR Transition.

Qualifier Type Properties

A new category is available in the category tab: ‘Clinical Synopsis’. This is not end user 

maintainable. Qualifiers with this category are included in the ‘Clinical Synopsis’ section of 

an Event Summary (see below.)
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Shared Health Summary

Items in a Shared Health Summary now default to being ticked (included) or unticked 

(excluded) based on whether they were ticked or unticked in the Event Summary for the 

same service. If an Event Summary is not sent for a service, all items in that service default 

to unticked in any Shared Health Summary.

Event Summary

The ‘Clinical Synopsis’ section of an Event Summary now lists any qualifiers recorded within 

the service where the qualifier type has the category of ‘Clinical Synopsis’.

Printer Assignment Paper Source

The Printer Assignment dialog has a new option for selecting Paper Source for each 

category, which allows user to allocate a tray for each category.

Clinical Item Window

On pressing mouse button down on any of the buttons (except Help) on the bottom of the 

form, it will scroll to the bottom so the user gets a visual cue that there are more qualifiers. 

User may then slip off button to view/edit qualifiers in lower part of the form.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are: o National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Messaging

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 14.0

Release notes for V14.0.
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Smoking Status

The central qualifier of Smoking status has been modified to distinguish between smokers 

who quit less than 12 months before being challenged and those who quit more than 12 

months ago. To facilitate this, and to clarify data entry, the options are now this:

• Current smoker – intends to quit later previously 'Smoker - intends to quit later'

• Current smoker - no intention to quit previously 'Smoker - no intention to quit'

• Current smoker – wants to quit now previously 'Smoker - wants to quit now'

• Ex-smoker quit 12 months or more ago &#42;new

• Ex-smoker quit less than 12 months ago &#42;new

• Non-smoker (never smoked) previously 'Non-smoker'

The previous option of Ex-smoker has been disabled, although data recorded using this 

option is still visible and reportable.

Clinical Record

A new button has been added to clinical item form. This button allows you to print the 

details in the form before saving them.

Data Synchronisation

A new system parameter called 'Offline - Enable Discard Data' has been introduced. It 

controls whether offline clients will be able to discard their changes when synchronising. For 

more information, see System Parameters - System.

Investigation Requests

• Investigation requests have been split up into two separate categories - radiology and 

pathology. For more information, see Investigation Requests.

• Investigation types are no longer end-user maintainable and the Investigation types 

reference table has been removed. If you have created any 'local' investigation types 

- that is investigation types that did not exist in the original data, any investigation 

requests of that type will not be available by default. You can make these investigation 

requests available in the Investigations references table, for more information, see 

Investigation Maintenance.
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Investigation Results

When matching incoming results to existing outstanding requests these are now presented 

with the most recent at the top. Also, by default, only outstanding requests from the last six 

months are shown (to see all requests change the filter to 'All').

PCEHR Record

The PCEHR window can now remain open whilst you are working in a patient's clinical 

record.

PCEHR Assisted Registration Identity Verification Code

There is now an option to print this code.

User Group Maintenance

A third locate field has been added to the user group maintenance window. This field can 

be used to locate any user registered with Communicare. For more information, see User 

Groups.

Patient Addresses

It is mandatory to enter a locality against all patient addresses. This previously only applied 

to patient home addresses. Where a locality is not known it should be set to ‘Other / 

Elsewhere’. Please note that addresses previously entered with no locality were not available 

for viewing in the Patient Biographics window. These will be automatically updated to have 

their locality set to ‘Other / Elsewhere’, and will now show in this window.

Qualifier Maintenance

The qualifier currency attribute is now maintainable for all qualifiers including centrally 

maintained qualifiers.

Obstetrics

Items can now be removed from the 'Relevant Medical History' grid by right clicking them 

and selecting 'Remove Item from Obstetric Summary'.
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Address Book

A new field called 'HPD Practice Name' has been added to store the organisation name 

associated with the organisation's HPI-O in the Healthcare Provider Directory (HPD). 

Address book entries that have a differing name recorded in Communicare to the name 

registered in the HPD can make use of this. For example, a service under the auspice of 

another.

Scanned Documents

There is a new label that has been added to the scanned document editor. This label 

indicates that user account that was used to scan the document and the date that it was 

scanned on.

Appointment Book Report

The ‘Phone’ field will now show either the patient’s Mobile Phone No, Home Phone No, or 

Work Phone No in that order. If the patient has no phone number recorded it will say ‘No 

Phone’.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are: o National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Messaging

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 13

Release notes for version 13 releases.

Version 13.6

Release notes for V13.6.
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Sending documents securely

Saved documents that are over 8 hours old can now be sent securely. Previously, after 8 

hours the document, sender, recipient and patient details would become read-only and 

the document could not be sent. Now the document details will become read-only after 8 

hours, but the sender, recipient and patient details will only become read-only after the 

document has been sent. A document may still only be sent once and only to one recipient. 

The document details will also become read-only as soon as a document is sent, even if it is 

less than 8 hours old.

Scanned Documents

Scanned documents can now be rotated to aid on-screen viewing. The Rotate Image 90° 

button can be used to change view of the document from landscape to portrait and vice 

versa. Note that orientation changes are to assist viewing only and are not saved or reflected 

in prints of scanned documents. For more information see Scanning Documents.

Service Details Report

This report now also shows the Provider Speciality, listed beneath the Provider Name under 

the signature line.

Progress Notes

In the Historical Progress Note within the Clinical Record, the Service Header buttons will 

now indicate if the service was after-hours.

Transport Management

Transport requirements are no longer allowed to have a pickup date and a dropoff date. Only 

one date/time may be specified.

Backups

Communicare now supports backing up to double layer DVD+/-R discs (DVD+/-R/DL). For 

more information, see Backup Regimes.

Service Exit Window

The ‘Send Shared Health Summary to PCEHR’ and ‘Send Event Summary to PCEHR’ 

tickboxes will default to unticked if the patient has not yet indicated whether they consent 
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to send documents to the PCEHR. Previously they only defaulted to unticked if the patient 

had specifically not consented to send documents to the PCEHR.

Image Qualifiers

Image type qualifiers can now be printed by right clicking on the image and selecting "Print 

Image". Images will be sent to the Communicare Default printer.

Printer Assignments

A new printer assignment has been added for use with charts. For more information see 

Printer Assignments.

Prescribing

When closing the clinical record, if there are any unprinted prescriptions on the patient, a 

message will appear confirming whether you would like these prescriptions to be printed. 

This message now appears before the Medicare claim window.

Patient Merge

Patient merge has been improved to clean-up duplicate and similar names. Refer to Patient 

Merge for full details.

Patient Biographics

'Legal Guardian' has been added as a new Relationship option when recording additional kin 

or emergency contact information in a patient's biographic record.

MBS Item Search

The MBS item search window has been updated with a new pop-out window to display the 

full description for MBS items with long descriptions.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)
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• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Messaging

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 13.5

Release notes for V13.5.

System Rights

Report Administration has been added to System Rights to allow members of a user group 

to import, export, edit and delete reports. <color Red>This right is OFF by default so you will 

need to assign this to a user group so that members of that user group will be able to import, 

export, edit and delete reports.</color>

Customisable Printable Forms

The Printable Forms that are displayed under the Help menu are customisable. Forms 

may be overridden with new versions, and new forms may be added to the list. Please see 

Printable Forms for more information.

Web Service Configuration

The web service addresses have been moved from Organisation Maintenance to System 

Parameters.

Recalls

"Patient could not be found" has been added as a reason to cancel a recall.

Rural Prescriptions

A patient's Centrelink concession number has been added to Rural Prescriptions.

Qualifier Summary

A new feature has been added to the Qualifier Summary in the Clinical Record. This feature 

allows you to define a period of time that is linked to a qualifier. If an entry in the Qualifier 

Summary is older than the defined period of time, then it's date will appear highlighted in 

red. For more information see Qualifier Properties.
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MIMS Pharmaceutical Database drugs browser

Streamlined Authority drugs are now treated as a separate category. These were previously 

displayed in <color Red>red</color> and belonged to the Authority category. Streamlined 

Authority drugs are now displayed in maroon.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Message Delivery (SMD)

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 13.4

Release notes for V13.4.

MeHR and PCEHR

The MeHR and PCEHR modules can be turned on simultaneously. If they are, in the Clinical 

Record the toolbar buttons relevant to both modules will be available, and on closing the 

Clinical Record there will be checkboxes for sending both MeHR and PCEHR documents. On 

the MeHR Medical Event Summary and Current Health Profile documents a Dual Send Flag 

will be included with the PCEHR Document ID of the corresponding PCEHR document for 

that encounter, if one exists.

MeHR Note

MeHR’s security model does not support Communicare’s Viewing Rights. Granting access 

to MeHR to users with limited Viewing Rights may result in those users seeing restricted 

information in the MeHR. Furthermore, CHP’s generated by users with limited Viewing 

Rights may result in restricted information being inadvertently posted to the MeHR. 

Communicare recommends that users who access the MeHR should have full Viewing Rights.
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Service Record - Medicare Tab

A button to view/edit admin notes for claims has been added in the Service Record - 

Medicare Tab. This is accessible by clicking the button with the green notepad icon available 

on this tab.

History of MBS Items for a Patient

Provider name has been added to MBS Items Claims History, right of the Payment Status 

column; Payment Status and Provider columns can be sorted.

Removed date constraints on recording patient's clinical items

There are no longer any date constraints on recording a patient's clinical information with 

clinical items. You can now record clinical items outside a patient's lifetime period.

PCEHR Assisted Registration

A PCEHR Assisted Registration window has been added, to enable streamlined registration 

of patients for the PCEHR. To use this function the following is required:

• Communicare to be set up for PCEHR Access

• Pdf reader software, for example 'Adobe Reader', to be installed on each client PC

For more information, see PCEHR Assisted Registration.

Secure Addresses

Changes made to how Communicare interacts with the Human Services Directory (HSD) 

through Argus have allowed us to identify more addresses that can be sent to securely. The 

Address Book Search form allows searching of the HSD and the addition of HSD addresses to 

the Communicare address book. Once these addresses have been added the Secure Message 

Delivery icon will be displayed alongside them if they have been identified as secure. See the 

help topics for Address Book Search and Secure Message Delivery for more details.

Discharge Summaries

Changes have been made to allow a user to create either a Clinical Document Architecture 

(CDA) compliant Discharge Summary, or a Rich Text Format (RTF) format Discharge 

Summary. See Discharge Summaries.
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.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Message Delivery (SMD)

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 13.3

Release notes for V13.3.

Human Services Directory Search

This has been enhanced to display an address's HPI-O and HPI-I on the address selection 

screen.

Appointments

The appointment book will now display the session's current program in the appointment 

details at the bottom, when an appoinment is selected in the list.

You can now view a patient’s biographics directly from the appointment book. For more 

information, see Appointment Book.

Letter Writer

A new letter item has been added the letter writer. This item is called ‘Clinical Items 

Summary (Detail)’. It works in the same way as the existing item ‘Clinical Items Summary’ 

and will display the clinical items' comments in full, not abbreviated.

Qualifier Maintenance

Support for custom calculated qualifiers has been extended to allow for more complex 

calculations. See Clinical Item Maintenance.
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Clinical Item Maintenance

The clinical item maintenance form has been increased in size to allow more space for values 

to be entered. There is now also more space on the right side of clinical item maintenance to 

allow more space for a qualifier's previous value.

Obstetrics pregnancy details

BMI has been restored to the antenatal check and displays in the details of the selected 

pregnancy.

Obstetrics Summary by Default

A new feature has been added to clinical item maintenance which allows you to control the 

default value of the Obstetrics tickbox the same way you can with the Main Summary tick 

box. See Clinical Item Type Reference Table.

Electronic Transfer of Prescriptions (ETP)

This has been optimised to speed up prescription generation.

NT Key Performance Indicators

These reports have now been updated to version 2.0.2. You should review the comments 

in the new indicator reports (1-13, 1-14 and 1-15). Pay particular attention to the RHD 

requirements in 1-15.

MeHR Antenatal Reports

A new tickbox 'Send Antenatal Reports', has been added to the 'Confirmed Pregnancy' and 

'Antenatal Check-up' clinical items. This is used to control the pregnancy details that will 

be sent to the MeHR. If ticked then all information that has been or will be recorded for 

that pregnancy will be sent to the MeHR. If unticked then no more information will be sent 

to the MeHR for that pregnancy, and all information that has already been sent for the 

pregnancy will be erased from the MeHR. For all services that contain information about this 

pregnancy, the value in this checkbox will determine if information is sent to the MeHR at 

the end of the service. For more information, see MeHR Antenatal Reports. The Antenatal 

Report has also been expanded to include a larger range of patient qualifiers.
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Alerts and Other Information Control

A new system right has been added to Communicare to restrict users from being able to 

access 'Alerts and Other Information' in the Clinical Record and Letter Writer. If this system 

right is turned off in System Parameters, all users will be able to access this information. For 

more information, see Alert Information.

Australian Childhood Immunisation Register (ACIR)

Immunisations recorded in Communicare are transferred to ACIR independently of Medicare 

claiming. A new field has been added to the Encounter Place Maintenance window: 'Default 

ACIR Provider'. This defines the provider that will be used on ACIR claims for that encounter 

place where no other relevant provider number can be found. For more information, see 

ACIR.

Reports

CTRL-ALT-R will now open the Reports Search window. For more keyboard shortcuts see 

Shortcut Keys.

Printable Forms

Printable Forms that were previously accessible from within the online Help have been 

moved to the Help menu on the main toolbar. See Printable Forms for more information.

Transport Management

The 'Transport Requirements List' report, which is run via the 'Print Transport List' button 

on the 'Transport Requirements List' form has been modified to show only active transport 

bookings for a given day. The full list of transport bookings for a particular day can still be 

obtained by running the 'Daily Transport Requirements' report from the reports menu.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)
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• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Message Delivery (SMD)

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 13.2

Release notes for V13.2.

CAT Exporter

This has been enhanced to export OSR (Online Services Report) data. This means OSR can 

now be submitted to OCHREStreams using the Clinical Audit Tool if required by your service. 

OSR can still be run from Communicare as usual.

Organisation Parameters

A new field called 'HPD Practice Name' has been added to store the organisation name 

associated with the organisation's HPI-O in the Healthcare Provider Directory (HPD). 

Services who have a differing name recorded in Communicare to the name registered in the 

HPD can make use of this. For example, a service auspiced by another.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Message Delivery (SMD)

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 13.1

Release notes for V13.1.
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Data Synchronisation Client

The data synchronisation client has been updated to make it easier to synchronise 

Communicare. If for some reason you need to cancel part the way through synchronising 

Communicare, when you next attempt to synchronise, the data synchronisation client 

will continue from where it was last stopped. This new behavior applies also if the data 

synchronisation fails - upon retrying, it will continue from where it failed.

The data synchronisation window now also has an updated look and feel.

National Prescription and Dispense Repository (NPDR)

The NPDR is a medications repository that will enable participating healthcare providers 

to access prescribed and dispensed medications information for participating consumers. 

Access to this information will allow medication prescribers and dispensers to make 

more informed decisions regarding the medications for their patients, which in turn will 

improve medication safety and quality in the community. The NPDR is accessed through the 

Personally Controlled Electronic Health Record (PCEHR).

Based on patient consent, the provider can upload patient medication data to the patient's 

PCEHR via ETP. When a patient withholds consent it prevents the provider from sending 

medication data to PCEHR.

The provider can then view patient medication data on PCEHR through Communicare.

On-line Services Reports (OSR)

On-line Services Reports (OSR) have been updated for the 25th of February 2013 (Version 

1.1) Data Collection Instrument.

System administrators should check that any local clinical items they have defined for the 

following procedures have system and export codes set as follows:

• Export code for any Health Promotion group activity procedures must be set to HP-

GRP.

• Export code for any Maternal and Child Health group activity procedures must be set 

to MCH-GRP.

• System code for any alternative 721 CDMP Plan clinical items must be set to CPA.

• System code for any alternative 715 Health Checks clinical items must be set to CHC 

(Child Health Check), AHC (Adult Health Check) or OHC (Older person Health Check).
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Complete details of codes used by each of the OSR reports can be found in the description 

displayed when the report is run.

All of the reports now accept 2 new parameters.

• The ‘locality group’ parameter allows a report to be run for patients living in the 

selected locality group and may be useful for large multi-clinic health services.

• The ‘year-end’ parameter allows a report to be run for any 12 month period, allowing 

comparisons to be made between years. The ‘year-end’ parameter will also avoid the 

need for new reports to be released each year, unless specifications are changed.

All of the reports have been re-written to ensure they will be 100% consistent with OSR 

data from future versions of CAT. The next version of the Communicare CAT Export will use 

the same procedures and codes to export data that CAT will use to create OSR reports and 

upload them to OCHREStreams. Note that these changes have resulted is some loss of speed, 

but the additional consistency should be worth make it worthwhile.

Please also note that all of the earlier OSR Reports have been made ‘Not Public’ so will not 

appear on user’s report menus. If required, the Communicare system administrator may use 

‘Tools | SQL Report Editor’ to set the ‘Public’ tick-box to make the old reports visible again.

Patient Obstetrics

A button has been added to the Obstetrics section of the Clinical Record. This button is 

located in the current pregnancy section and allows users to easily edit the most recently 

added 'Pregnancy;confirmed' clinical item that was added to the patient.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• National Prescription and Dispense Repository (NPDR)

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)
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• Secure Message Delivery (SMD)

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 13.0

Release notes for V13.0.

eReferrals

Communicare can now create NEHTA compliant eReferral documents. These may be 

uploaded to the PCEHR or sent via SMD (if you have these modules enabled). For more 

detail, see Generating eReferrals.

Event Summaries

Communicare can now create NEHTA compliant Event Summaries and upload these to the 

PCHER. The PCHER module needs to be enabled.

Service Exit Dialog

When PCEHR is enabled for a patient, there will be two new check box options on the Service 

Exit Dialog to allow you to send a Shared Health Summary and Event Summary document for 

the service to the PCEHR. See PCEHR Summary Documents.

Investigation Requests

The ‘request on behalf of’ feature in the investigations module has been enhanced to 

allow providers with their own numbers to be able to request on behalf of another. For 

example, an Aboriginal Health Worker with a provider number of their own may still request 

investigations on behalf of a doctor. See Investigation Requests for more information.

NOTE FOR ADMINISTRATORS:

Providers who are eligible to make claims will need to be identified as such in their provider 

table entry (File | Reference Tables | Provider). After upgrade, providers with a valid provider 

number and are of speciality type 'General Medical Practitioner' will have this box ticked, 

any others will have to be updated in the provider reference table. See Provider Reference 

Table for more information.

186 Integrated Team Care



HbA1c

Central clinical items with the qualifier 'HbA1c (%)' now also have the qualifier 'HbA1c' with 

the units 'mmol/mol'. This new qualifier (introduced in version 11.4 to process incoming 

pathology results of this type) exists alongside the 'old' qualifier so that clinicians have the 

opportunity to enter whichever value they have. Care should be taken to make sure that the 

appropriate qualifier is used. Administrators are advised that any local clinical items that 

have the ‘HbA1c (%)’ qualifier should also have the ‘HbA1c’ qualifier (recording mmol/mol) 

attached as well. In addition, any chart types (see File | Reference Tables | Chart Types…) 

should be reviewed accordingly.

Service Recording Automatic Refresh

Service Recording window is now refreshing automatically even when the window is in the 

background. However when the window is not at the top level it will be refreshed at a longer 

interval of two minutes as opposed to one minute, due to performance reasons. Automatic 

refresh will only occur if the Service Recording window has been idle for at least 10 seconds.

Record Locking on Summary Qualifiers

A situation that caused a lock conflict when two users added the same type of summary 

qualifiers to the same patient at the same time has been resolved. For example, a BP added 

as part of an Antenatal Check by one user at the same time as another user added a BP as 

part of different check for the same patient at the same time, would have caused a lock error 

in previous versions of Communicare.

Convert Other/Elsewhere Localities to Selected Localities

The Terms Converter now has a function to assist with cleaning up locality names imported 

from other systems such as MD and Ferret.

Healthcare Identifier Service Integration

• Communicare can now search for and validate Healthcare Provider Identifier - 

Individual (HPI-I) and Healthcare Provider Identifier - Organisation (HPI-O). See 

Healthcare Identifier Service for more information.

• Communicare now validates healthcare identifers (HPI-I, HPI-O and IHI) before 

creating, sending, receiving and uploading CDA documents to the PCEHR.

• For a provider to use their HPI-I they must now be using the logon name assigned to 

them. See Provider Maintenance.
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Update Postcode field of Localities

Communicare no longer allows non-numeric characters to be entered into the postcode field 

of localities. All existing postcodes that have a alphabetical character will be updated to 

'0000'. For example: 'o872' will become '0000', but '0872' is left alone.

Certificates Reference Table

A new reference table for certificates can be found under File - Reference Tables - 

Certificates. In the future, all certificates used within Communicare can be maintained in 

this table. Communicare certificates are used as means of authenticating the organisation's 

identity when using external health services. Some modules, such as PCEHR (Personally 

Controlled Electronic Health Record) or HI (Health Identifier) services, require a certificate 

without which the service will be unavailable. As part of current release, this reference table 

only supports Nash Org Certificate for the use of accessing the PCEHR (Personally Controlled 

Electronic Health Record). See Certificates Maintenance for more detail.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Message Delivery (SMD)

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 12

Release notes for version 12 releases.

Version 12.5

Release notes for V12.5.
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Transport Management

A new button has been added to the bottom panel of the Transport Requirement Manager, 

'Save &amp; Schedule Return'. This button will save the current journey and display a 

new journey with the addresses reversed, i.e a return journey. The dates and times for this 

journey need to be entered and then the return journey may be saved as usual.

A new button has been added to the bottom panel of the Transport Requirements List, 'Print 

Transport List'. This button will prompt you for a date and run a report similar to the 'Daily 

Transport Requirements' report, displaying all the outstanding journeys for the date entered.

Letter Writer

A new section has been added to the list of auto complete options on the right side of the 

letter writer, called 'MeHR'. This contains one item, 'MeHR ID', which will automatically 

insert into the document the patient's MeHR ID, as recorded in the patient biographics 

window.

Patient Biographics

Patient Biographics will no longer allow you to save a patient's details if the specified MeHR 

ID is being used by another patient. When you try to save an MeHR ID that is already in use 

an error will appear listing the patients who have already have this MeHR ID, and the MeHR 

ID field will automatically be blanked out.

A patient's gender can now be set to blank in the patient sex dropdown box.

Clinical Record

The 'Kanga' eRegistration button in the clinical record has been updated with new pop up 

hints that now reflect the MeHR registered status of the selected patient. This status can be 

one of the following: Registered, Not Registered and Declined.

In the detail tab of the clinical record, a new tickbox has been added next to the search field. 

Ticking this will make the search start automatically as you type rather than waiting for you 

to type the return key or click the search button. This tickbox will default to on, but it will 

also save the setting you last used.
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Searching for a Patient

The MeHR Reg Status field in the information panel at the bottom of the Patient Search 

form will now display 'Declined' for patients who have declined having an MeHR record. 

Previously these patients were shown as 'Not Registered'.

Social History

The qualifier for collecting social history that updates the Social and Family History tab has 

been added to the following central clinical items:

• Check up;Aboriginal &amp; TSI adult

• Check up;Aboriginal &amp; TSI over 55s

• Check up;Aged Care Resident

• Check up;over 75s

New Speciality Types

'Renal Medicine Specialist' and 'Otorhinolaryngologist' have been added as new speciality 

types.

Personally Controlled Electronic Health Record

A Personally Controlled Electronic Health Record (PCEHR) is a secure, electronic record 

of a patient's medical history, stored and shared in a network of connected systems. 

Communicare now interfaces with the PCEHR. See PCEHR.

Communicare has attained full PCEHR compliance from the National E-Health Transition 

Authority (NEHTA).

Please Note: In order to use the PCEHR functionality a PCEHR certificate must be 

obtained (See PCEHR) and the HPI-O in that certificate must be used as the HPI-O for the 

Organisation and Encounter Place.

MeHR Current Health Profile (CHP) and Medical Events Summary (MES)

Previously, if a client has given ongoing written consent for their information to be sent to 

MeHR, a popup dialog box will be shown at the end of the encounter asking if details of the 

encounter should be sent to MeHR. The details are sent in the form of a CHP and a MES.
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In this version a new system parameter has been added to control whether this popup dialog 

is shown. This system parameter can be changed by ticking or unticking a check box on the 

MeHR tab of the system parameters screen. If it is ticked, the popup dialog prompt is shown 

at the end of every encounter. This is the default setting. If it is unticked there will be no 

popup dialog, however it will still be possible to choose whether to send or not to send via 

a new check box that has been added to the Service Exit dialog box. Please read the release 

note on this change in the 'Closing a Clinical Record' section for more details.

If the user has changed to a previous service from a current service, the popup will always 

be displayed when they close this previous service, irrespective of the value of the system 

parameter. This is because in these cases no Service Exit dialog box is shown, so the choice 

to send or not send to MeHR must be explicitly made through the popup.

The CHP format has also been updated and will now always send Adverse Reactions (Drug 

&amp; Non-Drug), Alerts and Risk Factors. You will no longer be able to check or uncheck 

these sections of the CHP before sending as a result.

Closing a Clinical Record

A new 'Send to MeHR' check box has been added to the Service Exit dialog box that is shown 

at the end of an encounter. If this check box is ticked a Current Health Profile (CHP) and 

a Medical Events Summary (MES) will be sent to MeHR if the user chooses to complete or 

pause the service. The check box value will be ignored if the user chooses 'No service has 

been provided' or cancels out of the exit dialog and returns to the clinical record. If the 

system parameter is set to display the popup dialog asking whether a clients encounter 

details should be sent to MeHR, then this popup will control the value of the check box. i.e. 

if the user chooses 'Yes' on the popup dialog the check box will be ticked, and vice versa. 

The checkbox will always be editable so the user will still be able to change their mind after 

they have answered the popup dialog. If the system parameter is set to not display the popup 

dialog, the 'Send to MeHR' checkbox will be shown ticked by default. The user can then 

untick this as the wish.

CAT Export Reference Date

An extra optional setting 'Reference Date' has been added to the CAT Export tool. Set 

the date to export data 'as of' a specified past date. This field defaults to today's date. 

This version of the CAT Export can be deployed separately from the main Communicare 

application as long as Communicare is already version 12.0 or above.
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MIMS Pharmaceutical Database

It is now possible to copy and paste from the Product Information and Consumer Medicines 

Information windows. A right button mouse click will show a popup menu which will give 

the option to 'Copy' any selected text to the clipboard. The keyboard shortcut 'Ctrl + C' will 

also copy any selected text. The popup menu also has the option to 'Select All' which will 

select all the text in the window. The keyboard shortcut for this is 'Ctrl + A'.

Electronic Transfer of Prescriptions (ETP)

Communicare can now integrate with the eRx software to send prescriptions electronically 

to a dispenser. With eRx set-up and installed, when a standard prescription is printed from 

Communicare a barcode will be included on the print-out. When the patient presents the 

script at a participating pharmacy, the pharmacist will scan the barcode and the prescription 

information will be downloaded to their dispensing system from the internet. This will allow 

electronic verification of the printed details on the prescription.
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Please note that ETP is required for Practice Incentives Program (PIP) eHealth Incentive (see 

http://www.nehta.gov.au/pip).

For more information on registering for ETP please refer to the ETP help page.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are:

• Personally Controlled Electronic Health Record (PCEHR)

• Clinical Document Architecture (CDA)

• Electronic Transfer of Prescription (ETP)

• Healthcare Identifier Service (HI)

• Human Services Directory (HSD)

• Secure Message Delivery (SMD)

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 12.4

Release notes for V12.4.

Clinical Record

• The View buttons on the Details Tab have been modified to a 'radio button' format 

with text.

• The class view of the Details tab, has changed. The tabs now appear at the top instead 

of at the bottom of the form.

Copying a Document

If you open a document from the details tab in the clinical record you will be prompted with 

several choices on how to proceed. For read only documents, you are given two options: 

you can view the document as it is without being able to change the data in it or you can 

create a new document with the same data that is not read only. The old document will not 

be overwritten or lost if you choose to create a new document.
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For editable documents you are given two options: you can view or modify the existing 

document as it is or you can create a new document with the same data that is not read only. 

The old document will not be overwritten or lost if you choose to do this.

eRegistration

• Enhancements to the behavior of the MeHR automatic eRegistration prompts have 

been made. The MeHR eRegistration admin right has been renamed to 'MeHR 

eRegistration Auto-Prompt', and affects specifically whether a user is auto-prompted 

for MeHR eRegistration for an unregistered patient when they add the patient, go into 

their clinical record, or add a service for the patient.

• The 'MeHR Profile' button in the Clinical Record window is now clickable when 

displaying as a 'Red Kanga'. This will open the MeHR eRegistration window. This 

function will be available to all users, as long as the main 'MeHR' system module is 

switched on. This also now applies to the eRegistration button in Patient Biographics, 

and the ability to view a patient's MeHR Status in the Patient Search window.

Match and Review Result

• The Review Result section in the Match and Review Result window now has an extra 

field 'Status', which records the status of the pathology result, for example 'interim' or 

'final'. Communicare will try to determine this from the information in the pathology 

file, but it can also be updated manually. This information is used when creating a 

Discharge Summary CDA document.

CDA Documents

CDA is 'Clinical Document Architecture', the new standard format for e-Health Messages in 

Australia. Communicare can now send and receive documents in this format. Since version 

11.4 Communicare has had the facility to import and display Discharge Summaries and 
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Specialist Help Letters and display these in read-only format in the document window. 

Communicare can now receive and show CDA documents of any type.

Communicare can also create and send the following CDA Document types:

• Discharge Summaries

• Shared Health Summaries

If you wish to create and send either of these types of documents, please contact the 

Communicare Helpdesk for assistance in configuring your system to do this.

Information System For Oral Health Interface

Communicare can now export patient's details to the ISOH tool. Please contact 

Communicare to active this functionality.

Distribution Server

A Distribution Server is a specialised kind of Communicare Server that enables offline 

replication clients to sync quickly when there is only a relatively slow network between them 

and the main Communicare Server. In a nutshell; the Distribution Server does the slow part 

of synchronising, unpacking and restoring for you so your synchronisation is quick and easy.

Coordinated Care Trial

All data relating specifically and only to these two trials is removed from the database in this 

upgrade. Health services that were at one time participants in CCT1 or CCT2 should make 

sure that a backup taken prior to this upgrade is kept and archived as a copy of the CCT data. 

<color Red>Coordinated Care Trial data will no longer be viewable on the system.</color>

The following windows and functions will no longer be available:

• File | CCDM Export

• File | CCT Cost Export

• File | Reference Tables | Generic Protocols

• Patient | Coordinated Care Trial Data

• Reports | Coordinated Care Trial Reports
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New Speciality Type

'Aboriginal and TSI Health Practitioner' has been added as a new speciality type. This does 

not replace 'Aboriginal and TSI Health Worker'.

Service Recording

Some of the Service Recording icons have been updated. The 'service started' icon is now 

a green play icon, the 'service paused' icon is now an amber coloured pause icon and the 

'service waiting' icon is now a red alarm clock icon.

Version 12.3

Release notes for V12.3.

New Look and Feel of Communicare

Some of the more commonly used parts of Communicare have been redesigned, all of the old 

icons have been replaced and the entire Communicare application now supports Windows 

themes. Below is a screenshot of the new Clinical Record, Appointments Book and Service 

Recording:

Searching for Patients

The patient searching functionality has been enhanced to support exact text searches. An 

exact text search will allow you to search for a patient's exact first and last names.
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To do an exact text search you must put a comma in between the forename(s) and surname. 

An exact text search will ignore any delimiters and search for exactly what is before and after 

the comma.

For more information see the help topic about Patient Searching.

Templates Form

The Locate text box on all Templates forms has been replaced by a 'Search Text' box that 

searches all of the templates names.

Searching begins automatically as soon as typing is finished just like the Select Patient 

Search.

Providers Table Form

The Provider Table has a new checkbox labelled 'Hide Disabled'. Ticking this checkbox will 

hide all disabled providers.

Print Previous Measurements

The Previous Measurements form now has a print button next to the chart button that 

previews a report of the currently displayed values.
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Healthy Under 5 Kids Dataset

Health services in the Northern Territory that wish to use the HU5K dataset should inform 

COMMUNICARE when organising an upgrade to this version of Communicare if they wish 

to have the HU5K child check items imported. The Healthy Under 5 Kids 2009 Program is 

a Northern Territory Government, Department of Health (DoH) initiative. This program 

incorporates a series of age specific child health checks which include growth assessment 

and the childhood vaccination schedule. AMSANT and DoH have jointly worked to make this 

program available through the Communicare system. For information relating to data and 

electronic health record system functionality, contact AMSANT. For queries relating to the 

Healthy Under 5 Kids program please contact NT DoH, Child &amp; Youth Health Strategy 

Unit.

NT KPI Reports

This version includes a new report for KPI 1.20 that assesses the immunisation status of 

children aged between 1 and 12 months. This data is not part of the data extract.
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Letter Writer

The previously imposed restriction on editing documents more than 8 hours old has been 

lifted. All saved documents may now be edited or sent at any time.

Version 12.2

Release notes for V12.2.

Patient Searching

The Forename and Surname textboxes have been removed from the patient search dialog. 

These fields have been replaced with a single 'Patient Name' textbox. In this new field you 

may type the patient's forenames, surnames or part of each. It also supports the following 

as common delimiters: Spaces ' ', Parentheses '()', Full Stops '.', Colons ':', Semi-Colons ';', 

Commas ',', and Exclamation Marks '!'. This means that you can search for forenames and 

surnames at once, delimiting your text in between.

For more details on this update, see Patient Search.

EPC reports now CDM

Two reports in Communicare have been renamed in line with health department 

recommendations:

'The Department of Health and Ageing is removing references to EPC in the (Medicare 

Benefits Schedule (MBS) Group A15 (GP management plans, team care arrangements, 

multidisciplinary care plans and case conferences) items (721-779) and in the Miscellaneous 

Group 3 (allied health individual) items (10950-10970).
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The change has been made because the GP Enhanced Primary Care (EPC) care planning 

items were removed from the MBS in 2005 and replaced by the Chronic Disease Management 

(CDM) items (721-731). The term 'EPC plan' is now obsolete.'

The reports are:

• Electronic Claims | EPC Summary for Selected Patient --> Electronic Claims | CDM 

Summary for Selected Patient

• Electronic Claims | EPC Summary Patients with current 723 --> Electronic Claims | 

CDM Summary Patients with current 723

To Do List

When referrals are ongoing (and thus display in the To Do List) the description includes 

the organisation/person referred to/from. This will allow easier monitoring of referrals 

where more generic referral types are used. For example, what used to display as '<Referred> 

referral' now displays as '<Referred> referral - to Dr Smith at City Hospital'.

Service Record - Medicare Tab

The following enhancements have been made:

• A new column with the heading 'Referred' has been added to the far right of the grid. 

This indicates whether an item has 'Specialist Services' selected. If it has been selected 

and details are complete, a green dot will be displayed. If it has been selected, but 

some details are missing, a yellow dot is displayed. No image is displayed if 'Specialist 

Services' is not ticked.

• Four new text boxes have been added to display the CentreLink and DVA card details 

for the patient. The card number and the expiry date are shown.

• The CentreLink details were previously displayed on this screen as a label. The DVA 

details were not previously displayed on this screen.

Prescribing - Medication Details

Two new text boxes have been added to display the DVA card details for the patient. The card 

number and the expiry date are shown.
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Referral/Admission Display Descriptions

Display description for 'Referral' and 'Admission' clinical items now incorporates additional 

information. The name of the organisation, direction (to/from), and the name of the person 

for the referral/admission will be included in the display description if they exist.

Bulk Bills Status Form

The following changes have been made to the Bulk Bills Status Form:

• A button to print Bulk Bill Assignment Advice has been added.

• A new 'Claims Admin Note' column has also been added to the grid, displaying the 

admin notes regarding the claims. Users are able to edit notes by clicking on the green 

notepad icon available above the grid, or in the popup menu accessible right-clicking 

or double-clicking the record.
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Data Synchronisation - Offline Client

Offline clients can now only claim for a service that has been created offline. If a service has 

been created online, then an offline client can view it but not claim for it.

.Net Requirements

Some Communicare modules require Microsoft .Net Framework 4.0 or greater to be 

installed. These modules are

• HI Service

• Human Services Directory

• Secure Message Delivery (SMD)

• Reports outputting to the ANFPP web service, see Edit SQL Reports

Version 12.1

Release notes for V12.1.
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Patient Alert Popup

• Patients can now have Popup Alert Notes associated with them. Any text recorded as 

a Popup Alert Note will be displayed as a pop-up in Appointments, Service Recording 

and the Clinical Record (See Patient Alert Popup).

Documents and Results

• The 'Investigation Results' tab now has an 'Encounter Place' dropdown which allows 

filtering the results by the Encounter Place they are expected to be relevant to (See 

Documents and Results for further detail).

• The documents tabs have been optimised to load and filter faster when there are a 

large number of documents.

Provider Maintenance

• When recording provider numbers there is now an extra field to specify the 'Effective 

Date'.

• This field is used to prevent encounters at the relevant encounter place showing as 

claimable in the Bulk Bills Status window, on reports, and in various other areas of 

Communicare, if they occurred prior to this date.

• It may be back-dated to when the provider first started performing claimable services.

• Existing records will show the 'Effective Date' as the date the provider number was first 

recorded.

Qualifier Maintenance

• In the Qualifier Maintenance window, the capability to clone a qualifier has been 

added. This is available through the 'Clone' option on the right-click menu. All 

qualifier data excluding charts, clinical items and recalls will be copied.

My eHealth Record

• Shared Electronic Health Record (SEHR) will now be referred to as My Electronic 

Health Record (MeHR).
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Bulk Bill Claims List - Medicare Details

• In the Bulk Bills Status window, if a patient's Medicare Card details are incomplete an 

icon will now be displayed in the second column to show this. This works the same as 

in the Patient Search and Service Recording forms.

Clinical Items

• The viewing right of the clinical item type is now displayed for reference in the bottom 

left hand corner of the Clinical Item Maintenance form.

Login Dialog

• The Login Dialog now has an additional dropdown option for the organisation the user 

will be logging into. This replaces the old Organisation Selection dialog that used to 

pop up for users with multi-organisation access.

• As most users only have access to one organisation they will not need to touch this 

setting.

CAT Exporter / NKPI Reports

• These data extracts now include deceased patients, as services performed for them in 

the reporting period affect certain statistics.

Version 12.0

Release notes for V12.0.

Provider Specialities

Specialities have been re-worked to better match the ANZSCO standard.

• There are new speciality types such as ‘Nurse Practitioner’ and ‘Youth Worker’.

• Some speciality types have changed description (e.g. ‘Nurse – registered’ has become 

‘Registered Nurse’ and ‘Dietician’ has become ‘Dietitian’).

• Some speciality types have been disabled for future use (such as 'Team. 

Psychogeriatric Assess Team (PGAT)').
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Administration Rights

• Users in the System Administrators group can add, delete and change other users' 

details.

• The Administrator user cannot be removed or modified, however their password can 

be changed.

• Users will now be prompted to change their password on the first login after a member 

of the Systems Administrators group sets or resets the user's password.

• You can no longer have a username of Admin as this has special meaning in the 

database. <color Red>Any existing users with a username of Admin will be removed.</

color>

• Usernames in the System Administrators group can only contain alpha-numeric 

characters.

• Usernames in other groups can not contain any of the following characters \\, /, :, 

&#42;, ?, ", \<, \>, |, '

• <color Red>Any existing users in the Systems Administrators group will be able to add, 

delete and change other users' details. This includes passwords, system rights, viewing 

rights, program rights and user groups.</color>

• <color Red>Any existing users in the Systems Administrators group that contain non 

alpha-numeric characters will remain, however these will not gain the rights of the 

System Administrators group. It is recommended that these users be Deleted and 

Recreated using alpha-numeric characters.</color>

Converted Documents Behaviour

• MD Converted documents used to have an embedded 'Dummy' document which 

contained a link (to the file system) to the converted document. This 'Dummy' 

document has been removed and replaced by native functionality. Opening a 

converted document will now just open it. No link is displayed.

SEHR (Northern Territory)

Some amendments have been made to SEHR Medical Event Summary and Current Health 

Profile generation.
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• Observations - Blood Pressure and Pulse Measurements - Systolic and diastolic 

measurements that were taken at the same time are now grouped together.

• Observations - Blood Glucose - Measurements are now displayed (previously they were 

not included).

• Risk Factors - Comment field is no longer displayed, and only the most recent qualifier 

of each relevant type is included.

• To-Do List - Now supports ticking / unticking of items to be included.

• Drug Allergy / Other Information - The sub-headings for alerts and adverse reactions 

are now also displayed in red to attract attention.

Service Recording

• A notes icon,  is displayed before a patient's name if there are notes entered on the 

Administration tab of Patient Details.

Match and Review Result

User interface behaviour when matching investigation results to requests has been tweaked, 

when there are qualifiers to display in the 'Result Qualifiers' box. The qualifiers shown 

may change depending on which requests have been checked, therefore the values are not 

editable until the user checks 'Review Result'. The non-editable state is indicated by greying 

the box out. This clarifies the intended user workflow.

OSR Reports for 2012

A new set of OSR reports have been provided for 2012. These are identical to the 2011 OSR 

reports with the exception that they have been set to operate on the 2012 date range.

Database Server

This version of Communicare includes a 64-bit version of Firebird 2.5 which will be 

installed on all servers running a 64-bit version of Windows, for improved scalability and 

performance.

Version 11

Release notes for version 11 releases.

Version 11.4

Release notes for V11.4.
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Secure Message Delivery

This version of Communicare has been enhanced to send messages via Secure Message 

Delivery (SMD), rather than secure email. To enable SMD you must have a local installation 

of the Argus 6 messaging installation and Microsoft .Net Framework 3.5 Service Pack 1 or 

greater. See the SMD page for more information.

Human Services Directory

Communicare now interacts with the Human Services Directory (HSD) to lookup addresses. 

Additional detail is imported with these addresses which enables Communicare to send 

documents to these addresses via SMD. HSD lookup is available in the Address Book Search 

window. To use the HSD you must have Microsoft .Net Framework 3.5 Service Pack 1 or 

greater.

<u>Updating Your Address Book:</u> As part of the upgrade to use HSD and SMD, old 

address book entries will need to be matched to their entries on the HSD.

• Before the upgrade we will send you a list of all address book entries that have been 

automatically downloaded through Argus (not manually created), that have never 

been used. These will be deleted when you upgrade unless you specify that they should 

not be.

• Following the upgrade, any entries that have not been deleted (i.e. have been 

manually created, or automatically downloaded through Argus and used), and that 

you send messages to, will have to be manually matched to the HSD. This can be done 

using the 'Match to HSD' button on the Address Maintenance window. Until this is 

done, the address will not be available to send electronic messages to.

• Following the upgrade, any new addresses that you wish to send electronic messages 

to should be downloaded directly from the HSD using the HSD lookup function in the 

Address Book Search window.

Documents and Results

The 'In-tray' window has been renamed 'Documents and Results' and features a new tab 

'Outgoing Documents' to show documents that have been sent via SMD. See new section: 

Sending and Receiving Documents for further details.
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Service Recording Medicare Card Status

The service recording window now displays the  incomplete Medicare details icon if a 

patient's Medicare card details are missing or incorrect. This should help remind reception 

staff to update details for booked or waiting patients.

Telehealth Video Mode

A new encounter mode of Telehealth Video has been added. Administrators should 

consider adding this as a mode to any encounter place equipped with the facilities for video 

conferencing with patients. Providers should use this mode for recording services where the 

contact with the patient was via video conferencing.

Address Book

The Address Book option from File  > Reference Tables  has been moved up one level to File 

> Address Book Maintenance  and now it has its own system right. Users who currently 

have Reference Tables rights will initially have Address Book rights. Administrators should 

review which user groups have rights to Reference Tables and Address Book with a view to 

adjusting these so they are appropriate. Administrator can run the report at Report  > User 

Groups  > System Rights Grid  to assist in this process.(See Address Book).

New Qualifiers with LOINCs

Communicare can now recognise and process the following from incoming HL7 laboratory 

results:

'PCR (Protein/Creatinine Ratio)' with the units mg/mmol (LOINC 2890-2).

In addition, the existing qualifier 'HbA1c' has been renamed 'HbA1c (%)' and a new qualifier 

has been created with the name 'HbA1c' and the units of mmol/mol (LOINC 59261-8). For a 

period of time labs will be sending HbA1c results as % and as mmol/mol but the % value will 

be phased out. Contact your lab for details.

To review all measures processed by Communicare as qualifiers (i.e. incoming results that 

will populate graphs and reports immediately with these measures) run the report at Report 

> Reference Tables  > Numeric Qualifiers - Central  and select the option 'HL7 only'.
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Rural Prescriptions (For NT Users)

Three new options are now available to be used with Rural Prescriptions; 'Show Print 

Medication Summary Button', 'Print PADDA compliant Health Centre Prescriptions' and 

'Remove Dispensing Record' (See System Parameters - Clinical).

A patient's Medication Summary can now be printed.

Prescriber Comments can now be entered against a patient for their prescription.

Prescriptions

The number of items on a prescription is now printed on the prescription.

Communicare In-tray has changed to Documents and Results

Communicare In-tray has been redesigned and now consists of four main categories: 

Investigation Results, Scanned Documents, Received Documents and Outgoing Documents. 

(See Documents and Results).

Clinical Record

The following changes have been made to the links on the Links Bar in the Clinical Record.

• A link will only be visible when permission to view the target has been granted.

• There is now an Immunisation History link on the summary tab of the clinical record 

that will take you to a patient's immunisation history.

• The documents link has changed to inform you when there are unreviewed documents 

(this now behaves like the Investigations link).

Immunisations now display the dose in the item description when viewed on the detail tab 

of the clinical record.

The Patient ID is now displayed at the top of the Clinical record

Reports for Individual Patients

Additional reports on the print button of a patient's clinical record allow you to print a 

full immunisation history with details of batch number, expiry date, dose, etc. and a full 

medication summary that shows all details shown in the Medication Summary (i.e. current 

and regular medications only) and also the name of the prescriber.
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Patient Appointment and Service History

The Print button caption has been changed from 'Print' to 'Print all future appointments' on 

the Service List Form.

Tackling Smoking

This version contains the Tackling Smoking dataset. Contact COMMUNICARE for more 

information.

Peri-natal Depression Project

The Communicare value-added dataset now has a clinical item Perinatal Depression 

Assessment that will record details of the Edinburgh Postnatal Depression Scale. This item 

will populate two reports for the Peri-natal Depression Project:

• Report | Pregnancy | Perinatal Depression Project

• Report | Pregnancy | EPDS Scores

Health services with a local clinical item that collects similar data may wish to review 

this item and decide which to use. Contact Communicare System if you wish to discuss 

conversion from a local item to this central item.

System Parameters - Devices

The option Show scanner interface has been removed. This option has been deprecated as 

Communicare handles scanner interfacing.

An edit box that allows the customisation of Maximum Document Size has been added to the 

devices tab.

Match and Review Result

This window has been re-arranged. The review result section has been moved underneath 

the list of requests. The print and print preview buttons have been moved towards the 

bottom-left of the window and icons have been added to them. Request clinical notes and 

the matched patient's details are now in the top-right corner. The urgent and abnormal 

boxes have been replaced with status icons and they will only appear if the status is true.
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National KPI Reports

New reports have been added for National Key Performance Indicators for Indigenous 

Primary Health Care (2012). See National KPI Reports for more details.

CAT Exporter

The tool used to export data to the Clinical Audit Tool has had the following changes:

• When calculating a patient’s “active” status (3 visits in 2 years), providers without 

provider numbers are now considered. The previous version only considered providers 

who had provider numbers.

• All qualifiers (currently supported by the CAT export tool) are exported regardless of 

whether or not the associated clinical item is “Complete”. The previous version did not 

export qualifiers recorded on incomplete clinical items.

• Email and Patient Status from patient biographics are now exported.

• Alcohol Status is now detected by looking for any qualifier system codes ALP or ALC 

(normally Alcohol Consumption Level and Alcohol Consumption During Pregnancy). 

Refer to PCS Clinical Audit Tool – User Guide for more information.

• Smoking Status is now detected by looking for any qualifier system codes SMO or SMP 

(normally Smoking Status and Smoking During Pregnancy) rather than primary keys. 

Refer to PCS Clinical Audit Tool – User Guide for more information.

• Birth weight from the infant's file is now exported. If birth weight is not recorded in 

infant's biographic details, any qualifier system codes of WKG (normally 'Weight') 

recorded on day of birth are used.

• Any qualifiers with system code BMI (normally Body Mass Index) are now exported.

• International Normalised Ratio and Protein/Creatinine Ratio qualifiers are now found 

using system codes (INR &amp; PCR) rather than primary keys.

• Pap Smear, Eye Exam, and Foot Exam qualifiers now found using export codes 

(PAPSMEAR, EYEEXAM &amp; FOOTEXAM) rather than primary keys. Refer to PCS 

Clinical Audit Tool – User Guide for more information.

• Pap Smear investigations are now used to find pap smear checks in addition to 

clinical items and qualifiers. Refer to PCS Clinical Audit Tool – User Guide for more 

information.

• Close button added.

Version 11.3

Release notes for V11.3.
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Communicare has a new look!

Communicare has a new look splash screen and login form. The login form contains all 

the existing functionality with the addition of the selection of 'workstation location'. (See 

Communicare Login.)

Also, new icons have been used on the main toolbar buttons (see Main Toolbar). These 

changes are the begining of a whole refresh to the product package.

To Do List

The To Do List in the clinical record now shows the due date for recalls and referrals with 

less than 28 days to go as amber (similar to the way regular medications are displayed in the 

Medication Summary). This is to alert the user to recalls and referrals which are due soon so 

that they can be considered for completion as part of this consultation rather than waiting 

for the patient to attend again.

Due dates for overdue recalls and referrals are shown as red. Note also that unreviewed 

investigation results on the detail tab have their dates shown as red to draw attention to 

them.

HI Service Integration

Communicare now has the Healthcare Identifiers Service (HI Service) integrated into 

Biographics. Users can manually enter a known Individual Healthcare Identifier (IHI) and 

have it validated with Medicare, or automatically initiate a search for an IHI when saving 

patients with enough detail for reliable retrieval. Valid IHI's can also be seen when selecting 

patients in Patient Search. Correct setup is required before the module can be used, which 

includes the deployment of Microsoft .NET Framework 3.5 Service Pack 1 on all client 

workstations. Further detail on the new functionality can be found in Biographics and HI 

Service.

Required Qualifiers on Referrals

Following the changes necessary to prevent users undermining the status of an incomplete 

item by returning to it and completing required qualifiers (this must now always be done 

from the recall in the To Do List) referrals are no longer allowed to have required qualifiers. 

Referrals appear in the To Do List with their own logic for completion. Any local referral 

items with required qualifiers are reported in the Database Consistency Check and any 
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required qualifiers should be set as not required. Future attempts to make a qualifier on a 

referral clinical item as required are prevented.

Communicare Reports for Excel

All Communicare SQL reports can be exported to Excel but some are designed only for 

export to Excel (i.e. there is no print layout). These reports typically either have many 

more fields than can be shown on a page of A4 paper or the data lends itself to further 

manipulation by a trained Excel user (e.g. ordering, filtering and the creation of graphs and 

charts). Several reports of this nature have been added in this release:

Report | Electronic Claims | Bulk Bills Status Report - this report shows all the information 

displayed in the Bulk Bills Status window when no filters have been applied (i.e. excluding 

fully paid claims and those for services more than two years old). The report also shows 

the status of the patient's Medicare card, the home locality of the patient, the status of the 

claim and any error code associated with the claim. Where a claim has not yet been made the 

names of all providers on that service are shown and where a claim has been attempted the 

claimant is shown. It will be invaluable for Medicare claims staff wanting to prioritise how 

they follow up on unclaimed services.

Report | Procedures | Performed by date with qualifiers (export) - this very versatile report 

prompts for a procedure and then shows all such procedures added between two dates 

with the qualifiers presented as columns rather than rows. By exporting this to Excel and 

removing the first header row the data can be ordered and filtered depending on responses 

to qualifiers on the procedure. This report can be used to analyse responses to qualifiers by 

looking for omissions or responses with specific values. Up to fifty qualifier types on a single 

clinical item will be displayed.

Pathology Results and Structured Numeric values

Pathology results for structured numeric values (e.g. eGFR values like '\>90') are now 

imported into Communicare. These will now display in the qualifier summary along with 

any comparator operator, separator operator and values. (e.g. greater than '\>90', less than 

'\<100', range '10-100', ratio '1:2' etc.).

Qualifier Charts

Qualifier charts have been enhanced to be able to effectively display structured numeric 

values that describe 'greater than', 'greater than or equal to', 'less than' and 'less than or 

equal to' values. See Qualifier Charts.

(c)Telstra Health | Communicare 213



In addition to this, if multiple qualifiers are graphed, users can select to turn on/off display 

one or more of the qualifier data sets by clicking on the legend checkboxes.

CDA Specialist Letters and Discharge Summaries

Communicare now supports importing Clinical Document Architecture (CDA) documents 

(HL7 v3) specified as Specialist Letters and Discharge Summaries via the regular 

investigations drop folder. (See Electronic Results.) These CDA documents are completely 

integrated into existing workflows and can be accessed from the clinical record or the 

Communicare In-Tray in the same way as other electronic documents.

Version 11.2

Release notes for V11.2.

Text Shortcuts

Now available within Progress Notes and the Letter Writer, are text shortcuts. This allows 

you to type a shorthand word, which will expand to configured template text. For example, 

typing '.QUIT' could expand to commonly used information for patients requiring assistance 

to quit smoking. These shortcuts are configurable by the system administrator. More 

information is available at: Text Shortcuts.

Social Problems Viewing Right

All Central clinical items with the topic 'Social Problems' have had their viewing right of 

'Common' replaced with a new viewing right of 'Social Problems' because of the sensitivity 

of many of these items. After this upgrade any user group with previous access to 'Common' 

will have access to 'Social Problems'. User groups with no access to 'Common' will have their 

access unchanged.

Important:

It is critical that the Administrator review all user groups to see if this new access 

right is appropriate to that group. If the upgrade found a prior local viewing right 

of 'Social Problems' this has been renamed. Contact COMMUNICARE if you require 

further assistance.
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NT KPI Reports

This version of Communicare introduces version 1.3.3 of the NT Aboriginal Health Key 

Performance Indicators. The Administrator should review local clinical items that may have 

been created and adjust them in the following way:

• Any clinical item that is an indication that a Pap Smear has been performed should 

be given the export code of PAPSMEAR. These will now also be looked for as evidence 

that a woman has had a Pap Smear on that date.

• Any clinical item that is evidence of an antenatal check (i.e. it has the rule code of 

PR-CHECK and the system code of PRE) should have the qualifier Antenatal check 

performed added to be able to record if the check was done at the health service or 

elsewhere.

• Panvax and Fluvax recalls are excluded from the definition of fully immunised 

children when a health service does not use the immunisation review items.

See NTKPI for more detail.

Antenatal Care

Some specific conditions can now be recorded in the obstetric summary against a 

specific pregnancy number. These terms are effectively qualifiers of the current or past 

pregnancy and include: 'Pregnancy;high risk', 'Pregnancy;multiple', 'Pregnancy;ectopic' and 

'Pregnancy;unplanned'. Also included are conditions that relate to a specific pregnancy such 

as 'Diabetes;gestational', 'Oedema;pregnancy', and 'Hypertension;in pregnancy'. To allow a 

local clinical item to be able to record a specific pregnancy number it should have the rule 

code of PR-STAT and the system code of PRE.

Student Providers

Providers may now be identified as 'student' via a checkbox in the Provider Edit dialog. A 

student provider will be indicated in the clinical record for any contacts or progress notes 

that they write.

Patient Email Address

A patient's email address can now be recorded in Patient Biographics.
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Drawing Qualifiers

Drawing Qualifiers now display when using the Latest Qualifier letter item.

Automated Calculation of Gestation

There has been a revision of the way that this value is automatically caclulated when 

clicking in a Gestation qualifier edit box. The value is still calculated in whole weeks but it 

is assumed that a woman who is 36 weeks pregnant, say, will have a gestation of 36 weeks 

until the gestation is 37 weeks (i.e. 3 weeks before the EDD). This is analagous to the way a 

patient's age is displayed in whole years until the next birthday.

INR (International Normalised Ratio) Chart

A chart displaying the current target INR and past INR values and associated warfarin 

dosage is now available in the Clinical Record via the INR toolbar button.

Reports for Individual Patients

SQL reports that present data for an individual patient can now appear in the Clinical Record 

on a menu that appears when the Print button is clicked. Initially the following centrally 

maintained reports are available from this menu:

• EPC Summary for Selected Patient (also available on the Report | Electronic Claims 

menu). This report details Medicare claims over the past two years for EPC items 

including allied health claims.

• Biographics for Selected Patient (also available on the Report | Patients menu). This 

report prints details of a patient's biograohics.

• Patient Mailing Label (also available on the Report | Patients menu). This report prints 

a single mailing label for a patient designed for a label printer.

• Patient Specimen Label (also available on the Report | Patients menu). This report 

prints a single specimen label for a patient designed for a label printer.

• Patient Measurement History (also available on the Report | Qualifiers menu). This 

report shows all qualifier values for a selected qualifier for a patient, ordered by date.

Locally created and other reports not centrally maintained can be placed on this menu so 

long as they are for a single patient. Contact COMMUNICARE for advice.
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Service Recording - Ordering

It is now possible to order services by Patient Name, Start/Withdraw time and Encounter 

Place and Mode columns.

Communicare CAT Exporter

The Communicare CAT Exporter is now available for Administrators to export data for the 

PEN Clinical Audit Tool. See CAT Export.

Preferred Language and Language Spoken at Home

These lists have been augmented with wider definitions of Aboriginal languages, such as 

'Yolngu Matha, nfd', 'Western Desert Language, nfd', etc. The text 'nfd' refers to 'no further 

definition'.

Special Patient Check

The service now has the ability to enable a custom patient check dialog which will be 

displayed when a user accesses a patient's record. The user must confirm the check before 

they can access the patient's record. See Special Patient Check for more information.

Database Server Upgrade

The back-end database server has been upgraded from Firebird 2.1 to Firebird 2.5. This 

upgrade will increase stability and improve performance of the server.

Error Logging

This version introduces unified logging of errors to the entire system. Administrators can 

control whether these error logs are sent back to Communicare Helpdesk. Communicare 

strongly recommends that this option be left enabled to assist in the resolution of active 

problems.

See System Parameters | System for more information.

Appointment Book

The 'Free Appointment Search' function now allows you to select the next free appointment 

slot filtered by a specific appointment slot type. See Appointment Book for more 

information.
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Internet Explorer 9 and PDF Links

As of April 2011, IE9 was available for download through Windows Updates for the Windows 

Vista and Windows 7 operating systems. However, a defect in IE9 causes help documentation 

to crash when an embedded link is clicked. This includes the Printable Forms section of 

Communicare Help.

We advise users to not install (or uninstall) the IE9 update until this defect has been fixed by 

Microsoft. Please contact your system administrator if you are unsure of how to do this.

Version 11.1

Release notes for V11.1.

Coordinated Care Trials

The first Coordinated Care Trial was conducted between 1997 and 1999. The second 

Coordinated Care Trial was conducted between 2002 and 2005. Participating Communicare 

sites still have CCT data in the database. In a future upgrade of Communicare this data 

will be removed. We will be contacting the sites known to have been participants in either 

CCT to arrange for this data to be extracted and stored outside the database. If you were a 

participating site and wish to have this data exported please contact us to arrange this.

Investigation Requests

There have been some enhancements to the Investigation Requests form. The Print 

checkbox has been replaced by a 'Print and Save' button which will save the request and print 

according to the chosen printing format. Also added is the 'Critical if result outstanding' 

checkbox, which is to be used when a patient's welfare is at risk if the investigation is 

not performed. This can be tracked using the Report  > Investigations  >  | Outstanding 

requests by provider  > Outstanding requests by provider  report, which highlights any 

requests marked as Critical.

Integrated Progress Notes

There are extra filters available when viewing Historical Progress Notes. The ability to filter 

by any provider, encounter place, encounter mode has been added. More information is 

available in the Help documentation for Progress Notes.
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Scanned Documents

Scanned documents now allow the Document Date to be modified to allow the date to reflect 

the actual date of the document, not just the date it was scanned.

Attachments

When adding an attachment to the clinical record, the comment now defaults to the file 

name (without the path or extension), but can be edited. This will make bulk addition of 

attachments much easier.

Version 11.0

Release notes for V11.0.

STRIVE

This version contains the STRIVE STI dataset. Contact COMMUNICARE for more 

information.

Letter Templates

• There are now letter templates for 'South Australian Report of Notifiable Disease or 

Related Death', 'Victorian Referral Form', 'Queensland Workers Compensation' and 

'Edinburgh Postnatal Depression Scale'. The state-specific templates may need to be 

enabled by your administrator before they can be used.

• The 'Allied Health Referral EPC' form has been replaced with the 'Referral Form 

for Individual Allied Health Services' (Form CDAH-I 0510) as per release from 

Medicare. (Ref: http://www.health.gov.au/internet/main/publishing.nsf/Content/

mbsprimarycare-removalofepc). The 'Allied Health Referral EPC' form will still be 

available but will be disabled by default.

Biographics

• The patient search window now displays Aboriginality in the details for the selected 

patient. This will allow staff to easily identify this information when searching for 

patients without the need to open the Biographics window. Note that if a patient has 

not had their Aboriginality recorded the Aboriginality dropdown box will be empty.

<color Red>Note for Administrators: any local reports that look at the Aboriginality 

of patients may need amending to account for patients where this status has not been 
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recorded. If the report looks only for Aboriginal patients then no change will be required, but 

if the report has to include patients even if their Aboriginality is not recorded then a minor 

change may be required. All Communicare reports have been updated. Local reports can be 

identified using the report at Report | Database Consistency | Local Reports. If you need any 

assistance then call COMMUNICARE. This change is to follow good practice guidelines and 

allows us to distinguish between patients who have declined to state their Aboriginality and 

those who have never been asked.</color>

• The emergency contact details are now displayed in the patient search window in a 

single entry showing phone, relationship and name (if provided).

Medicare Claiming

The prompt for additional MBS item 10990/10991 will now be triggered by any recorded 

CentreLink card, not just HCC.

Editing clinical items

When editing an 'incomplete item' (i.e. a clinical item that was saved without all the 

required qualifiers being addressed) any required qualifier that was not addressed will be 

disabled to prevent the item changing status to 'complete'. To add the missing required 

qualifiers the recall must be completed. Although this has always been recommended 

practice some clinicians have been editing another user's incomplete item and this has 

changed the status to complete but undermined the existing automated recall behaviour and 

also left behind unwanted recalls.

Integrated Progress Notes

There has been a change to the way a user's viewing rights and the free text in a progress 

note are handled. When a user does not have the viewing right for any of the items within a 

note, only those items are now blocked, and the free text remains if the user has the viewing 

right that is attached to the note itself.

SEHR (Northern Territory)

Background changes to allow transmission of data to the SEHR via WSMA (Web Services 

Messaging Application) only, for sites that do not need to use Argus.
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Version 10

Release notes for version 10 releases.

Version 10.6

Release notes for V10.6.

Prescribing

• Prescription labels now also show the patient's date of birth. The drug description and 

dosage text wraps to multiple lines and may shrink in size if it does not fit inside the 

allocated space.

• New prescriptions now default to 'once off' instead of 'regular' for providers without 

a Prescriber Number. This change applies to sites using the rural prescription form. It 

will not deny users from adding regular medications; only the default behaviour has 

been changed.

Investigations

• Users are now able to request an investigation on behalf of another claiming provider. 

A selection of available claiming providers is displayed on the investigation request 

form when the current provider does not have a valid Provider number for the 

encounter place. This option is enabled in Organisation Maintenance. A default 

investigation provider may also be set in Organisation Maintenance.

• Users can now add and remove multiple investigations on the request investigations 

screen using the '>>' and '<<' buttons respectively. After filtering the list of 

investigations using the keyword search function, the add all (>>) button is enabled. 

Pressing the button adds all the listed investigations. The remove all (<<) button will 

remove all investigations that do not have a result attached.

Service Recording

• Users will now be prompted with the service selection dialog (as encountered on entry 

to Clinical Record), when attempting to add new services via the '+' button in Service 

Recording. Selecting an existing service will open its details for editing. The dialog will 
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only be presented if another service already exists for the chosen patient on the same 

day. This change aims to reduce the creation of duplicate services.

• Additionally the service selection dialog will no longer auto-select the first service 

in the list, in the interest of improving accuracy (for claiming purposes, etc) when 

recording multiple encounters with a patient.

See Service Selector for more detail.

Clinical Record To Do List

Double-clicking on a recall now gives you the option to complete, modify or cancel the 

recall.

Biographics

Patient aliases are now ordered as follows: preferred name first (in bold type) and then other 

names with the most recently added first. This is a change from the previous ordering which 

was all names ordered with the most recently added last. For patients with more than three 

names this used to lead to the preferred name possibly being hidden and the most current 

alias being hidden also.

SEHR (Northern Territory)

• SEHR functionality has been enhanced for reliability when manually sending Current 

Health Profiles via the Clinical Record toolbar CHP button, regardless of whether the 

service is subsequently removed.

• 'Administration' encounter modes will now also trigger the prompt for whether the 

encounter should be sent to the SEHR, as for other modes.

• Users will now be able to attempt eRegistration for patients with incomplete details; 

patients no longer need an address to be able to proceed with eRegistration. A prompt 

will come back from the SEHR if required details are missing.

Version 10.5

Release notes for V10.5.

Miscellaneous

This version has a variety of small improvements addressing functionality and performance.
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Letter Writing

There are three new letter writing items available in the Clinical Record list:

• Investigation Results

• Progress Notes

• Topic

These allow you to include information from the entire Clinical Record in your letters. The 

font styling of generated items has also been enhanced to more accurately match the desired 

font and colour. More information is available in the Writing Letters help topic.

Service Recording

New filter options are available:

• Provider Specialities

• Fictitious Patients

More information is available in the Service Record Filter Selections help topic.

New navigation buttons are available:

• Move date forwards / backwards by a day

• Return to today

New filter is available to find patients currently in view via search text.

New 'Quick Print Services' tool button is available to print a Service List report:

• Patients in the clinic now (waiting, started and paused services)

• Full list for the day in view

• Current filtered selection

More information is available in the Quick Print Services help topic.

Appointment Book

A new button will now appear next to the Appointment Date to easily return the selected 

date to today.
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Appointment Sessions and Encounter Programs

Appointment session templates can now be assigned an Encounter Program. Sessions in the 

Appointment Book created by a template with an Encounter Program which you do not have 

access to will not be visible. More information is available in the Appointments help topics.

Bulk Bills Status

A new 'View Progress Notes' button has been added to the Claims Status window toolbar, 

allowing for quick access to all notes associated with the selected service. The usual system 

rights and viewing rights apply. More information is available in the View Progress Notes for 

Service help topic.

Address Book

A read-only view of the Address Book with the same search capability as Address Book 

Search is now available to all users via the 'Tools | Address Book' menu option. Users are able 

to view the Address Book and all details for contacts by double clicking on the grid. The full 

editable Address Book is still available via the 'File | Reference Tables | Address Book' menu 

option for users with the 'Reference Tables' system right.

Version 10.4

Release notes for V10.4.

Progress Notes

This version introduces further enhancements to the Integrated Progress Notes in the 

clinical record.

• The progress notes tab now displays a historical list of notes on the left. The amount 

of detail shown in the historical notes is variable by the user.

• The right hand side of the progress notes tab allows the user to enter the current 

progress notes. To-do list has been added at the bottom.

• The font colour and style has been changed for plain text and for clinical items entered 

in the note.

• Clinical items are now bordered for clarity and highlight when you hover the mouse 

cursor over the item.

• Added spell checking to progress note.

• See 'Progress Notes' for full details and instructions.
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ACIR Claims List

This list now automatically excludes any immunisations that were performed in an 

encounter that has been marked as 'not claimable'.

Disabling of Dropdown List Items

Users can now disable list items for Dropdown List qualifiers. See Dropdown List Qualifiers 

for more information.

Service Recording

When double clicking a service in Service Recording, users are now presented with a prompt 

to either edit the service details or open the Clinical Record. Users without access to Clinical 

Record will simply get the service details without a prompt.

Service List

The appointment service list displayed in the appointments book and the clinical record (if 

the appointments module is enabled) now also displays service comments. See Service List 

for details.

Investigation Results

Incoming electronic investigation results are addressed in a more sensible manner. For sites 

that have multiple labs sending multiple results with different formatting of names (e.g. 

'SMITH, JOHN', 'JOHN SMITH', 'SMITH, J', etc) these will now all appear addressed to the 

name as recorded in the Communicare Provider table, rendered in upper case (i.e. 'JOHN 

SMITH') so long as the provider number returned by the lab matches a provider number in 

the Communicare database.

During the period immediately after the upgrade there will be some unreviewed results that 

arrived before the upgrade that show in the 'old' format. Once these have been reviewed 

there will be the single name for each provider.

Sites where there is only one lab that is used will either notice no change (if the lab's 

convention is for 'FIRSTNAME SURNAME') or will have a temporary period with both the 

'old' format (e.g. 'SMITH, JOHN') and the new, final format. Again, the 'old' format names 

will disappear with the last unreviewed result that arrived before the upgrade.

(c)Telstra Health | Communicare 225



Version 10.3

Release notes for V10.3.

Attachments

PDF documents can now be directly attached to a patient's clinical record using either 

Drag 'n' Drop or a new ‘Add Attachment’ button. The attachments appear alongside the 

patient’s other data in the Details tab and Progress Notes. In addition, you can launch the 

document at a later date from within Communicare. See the Attachments help page for more 

information.

Close the Gap Co-payments (CTG)

This version has added functionality to register a patient for Close the Gap Co-payments 

(CTG). Patient Biographics has a checkbox to indicate that a patient is eligible for payment 

relief. Prescriptions are then marked for CTG Co-payments for this patient and the CTG code 

for CTG prescriptions is printed on the script.

WSMA 1.1 Integration

The Shared Electronic Health Record (in the Northern Territory) has been enhanced to 

enable WSMA (Web Services Messaging Application) to send activity reports to SEHR.

Version 10.2

Release notes for V10.2.

Qualifier Types

There is now a new qualifier type called Investigation Request. You can define a qualifier of 

this type and provide a keyword that identifies one or more investigation requests. Adding 

the qualifier to a clinical item provides a button when the user completes that item - clicking 

the button generates an investigation request with the identified test pre-selected.

Central Item changes

Centrally distributed items for Aboriginal and Torres Strait Islander Health Checks (formally 

MBS items 700 - 710) have been edited to reference and claim item 715 in accordance with 

the MBS changes effective 1st of May 2010.
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Important:

Any locally maintained items will need to be adjusted by the administrator.

Version 10.1

Release notes for V10.1.

Miscellaneous

This version addresses some issues relating to data synchronisation, ACIR electronic claims 

and integrated progress notes.

Recent Additions to Communicare Templates

Recent additions include Proof of Identification (Centrelink) and Medical Certificate 

(Centrelink). There is also now a full Health Check Report for Item 710 that includes all 

qualifiers.

Panvax clinical items

We continue to distribute Immunisation;Panvax (H1N1 Influenza) for the recording of 

Panvax immunisations but now also distribute Immunisation;Panvax (H1N1) 0.5mL and 

Immunisation;Panvax (H1N1) 0.25mL for the specific recording of adult and child doses. The 

administrator should decide whether to disable the Immunisation;Panvax (H1N1 Influenza) 

and start using the adult and child items or to disable the adult and child items and continue 

to use the Immunisation;Panvax (H1N1 Influenza) item. If you have recall protocols based 

on the Immunisation;Panvax (H1N1 Influenza) item then be aware that disabling this item 

will turn off the rules. Creating new recall rules for the adult and child doses will create 

unnecessary recalls for patients that have had a Panvax already.

Where a local version of the Panvax item has been created you may choose to disable all 

the Central Panvax items and continue to use the local term. This may be required in states 

where priority group data is also collected on the local Panvax item.

Any site that wishes to collect the priority group data and have a report created specifically 

for their state should contact COMMUNICARE to discuss. We currently have a report and 

item for Panvax reporting in WA, SA, ACT, QLD and NT.

Version 10.0

Release notes for V10.0.

(c)Telstra Health | Communicare 227



Partial Medicare Claims

This version of Communicare allows multiple providers to make Medicare claims on a single 

service. It is important that you review the help topics Bulk Bills Status (Online Claiming) 

and How to Use Bulk Bills Status (Online Claiming) before reviewing the new version and 

upgrading.

SEHR eRegistration (Northern Territory)

This version of Communicare introduces an electronic registration system (eRegistration) 

to allow for the immediate transfer of medical data from the medical centre to the SEHR 

Repository for that patient. eRegistration creates a temporary registration for the patient 

until the signed documentation is received by SEHR and is approved. While in its temporary 

state, medical data can be recorded in the SEHR for the patient by any SEHR enabled medical 

centre but can’t be viewed.

Version 9

Release notes for version 9 releases.

Version 9.6

Release notes for V9.6.

Transport Management

The new Transport Management module introduces the ability to plan transport 

requirements for patients ahead of time. This module is mutually exclusive to Transport 

Services, so you should contact the Communicare team if you are interested in learning 

more.

Version 9.5

Release notes for V9.5.

Progress Notes

This version of Communicare introduces Integrated Progress Notes. This exciting new 

feature means that details of a service, as they are recorded, are displayed in the body of the 

progress note along with the free text details of the service. For example, if a health check 

is done as part of a service, the details such as weight, height, BP, etc, are displayed in the 

progress note.
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Please take note of the following comments:

• the spell-checker is not available in the integrated progress notes for this version of 

Communicare. It will be reinstated in a future release

• services created from outside the clinical record will not be able to create an 

integrated progress note in this version. This means that the reviewing of results and 

documents from the in-tray will show in the detail tab of the clinical record as usual, 

but not yet in the body of the progress note

• although most of the detail of a clinical item is shown in the progress note, some 

minor detail such as actual duration will still need to be found by double-clicking the 

item itself. These details will be visible in the progress note in a future version

• because the progress note now records all editing and deleting of clinical items it is 

no longer possible to enter a clinical record to edit, say, an incorrect patient weight, 

without leaving behind a record in your progress note. All such actions should be done 

in a no client contact service because the service will no longer be able to be ignored. 

This means that there is greater accountability for users

Note:

Because old data needs to be re-processed to enable this new feature, administrators 

should note that extra time will be needed for an upgrade to this version of 

Communicare or later.

APCC Reports

This version of Communicare has the updated APCC reports, including COPD and General 

measures and enhanced CHD and Diabetes measures. The reports are to aid manual data 

entry.

Version 9.4

Release notes for V9.4.

Extemporaneous Preparations (Drug Recipes)

Prescribers can now define their own preparations and record them on the patient's 

medication summary. The details will print to a prescription the same as medications 

prescribed from MIMS. See Extemporaneous Preparations (Drug Recipes) for more details.
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Single Label Printing

The Patient Labels button on the main toolbar can now be configured to run a specific report 

which is designed to print a single label. This can be a patient mailing label, for example, or 

a specimen jar label. The selected report should support the label size being used. Contact 

Communicare Systems for advice and support.

Investigation Requests

Radiology - Communicare now supports pre-printed radiology request forms. Administrators 

should check the address book at File  > Reference Tables  > Address Book  for any radiology 

places and set the type to Radiology Place. This will present a list of default options 

including standard plain paper, standard pre-printed forms, Perrett pre-printed radiology 

forms and Queensland Diagnostic Imaging pre-printed forms.

Pathology - Communicare now supports pre-printed pathology request forms with bar-coded 

specimen labels. Use FileReference TablesAddress Book  to change the default request 

form for pathology labs that supply this stationery to you.

ABCD Project

There is a new report that supports the clinic audit protocols for the ABCD project.

SEHR minor changes

WSMA (Web Services Messaging Application) settings. See System Parameters for details.

Version 9.3

Release notes for V9.3.

Clinical Record

In this version of Communicare a patient's clinical record will fill the whole screen when 

maximised. To access the main toolbar when a patient's record is open you can use the 

restore button to resize the clinical record. Communicare will remember your settings.

Support for Multiple Organisations

This version of Communicare introduces support for more than one organisation to share 

one database. Existing customers that belong to one organisation will notice few changes. 

The Administrator will notice that some of the details usually kept in File|System Parameters 
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have now been moved to File|Organisation Maintenance. Please note that this feature is not 

available for general use pending completion of Communicare's contract with SA Health.

Obstetrics and Pregnancy Tab Enhancements

This tab in the clinical record of female patients has been enhanced following feedback from 

antenatal staff in many of our clinics. See Obstetrics &amp; Pregnancy for details.

Drawing feature

The facility to draw on images is now implemented as a new qualifier type. A selection of 

specific qualifiers of this type and associated clinical items are included in the centrally 

distributed items (see Central update, below).

Point of care pathology tests

There is now a Central qualifier (Point of care test) that can be attached to clinical 

items used to record point of care tests such as HbA1c. The qualifier should be ticked to 

distinguish tests performed in the clinic from test results sent by a pathology laboratory in 

some form other than electronically. The qualifier has been attached to various ICPC2 terms.

Administrators should review clinical items that are used to record point of care tests. If 

local terms are used (rather than the ICPC2 terms) then consider using the Terms Converter 

to convert the term (e.g. to convert Lipids to Test;lipids profile). Local items that may have 

been used include Lipids, INR, Random BSL and Fasting BSL. Alternatively, attach the 

new qualifier to the local clinical item. Please Call Communicare if you have any further 

questions relating to this.

Central update

Administrators can review new clinical items and qualifiers by running the report Report|

Reference Tables|Clinical Item Types Added. Enter the number of days since the last 

Communicare upgrade and specify Central items created by the user CENTRAL. New items 

include Check up;Healthy Kids Check for items 709 and 711, Check up;Aged Care Resident 

{712} for item 712.

Appointments Book

Provider gender is displayed if this has been specified at File|Reference Tables|Provider. The 

Free Appointment Search can search for providers of a particular gender.
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Medicare Item Search

On the Medicare tab of a patient service (and in the shortlist reference table) you can now 

search the MBS schedule using search words. For example, typing the word NURSE brings up 

claims where the word nurse is in the short or long description.

Biographics

A patient's existing file number is now displayed on the Administration tab rather than the 

Personal tab. There is the facility for recording different file numbers for each encounter 

place that is marked as a record storage site.

A patient's record storage location that was previously stored as a value in a dropdown box 

is now displayed as a tick next to the same encounter place. If a patient has a place marked 

in this way (i.e. as the primary place) then this place will be the first place in the list, with 

places that have existing file numbers shown alphabetically after this and then places that 

are not the primary place nor do they have existing file numbers shown alphabetically at the 

end.

This means that all patient data is visible without scrolling unless there are more than four 

places in addition to the primary place that have file numbers.

Version 9.2

Release notes for V9.2.

Letter templates and adverse reactions

Note:

Any locally made letter templates that include the Alert item should now also 

include the Adverse Reactions items. You should review any such letter templates 

and add the new items (on the Clinical Record tree) as appropriate.

Database Server

This version of Communicare uses the database server Firebird 2.1. Improvements are 

mainly 'behind the scenes' concerning reliability, security and performance.
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Note:

For this reason, Communicare versions older than 8.6 cannot be upgraded to version 

9.2 or later unless they are first upgraded to version 9.1.

Centile Charts

The centile charts have been changed to use current World Health Organisation child 

growth data. They have also been enhanced by the addition of a BMI for age chart. For 

more information refer to http://www.who.int/childgrowth/en/  and http://www.who.int/

growthref/en/.

Service Recording

Waiting time is now shown in minutes. When this time reaches 60 minutes the label turns 

bold to highlight patients that have been waiting more than an hour.

Claim status is displayed by an icon on the left of the screen.

•  indicates that a claim has been made.

•  indicates that a claimable service has not yet been claimed.

•  indicates that the service has been marked as not claimable

Clinical Record title bar details

There is now an option to include the Medical Record Number in the title bar of the clinical 

record. To do this, the Administrator should go to File|System Parameters and select the 

Patient tab. Under the 'MRN term' edit box is a checkbox to include this on the title bar 

of the clinical record. If your term has been named 'HRN', for example, then the label will 

include this label as well as the number.

In addition, the gestation of a woman who is currently pregnant is shown in weeks and days, 

for example, (11/40 + 2) rather than just weeks.

Local Reports

Some user defined functions have been deprecated. A local report may fail to run with 

an error 'Function unknown' followed by the name of the function (e.g. F_YEAR). If this 
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happens please contact COMMUNICARE and we can advise on an alternative function that 

will serve the same purpose.

NT Aboriginal Health Key Performance Indicators

There are reports added to view and generate NT AHKPI data for submission. The reports 

and export file adhere to 'NT Aboriginal Health Key Performance Indicators, Definitions, 

September 2008, Version 1.3.1'. These can be found in Report|NT KPI. There are individual 

reports for each KPI, and Export report and an Export Summary report. Further details can 

be found in the Reports topic in the Communicare Help file.

Version 9.1

Release notes for V9.1.

Prescribing

Adverse Reactions: This new tool on the Clinical Record Summary tab allows adverse 

reactions to be reviewed and considered when prescribing medications. Warnings will appear 

when conflicting medications are prescribed, or are already prescribed. See the Adverse 

Reaction Maintenance topic for more information. Note that users without the Common 

viewing right will still be able to see adverse reactions but not add, delete or modify them.

<color Red>Prescribers should note that each time they prescribe for each patient after this 

upgrade they will be warned unless the 'Nil Known' checkbox has been ticked or there are no 

adverse reactions recorded.</color>

Adverse Reactions Audit Report: This new report is available in the Reports Clinical Record 

submenu. A list of patients who have adverse reaction clinical items, or text in 'Alerts' which 

indicate an adverse reaction will be listed. This report should be run by an administrator 

with the intent to transcribe the adverse reactions into the new Adverse Reactions tool. This 

will ensure medication warnings take these reactions into account. The current Adverse 

Effect clinical items and any locally created adverse reaction related clinical items should be 

disabled to encourage users to enter information into the new tool.

Report Search

This valuable new tool allows you to search the Communicare reports, mark reports as 

favourites and run reports multiple times without needing to open the menu each time. See 

the Reports Search topic for more information.
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Address Book Search

You can now search the Communicare Address Book. The search is available from the 

Address Book maintenance and a number of other places in Communicare where the Address 

Book is used. See Address Book Search for more details.

Medicare Claiming

This version of Communicare incorporates the changes to the Medicare Claiming module 

that allow claims up to two years old to be claimed electronically.

Practice and Clinic Addresses

Administrators should note that this version of Communicare adds a dropdown box for 

locality selection (similar to the patient biographics and address book maintenance) for the 

practice address and clinic addresses. You should check these details after the upgrade to 

either:

remove the locality from address line 2 if the locality dropdown box has correctly updated; 

or

select the correct locality and then remove the locality from address line 2.

Once you have done this then address line 2 can be used for further address details. These 

details are used in letters, prescriptions, investigation requests and some reports so they 

should be reviewed as soon after the upgrade as possible.

Version 9.0

Release notes for V9.0.

Programs

Services can now be associated with a specific program as well as an encouter place and 

encounter mode. Contact COMMUNICARE for advice on using this functionality.

Data Synchronisation

Support for data synchronisation has been extended.
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Clinical Record Detail Search

On the Detail tab of the Clinical Record you can now search clinical items for a word or 

phrase:

See Clinical Records - Details Tab for more information.

Note that the filter buttons for showing clinical items by class, topic or date have moved to 

this panel.

Clinical items

The comment that can be attached to any clinical record can now be of any length. Note 

that if the comment is lengthy it may be only partially displayed when clinical items are 

presented in reports or grids. The full comment can be read by double-clicking the item.

Patient Biographics

The patient biographics window has been rearranged to accommodate smaller screens. The 

Skin, Language, Birthplace and Marital Status information is now recorded on the Social tab 

along with family information.

Items that are not used are no longer invisible but are now displayed in a disabled state. 

Administrators wishing to enable such items should call Communicare for the daily code to 

make this change.

Items previously found on the Special tab are now on the Administration tab.

Service Recording

• The providers for a service are now displayed in the main grid allowing easy scanning 

of services by provider.

• When providers close the clinical record they have the opportunity to edit the service 

comment. This will be visible in the Service Recording window.
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Communicare In-tray

This window now has a filter to hide all records that are more than 6 months old. This filter 

is set when you log on to Communicare but can be turned off to view older records, both 

documents and investigation results.

Letter Template Items

A patient's Mother and Father can be added to a letter template individually. This enhances 

the Additional Kin Information and Emergency Contact Details items.

Appointments

• When making or modifying a booking, you can append the next timeslot.

• You can no longer move a booked appointment simply by click and drag. You have 

to select it first, then drag it. When you move a booking, a dialog will alert you and 

confirm that you do want to move the appointment.

• Click and drag selects timeslots, regardless of their state.

• Click-Shift works in a Windows standard manner by selecting the first cell that is 

clicked and all cells up to and including the next cell clicked.

Qualifiers

Numeric qualifiers can now have minimum and/or maximum values specified. See 

Qualifier_Type for details.

Reports

Administrator should be aware that any locally created SQL reports that select from the 

table PAT_ENCOUNTER should be edited to select from PAT_ENCOUNTER_VIEW otherwise 

users other than Administrator will get an error message. Query Builder reports will work 

correctly. Call COMMUNICARE if you need any advice in this matter.

Pregnancy items

Two new items have been added to the obstetric and pregnancy section ‘End Pregnancy’ 

list – Hydatidiform Mole and Blighted Ovum. Selecting these as an outcome will end a 

pregnancy and prompt the user to cancel any antenatal checks recorded.
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Version 8

Release notes for version 8 releases.

Version 8.6

Release notes for V8.6.

Note:

IMPORTANT INFORMATION FOR THE ADMINISTRATOR

From this version onwards a Communicare upgrade rebuilds the metadata of the 

database. This means that any metadata (stored procedures, view, tables, fields, 

etc) that have been defined locally will be lost. This may cause some specific local 

reports to no longer work.

If you are aware of any metadata that has been created locally please let us know 

BEFORE ARRANGING AN UPGRADE. We can advise you if you are unsure.

Metadata cannot have been created using the Communicare program but only by 

other database tools. Normal usage of Communicare will not create metadata.

Shared Electronic Health Record

There have been major improvements in the performance of the SEHR Initial Health Profile.

MIMS Update

There have been performance improvements in the MIMS database import.

Letter Writing

The address details for the Health Service and Clinic have been further itemised. Users can 

now select the most suitable phone or fax or clinic name with the most suitable address. 

Health Service address details are kept at File|System Parameters and clinic address details 

are kept at File|Reference Tables|Encounter Place.

<color Red>CAUTION: the letter item Health Service.Clinic Address is now just the address 

details. To include the clinic name, fax and phone use the item Health Service.Clinic Details 

if appropriate. Pay attention to your letterhead if the clinic address item has been used in 

this.</color>
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Rural Prescription

The rural prescription form now orders medications the same as the clinical record 

medication summary. Also, when a reprint is performed and there are regular medications 

that have been recorded but not prescribed, the misleading date of '17/11/1858' is replaced 

with 'No date!' to alert users to the fact that the medication has no prescibed or until dates.

Miscellaneous

There have been performance improvements and structural changes to various server 

applications.

Version 8.5

Release notes for V8.5.

Automated Recalls

Self referential recalls are created as intended.

Prescribing

Medication Summary: This tab has been enhanced for ease of use. Stopped medications 

appear disabled with a stopped icon. One click links allow the user to repeat, edit or stop 

a medication. Medications marked as 'Print required' but not yet printed are marked with 

a printer icon and there is a button at the top of the tab to print all new prescriptions and 

labels. There is a link at the bottom of the tab that will take you to the medication history 

details.

Rural Prescription: Where the Rural Prescription is used, providers with the Medication View 

right but not the Prescribing right are now allowed to reprint rural prescriptions.

The button to generate a new rural prescrition  has been 

moved from the main Clinical Record toolbar to the Medication Summary

Generic formulations: Medications which specify 'modified release' or similar in the brand 

formulation now have the formulation displayed if this drug is prescribed generically. This 

allows the prescriber to distinguish between, say, Diabex and Diabex XR without prescribing 

by brand name. Normally, a generic prescription does not specify the formulation.
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NPCC Reports

The National Primary Care Collaboratives is now the Australian Primary Care Collaboratives. 

The NPCC reports can now be found at Reports|APCC.

Version 8.4

Release notes for V8.4.

Data Synchronisation

Users of Data Synchronisation Client should check the revised help topic.

Shared Electronic Health Records Version 2.2

There have been various changes to SEHR (formerly NT HealthConnect). Sites can now 

disable some of the functions of the SEHR without disabling the complete module.

NT Child Health Check Initiative

Sites in the Northern Territory can now use Communicare to record and submit details of 

Child Health Checks direct to AIHW. See Child Health Check Initiative Reporting for details.

Clinical Record

Main Summary: When the 'simple summary' is used at a clinic you can now double-click on 

an item on the summary and the item will open for editing. This is simpler that using the 

right-click function to find the associated service details and then selecting the item.

Manual Recalls: Your administrator can attach a $Recall keyword to frequently used manual 

recall types so that they appear as a shortlist on the Add Manual Recall button. This will 

save time searching for commonly used manual recall types. Also, manual recalls added by 

providers when reviewing test results from the In-Tray are now attached to a service and as 

such can be reported against the provider's name.

Automated Recalls: When a provider declines to add an automated On Completion or 

On Presentation recall a cancelled recall is added rather than no action being taken. The 

cancellation reason is recorded as 'Declined by user'.

Pregnancy warnings: When a medication with a pregnancy warning is added to the clinical 

record for a female patient aged 10 years or older a warning label is displayed. Clicking on 

the label displays the full pregnancy details from the MIMS PI.
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Qualifier Summary: Central qualifiers can now be added as a summary item or removed as 

a summary item by your Administrator. This means, for example, that a site can choose to 

have Hb (haemoglobin) as a summary item for all patients or not.

Prescribing

There have been enhancements to the way the stopping of medications from the medication 

summary is handled. Deletion is reserved for medications prescibed in error. When a regular 

medication is stopped it is automatically removed from the regular list and the current 

medication is stopped. Note that when a regular medication is stopped from the medication 

summary and there are overlapping prescriptions for that medication, any old scripts that 

are still current (that is, have an until date in the future) will be stopped and appear as 

stopped medications.

Biographics Fields

There is now a further language field to record language spoken at home when this is 

different from preferred language.

It is also now possible to conceal the following fields if they are not required: preferred 

language, language spoken at home, country of birth and marital status. This is done by the 

administrator from the system parameters form.

Birthweight: This is now restricted to a maximum of 10kg. Users will be warned if the value 

they enter is greater than 5 and prevented from entering a value greater than 10.

Note:

as part of the upgrade to this version of Communicare, the following data cleaning is 

done:

• all birthweights greater than 1000 and less than or equal to 10000 will be 

divided by 1000 on the assumption that the birthweight was erroneously 

entered in grams

• all remaining birthweights greater than 10 will be cleared on the assumption 

that they are incorrect (for example, the weight was mistyped or an adult 

weight was recorded by mistake).

A report of patients whose birthweight has been adjusted will be provided on request.
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Letter Writing Check Box

Please note that the interactive checkbox no longer appears in the tree view under 

Miscellaneous but can be found as a button on the toolbar or as a menu item on the Insert 

menu.

Appointments

Many usability improvements:

• You can now filter the view by any combination of place and mode

• You can now choose to hide provider absences using the right click menu

• When you insert a session for today, session templates that have an end time earlier 

than now, are not displayed for selection

• If a patient is highlighted, that patient will be the default if you select the service list

• You can use Ctrl-Click to select multiple slots

• There are many changes to how appointment slots are selected and unselected on 

screen and how the process behaves according to how many and what sort of slots are 

selected.

User Group Maintenance

The administrator can now move a user from one group to another by dragging and 

dropping. This also has the advantage of preserving that user's default settings in 

Communicare.

Scheduled Reports

Communicare sites that have not yet set up the e-mail server details in System Parameters 

will have a default e-mail server and account details defined. This allows Communicare to 

schedule a regular monitor report that will allow us to monitor the health of your database.

Version 8.3

Release notes for V8.3.

Synchronisation Client - One way Synchronisation

This version introduces the next phase in database synchronisaton. The existing database 

replication client (allowing a user to take a copy of the database away from the network but 

not to upload changes to the main database automatically) has now been superseded by a 
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data synchronisation client - one-way synchronisation. This allows the user to take a copy 

of the database away from the network and, on returning, upload any changes to the main 

database electronically.

Contact COMMUNICARE on (08) 6212 6900 if you are interested in taking advantage of this 

new functionality. Health services with mobile health providers who work in areas of poor 

connectivity will be able to record consultations 'in the field' and not have to spend time 

back in the clinic re-entering data into the main database.

New clinical items

The Communicare Value Added dataset has been enhanced by the addition of ten age-based 

child development check clinical items based on West Australian and CARPA guidelines. 

These will appear on a button in the clinical record labelled Child health.

Fourteen new examination clinical items have been added to a button labelled Examination.

Contact Communicare if these buttons are not visible after this upgrade. If you do not wish 

to use these items at your site please contact your administrator who can disable them.

Version 8.2

Release notes for V8.2.

Shared Electronic Health Records Version 2

This version completes the NT HealthConnect functionality. NT HealthConnect (now known 

as SEHR) has been tested and implemented in the Northern Territory and allows exchange of 

patient's clinical information between different clinical information systems.

See NT Health Connect for more information.

Check Boxes in Care Plans

When designing a Care Plan template and you wish to offer an interactive check box, do not 

use the tree view item Miscellaneous - Tickbox but rather the menu item Insert - Check Box. 

See Document Template Maintenance for more details.

Version 8.1

Release notes for V8.1.
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NT Child Health Check Initiative

This version introduces the NT Child Health Check Initiative.

Version 8.0

Release notes for V8.0.

Reports and reminder letters

In addition to the existing reports that generate reminder letters (Appointments  > Missed 

appointment letter, Appointments  > Reminder letters list, Recalls  > Immunisation 

Reviews Reminder Letters, Referrals  > Reminder Letters) there is now a more 

configurable letter generation report for any recall called Recalls  > Reminder Letters.

This report will print a reminder letter for a specific recall reason with options to select 

patient status, locality group, lower age, upper age, days ahead due and days overdue. The 

standard letter has the service address, today's date, patient's name and address details and a 

request to attend the specified overdue or nearly due recall.

The report can be copied and edited to add your own body text if desired.

Version 7

Release notes for version 7 releases.

Version 7.7

Release notes for V7.7.

Healthy for Life

This version of Communicare introduces version 3 of the Healthy for Life reports (October, 

2007). See Healthy for Life Reports for further details.

A new report at Pregnancy  > Outcomes  allows users to see those pregnancies that have 

been ended between two dates. This is the main criterion for inclusion in the maternal/

antenatal reports for H4L. The NPCC  > ...  reports provide more detailed information about 

the patients included in the chronic disease reports for H4L (note that the NPCC reports also 

include non-Aboriginal patients).

Note:

Important note about version 1 reports:
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The upgrade to this version of Communicare will first remove all reports on the 

Healthy for Life  menu before adding all the version 3 reports. If you wish to 

preserve any of the version 1 reports the Administrator should rename the old 

reports from Healthy_for_Life [Report name]  to Healthy_for_Life_V1 [Report 

name]. The underscore between 'Life' and 'V1' is essential. Renaming reports is done 

at File  > Queries  > Import Query from file.

Note:

Important note about scheduled reports:

If you have scheduled the version 1 Healthy for Life reports to be run automatically 

and choose not to rename them before the upgrade you will find that these reports 

have been removed. The scheduled e-mails will display a message that the report 

could not be found. The Administrator should review the scheduled reports and 

select each appropriate new report. Reviewing scheduled reports is done at Tools  > 

Scheduled Reports.

Healthy for Life Report Name Changes:

All reports have been updated to report by age groups, gender and new criteria. Some have 

been named slightly differently and some are new:

• EI 1 First antenatal visit - name unchanged

• EI 2 Average birth weights - name unchanged

• EI 3 Low birth weight babies - name unchanged

• EI 4 I Antenatal risk (first visit) - name unchanged

• EI 4 II Antenatal risk (third trimester) - name unchanged

• EI 5 I Child health checks - name changed

• EI 5 II Child health checks (alternative) - new report

• EI 6 Fully immunised children - name unchanged

• EI 7 I Adult health checks - name changed

• EI 7 II Adult health checks (alternative) - new report

• EI 8 I Diabetes &amp; CHD (with 721) - name changed

• EI 8 II Diabetes &amp; CHD (with alt GPMP) - new report

• EI 8 III Diabetes &amp; CHD (with 723) - name changed

• EI 8 IV Diabetes &amp; CHD (with alt TCA) - new report
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• EI 9 I Diabetes with HbA1c - name unchanged

• EI 9 II Diabetes with low HbA1c - name unchanged

• EI 9 III Diabetes average HbA1c - name unchanged

• EI 10 I Diabetes with BP - name unchanged

• EI 10 II Diabetes with low BP - name unchanged

• EI 11 I CHD with BP - name unchanged

• EI 11 II CHD with low BP - name unchanged

Progress Notes

In this version, if a provider is defined with a specific logon user name, then only users 

logged on with that user name or the provider's delegated user name can create or change 

progress notes on behalf of that provider.

Recall Reports

The two reports Recalls  > Due Except Pap and Immunisations  and Recalls  > Due Except 

Pap, Imms and Health Checks  have been replaced by a single report Recalls  > Due Except 

Selected Recall Types  that uses parameters to allow various options to be chosen. Please 

check any scheduled reports you may have that use the old reports and edit them to use the 

new report with the desired options set.

Version 7.6

Release notes for V7.6.

Care Plans

Usability has been much improved when recording care plans:

• The care plan can be kept open to facilitate browsing of the clinical record, etc. An 

icon appears in the floating toolbar to allow you to find it again if it goes behind 

another window

• When the care plan is in 'template' mode the data items reveal the contents rather 

than a placeholder - this allows such items as the current medications, etc, to be read 

whilst updating the care plan
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Letter Writing

There have been changes made to letters and letter templates to improve performance. Also, 

an interactive checkbox item has been added to allow users to tick boxes before printing a 

letter.

There is now an additional item for patient mailing address and items for the special 

checkbox and special lookup.

Printer assignments

You can request the Windows printer dialog to always appear. This is useful for users 

that move regularly from one place to another. Do this from File | Printer Assignments by 

selecting the assignment (e.g. Prescriptions) and selecting a printer, if appropriate, and 

ticking the 'show printer dialog checkbox'.

For the letter writer you can use the File-\>Print menu item if you want the dialog.

Prescribing

Streamlined Authority has now been enabled in Communicare. If the MIMS database has 

details of a single approval number then this is automatically completed on the authority 

page. If there is more than one approved indication then these are presented in the 

approved indications area. Clicking the button in the approval number edit box presents the 

indications for selection.

See Choosing Streamlined Authority for more details.
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Electronic Claims

For Services with multiple providers where more than one provider may be able to claim 

Communicare will default the claiming provider according to the following rules:

• The first General Medical Practitioner to be added to the Service will be selected as the 

claiming provider.

• If there are no General Medical Practitioners on the Service then the first Specialist 

will be the claiming provider.

• If there are no GP's or Specialists on the Service then the first Registered Nurse will be 

the claiming provider.

Only Providers with Provider Numbers recorded in Communicare will be considered. The 

Claiming Provider can be changed manually on the Detail tab of the Service Record window.

Always check the label above the claim buttons to confirm the claiming provider before 

making a claim.

Qualifiers

Administrators can now define dropdown box qualifiers with descriptions of up to 60 

characters (increased from the earlier limitation of 30 characters).

Reason for Encounter

There is a new feature on clinical items to enable the user to flag that clinical item as a 

reason for encounter. The first clinical item to be flagged as a reason for encounter is set as 

the main reason for encounter. If the first clinical item flagged as a reason for encounter is 

changed to not be a reason for encounter then the main reason for encounter is changed to 

the oldest clinical item set as a reason for encounter. If there are no clinical items set as a 

reason for encounter then the main reason for encounter is cleared.

This feature is enabled by the ADMINISTRATOR from the System Parameters form.

Appointments

• When reserving or un-reserving a timeslot, you can enter a description. Defaults to 

'Reserved' or blank

• When creating Appointment Templates you can enter a description for any timeslot. 

For example you could create a reserved timeslot and describe it as 'Lunch break' or if 
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you had timeslots for a particular procedure, you could mark them as such. (Variable 

length timeslots were introduced in a previous release).

• Session templates and Session types can now have their own horizon dates so that the 

amount of time ahead that appointments can be made can be varied from the system 

default.

• A day of week called 'Manual' is now available. These sessions can only be entered 

manually, but for any day of the week.

• The window used to create or modify Session Templates has been rearranged and 

improved with drop down lists, a date picker and intelligent hiding of irrelevant items.

• The repeat date is renamed to effective date and is now optional, can be in the future 

as well as the past and does not have to correspond to the day of week, because it is an 

effective from date.

• The facility also shows the place and mode.

• Because the horizon date is now associated with the individual session template, 

there is no need to manually generate appointments for a new session as they will be 

generated automatically overnight.

• Using the effective date, session templates can be created long in advance of when 

they are required.

Replication

The replication client has been improved in speed and reliability. Clients using replication 

over satellite should now be able to resume interrupted downloads without any problems. 

Also the speed of the download should be almost 5 times faster for satellite connections. For 

sites replicating using local network only very little improvement should be visible as these 

are already very fast.

The replication client interface is now more responsive and properly updates the progress of 

the download.

Before replicating the database the Replication Client checks to see if there is a new upgrade 

available and prompts the user to upgrade Communicare before synchronising the database.

SQL Reports

• Default values can now be defined in the PARAMETERS section

• < and \> are no longer required

• Sections in the PARAMETERS section can be terminated with /\>
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• AgeBirthYears function - the database function which returns a person's age has been 

modified to not return a value if the input is unknown (i.e. null). The effect of this will 

be that patients with no date of birth will not be reported, instead of being counted as 

having an age of zero or, in reports where patients are shown regardless of age, they 

will show as age unknown or blank instead of zero.

Centrelink Card Numbers

The 'known to have a card, don't know the number' has been dropped because it was too 

vague. What you can do instead is :-

• Leave the type and number blank

• Select 'Known to not have a card'

• Select the card type but leave the number blank. The Medicare claim window will 

recognise that the patient has a Health Care card, regardless of the number and act 

accordingly

Existing entries are converted to Health Care Card with a blank number.

Encounter Place Reference Table

There is now an Add/Edit screen for encounter place management. This new screen can be 

found at: File |Reference Tables  > Encounter Place...  by adding a new encounter place or 

editing an existing encounter place.

Home Health Centre

There is now a concept of home health centre which links a patient to an encounter place. 

This is done by assigning a locality group to an encounter place on the encounter place edit 

screen.

• A locality group can only be assigned to one encounter place.

• A locality may not overlap in locality groups if more than one of the locality groups is 

assigned to an encounter place.

• In the same way a locality group may not be assigned to an encounter place where that 

locality group contains a locality that already belongs to another locality group that is 

already assigned to an encounter place.
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Use the new report at Report  > Reference Tables  > Locality Group Analysis  for an easy 

way to check that your locality groups are mutually exclusive where required. This report can 

also be used to check that your locality groups are comprehensive.

User Group Maintenance

Three new reports for the Administrator help to manage user access to Communicare. The 

reports (found at Report  > User Groups) allow you to:

• Usernames - check which users belong to which user group, whether they can change 

their password and how many days in the last 60 each user logged on to Communicare

• System Rights Grid - a visual display of which group has which access rights on the 

system (i.e. who can do what)

• Viewing Rights Grid - a visual display of which group has which viewing rights on the 

system (i.e. who can see what)

Use these reports to spot users who may have left the service and to review the rights that 

different user groups have.

NT Health Connect

This is an update to Health Connect (in Northern Territory) functionality.

Health Connect enables provders to use the Shared Electronic Health Record (SEHR). The 

Shared Electronic Health Record focusses on providing clinicians with clinical information 

across the continuum of care, from primary health care centres to hospitals. The current 

health profile is a summary of allergies, current medications, current medical diagnoses, 

observations and progress notes, together with hospital discharge summaries.

The Shared Electronic Health Record stores medical information to enable key clinical 

information to be available where and when the client needs care.

Communicare now supports v2.0 of the NT HealthConnect repository. Some of the new 

features are:

• Patient Search - when adding a new patient in Communicare, a search is performed 

at the HealthConnect repository if search details were entered in the Communicare 

patient search screen. If a match is found then the details of the match can be 

automatically entered in the patient biographics screen.
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• Bulk Consumer Home update - this is a process where all the patients with a 

HealthConnect ID and whose patient status is Current have their home health centre 

(NT Health Connect Site ID) sent to the repository.

• Notify of Medical Changes - this feature allows the provider to check if any of their 

patients have had updates on the repository by other providers.

• Consumer Home update - Communicare informs the repository if the home health 

centre changes for any of the HealthConnect patients ie. A patient's address changes 

where the new address locality belongs to a different locality group and that locality 

group is linked to an encounter place that is assigned a HealthConnect Site ID.

• Display Client - Communicare takes the user to the HealthConnect website to view the 

patient details. The 'NT HealthConnect registered status' button can be found on the 

patient clinical record screen.

• Current Health Profile (CHP) - This is a summary of a patient encounter that is 

optional to send to HealthConnect when the patient clinical record is closed. The 

'Send Current Health Profile to NT HealthConnect' button can be found on the patient 

clinical record screen.

Version 7.5

Release notes for V7.5.

Obstetrics & Pregnancy

This version introduces the Obstetrics &amp; Pregnancy tab for antenatal care. All female 

patients have this tab. See Obstetrics & Pregnancy help for further details.

Note that immediately after the upgrade to this version of Communicare no existing 

pregnancy outcomes or checks will have a pregnancy number. If appropriate, historical data 

may need to have the correct pregnancy number added.

Healthy for Life Reports

This version of Communicare introduces the reports to cover the essential indicators for 

Healthy for Life. Sites that use the ICPC2-Plus dataset and the Communicare Value Added 

dataset, make on-line electronic Medicare claims and receive electronic pathology results 

in the HL7 format will find the Childhood Health, Adult Health, Chronic Disease, Diabetes 

and Coronary Heart Disease indicators covered retrospectively. The Maternal/Antenatal 

reports will not be retrospective unless past data is re-entered using the new clinical items 

and qualifiers created for these reports.
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See Healthy for Life Reports for more details.

Contact COMMUNICARE on (08) 6212 6900 to discuss further issues of data collection and 

data conversion.

Service Activity Reports

The SAR and DASAR annual reports have been moved on the Report menu. Reports for all 

years can be found on the sub-menus of:

• Service Activity Report;

• Drug and Alcohol SAR; and

• Drug and Alcohol SAR Non Res.

Administrators of sites that do not require all these reports should disable the unnecessary 

reports at File|Queries|Import Query from file by unticking the Public checkbox.

See Service Activity Reports for more details.

Electronic Claims

• Specialist Services: There is now a button on the Medicare claim tab that will recall 

the details of the last referring provider for that patient.

• Receiving Medicare Australia notices: Medicare will automatically e-mail you notices 

about outages and other issues affecting on-line Medicare claiming if you register with 

them. The way to register is call 1300 550 115, give them your minor ID and then ask 

them to register an email address for notifications.

Version 7.4

Release notes for V7.4.

Appointments

There are many enhancements to the appointments book, including:

• reserving appointment slots at any time - no more booking in fictitious patients!

• merging two or more appointment slots into a single longer slot - no more booking a 

patient in twice for a long session!

• slots display the appointment length in minutes - no more mental arithmetic to find 

out how long an appointment is for!
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Electronic Claims

The time limit filter in the bulk bills status window has been adjusted to two years (for 

claims on or after 1st of April 2007) in line with recent Medicare changes. Claims made 

before 1st of April 2007 will be filtered for the previous six months.

Service Recording

• All encounters now have a comment box. The comment is visible in a column in the 

Service Recording window and whenever you edit a service. This comment should 

never contain confidential information but will allow reception staff to show extra 

information about waiting and booked patients.

• Requirements for a service can now be recorded in the same way as they can for 

bookings. Whenever a requirement (e.g. Transport, Fasting, etc) is recorded an 

exclamation mark icon appears in Service Recording in the column labelled Reqs. You 

can define your requirement types at File|Reference Tables|Requirements.

Progress Notes

• The progress notes tab now has a filter to allow you to see only your progress notes 

or only those of a particular speciality type (for example Dentist or General Medical 

Practitioner). When you open a new clinical record the filters default automatically 

to showing all progress notes. This change allows you to filter out your particular 

encounters with the patient or only those with, say, doctors.

• All progress notes, when opened up, now display the username, date and time when 

the progress note was first created and when it was last edited. This information is 

provided for historical progress notes also.

Investigations

There is now a plain paper radiology request form that can be used. It can be selected from 

the dropdown box next to the print button on the request form. To set this as the default for 

a specific lab adjust the setting in File|Reference Tables|Address Book.

New patients

From the Help button when searching for a patient or adding a new patient there is a link to 

print a blank form to give to the new patient to fill in their details:
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TO PRINT A BLANK BIOGRAPHICS FORM FOR A NEW PATIENT TO FILL IN go to Help|

Forms|Blank Biographics Form.

Version 7.3

Release notes for V7.3.

HACC (Home and Community Care)

HACC (Home and Community Care) Programs are run by many Communicare Clients 

to provide services to their aged community members. As it is a national government 

supported operation, HACC funded services are required to maintain information and 

accountability to the national body on their work. Communicare now provides the ability 

to record the HACC national minimum dataset requirements in your existing database, 

giving your organisation the benefit of a central place to record all HACC activities in your 

community, and report on these directly from the Communicare program.

There is a dataset of HACC items and a data export available. To commence using the HACC 

features at your site please contact COMMUNICARE to arrange.

Electronic Claims

• Enterprise Patient Validation (EPV): EPV is a new automated feature in Communicare 

allowing all patients' Medicare cards to be validated at once. Communicare uses EPV 

to validate all Medicare cards every month automatically, saving you time and hassle!

• ACIR General &amp; History Immunisation Claims (ACIR Claims): Have a look 

at this!!!! ACIR Claims are a new automated feature in Communicare allowing all 

patients' immunisations to be submitted to ACIR without further intervention from 

the user. Please see ACIR Claims for requirements on using it and to find out how this 

fantastic new feature can benefit your service.

Prescribing

• Dosage Instructions: Dosage instructions edit box has been increased in size to 180 

characters from 100. This will allow for longer instructions to be typed in.

• Drug Browser: Searching the drug browser now defaults to searching all products.

• Add to favourites: You can add a drug to your favourites list by right clicking the 

drug in the Drug Browser search window. This allows doctors to customise all their 

favourites in one go without actually prescribing.
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• Strength on authority window: The strength of the drug is now also displayed on the 

authority form for your convenience.

• Number of repeats: The default behaviour for number of repeats can be disabled from 

system parameters. This allows sites that do not want ever to give scripts that can 

repeat to turn this feature off. The default behaviour is still to get the number from 

the PBS data in MIMS.

• Printing labels: Labels can now be created and printed by Health Workers. Once the 

label has been printed the medication can no longer be modified.

HL7 Results

We have now added eGFR and PSA as pathology results that are automatically processed as a 

qualifier when sent by your pathology lab as a coded HL7 result.

NPCC Report

There is now an NPCC report that summarises all the data in one place and offers the 

calculated percentages. Run this from Report|NPCC|All the Measures.

Sensitive Information

The viewing right 'Other Sensitive Information' has been altered to 'Highly Sensitive 

Information'. Under this topic the following conditions are now included:

• HIV

• AIDS

• Hepatitis B

• Hepatitis C

Administrators should be aware that providers without this viewing right will not be able to 

see these conditions and will need to be given this right if necessary.

Investigations

• Doctors can now add a suitable recall to a patient's record direct from the review 

results window without having to open the clinical record. To shortlist commonly used 

recalls ask your Administrator to add the keyword $IxRecall to the appropriate items.
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• Users with the 'Investigations View' viewing right but not the 'Investigations' system 

right can now see the unreviewed results in the in-tray but cannot review them. 

This will allow, for example, nurses to monitor incoming results prior to the doctor 

reviewing them.

• The source lab's name is now displayed at the top of the result.

Version 7.2

Release notes for V7.2.

Patient Search

Administrators can specify a clinical item group to be used to identify patients in the patient 

search window. Any patient with a clinical item belonging to the specified clinical item 

group will show with the details panel highlighted in gold.

The first step is to specify the clinical item group on the Patient tab of the System 

Parameters form (File|System Parameters). If a suitable group does not exist then define 

your own group in File|Reference Tables|Clinical Item Groups and add items to the group 

using File|Reference Tables|Clinical Item Types - select each item and use the Groups tab to 

indicate that it belongs to your new group.

When a patient is selected in the Patient Search window, if that patient has a clinical 

item in the specified group then the details panel is highlighted in gold. The user does 

not know which clinical item group has been specified to indicate the patient, so patient 

confidentiality can be respected.

This functionality can be used, for example, to indicate to reception staff that the selected 

patient should be dealt with differently. Selecting the ICPC2 group 'CHRONIC CONDITIONS 

(ALL)', for example, will indicate all patients with a chronic condition diagnosis so that they 

can be 'fast-tracked' to a doctor.
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Electronic Documents

Communicare is now able to receive electronic documents that have been sent in HL7 

format. Your administrator should arrange for the sending software (such as healthLINK) 

to put such documents into the same folder that receives investigation results (usually \\\

\servername\\results). Communicare will process the files. Such documents must adhere to 

the Australian Standard for sending HL7 files (AS4700.6-2004 V2.3.1 - Referral and discharge 

summary) or be a hospital discharge letter as sent by healthLINK.

Documents such as hospital discharge letters and specialist correspondence will appear 

in the Communicare In-tray under the Other Documents tab and should be reviewed by a 

qualified provider in the same manner as investigation results.

These documents will appear in a patient's clinical record as soon as they have been matched 

to the correct patient. They are visible in the detail tab when using the Class view under 

Documents. In addition, the most recently arrived document can be found using the link on 

the Summary tab (Last document added on D/MM/YYYY).

Automatic Scheduling of Reports

Communicare's SQL reports can now be scheduled for automatic running and e-mailing of 

the reports to designated recipients. The scheduling is organised at Tools|Scheduled Reports. 

See Report Scheduler for details.

Version 7.1

Release notes for V7.1.

Clinical Record Windows

This version of Communicare allows some forms in the clinical record to remain open whilst 

consulting the clinical record. The forms that can now remain open are clinical items, 

progress notes and documents. Note that only one of each type can be open at one time (i.e. 

a clinical item must be saved before opening a different one).

To help you maintain multiple windows, whenever you open a progress note, clinical item 

or document, a floating window appears letting you know what windows you may have open 

(especially as they may be in the background):

258 Integrated Team Care



The above image shows that a progress note is open and a letter is open. Clicking on one of 

the 'active' buttons brings that form to the front. The floating window disappears when there 

are no such forms open. You can move the window but it remains on top of other windows 

whilst it is open.

Browsing the Clinical Record

Right-clicking on any item in the main summary, medication summary or detail page allows 

you to choose 'Find Associated Service Details'. This will take you to the progress notes and 

details of the service in which the item was added. This can be especially useful when you 

wish to find more information about a diagnosis, say, or prescription, beyond what has been 

recorded in the comment field.

Age Specific Qualifiers

Administrators can now design clinical items with qualifiers that only appear for the user if 

the patient is within a specified age range. For example, a child health check can be designed 

so that the Head Circumference qualifier is only visible if the patient is under three years 

old.

Triggering Recalls with Qualifiers

Responses to qualifiers in a clinical item can now trigger automated recalls. For example, 

the response 'Smoker - wants to quit now' for the 'Smoking status' qualifier could trigger a 

recall for 'Advice/education;smoking'. The recall is triggered immediately after the response 

is made and can be accepted, changed or cancelled in the usual way.

Administrators can create automated recalls of this type at File|Reference Tables|Automated 

Recall Types - add a new item and select 'On Qualifier' then specify your details.

New Current Status

In addition to 'Current Patient', 'Past Patient', etc, there is now a new status of 'Non Patient'. 

This allows for people other than patients to be defined. For example, a patient's carer can be 

added, or a patient's parent that does not use the service. Some agencies require biographic 

details of such people and this allows them to be recorded.
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New Qualifier Type

We have introduced a new qualifier type of 'Person'. Creating a qualifier of this type will 

present the user with a patient search form to select any person in the database. This type of 

qualifier is designed to allow, for example, a carer for a patient to be specified.

Investigations

Previously, a red link appeared on the summary page of the clinical record if there were 

unreviewed results in a patient's clinical record. Clicking the link took you to the first 

unreviewed result. This behaviour has now been enhanced so that if there are unreviewed 

results the link is red and labelled 'Unreviewed investigation results'; if there are no 

unreviewed results but there are outstanding requests the link is labelled 'Outstanding 

investigation requests' in purple and clicking the link takes you to the first outstanding 

request; if there are no unreviewed results or outstanding requests the link is labelled 

'Investigations' in blue and clicking the link takes you to all that patient's results. A clinical 

record with no outstanding requests and no results has no such link.

Matching Investigation Results

When an investigation result arrives for a patient who is not in the database and you wish 

to add that patient with the details provided in the investigation result, the 'New Patient' 

button from 'Match Patient' will copy name, gender, date of birth, address and Medicare 

details into the form.

Prescribing

The Medication Summary shows regular medications that have 'expired' with a red date. 

From this version, regular medications that are due to 'expire' within the next 28 days 

appear with an orange date. This is to alert prescribers to the imminent expiry of a regular 

medication.
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Clinical Item Procedures

In the same way as a Referral item shows a 'Save & Write Letter' button, any procedure 

that has had a specific letter template type attached will show the button also. Thus, the 

administrator can design a clinical item that is a health check and attach the letter template 

type of Health Check Report. An example of this is the Check up;aboriginal &amp; TI child 

{708} which shows the 'Save &amp; Write Letter' button so that the provider can select an 

appropriate health check report.

Note to administrator: to enable this behaviour on an item go to File|Reference Tables|

Clinical Item Types, edit the item and click the 'Advanced' button. Select the letter template 

type from the dropdown box.

Reports

• Communicare will now 'remember' values entered into parameters for SQL and 

QueryBuilder reports. This is very helpful when running a report multiple times or 

running many reports with the same parameter details. Report designers may wish to 

review locally created reports to check that parameter names are consistent.

• Reports can be exported straight to Excel without using the Advanced button and 

clicking through the options. Dates are successfully exported in DD/MM/YYYY format.

Patient Biographics

Marital status, country of birth and language can now be recorded in a patient's biographics. 

If a patient already has a place of birth recorded and this is recognised as being in Australia 

then 'Australia' will be entered as the country of birth. To see all countries or all languages 

tick the checkbox on the right of the dropdown box. 170 Aboriginal languages are included.
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Whenever a new country or language is selected by any user it is automatically added to the 

'shortlist' to save you looking for it in future.

CentreLink and DVA card numbers have been revamped. There is a dropdown box to specify 

card type as well as number and expiry.

Version 7.0

Release notes for V7.0.

This version addresses minor issues relating to Communicare's standard reports..

Version 6

Release notes for version 6 releases.

Version 6.7

Release notes for V6.7.

Medicare Claiming

A label above the 'Claim' buttons shows the name of the claiming provider and the duration 

of the service (that is, the time in minutes that the clinical record was open in the name of 

that provider). These details can be edited on the Detail tab before claiming.

This is very useful for the claiming doctor because it indicates the duration of the service 

and can help when selecting an appropriate time-based item. It is also useful when there are 

multiple providers with provider numbers on the service - only one can make the claim.

Prescribing

• Prescribers can now choose to enter an 'until' date instead of the days supply. Also, 

the days supply can now receive values in days, weeks, months or years by entering a 

value followed by d, w, m or y. If only a number is entered Communicare assumes it to 

be days. Changes to the days supply will automatically adjust the until date and vice 

versa.

• All prescriptions are now dated to the date of printing. if a prescription is created but 

not printed on that day, the date will be changed if the prescription is printed on a 

subsequent day.

• The date of a prescription can manually be adjusted allowing for the entry of historic 

records. It is not intended that such prescriptions would be printed.
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To Do List

The To Do list in the clinical record shows recalls and incomplete referrals. A filter checkbox 

allows the user to see all recalls and incomplete referrals or just those up to one year ahead. 

Overdue items appear with a red date.

Both recalls and incomplete referrals are managed similarly. Double-clicking allows you to 

complete or adjust a recall or incomplete referral. A recall is removed by either completing 

it or cancelling it if it is no longer required. A referral is removed by either providing a 

completed date or cancelling it.

The date of a referral is either the recall date (if it is also a recall), or the referral date (if 

the referral process has been started) or the appointment date (if this has been recorded). A 

completed referral is visible in the Detail tab of the clinical record.

Please note that this version of Communicare may reveal some old referrals that have 

an incomplete status. These referrals date from previous versions and configurations of 

Communicare that did not require providers to declare the outcome of the referral process. 

Providers should manage them by cancelling or completing appropriately.

Contact COMMUNICARE if you require further help addressing these 'old' referrals.

Investigation Requests

Requests can now be printed to pre-printed laboratory request forms. The dropdown box 

next to the Print checkbox offers a choice. Each pathology provider can be given a default 

format by indicating this in the Address book entry for each pathology provider.

Adjusting the position of the details for the pre-printed form can be done from the System 

Parameters form. Please consult your administrator.

Biographics

The biographics for deceased patients now has a label showing the date of death.

Reference Tables

Provider names on the Provider reference table have been re-formatted as Forenames and 

Surname. The upgrade will have taken the last name as the surname and all other names 

as the forenames. Administrators should check that provider names where the last word is 
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not the entire surname (e.g. 'Martin von Schmidt', 'Roger Jones MA', 'Sally', etc) are adjusted 

manually.

Lifescripts

There are now letter templates for the five Lifescripts - Smoking, Nutrition, Alcohol, 

Physical Activityand Weight Management. These can be selected by adding a new letter.

Reports

As part of continuing development Communicare often distributes useful reports as part 

of an upgrade. Administrators should run the Report at Report|Reference Tables|Report 

Comments and review any new reports and their descriptions. This report has just been 

updated to include available QueryBuilder comments. Use it to identify local reports that 

may be lacking a comment.

There are new reports on the Population Analysis menu that break down statistics by gender, 

aboriginality, locality and age groupings specified by the user. New Performance Indicators 

reports address NT key performance indicators.

Administrators should also check any local SQL reports that use the Provider dropdown box 

parameter. They will need to be adjusted. Find the line

select cast('\<All Providers\>' as Char(60)) provider_desc,

in the PROVIDER parameter definition and edit it to

select cast('<All Providers>' as VarChar(40)) provider_desc,

to account for a database change.

Miscellaneous

There have been various minor and cosmetic enhancements.

Version 6.6

Release notes for V6.6.

Prescribing

Stopping medication is now a fully implemented feature.

264 Integrated Team Care



In order to stop a medication you have to right click on the active medication on the 

Medication Summary tab in the clinical record and select stop medication from the popup 

menu.

System Access Rights

From this version access to Electronic Documents (letters) will not be granted to groups with 

Document Scanning rights. They must have the Electronic Documents system access right in 

order to see Electronic Documents.

Tractor Fed Prescription Labels

Tractor Fed prescription labels can print multiple copies based on system settings.

The number of copies has to be configured in system parameters.

It prints multiple copies only when you print a label for the first time. Reprint only prints 

one label.

Referral Clinical Items

When adding a referral clinical item you can choose to create the referral letter directly from 

the clinical item. This will prompt for a referral template and create the referral letter.

Document Templates

Document templates now require a document type. All templates must have an appropriate 

template type in order to be used correctly.

This means that referral document templates must have the type Referral Letter, care plan 

templates must have the type Care Plan Template and all normal letters use the type Letter.

<color Red>Note to Administrators: to use the feature for creating Referral Letters from the 

Referral Clinical Item you must update your templates accordingly. Use Tools|Communicare 

Templates and double-click on each of your referral templates and change the Document 

Type to 'Referral Letter'.</color>

Electronic Documents access rights

Electronic Documents have access rights attached just like progress notes. Unlike progress 

notes it is allowed to have no access right attached until the document is reviewed.

(c)Telstra Health | Communicare 265



Electronic Documents behavior

All Letters are now outgoing and the user cannot change them to incoming.

P2P messaging

Peer to peer messaging has been implemented in Communicare following TEDGP 

specifications. This means electronic documents can be received directly from agencies 

that are part of the P2P project. Although Communicare is able to receive documents 

electronically via secure email, these documents must be in HL7 format.

Central Update

This version introduces a health check to cover items 700 and 702 for patients over 75. It 

behaves in the same way as the aboriginal health checks for adults (710), children (708) and 

over 55's (704, 706).

Version 6.5

Release notes for V6.5.

Communicare In-Tray

This version of Communicare merges the Review Results form and the Process Documents 

form into a single in-tray.

Central Update

This version introduces a health check to cover items 704 and 706 for aboriginal patients 

over 55. It behaves in the same way as the health check for adults (710) and children (708).

Exam;pre-consult: Also added is a pre-consultation examination (similar to items such as 

General Observations or Health Worker Check created locally) which can be used at sites 

where patients are checked by health workers before seeing a doctor.

Assessment;hearing: There is also now a comprehensive hearing assessment.

Check up;antenatal: This item now has comprehensive qualifiers appropriate to monitoring 

anetnatal care.

All the new items above can be easily found on the 'Check up' clinical item button in the 

clinical record. If any of these items are not required then they can be disabled by the 

Administrator.

266 Integrated Team Care



Shortcut keys

The address book is now called using Ctrl-Alt-B instead of Ctrl-A. QueryBuilder is now called 

using Shift-Ctrl-Q instead of Ctrl-Q.

Miscellaneous

Various issues relating to document scanning and prescription re-printing have been 

addressed.

Version 6.4

Release notes for V6.4.

Prescribing

Doctors are no longer forced to enter a Days Supply for a medication. If no Days Supply 

is entered the user is prompted to enter a value. The user can ignore this prompt. 

Communicare will then apply a default behaviour that makes the medication current for 30 

days for each repeat specified.

Address Book

This version of Communicare makes changes to the address book in preparation for peer-to-

peer messaging. It also adds extra fields for address information, such as e-mail address and 

contact name.

Administrators should check that the address book is up-to-date. The main item to check 

is that address line 2 has been successfully translated into the correct locality and state. If 

address line 2 is now a duplicate of the locality and state then it can be cleared.

Note that either the person name or the organisation can be empty but at least one must 

have a description. Where appropriate, Communicare displays the person name if there is 

one, otherwise the organisation.

Care Plan Monitoring

A new report at Report|Documents|Added Between Two Dates will allow managers to report 

on care plans added between two dates. The report is also flexible enough to cover other 

types of document.
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Reports

Any locally created SQL reports that search for the REFERRAL_TO_TYPE table should be 

edited to look now for the ADDRESS_BOOK table. This may affect referral, admission and 

transport reports.

Locally created Query Builder reports that use the Clinical Record model and also select from 

the REFERRAL_TO_TYPE table will need to be tested and repaired.

The administrator should contact COMMUNICARE for further help and advice if required.

Version 6.3

Release notes for V6.3.

Electronic Claims

• Processing and Payment reports are now merged into one and the new button has 

been named Get Reports. This will automatically retrieve the processing report and if 

successful it will get the payment report.

• Every morning Communicare will automatically get the reports for all claims not 

processed yet. This means the users no longer need to run the reports manually. It is 

still very important that the Electronic Claims Administrator checks the current status 

window for errors.

Communicare buttons

Where appropriate, OK buttons in Communicare that save data to the database are now 

labelled Save rather than OK.

Reports

Some standard Communicare reports on the Patients menu have been moved to the 

Population Analysis menu. They are the reports that only show counts of patients rather 

than lists of patients' names and details.

Clinical Record Buttons

The buttons to add a new scanned document and add a letter have been moved to the left for 

consistency.
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MIMS

Users can now search for generic drugs using synonyms.

MIMS Consumer Medicines Information

There is a new button  in the drug browser and on the medication details form that will 

show the MIMS Consumer Medicines Information for the selected medication.

Clinical Record Detail Tab

This page of the clinical record has been redesigned to better display items and their details 

- the extra details, such as provider, service and qualifiers, now appear on the right instead 

of at the bottom.

Child Health Check

Sites that import the EPC dataset can now have a child health check to cover item 708 

(claimable since May 1st for Aboriginal children under 15 years old).

Progress Notes Access Rights

Administrators can now define a default access right for a user group's progress notes. This 

is done by using File|User Groups and selecting the Clinical item Rights tab. For a user group 

selected at the top you can specify which of their access rights is to be used as a default by 

using the checkbox under 'Default'. If no default is specified then Communicare will use 

'Common' or 'General' as the default, if they are allowed for that user group, otherwise the 

first right they are allowed will be used.

Communicare Standard Reports and Templates

Communicare regularly distributes new reports and letter templates when a site upgrades. 

The 'owner' of these reports is MEDISYS. Site administrators should find these reports using 

File|Queries|Import Query from file and untick the Public tickbox if the reports are not 

applicable at your site (for example, the DASAR, DATS and Drug and Alcohol reports only 

apply to residential drug and alcohol centres). Similarly, letter templates not applicable 

at your site should be found using Tools|Communicare Templates and made not public by 

double-clicking and unticking the Public tickbox.
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Note:

If a standard report or template is made not public it will remain so after a 

Communicare upgrade. If a report or template is deleted it will be reimported 

following a Communicare upgrade.

Version 6.2

Release notes for V6.2.

IMPORTANT

Before upgrading Communicare to this version administrators should run the report at 

Tools|Database Consistency Check and address any patient biographics with the message 

'Structure Incomplete. Please Edit this patient's biographic details' or 'Update Failed. Please 

Edit this patient's biographic details'. These may be the result of duplicate patients or 

patients with missing mandatory details.

Care Plans

This version of Communicare introduces a Care Plan tab to the Summary page of the Clinical 

Record.

Family and Social History

This version of Communicare introduces a Family and Social History tab to the Summary 

page of the Clinical Record.

Recalls

Recalls can no longer be deleted from the Clinical Record. Users are prompted to cancel 

recalls instead.

Recalls are now ordered ascending so that the longest overdue are on top.

Incomplete Referrals

Incomplete referrals now also appear on the summary page with the recalls.

Electronic Claims

The MBS Schedule in Reference Tables now orders by category number and group number 

rather than ordering alphabetically. Items deleted by Medicare Australia are shown in grey 
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(note that this will not be effective until the next MBS update - you should re-import the 

latest schedule if you wish to see the changes now). Deleted items are still available for 

claims entered retrospectively.

Prescription Labels

Support for tractor fed labels has been added to Communicare. Your system administrator 

can enable the new label printing in system parameters.

Request Remote Assistance

Communicare has a new feature under the Help menu called Request Remote Assistance. 

This allows a user to invite a Communicare Helpdesk operator to see and control their 

computer and provider 'live' assistance.

Documents

All documents (letters and scanned images) can now be given an access right. This means 

that letters of a sensitive nature can be given restricted access.

Letter templates

There are many more letter items that can be used when designing letter templates, such as 

patients' first name in proper case (useful when addressing letters to patients), his/her item, 

provider speciality and patient's medical record number and pension number. Note also 

that carriage returns have been removed from the end of most letter items. Administrators 

may wish to review any templates they have designed in order to adjust layout and take 

advantage of new letter items.

Medication Interactions

A new helper module for the Prescribing module has been implemented. Medication 

Interactions is based on the MIMS Drug Alert database and is intended to help doctors view 

interactions between generic classes. This tool cannot replace medical knowledge and it is 

the doctor's responsibility to check if there are more interactions than those the computer 

can see.

Medications Reports

Administrators should check any reports they may have made that use the MIMS interaction 

class tables. The following changes in tables and fields should be noted:
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The fields GENCODE and CLACODE from the table MIMS_GENCLA have been 

replaced by the fields GENERICCODE and DRUGINTERACTCLASSID from the table 

MIMS_DRUG_GENERIC_ROUTE_INTERAC.

The fields CLACODE and CLADESC from the table MIMS_CLASSES have been replaced 

by the fields DRUGINTERACTCLASSID and DRUGINTERACTCLASSEN from the table 

MIMS_DRUG_INTERACT_CLASS.

Communicare Logon

Spaces are no longer allowed to be typed in passwords. Users could insert spaces when 

setting up their password and create invalid passwords so hey could never logon to 

Communicare.

Medicare Claims History

There is a new button in the Clinical Record  that allows a provider to see all Medicare 

items previously selected for claiming for that patient. This includes all items marked for 

claiming, whether or not they have been submitted, processed or paid.

Version 6.1

Release notes for V6.1.

Data Entry Wizard

This version introduces a new, simpler way of recording a clincal item in multiple 

patient records. The Data Entry Wizard  (on page )  can be used when a provider has 

performed a procedure for a group of patients. For example, an immunisations nurse may 

have visited a community and given Fluvax jabs to twenty patients. This method allows the 

nurse to select a date, then the clinical item, then select the patients one after the other. 

Access to the Clinical Record is not required so this method will save time. The Data Entry 

Wizard can also be used by non-medical providers to record items in a patient's record 

without having the right to open clinical records.

The Communicare Administrator should contact Communicare Systems for an access code to 

enable this module and give rights to users.
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Patient Labels

There is now a third standard patient label  (on page )  design suitable for Avery L7163 

labels (14 to a sheet of A4). These labels are larger than the other labels available and 

contain more address, contact and card details.

Data replication

Brand new data replication client. This replaces the old data replication client.

Old replication clients must be fully uninstalled before the new one is installed.

Electronic Claim Reports - Medicare Australia

Added optimized reports to help reconcile and manage the claims that have been paid by 

Medicare Australia.

Performance improvements

Major optimization done for remote connections over a VPN. Communicare can be now used 

with good performance, in a Client-Server configuration, over a VPN connection with an 

average round-trip latency of 45ms.

Many minor cosmetic optimizations in the visual interface.

Version 6.0

Release notes for V6.0.

More flexible buttons

Both 'local' and 'central' Clinical Item Types can now be added to centrally maintained 

Clinical Item Buttons, which appear at the bottom of the clinical record. You can of course 

still create your own buttons and freely add Clinical Item Types to those buttons.

This button bar is now also available at the bottom of all tabs in the clinical record.

These changes make accessing commonly used clinical items even easier than before.
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Prescribing

Regular medications prescribed by brand that are subsequently deleted from MIMS can more 

easily be replaced. When the medication is being prescribed generically no action is now 

necessary.

Medicare Australia's Online Claiming

Changes have been made to Medicare bulk bill claiming more robust.

System Infrastructure

There have been significant changes 'behind the scenes' to optimize the speed of 

Communicare over local and remote networks.

Logging

CD Backup now keeps a log for the last 14 backups (2 weeks) on the server.

Version 5

Release notes for version 5 releases.

Version 5.9

Release notes for V5.9.

Investigation Requests

The means of selecting investigation tests has been greatly improved. There is now a 

keyword search box which will accept up to two keywords separated by a space (e.g. ANTIB 

DN). The keyword search includes all enabled tests not just the shortlist (which still appears 

when creating a new request).

Users can add new keywords to a test at File|Reference Tables|Investigations|Investigation 

Keywords. For example, attaching the keyword ANTENATAL to all common antenatal tests 

will mean that using the ANTENATAL keyword will present a short list of just those tests. 

This will allow the doctor to quickly select the antenatal tests required without further 

searching.
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Drug Browser

Sites can now choose to present generic names in the Drug Browser instead of brand names. 

This feature is turned on in the System Parameters form and can be overridden by a user 

using a checkbox in the Drug Browser.

Automatic Patient Status Change

This feature can now be disabled by removing the Inactivity years value in the System 

Parameters form.

Investigation Requests

Pending acceptance by your pathology lab a site can choose to use Bulk Assignment Request 

Forms. These have the label 'Bulk Assignment Request Form' and are not required to be 

signed by a doctor. This feature is turned on in the System Parameters form.

Standard Reports

Some standard reports with missing subtitles have been repaired.

Version 5.8

V5.8 is a major release to coincide with updates to MIMS.

Schedule 8 Medications

Standard prescriptions are now printed with extra information that is intended to address 

prescription forgery: the patient's date of birth; a repeat interval (specified in days) if repeats 

are prescribed; and precise directions for use.

Miscellaneous

Some minor issues have been addressed.

Version 5.7

Summary By Default

The behaviour whereby certain clinical item types can be set to display on the Clinical Item 

Summary by default can now be disabled.
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Summary by default has been disabled for all users of ICPC terms. If you use ICPC and want 

items to be placed on the clinical items summary by default, then you must re-enable the 

option in system parameters. We strongly recommend that ICPC users do not re-enable 

'summary by default'. When adding a diagnosis to a clinical record, the clinician should 

decide whether it should be placed on the summary. The decision should be based on the 

individual client's condition and other items already on the summary.

Clinical Record Summary Tab Changes

To reduce congestion on the summary tab and to make space for new features currently 

under development, the medication summary has been moved onto its own tab.

Letter Writing Improvements

Letter writing has been fully implemented. Some templates will be centrally distributed and 

users can create their own templates.

The Reference Table Referral/Admission/Transport Place has been replaced with the Address 

Book. By double-clicking on a record address details can be entered or edited. This will need 

to be maintained so that letters can be appropriately addressed.

Templates are created and edited at Tools|Communicare Templates. Reference Tables system 

rights are needed to be able to use this feature. See the help by clicking here.

Define your own letterhead in System Parameters. See the section Devices in System 

Parameters by clicking here.

Northern Territory Health Connect improvements

New feature added in Communicare to enable sending pathology results to NT Health 

Connect.
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Additional MBS Item Claims for Bulk billing

Communicare will now prompt, and automatically add an MBS 10990 or 10991 items to 

claims for clients under 16 or who have a Health Care Card. This feature claims 10991 by 

default. The item to be claimed can be changed on the MedClaims tab of System Parameters. 

Set the item to null to disable the feature.

After Hours MBS Item Claims

Claims for items 3, 23, 36 or 44 will prompt for an automated change to item 5000, 5020, 

5040 or 5060 respectively when the service is on a Sunday or public holiday, is before 8 AM 

or after 1 PM on a Saturday or after 8 PM on a weekday. The Public Holidays reference table 

must be kept up-to-date for this feature to work correctly.

Patient Query Report

The Patient Query Report now includes a selection for 'Current Patient Status'.

Recalls

All Referrals and Procedures are now automatically recallable. There is no longer any need to 

set the 'Recallable' tickbox in the Clinical Item Type Maintenance window.

Immunisations

A number of new attributes have been added to Immunisations. This change is intended 

to facilitate the change to standardised recording of immunisations and ultimately the 

electronic exchange of immunisation data with ACIR. The new fields include data specified 

by the Australian Immunisation Handbook, such as Route and Site, Sequence, Where 

performed, Batch, and Expiry.

Immunisations Central Dataset

A centrally maintained dataset of all Australian Immunisations has been developed and is 

ready for distribution. This dataset has been compiled from information from ACIR and 'The 

Australian Immunisation Handbook - 8th Edition'.

Incremental Searching in Qualifier Dropdown Lists

The dropdown lists are now incrementally searched. This allows rapid data entry by reducing 

the need to scroll through lists to locate items.

(c)Telstra Health | Communicare 277



Provider Names linked to Logon Username

In the provider maintenance window, a provider may now have a logon username specified. 

If specified, the default provider name can not be changed while the user is logged on. 

This change addresses issues of default provider names being changed (and saved) when a 

different user uses a workstation without logging off the previous user.

Providers can still be freely changed within a service, regardless of this option.

Note: All users who use HIC Online Bulk Billing will have this option enabled.

New Referral Attributes and Status Calculation

New attributes have been added to referral clinical items for Appointment date, Escort, and 

Referral Completion date. These attributes are now used to calculate the status of a referral, 

removing the need to manually set the status using the (now absent) radio buttons.

This enhancement paves the way for many new, more powerful referral management reports.

Miscellaneous

Many other minor improvements and bug fixes have also been made. Full details are 

available on request.

Version 5.6

Release notes for V5.6.

HL7 Results and Qualifiers

In addition to HbA1c, the following qualifiers are now automatically imported into a 

patient's clinical record if your site is receiving HL7 results electronically:

ALP (Alkaline Phosphatase); ALT (Alanine Aminotransferase); Free T4 (Free Thyroxine); 

GGT (Gamma Glutamyl Transferase); Hb (Haemoglobin); TSH (Thyroid Stimulating 

Hormone); Urate (Uric Acid); Urea (Urea Nitrogen); INR (International Normalised Ratio); 

Transferrin Saturation; Ferritin; Transferrin; PT (Prothrombin Time); Iron; ACR (Alb/Creat 

Ratio); HDL level; LDL level; Total cholesterol level; Triglyceride level; Total cholesterol/HDL 

ratio; Blood glucose level - random.

Administrators should run Report|Reference Tables|Numeric Qualifiers to see if any of 

these qualifiers should replace a locally maintained qualifier. The local qualifier should 
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be renamed with the same name as the Central qualifier and '[1]' appended. Now run the 

Terms Converter to convert qualifiers by description. Contact COMMUNICARE for further 

information.

Clinical Items and Qualifiers

Qualifiers attached to a clinical item now appear together with details of the clinical item. 

This allows for greater ease of use by providers and cuts down the number of mouse clicks 

required to record, say, a check up.

Creating Menu Buttons for Clinical Items

Administrators can easily create menu buttons for adding frequently used clinical items. 

Adding a keyword such as '$Check up' to commonly used check up items will instantly 

create a button at the bottom of the Summary page of the clinical record called 'Check up' 

containing items that have that keyword:

Users need only to click the button and select the item. This is a great way for providers to 

see all the items they need to perform particular specific tasks.

Note that ICPC2-Plus terms can also be managed in this way, not just local terms.
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Automatic Patient Status Change

The automatic updating of patient status has been upgraded to move patients to Transient 

and back to Current status as required. This feature makes use of the locality group Health 

Service Area, so it is important to keep this group up-to-date. Refer to the Automatic Patient 

Status Change topic for full details.

Miscellaneous

A number of minor improvements have been made to streamline performance in on-line 

claiming, investigations, prescribing and other key areas.

Version 5.5

Release notes for V5.5.

Investigations

There have been major changes in the way that investigation requests and results are shown 

in the clinical record.

Requests and results appear on different tabs in the class view. Results appear with the name 

of the test as shown in the result. Requests appear once for each printed request with the 

individual tests requested appearing in the detail panel to the bottom left of the detail tab. 

Unmatched requests no longer appear with a red status but can be found in the reports at 

Report|Investigations.

Reviewing a result from the review results window assumes a 'no client contact' service for 

the place selected as the default on the main toolbar. You may change this if appropriate. 

If the mode is left as a 'no client contact' mode then the Medicare details will assume the 

service is not claimable and mark it as such.

This version of Communicare can now support HL7 format results. Initially, HbA1c results 

will be automatically added as qualifiers and thus be available immediately on charts. This 

will extend to other qualifiers in later releases of Communicare.

System Rights and Clinical Item Rights

The right to view investigations but not process them is now a Clinical Item Right rather 

than a System Right. Users with only Investigations View have had their rights transferred 

and users with Investigations have been granted the Investigations View clinical item right. 
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A user group with Investigations system right should always have the Investigations View 

clinical item right.

Electronic Claims

There have been improvements to the claiming interface:
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Note that the Claim button has been replaced by three buttons which are only available on 

the Medicare tab. The 'Claim now' button allows you to claim now, a 'Claim later' button 

allows you to make the claim later and the 'Not claimable' button will set the service as not a 

claimable service. At a later stage you can edit this service to make a claim by unticking the 

'This service is not claimable' tickbox and submitting your claim.

When the 'Claim now' button is clicked the actual claim is not transmitted to the HIC for 

an hour. During this time a provider can edit the claim (for example, by adding a 10991 

item) and press the 'Claim now' button again - this will update the claim. If this is attempted 

after an hour after the initial claim and the claim has been transmitted then the user will be 

alerted that the amended claim cannot be made.

There is also a new system right to allow a group of users the rights to maintain the HIC 

Online module without the need to log on as Administrator.

Centrally maintained items

In addition to the 710 Aboriginal and TI Health Check we now distribute an Immunisation 

Review plan.

ICPC2-Plus immunisation items are now also distributed with the central update.

Contact Communicare on (08) 6212 6900 for details.

Clinical Item Types

There can now be more than one clinical item type with the same name but only one of them 

can be enabled. This will allow you to, say, disable a central item and create a local item with 

the same name. This update strips the [1] from items with otherwise the same name and 

makes sure that only one is enabled.

Administrators need to check that any reports they have that explicitly look for a term with 

[1] are adjusted accordingly.

Reports

The report Electronic Claims|Patients with Invalid Medicare Cards has been removed. Please 

now use the report Patients|Invalid Medicare Details to find patients with invalid Medicare 

cards.
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Version 5.4

Release notes for V5.4.

Health Checks

There have been many changes to the way clinical items and qualifiers can be designed. 

Recalls for a health check for example can be designed so that the recall is not completed 

until all required qualifiers have been completed within a predetermined time frame. The 

clinical item can then be linked to an MBS number. These changes allow the Aboriginal and 

TI Health Check to be implemented within Communicare. Contact Communicare for details.

Letter Writing

A beta version of letter writing is included in this version.

Default Settings

All users may notice after the upgrade to this version that Communicare will intially revert 

to default settings for such things as sizing and placement of forms, printer assignments and 

dates in reports. Once you have reset these they will continue to be remembered.

Provider Specialities

26 new specialities have been added from the Australian Standard Clasification of 

Occupations (ASCO). All of the ASCO Health Occupations are now included. Some of the 

existing specialities have been renamed to make them easier to find. For example, 'Medical 

Practitioner - GP' has been renamed 'General Medical Practitioner'.

Miscellaneous

There have been a number of minor fixes and improvements.

Version 5.3

Release notes for V5.3.

Qualifiers

A new button on the qualifier window of a clinical item allows you to view all previous values 

of that qualifer and see them in a chart.
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Investigations

• When a clinical record has unreviewed pathology results a label on the summary page 

alerts the user to this. Clicking the label takes you to the unreviewed results.

• Requests and results can be logically deleted from a patient's clinical record. To 

undelete a result you can go to the Review Results window and select the result using 

the Deleted filter.

• If an investigation result is returned from the pathology lab with an unrecognised 

reference number Communicare will show all unmatched requests.

Rural Prescription

• You can now reprint a rural prescription by right-clicking on a regular medication on 

the summary tab and selecting Reprint Rural Prescription. There is also a tickbox for 

the mode of dispensing to be indicated on the printed form and the patient ID is now 

shown too.

• When a new regular medication has been added or the details, such as dosage, 

have changed for an existing regular medication then this is indicated on the rural 

prescription form. Also, the reason for the prescription is indicated if a condition has 

been selected.

HIC Online

• If a Medicare claim has been submitted then the Medicare claim window is not shown 

every time a provider returns to that service.

• Health Care Card details are now displayed in the Medicare claim window.

• Patients deceased for more than 6 months do not now appear on the Bulk Bill Status 

form.

Prescribing

A provider with no prescriber number will be prevented from recording a new medication 

which requires an authority.

Version 5.2

Release notes for V5.2.
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Clinical Item Type Groups support has now been extended

• Groups can now be used to trigger recalls. For example the group DIABETES (NON-

GESTATIONAL) can be used to trigger diabetes care plans. This greatly simplifies the 

maintenance of recalls that require multiple triggers.

• A keyword driven browser is now available to select a group. This is useful when 

maintaining Automated Recall Types or generating reports.

New Reports

New patient reports have been added which allow list of patients to be created according to 

clinical item groups. For example, list patient who have any condition within the DIABETES 

(NON-GESTATIONAL) group.

SQL Reports

• SQL Report parameters can now use dropdown lists and pop-up browsers. For example 

a Provider Activity report can have a dropdown list to select a provider. A patient 

based report can use the usual patient search pop-up window.

• Advanced users can now design and edit SQL reports from within Communicare. This 

speeds up report development even further!

Service Recording Filters

• The filter settings in the Service Recording window have now been separated from the 

default Provider, Place and Mode displayed on the main toolbar. This allows filters to 

be different to defaults. You may now, for example, display all waiting patients (all 

providers) but still enjoy the benefit of defaulting services to yourself.

• Patients waiting with no provider allocated will be displayed regardless of specific 

provider filters. This removes the risk of patients who have not been assigned a 

provider being left waiting because no provider sees them listed in Service Recording.

• New filter setting of All Modes for a specific Place is now available.

Other

The MBS Maintenance window can now locate an MBS Item by number as well as by 

navigating the hierarchy. This can make it much easier to locate an item for short-listing 

when only the number is known.
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Version 5.1

Release notes for V5.1.

Prescribing

The MIMS drug database has been substantially improved and Communicare is making full 

use of the new tables provided by MIMS.

To use the new version of Communicare you must use the February 2005 update of the 

December 2004 version of MIMS or later. The February update has been included in the 

Communicare Software CD for your convenience.

If you do not use the Prescribing module then these changes will not affect you.

Version 5.0

Release notes for V5.0.

Electronic Claims

• It is now possible to claim an item that is not shortlisted. Select the item number you 

want to claim and click on 'Add an additional MBS Item to the list' button.

• You can now copy a selected item in order to claim the same item more than once. 

(e.g. 10990, 10991). In order to do this you right click on a selected item and chose 

'Add this MBS item again'.

• For MBS items that do not have a simple amount to be claimed you can now right click 

on the item and chose 'Show me with the derived fee description' for the item. This 

will display a box with the formula to claculate the derived fee.

Version 4

Release notes for version 4 releases.

Version 4.9

Release notes for V4.9.

This version is a major release following beta testing with versions since the last major 

release (version 4.4.160).
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Investigations enhancements:

Investigation results can be viewed read only by anyone with access to the clinical record.

They can only be updated (reviewed) by doctors with access to investigations.

This change affects investigation results only.

Version 4.8

Release notes for V4.8.

Main Toolbar

The Exit and Help buttons have been removed to create more space on the desktop. Close 

Communicare by selecting File|Exit or by clicking the Windows X button. Open the Online 

Help by selecting Help|Communicare Help or by pressing F1 on your keyboard.

Note that users familiar with the main toolbar may choose to hide the button captions to 

make further space on their desktop. Do this by removing the check next to Tools|Show 

Button Captions. Communicare users should have a minimum screen resolution of 800x600, 

with 1024x768 recommended.

Help

Help has been updated for HIC Online and there are new System Administration topics. 

Refer to HIC Online - Electronic Claims, Regular Administrator Tasks, Backup Regimes, 

Firewall Configuration.

Version 4.7

Release notes for V4.7.

Service Recording

This version of Communicare introduces a major change in the way that services are 

recorded. The change will make service recording much more efficient but does require that 

staff are prepared for the change following an upgrade to this version.

We strongly recommend that all staff are prepared for the change and have provided some 

specific help (see Service Recording - a User's Guide). The administrator may wish to print 

these notes for distribution or use with training.
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Progress Notes

Progress Notes now have an access level of security. Only users with the appropriate clinical 

item rights will be able to see progress notes marked as having that clinical item right. 

Users can reopen their own progress notes and set a clinical item right other than General if 

appropriate.

For example, if a progress note is set to 'Sexual Health' then users without that clinical item 

right will not be able to see it.

Qualifiers

Qualifiers attached to a clinical item (such as weight, creatinine, etc) are now presented with 

the previous value and date displayed. You will now be able to see when a measurement for 

that qualifier was last taken and what the value was.
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Patient Search

Names are now displayed with the surname first, e.g. SIMPSON, BART 10yrs Male.

Clinical Record

Editing clinical items added in a different service will not cause the current service to change 

to that service. To change service intentionally you will need to open the Progress Notes tab 

and double click on the service under 'Consultation'. See Service Recording - a User's Guide 

for further details.

Providers

Providers can now have multiple provider numbers for use at different encounter places. Go 

to File|Reference Tables|Provider to edit your provider numbers.

Reports

• QueryBuilder and SQL reports run from the Report menu now go <color Blue>straight 

to the preview</color>. Print the report from the print button at the top. If you wish 

you can still see the grid of results by clicking 'Advanced' instead of 'Yes'.
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• Reference Table report for Clinical Items now displays ICPC2 codes.

• IMPORTANT NOTE FOR COMMUNICARE ADMINISTRATORS: the change to Service 

Recording introduces a new status of 'Paused'. A service which is left paused is 

considered to be a service. If you have any reports, either SQL or QueryBuilder, which 

include the line PAT_ENC_STAT IN ('S', 'F') then edit this to now read PAT_ENC_STAT 

IN ('S', 'F', 'P').

• IMPORTANT NOTE FOR COMMUNICARE ADMINISTRATORS: the services model has 

been slightly amended. Please check any QueryBuilder queries you may have created 

which use this model and select from table T28 (Patient Clinical Item) but do not 

include table T27 (Service Provider). You will need to decide whether to include T27 or 

to use T21 (Patient_Clinical_Item) instead of T28.

Investigations

• Results can now be logically deleted from the Review Results window. This is useful 

for results that arrive for patients who are not patients at the clinic. The results can be 

seen by changing the filter to show deleted results. You cannot delete results that have 

been matched to a patient.

• Minor bug fixes and enhancements since version 4.6.

Biographics

There are new relationship names of father-in-law, mother-in-law and friend.

Version 4.6

Release notes for V4.6.

Recall Responsibility

• Recalls can now be assigned to particular groups of users for completion.

• Automated recalls default to the responsibility assigned to the automated recall type.

• Manual recalls default to the group of the user who is adding the recall.

• Recalls due reports can be filtered for a particular responsibility.
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Pathology Results

• A patient's clinical record can now be accessed directly from the Review Results 

window.

• Pathology results sent by providers that support highlighting will now appear with the 

proper font styles and colours.

Progress Notes

In the clinical record the place and mode for each service and provider is displayed as well as 

the date and provider.

HIC Online

Each encounter place can now have its own HIC location ID.

Service Recording

The Service Recording window now auto-refreshes every minute to display changes. The 

manual refresh facility is still available (F5).

Transport module

Numbers of patients who did not attend for transport can now be recorded.

Version 4.5

Release notes for V4.5.

Recalls

A patient's recalls are now only visible on the Summary page of the Clinical Record. The 

Detail page will only show completed procedures and immunisations.

Note that the Recalls pane can be resized if it is too small. Communicare will remember the 

size based on the user's Windows logon username.

HIC Online

Online Medicare claims are now available using Communicare. Contact Communicare for 

further information.
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Health Centre Prescription

NT sites that use rural prescriptions or medication charts can opt to print a health centre 

prescription instead of the standard prescription. Contact Communicare for further 

information.

Clinical Terms Browser

The clinical terms browser now supports searching by keyword PLUS word-search. The list 

of terms associated with a single keyword can sometimes be quite long. After entering a few 

letters of a key word enter a space followed by a few letters of any word appearing in the 

term you are searching for and the pick list will be shortened accordingly.

For Example DIAB will list all diabetes terms.

The search can be further refined by entering the starting characters of a second word. Terms 

that do not contain a word starting with those characters will be eliminated.

For Example DIAB ME will shorten the list to 'Diabetes melitus' only.

Reference Tables

Communicare reference tables with two grids (top and bottom) now have two navigation and 

edit bars to make it clearer which grid is being edited.

Appointment Book Report

Cancelled sessions are no longer shown when printing the Appointment Book Report.

Prescribing

Changes include:

• double-clicking on a prescription will allow you to either edit or repeat that 

prescription

• prescriptions now show the address details of the encounter place rather than the 

site address details. To amend the address details for an encounter place go to File|

Reference Tables|Encounter Place and right click on the upper grid, selecting Show 

hidden columns. Edit the address fields here.
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Miscellaneous

• This release also addresses a few minor issues.

Version 4.4

Release notes for V4.4.

Client Installation

• Client installation script grants full access to Communicare folder for everyone.

• Future upgrades will no longer need Administrator rights.

Investigations

• The electronic pathology results facility has been reworked following extensive beta 

testing.

• Contact Communicare on (08) 6212 6900 for details.

Printing Medicare Assignment Forms

• Following HIC permission a site can now print Medicare Assignment Forms onto plain 

paper as well as onto the preprinted, tractor-fed stationery.

Prescribing

• There have been some minor changes to prescribing.

Version 4.3

Release notes for V4.3.

Patient Status

• There are two new patient statuses (Banned 30 days and Banned 60 days). Changing a 

patient's status to one of these will cause that status to be displayed after the patient's 

name and age in the patient search screen. After the correct number of days the 

patient will automatically revert to being a Current Patient. To manually remove a 

banned status from a patient, click Change Details for that patient and select the 

Administration tab where you can reset their status. The topic Patient Status has more 

details.
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Miscellaneous

• This release also addresses a few minor issues.

\

Version 4.2

Release notes for V4.2.

Northern Territory Health Connect Trial

• This version of Communicare facilitates the NT Health Connect trial. Participants will 

need to install this module separately. Contact Communicare for details.

Miscellaneous

• There have been further enhancements to Biographics and other features.

Version 4.1

Release notes for V4.1.

Biographics

• Performance tuning of the New Patient function has sped up the creation of new 

patient records.

• A new automatic daily process now adjusts the status of patients who have not had a 

service contact in a certain number of years. Refer to System Parameters for details.

• Adding patient names has been improved by setting defaults for forenames and family 

names after the first name has been added.

• Editing and deleting patient names has been made easier by the adition of an edit 

control bar above the names grid.

• Address maintenance has been made easier by associating Mobile and Work phone 

numbers with the patient instead of the address. This means that when a patient 

moves there is no need to re-enter the Mobile and Work phone numbers.

• New prompts have been added to make it easier to add a new address when a patient 

moves, instead of changing a prior address.
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• Colour has been added to the name and address records to make it easier to identify 

edit, insert and delete operations.

• The Medicare reference number has been moved to reduce the likelihood of it being 

confused with card issue number.

• Upgrading to database versions 205 or 208 will automatically set patient's forenames 

to preferred forenames where they are blank. This allows Communicare's duplicate 

patient checking to work more effectively.

• Upgrades to database versions 205 or 208 will scan the database for illegal hard 

duplicate patient records. These records will be automatically be merged. Typically 

only about 1 in 20,000 patient records is effected, but it is important to check=the 

output files for scripts 205 and 208 on the server after the upgrade is completed.

• Database version 207 may have automatically marked a few patients who have no 

services recorded as Past Patients. Script output file 213 should be checked to see 

which patients were effected if version 207 was in use. Few sites will be effected as 

most upgrades will take the database from a version prior to 207 to 213 or greater.

Service Recording

• Encounter mode and place have been combined as Place and Mode in the service 

recording module. This change makes information easier to read and reduces the 

number of mouse clicks required to create a service record.

• A disable flag has been added to encounter Place and Mode to allow the suppression of 

encounter places that are no longer used.

Clinical Record

• A new automatic daily process now deletes recalls that are no longer age appropriate 

due to patient aging. This process will reduce the number of overdue recalls displayed 

and reduce the length of recall reports.
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Reporting

• Patient Status and Patient Group selections have been added to the Clinical Record 

standard reports. By default, only recalls for current patients will be printed, which 

will reduce the length of your recall reports.

• The recall report now includes recalls that were previously excluded on the bases that 

they were illegal types. For example, recalls for conditions has never been a supported 

function, though some users have created them. This version of the recall report will 

print such recalls.

Other

• Users may now change their own password, provided they have been given the right by 

the system administrator.

• The system administrator can now easily change any users password from within 

Communicare, instead of using InterBase Console.

• This release also addresses other issues either too trivial or technical to itemise here.

Version 4.0

Release notes for V4.0.

Investigations

Communicare now has the facility to request investigations and then download the results 

from the pathology lab.

Prescribing

• The Regular check box has been replaced by Once off and Regular medication radio 

buttons for greater clarity.

• A Save as default check box on the prescription details form allows dosage and other 

details to be saved as a personal default for next time the same drug package is 

prescribed.

• A Favorites check box on the prescription details form causes a medication to be added 

to your personal favorites and listed automatically every time you enter the drug 

browser.

• The Print prescription check box can now be set to default to un-checked by a system 

parameter setting.
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Recallable Clinical Items

Only Procedures and Immunisations can be recallable. This version prevents users from 

making any other class of clinical item recallable. If you still have, say, a condition which is 

both recallable and used in an automated recall you should first disable the automated recall 

then uncheck the Recallable checkbox of the condition.

If you have inadvertently created a procedure but assigned it a class other than procedure 

and wish to recall it you should contact Communicare for details.

Version 3

Release notes for version 3 releases.

Version 3.9

Release notes for V3.9.

Normal Hours

Communicare now records whether a service is after hours or not. If services are not 

Date Only then the user needs to do nothing once the normal clinic hours have been set 

at File|System Parameters and public holidays have been set at File|Reference Tables|

Public Holidays. Existing records can then be updated once this has been done. Contact 

Communicare for details.

A service is deemed to be after hours if the start time is outside the clinic normal hours or 

falls on a public holiday.

For Date Only services there is a checkbox to record after hours services. By default, 

Communicare treats date only services as not after hours unless they occur on a day where 

there are no clinic hours. To record a date only service as after hours simply check the box 

when adding the service.

SAR reporting now requires statistics on after hours services.

Spellchecking

All memo type forms (including Progress Notes, Administration Notes and the Alert box 

on the Clinical Record) now have the facility to check your spelling. Right click to select 

the spellchecker or select Edit and use the toolbar button. You will need to have MS Word 

installed on the workstation to use this option.
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Prescribing

Using the MIMS Pharmaceutical Database is now considerably faster. When you open the 

drug browser no drugs are visible. Once at least three characters are entered in the Product 

edit box then the browser will present all products where the brand name or generic name 

starts with the entered text.

Preferred Localities

The Locality reference table can now select preferred localities automatically. To include 

localities which have been used a certain number of times already, enter a value in the edit 

box (e.g. entering '5' will include all localities used five or more times already) and click the 

 button. This will add the localities to the preferred list.

GFR Qualifier

There is now a GFR(IBW) qualifier which behaves like the GFR qualifier only ideal 

bodyweight is used if the patient's weight is above their ideal bodyweight. For more 

information see the GFR topic  (on page ).

Document Scanning

There is now a button on the main form for quick access along with new shortcut keys (Ctrl-

D to browse documents and Ctrl-S to scan a new document).

Transport Services

This module now has the provision to record journey time and to record passengers as male 

or female.

System Parameters

There have been some changes to the System Parameters form to accommodate normal 

hours recording. The General and Datasets tabs have been combined into the General tab 

and a new System tab. The Printers and Scanners tabs have been combined into the Devices 

tab.

Automated Recalls

Some issues involved with disabling and re-enabling automated recalls have been resolved.
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Version 3.8.1

Release notes for V3.8.1.

This release addresses a few minor issues.

Version 3.8

Release notes for V3.8.

Document Scanning

Communicare now has the facility to scan patient's documents into Communicare. You will 

be able to scan incoming and outgoing correspondence and other documents. They can be 

viewed from within a patient's clinical record and sorted into relevant topics. All a patient's 

documents can be seen together using the new Document class view tab. For details look at 

Documents.

Patient Service Report

From a patient's clinical record you can now print a hard copy of a complete service. This 

report includes progress notes, clinical items, manual recalls and prescriptions added in that 

service. Clicking the  button will print the current service (this button is disabled if a 

service has not been started).

To print a report of other services for that patient, go to the Progress Notes tab, right-click 

on the service required and select Print selected patient service report.

Patient Search

Clicking once on the  icon when it appears will open the Administration Notes for that 

patient. Administration Notes are added or edited by entering the patient biographics form 

and selecting the Administration tab. The icon appears on the Patient Search form for 

patients who have notes.

Miscellaneous

A date is now printed next to the doctor's name on prescriptions. A few minor bugs have 

been fixed.

Version 3.7.1

Release notes for V3.7.1.
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Clinical Terms Browser

The clinical terms browser can now be used to locate enabled clinical items types. Click 

on the  button to locate an enabled clinical item type with the clinical terms browser. 

Disabled items cannot be located using this method.

Coordinated Care Trial 2

In line with Coordinated Care Trial 2 changes the list of co-exisiting problems has been 

shortened. CCT2 sites should review the list of co-existing problems that have been deleted 

in file SiteId_DatbaseName_168.txt. Please contact Communicare if you require assistance.

Miscellaneous

This release also addresses a number of minor technical issues.

Version 3.7

Release notes for V3.7.

Patient Status

Patients can now have a recorded status of Current, Transient, Past or Fictitious. Patient 

status is an important indicator that allows reports and analysis to accurately select only the 

appropriate patients. For example, a Recalls Due report would normally be targeted at only 

the Current Patients. The topic Patient Status has more details.

Patient Groups

Patients can now be allocated to groups which can be useful for specific reporting. Groups 

can be defined for three types of group at present - Case Worker, Inclusive Care Program 

and Unique Care Program. The topics Patient Group Membership and Patient Group 

Maintenance provide more details.

Clinical Item Datasets

Communicare can now import specific clinical item datasets such as ICPC2-Plus. The import 

uses a special program and database on the Communicare Distribution CD which must be 

run on the Server. Datasets are selected in File|System Parameters after running the program 

which is then run again to 'activate' the datasets. Appropriate Users Groups are then given 

the Access Rights to use these new clinical items. The topic Central Data Update has more 

details.
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Transport Services

There is now a module which can be used for recording transport services. Drivers, distances, 

stops and numbers of passengers picked up and dropped off can be recorded and reported on 

where a practice offers this service to its patients.

Miscellaneous

This version also addresses a bug in the way Service Recording handled the adding of 

patients.

Version 3.6.3

Release notes for V3.6.3.

Coordinated Care Trial

Release for the first phase of Coordinated Care Trial 2 (CCT2). Non-consenting participant 

attributes of CCT1 are removed. All patient participants in CCT1 are carried forward as non-

consenting for CCT2. The Coordinated Care Trial Data form has been changed in line with 

CCT2.

Cause of Death

'Cardiovascular Accident' (which is not a medical condition) has been changed to 

'Cerebrovascular Accident'. There is also a new type, 'Unknown Cause'.

Prescriptions and Clinical Item Deletion

A clinical item which has been used as a Reason for Prescription cannot be deleted from a 

patient's clinical record. A message now informs the user to which prescription(s) a clinical 

item is attached.

Deleted prescriptions are not removed from the database but are recorded as being deleted 

along with a deletion reason. Right-clicking on the Detail tab presents an option to Show 

Deleted Items. This will make deleted prescriptions visible (marked with a status of Deleted). 

The deletion reason can be read in the Details Pane.

Image Type Qualifiers

When an image type qualifier is attached to a clinical item the image can be viewed full size 

by double-clicking on the thumbnail. Double-clicking on the full size image will close it.
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Database Consistency Report

If there are multiple Chronic Medication or Acute Medication type clinical items enabled 

then the Database Consistency Report will recommend disabling all but one of the Chronic 

(or Acute) Medications, or disabling Free Text Medication.

Run the Database Consistency Report from Tools|Database Consistency Check.

Report Layouts

Threre have been refinements to way the Report Wizard works. This is called from the Print 

Data button when running a Query Builder report.

Help

The on-line help has been further developed and more context-sensistive topics added. 

Pressing the F1 button at any time brings up an appropriate help topic.

Data Dictionary

Visible in Help under Reports|Data Dictionary, this has now been updated with more 

informative column names and descriptions.

Miscellaneous

There have been various small changes to System Parameters.

Version 3.6.2

Release notes for V3.6.2.

Version 3.6.2 is a maintenance release for 3.6.1. It addresses a bug in Generic Prescribing and 

a number of minor defects and technical issues.

Automated Recall Cleanup

Communicare has left some recalls in patient's clinical records after the automated recall 

that created them has been disabled.

This problem has been corrected and all recalls generated by automated recalls which are 

now disabled have been deleted.
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Your system administrator should review the list of recalls that have been so deleted in file 

SiteId_DatbaseName_138.txt. Please contact Communicare if you require assistance.

Version 3.6.1

Release notes for V3.6.1.

Appointments

• The size of the cells in the appointment book has been reduced, allowing a third more 

appointments to be displayed on the screen at a time. Removing the “canceled session 

status” line from each cell and replacing it with a graphic have achieved this.

Query Builder and SQL Reports

• Query Builder queries and models are now stored in the Communicare database 

instead of disk files. This allows updated queries to be available instantly to users 

network wide. See Loading_and_Saving_Queries for more information

• Query Builder queries and SQL queries can now be selected and run directly from the 

Reports menu, making them easier to find and run. An icon is displayed next to each 

report name to identify the type of report. Query Builder reports have an  icon, SQL 

Reports have an  icon, while other reports have an  icon.

• Queries now have Public and Owner attributes and access controls. Refer to 

Access_Control_for_Query_Builder_Reports for details.

• The Communicare Data Dictionary is now available from within this help file.

Clinical Record

• A new style of clinical summary is now available, which includes comments and does 

not consolidate summary items. Refer to System_Parameters for details.

• A new tick box allows referrals to be marked as “Critical”. Critical referrals can 

be reported using the referral report. Refer to Clinical_Item_Maintenance and 

Clinical_Item_Type_Properties for details.
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Prescribing

• Generic Prescribing is now supported. This is the first version of generic prescribing 

and does not include any changes to the drug browser. Further changes are likely 

pending feedback from users.

• Printing of S8 and S9 prescriptions has been improved to allow for easier transcribing 

of drug details.

• A tick box in the drug browser allows “over the counter” medications to be excluded 

from searches.

• Several minor improvements have been made to the prescribing interface and 

authority prescription windows.

Medicare Assignment Forms

• The Medicare_Assignment_Form now prints to plain paper. To facilitate printing 

to a general use printer the form prints to the top half of A4 portrait paper. 

System_Parameters can be set to determine whether Practitioner or Patient copies are 

required (File|System Parameters... then select the MedClaims tab).

Miscellaneous

• Incremental searching of provider names in Service Recording has been improved to 

deal with names starting with lower case characters in the same way as names starting 

with upper case characters.

• Patient's addresses may now have a “From” date up to 30 days into the future. This 

allows notification of a future address change to be recorded.

• “Planned Date” has been removed from the Patient Summary report for completed 

recalls. This makes the report easier to read and understand.

• Patient's address details on printed prescription forms have been expanded.

• A bug with the way “withdrawn” services were counted has been corrected in the 

encounter analysis reports.

• Users may now only belong to one User Group. If a User requires a unique set of Rights 

then a new User Group needs to be created.

• A bug in the Encounter Analysis reported withdrawn encounters has been fixed.

• Progress notes are now included in the patient summary report.
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• The GFR can be automatically calculated using the GFR qualifier which works in 

the same way as the Body_Mass_Index qualifier. By setting up a Clinical_Item and 

attaching the Weight, Creatinine (umol/l) or Creatinine (mmol/l) and GFR qualifiers 

the GFR is calculated automatically when you click in the edit box.

Version 3.6

Release notes for V3.6.

Progress Notes

• Progress notes can now be recorded and displayed for each service and provider.

• The new progress notes tab displays all progress notes in sequence along with a list of 

every clinical record, recall and prescription generated by the service provider.

• Progress notes can be filtered by any diagnosed condition, allowing all notes relating 

to the diagnosis to be readily accessed.

Patient Search

• A Notes symbol  appears when there are Administration notes recorded about a 

patient.

Clinical Record

• All tabs now feature a common toolbar with items to access Patient Details, Centile 

Charts, Qualifier Charts and Services and Appointments.

• New buttons  allow the user to add prescriptions, edit progress 

notes, add clinical Items and manually add, complete and delete recalls.

• Alternatively, you can now use [F9] to add prescriptions, [F10] to edit progress notes, 

[F11] to add clinical items and [F12] to add a manual recall.

• Note that the only way to manually add a recall is now by using the 'Add a manual 

recall' button or [F12].

• Immunisations are displayed with a 'Status' of 'Performed' or 'Incomplete' for easier 

recognition of immunisation recalls.

• BMI calculation is now to 1 decimal place precision rather than the nearest whole 

number.
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Patient Summary Report

• The Standard Patient Summary Report now shows Current Medication, Regular 

Medication and Medication History, if Prescribing is enabled. These can be de-selected 

from the Patient Summary Report by selecting the Customise button and Clinical 

Record tab.

• If Prescribing is not enabled and Free Text Medication has been enabled then a 

Chronic Medication summary will appear on the Standard Patient Summary Report.

Prescriptions

• In addition to the prescriber's title and qualifications there is now a full patient's 

address on the prescription.

Provider Details

• Provider details now include Title (Dr, etc) and Qualifications. These appear at 

the bottom of the Provider reference table. Printed prescriptions now include the 

prescriber's title and qualifications.

• Provider names can now be up to 60 characters long.

Release Notes

• These now appear in the On-Line Help rather than as a separate document.

Version 3.5.1

Release notes for V3.5.1.

Service Recording

Each combination of Encounter Mode and Place now has checkboxes to indicate whether 

arrivals and times are recorded. This facilitates consistent, fast and accurate service 

recording with minimal training requirements.

Clinical Record

Double clicking a recall record now pops-up a confirmation dialogue which asks if the recall 

is to be completed. This allows the system to distinguish recalls completion operations 

from recall edit operations. The preferred method of completion a recall is to simply click 
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the ‘Recall Completion’ button, but this change helps protect the integrity of the system 

with untrained operators. Recall completion has been simplified in relation to the service to 

which the recall is linked. When a recall is completed it is now automatically linked to the 

current service. This makes recall completion faster and simpler.

Patient Labels

The left margins of the patient labels have been adjusted by a small amount for better print 

alignment. If margins have been entered in the printer setup, then they should be reviewed 

following this release.

Version 3.5

Release notes for V3.5.

Prescribing

A feature rich prescribing module has been added to Communicare version 3.5. MIMS 

Pharmaceutical Database includes MIMS “full product information” which is accessible 

at the touch of a button. Current medication is displayed on the clinical summary page of 

each client’s clinical record. Regular medication can be easily re-prescribed. Prescriptions 

can be reprinted when necessary. Tamper resistant system allows only logical deletion 

of prescription records and requires a “reason for deletion” to be entered. Drugs can be 

browsed by product group, product name, brand, generic or indication. A condition can be 

selected from (or added to) the clinical record as a “reason for prescribing”. Smart auto-

replacement text system simplifies dosage instructions. For example, “1 tds” translates to 

“one three times a day”. An extensive table of “dosage instructions” is provided. Additional 

instructions can be user defined.

Security

New Access rights have been created for ‘Clinical Reporting’ and ‘Patient Deletion’ to allow 

greater control over which users can perform these functions. · The ‘Clinical Reporting’ 

right allows users to print clinical reports without necessarily having the right to access 

management reports. · The ‘Patient Deletion’ right allows users to delete and merge 

patients.

Main Tool Bar

The buttons on the toolbar now have captions to make them easier for new users to 

understand. The selected default provider name, encounter mode and encounter place are 
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now displayed in a status bar under the button. Double clicking the status bar allows the 

defaults to be changed. This helps make Communicare’s default settings more obvious. Both 

the button captions and the status bar can be suppressed by a selection on the tools menu. 

Suppressing either or both of these features maximises the amount of screen space available 

for other windows.

Biographics

The patient's biographics now includes telephone numbers for work and mobile phones. The 

patient search now displays the new phone number and the current address locality name. 

Medicare number cleaning. Some Medicare numbers have been found to be lacking the last 

digit, making them invalid. As a part of this upgrade, these numbers have had a ‘1’ added 

and the reference number set to blank. In most cases this results in a valid number. Any 

numbers that are still invalid are set to blank. A list of all the numbers changed like this is 

available in SiteId_Ccare_115.txt.

Clinical Record

When adding or changing a clinical item, definitions can now be viewed in the large ‘view’ 

window by simply double clicking in the definition box. The right click menu ‘view’ option 

is still available. The clinical summary window now has an additional panel for a summary 

of qualifiers. This pane lists the latest values for any eligible qualifiers. Qualifiers are made 

eligible for listing by ticking the new ‘Summary’ tick-box in the (reference tables) Qualifier 

maintenance window. This feature allows current qualifier information for important 

measurements (EG BMI, Blood Pressure) viewed instantly on opening any patient’s clinical 

record. The hospital morbidity ‘date of separation’ now defaults to the end date of the 

associated service record. This makes for slightly easier data entry.

Service Recording

A service record is now required for all clinical items and prescriptions. This provides: · An 

audit trail of who authorised each item of a clinical record. · A reliable way of “catching” 

every patient contact for reporting purposes. Service records can now be created “on the fly” 

from within the clinical record. In many situations this simplifies operation considerably 

and removes the need for a clinician to access the “service recording” window. For reasons of 

security, providers can now only be changed when a service is either ‘Booked’ or ‘Waiting’. 

Once a service has started, the provider cannot be changed. Any number of providers can 

now be associated with a single service. · A check-box list of all active providers is displayed 

to allow selection by simply ticking a box. · A locate feature is also included to allow easy 
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location of a provider name if the list is long. · To make it easy to see the currently selected 

providers they are automatically moved to the top of the list

Patient Import

The Patient Import program has been expanded to include ‘administration notes’, special 

checkbox 1’ and ‘record storage site’. This improvement allows a more comprehensive 

biographics import to be performed.

Reporting

New Query Builder sample queries break down biographic data by sex and age group. Any 

data can now be easily analysed by ages in weeks, months or years as of any given reference 

date. Address ‘to’ date. A ‘to’ date has been added to the patient address table to make ‘point 

in time’ queries easier. The new date is maintained automatically so there is no additional 

user input required.

Patient Search

The value of the patient ‘Special Check-Box’ is now displayed in the search window.

Coordinated Care

Version 4.1 AN-DRG codes have been added for Coordinated Care hospital morbidity 

recording.

On-Line Help

The data dictionary is now accessible from within Communicare’s on-line help. Each of the 

Query Builder sample queries is now documented within Communicare’s on-line help.

Printer Setup

A new tab has been added to the System Parameters form to allow custom positioning of 

reports on individual printers. This feature allows precise positioning of printed text on 

forms that require exact text placement – for example prescriptions and labels.

Version 3.4

Release notes for V3.4.
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PATIENT MERGE

A new patient merge facility allows duplicate patient records to be easily combined.

Example showing 2 patient records about to be combined into a single record.

A new Browse program allows you to browse for duplicate patient records and merge them 

on the spot.
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Example showing a patient record with two similar records displayed in the grid.

SECURITY

A totally new security system is featured in this release. This system allows different users 

different levels of access to clinical information. Security can be set, for example, so that 

only users with appropriate security rights can access STD information. See the online help 

for more information.

MIMS PHARMACEUTICAL DATA

The full MIMS Pharmaceutical database can now be browsed from within Communicare. This 

drug data browser is in preparation for the release of full prescribing functionality in version 

3.5. If you are interested in prescribing then please take a few minutes to examine the drug 

data browser. It can be found on the Tools menu. A license to use the MIMS data must be 

purchased before this option may be used.

SERVICE RECORDING

Additional validation now prevents a service being started unless a provider has been 

identified.

The defaults for provider, mode and place have been simplified. Now provider, mode and 

place all default to what has been set in the ‘Service Record Filter Selections’ (the torch 

button), except if ‘All Providers’, ‘All Modes’ or ‘All Places’ has been selected, in which case 
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the respective field will default to blank. “Existing File Number” is now included in the 

details display at the bottom of the Service Recording window.

APPOINTMENTS

Free appointments can now be quickly located for any (or all) providers. The new ‘free 

appointment search’ can be used to conveniently navigate forwards or backwards through 

free appointments starting from ‘today’ or a future date. The appointment book display now 

shows: · the full name of the patient in a little yellow 'hint box' in cases where the column 

is not wide enough to diplay the name. · a little blue square in the first appointment of each 

session. This makes it easier to see where one session end and the next session starts.

Sessions can now be split into two sessions. Splitting a session makes it possible to cancel 

part of a session.

All of a patients appointments (past and future) can now be viewed from within the 

appointment book.

Cancelled sessions can now be hidden from view in the appointments book.

Session Template Screen has been redesigned to make it easier to use.

Session Templates now have an ‘Allow Facility Overlap’ flag that allows overlap checking 

to be disabled for some sessions. This can be helpful in situations where providers have no 

definite room allocations.

PATIENT BIOGRAPHICS

The previous patient copy function has been expanded to include Medicare number. The 

button has also been enlarged to include a label (Paste) to make its function more obvious.

Duplicate patient checking has been improved. It now uses the sounds of names and 

approximate dates of birth when searching for likely duplicates. When a list of likely 

duplicates is displayed a timeout is activated to ensure the operator takes sufficient time to 

read all the entries on the list.

The navigator bar in the address box has been expanded to include 'add', 'save' and 'cancel' 

buttons to make address maintenance easier.

The ‘Existing File’ field can now be renamed to better describe what you actually use it for 

EG: “Paper File No.’.
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Error handling and messages have been completely revised to make then easier to 

understand.

CLINICAL TERMS BROWSER

The clinical terms browser is the window that pops up each time you need to select a clinical 

item type. It has been completely redesigned to be exceptionally easy to use, no matter how 

long your list of clinical item types is. The new browser features: · Searching by any defined 

keyword. For example, ‘Heart Attack’ could be located using keywords ‘Heart’, ‘Attack’, 

‘Infarction’, ‘MI’ or any other word or abbreviation you care to define. · Selection from a list 

of the clinical items you have most recently used. · Definitions of clinical item types can be 

viewed with the click of a single button. Definitions may include drawings, pictures, sounds, 

animations, or any other OLE Objects as well as rich text. · Advanced searching by class and 

topic.

Example showing the ‘definition’ icon.
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Example showing use of a keyword that is not used in ‘clinical item type’.

CLINICAL RECORD

The 'Confirm Automatic Recall' dialog now displays recalls that were previously not 

displayed due to the existence of an existing recall of the same type. These additional recalls 

are now displayed along with the message 'This recall already exists on DD/MM/YYYY'. The 

'Confirmed' check-box will not be ticked in these cases.
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Example showing a case where 1 of the 3 recalls will not be generated. Note the un-ticked 

‘Recall confirmed’ box.

The title panel above the patient alert is coloured red if the alert is not blank. This makes it 

harder to overlook alert information.
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Trivial example of an alert showing graphic in alert and red title bar.

New qualifiers types for images, dates and memos have been added and the qualifier entry/

edit window has been redesigned to be more compact and easier to use. Here is an example 

of how some of the new qualifier types can be used.
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Example of the new image and memo qualifier data types.

PATIENT SUMMARY REPORT

The patient Summary Report has been enhanced with an option to include the Clinical 

Summary, Alert and Qualifiers. These changes allow prints of a patient's clinical record to be 

made with greater detail or as a true clinical Summary.

PATIENT LABELS

There are now 2 styles of patient labels available. Select the required style on the Tools 

menu. The new style is designed for Avery Laser Label DL30 for use on laboratory samples. 
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When selecting this style, enter a label heading, which can be anything but usually identifies 

the name of the health service that took the sample.

SYSTEM PARAMETERS

The 'enabled modules' check-boxes on the general tab have been replaced by a scrollable 

check-box list which allows any module to be enabled or disabled.

The security tab has been removed because it is no longer required with the new user based 

security system.

The 'subtypes' check-boxes have been removed from the clinical tab. Subtypes are now 

automatically enabled or disabled by simply enabling or disabling clinical item types.

PATIENT IMPORT

The patient import program can now accept input from HIC Medicare data files a well as 

the standard Communicare format files. This allows new sites to easily establish a client 

database of existing clients with out any data entry.

REFERENCE TABLES

The Clinical Item Types maintenance program has been rewritten for easier use and now 

supports Definitions, Keywords, Access Rights and Groups.
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Example of a clinical item type definition. Definitions can be viewed by any user at the point 

where a clinical item type is selected.

The new User Groups program allows users to be placed into groups. This program can also 

control all security settings.

New reference table maintenance programs for Clinical Item Type Groups, Keywords and 

Access Rights.

SCREEN MANAGEMENT

The Clinical Record, Services Recording and Appointment Book windows can now be 

maximized without obscuring the main toolbar. This makes it easier to use all of your screen 

whilst retain the use of the tool bar to quickly switch between windows. Other windows now 

remember wether you used them in Maximized or normal mode and will start again in that 

mode next time you use them.
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SPECIALITIES

New specialties have been added for the list of providers. The available list now fully 

supports the latest ‘Service Activity Report”. The new specialities are: · Substance misuse 

worker · Dentist · Dental therapist · Traditional healer

Version 3.3

Release notes for V3.3.

IMPORTANT NOTE

As a general principle, reference table item descriptions should fully and uniquely describe 

the item.

In Communicare 2000 version 3.3.0.87 or above duplicate descriptions are illegal.

During an upgrade to that version, duplicate descriptions are made unique by appending a 

number in square brackets. For example, the description 'Liver' might be changed to 'Liver 

[1]'.

After upgrading to version 3.3.0.87 or above you should run SampleQueries: 

DuplicatedClinicalItemTypes.QRY DuplicatedLocalities.QRY DuplicatedProviders.QRY 

DuplicatedQualifierTypes.QRY

These queries will list all items whose descriptions were modified during the upgrade.

HELP

The online help has been extensively revised and reconfigured to appear in the new 

Windows HTML Help format which is considerably easier to use than the old Windows Help 

format.

The online help has also been extended so that EVERY window now has its own context 

sensitive help. That means where ever you are within Communicare, striking the F1 key will 

always display a help window with relevant information.

PATIENT SEARCH

The patient search window now displays non-preferred names in an alternate colour. This 

makes it more obvious when a single patient is displayed with multiple names in the search 

window.

320 Integrated Team Care



PATIENT QUERY

Aboriginality has been add to the list of patient selection criteria.

BIOGRAPHICS

The duplicate patient check window has been redesigned to make it clearer and easier to use.

The Alert information has been moved to the Clinical Record view. This gives confidential 

information entered into the Alert the same security as the Clinical Record.

A new Administration notes feature has been added to the Administration tab. This allows 

an unlimited amount of rich text to be recorded for administrative purposes.

CLINICAL RECORD

The ordering of items in the clinical record has been reversed. The most recent item is now 

shown at the top of the list. This makes it quicker to view the most recent information.

Items in the clinical record can be ordered by other columns such as Description, Comment, 

etc. by clicking on the title at the top of the column.

Note that several of the clinical record views are ordered by a combination of both planned 

and actual date. These views show the ordering icons in both the planned and actual date 

columns.

CLINICAL SUMMARY

A new summary tab has been added to the Clinical Record View. The Summary is created 

semi-automatically to provide a quick overview of the most significant clinical items.

SERVICE RECORDING &amp; APPOINTMENTS

The encounter mode list now only includes modes for which places have been linked. In 

most cases this makes the list much shorter and easier to use. If you need to use modes that 

no longer appear on the list then you must link one or more places to the needed mode.

REPORTS

The births report now prints a grand total as well as locality sub-totals.

The Qualifier Analysis report now has an option to suppress rows for 'not measured' 

patients. This makes the report much shorter in many cases and easier to read.
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DEMONSTRATION SOFTWARE

The demonstration version of Communicare can now co-exist with the production 

Communicare client. This can be useful for training purposes.

Training
If you want someone to teach you how to use Communicare, from beginners to advanced 

users, try our training.

We can organise someone to come to you, or you can access our eLearning.

Tip:

Check our eLearning  site regularly for our invaluable Tips and Tricks.

Troubleshooting

Troubleshooting

Starting Communicare

I can't start Communicare

You try to start Communicare and get a message 'Communicare Server XXXXXXXX cannot 

be found. Please contact your systems administrator for assistance'.

Can anyone else connect?

• UNSURE - Try logging on to another workstation

• YES - This means the server is working fine. Please check all cables are connected 

correctly. The blue cable must be securely connected. Try to re-open Communicare

• NO - Ask your system administrator to restart the Communicare server

If the Communicare server appears to be running but you are still unable to open 

Communicare on the workstation, please check to see if you can establish an internet 

connection and do a search.
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Is the internet working OK?

• NO - It appears that you have lost your connection to the network. Contact your 

systems administrator.

• YES - Contact the Communicare Support  and request remote assistance for further 

investigation of the problem.

Logging in to Communicare

I can't log in to the offline client

When you try to login to the offline client, you get the message: Username or password 

is incorrect. Check the Caps Lock on your keyboard. Usernames are not case 

sensitive but passwords are

You keep getting this error even though you're sure you have entered the correct password.

Are you a new user?

If you've only just been given a login to Communicare, then your username/password 

combination may not have propagated down to the offline client yet. This is because the 

offline client uses yesterday's data as it's baseline - if you weren't on the system yesterday, 

then it won't know that you exist!

Make sure you notify your system administrator that you will be unable to use the offline 

client for your work today - you will need to use the online client instead. Tomorrow, you 

should be able to log in the offline client fine, provided there was a backup the previous 

night.

Still can't log in?

If you are still unable to log in, then contact the Communicare Support  for further 

investigation of the problem.

Printing from Communicare

I can't print from Communicare

You try to print something from Communicare and nothing happens.
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Can you print from Microsoft Word or another program?

• NO - It is possible that your default printer is not configured or available. See your 

systems administrator

• YES - Check File  > Printer Assignments  to see which printer has been allocated to 

each Communicare printing task. Confirm that the correct printer has been allocated 

to the correct task. If you have only one available printer then selecting (Default) for 

each task is recommended. Restart Communicare if you make any changes

Is Communicare now printing correctly?

• NO - Go to File  > Printer Assignments  and highlight the printing task you are 

wishing to do. Check the 'Show printer dialog' box. Restart Communicare. When you 

attempt to print the printer selection box appears so you can manually specify the 

exact printer

• NO - Make sure that your printer is not using a PCL 6 driver (If it is change to a Post 

Script driver). See your systems administrator for help with this.

• NO - Contact your Communicare Administrator

Do I have an Internet connection

If you are having problems sending or receiving information to/from outside 
organisations

You may have lost your connection to the Internet

Can you connect to an Internet site?

Open your browser, usually Internet Explorer or Firefox and attempt to go to an Australian 

site such as http://www.abc.net.au or http://ccare.biz

• NO - Check your equipment, make sure everything is plugged securely (sometimes 

network cables can work loose just enough to break the connection but not fall out) 

and turned on. Sometimes, turning everything off and on can fix the problem. If none 

of this works, call your ISP (Internet Service Provider such as BigPond or similar).

• YES - Contact the Communicare Support.
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I cannot find the browser or I am on a slow connection

If you are not using a proxy, to check that you have connection to the internet:

1. Go to Start  > Run cmd.exe

2. When the command prompt appears, type ping www.abc.net.au  and press Enter.

If you have an internet connection, you should get a response similar to the following:

Pinging a1632.g.akamai.net [203.59.140.21] with 32 bytes of data:

 

Reply from 203.59.140.21: bytes=32 time=12ms TTL=56

Reply from 203.59.140.21: bytes=32 time=11ms TTL=56

Reply from 203.59.140.21: bytes=32 time=12ms TTL=56

Reply from 203.59.140.21: bytes=32 time=11ms TTL=56

 

Ping statistics for 203.59.140.21:

    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trip times in milli-seconds:

    Minimum = 11ms, Maximum = 12ms, Average = 11ms

Electronic Claims

Medicare Online Status

The following web page will report on the status of Online Claiming:

http://mcoe.humanservices.gov.au/pext/ECLIPSEMonitor/external/eclipse_status.jsp

Use it to see if electronic claiming problems are a result of issues with Medicare Online.

Frequently Asked Questions

Healthcare Identifiers

A healthcare identifier (HI) is a unique 16 digit number for organisations, clinicians and 

consumers which makes sure the right health information is associated with the right 

individual. The HI Service forms the basis of other eHealth initiatives such as the My Health 

Record (eHealth Record).
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HPI-Os

All health services should now have a Healthcare Provider Identifier-Organisation (HPI-

O) number as this is a requirement for services to participate in the My Health Record and 

future SEMS processes. It is only a ‘seed’ health service organisation that needs the number; 

health services that are auspiced by another health organisation do not need a HPI-O at this 

time.

HPI-Is

Healthcare Provider Identifier-Individual (HPI-I) is the identifying number for future secure 

electronic transmission of patient data by healthcare providers and other health personnel 

involved in providing patient care. This number is allocated by Medicare (Department of 

Human Services - DHS). It will be required in the future for accessing the My Health Record 

and for sending messages by SEMS.

A clinician’s HPI-I is '8003 61' followed by the 10 digit AHPRA User ID. The User ID is the 

number AHPRA (Australian Health Providers Registration Authority) discloses to healthcare 

providers on their annual renewal notification (either by email or hard copy) to login to the 

AHPRA website (this should not be confused with the AHPRA registration number).

It is good planning sense for health services to begin recording their staffs HPI-Is. NEHTA is 

investigating a way for health service organisations to be able to directly search for the HPI-I 

number but this will be dependent on Privacy Legislation.

The other way to get HPI-I’s is by clinicians going online to the Department of Human 

Services (http://www.medicareaustralia.gov.au/provider/health-identifier) and completing 

an online one page application (‘Healthcare Identifiers Service’) to request their details be 

published on the Health Provider Directory (HPD). Once they submit this electronically, 

generally the next day someone from DHS will call and do a very short confirmation of name, 

DOB and provider number and then the process is complete.

The ACCHSs Organisation Maintenance Officer (OMO) or Responsible Officer (RO) can 

then access the HPD, via the Health Provider Online Service (HPOS) and the use of their 

smartcard or iKey and search for the clinician on the HPD and to access their HPI-I. It 

sounds confusing but it’s actually quite simple. Calling APHRA (1300 419 495, http://

www.ahpra.gov.au/) is relatively painless as all they ask for is name, DOB and provider 

number.
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Other Links

MeHR - NT MeHR Website (http://www.myehealthrecord.com.au/Pages/default.aspx)

eHealth Website - DoHA eHealth website including link to the My Health Record Learning 

centre (http://www.myehealthrecord.com.au/Pages/default.aspx)

Appointments

How do I edit a session template after the sessions have been generated and 
inserted in the appointment book and then reinsert them into the appointment 
book?

• Cancel the sessions you wish to change, all the way to the horizon. Add cancelled 

appointments to the reschedule queue and print the cancellation reports.

• Edit the session template and timeslots.

• Re-enable the session template.

• Right click on the session template and select 'Apply to appointments book' and accept 

the default date range.

• Examine the appointments book to confirm that the desired change has occurred.

• Use the cancellation reports and reschedule queue to re-book any cancelled 

appointments. Be sure to advise patients if any appointment times have changed.

Biographics

How do I edit the 'Records kept at' list available on the Administration tab of the 
Patient Biographics?

Go to File  > Reference Tables  > Encounter Place. and check that the place exists in the 

Encounter Place table. If it does, check the box labelled 'Record Storage'. If it doesn't exist, 

add it to the table by clicking the green + button.

Prescribing

When I edit a Regular Item from the Summary page the changes are not made to 
the initial prescription - why not?

Editing a Regular Item should not change a previous prescription, only subsequent 

prescriptions of that regular item.
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Is it possible to print the generic name on the script rather than the brand name?

In Communicare V20.2 and later, generic active ingredients are printed on all scripts to meet 

the Active Ingredient Prescribing legislation, including those prescribed by brand. For more 

information, see Active Ingredient Prescribing  (on page ).

You can also set the default prescribing options on the File  > System Parameters  > Clinical 

tab. When prescribing you can override the default by choosing to prescribe by brand name.

When prescribing, in the Add Medication  window you can switch between Brand Name 

and Generic Name.

Is it possible to print more than two medications on each prescription?

Yes, it will print as many as will fit (possibly three). However separate prescriptions will be 

printed for those drugs where you have ticked the box ‘allow brand substitution’. That is 

because there is only one check box on the stationery that applies to all the drugs on the 

form.

Authority prescriptions always print on a separate form.

Is it possible to write prescriptions without making it a new client encounter, e.g. 
when writing scripts owed to the pharmacy when the client is not seen?

The short answer is no. If the client is not seen then the service should be recorded with the 

mode “Administration – no client contact’. We need the service to determine who wrote the 

script. It is similar to the situation where a script is written during a home visit – here you 

would record the service with the mode ‘Clients home’. It is important to remember that you 

DO NOT need to enter Service Recording to do this. Just open the Clinical Record and click 

on the yellow triangle to edit details of the service if appropriate.

Reports

What do I do with reports that have been sent from Communicare by e-mail?

Communicare will occasionally send queries for use at a particular site. The e-mail will 

have files attached, ending in .sql, .qry or .mkr (layout only). To use these queries in 

Communicare, do the following:

• Save all the attached files in a convenient folder e.g. My Documents

• Open Communicare
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• Select File  > Queries  > Import Query from file.

• Click the Import button at the bottom left

• Find each of the files you saved in 1. (you will only see the .sql and .qry files) and click 

the Open button (you will need to do this for each of the queries in turn)

• Confirm you want to make each query public if it will need to be seen by anyone 

logged on with a different user name to you

• The queries will now be visible under Report|[first part of query name]|[last part of 

query name]

• You can now delete the files you saved in 1. if you wish

Requesting a New Communicare Report

If you wish to request Communicare to create a new SQL report for your system, print the 

form  Help  >  Forms  >  Report Request Form. Fill in the details, get the form signed by the 

CEO/Administrator, scan and raise a support request.

When using QueryBuilder or SQL, how can I search for a word that contains an 
apostrophe, such as Men's Health?

The issue here is that SQL uses single quotation marks (apostrophes) to delimit strings 

(words) and will therefore misinterpret a single quotation mark in the word being searched 

for. The solution is to simply double the quote. This process is most easily illustrated with an 

example. Instead of writing Men's Health write Men''s Health

Why does the Service Activity Report (SAR) on immunisations report a greater 
number of immunisations than the Immunisations Performed report?

By default, the Immunisations Performed report does not include deceased patients. Check 

the Include Deceased box to report all immunisations performed.

Service Recording

If staff forget to finish a consult on the service record will the consult be counted 
when we do a query of how many consults there were for a particular period and 
what happens if that person is seen more than once in a given period and some of 
the consults haven't been finished?

Our service reporting is based on "start time" only, with the assumption that every service 

ends even if the end was not recorded. Therefore, unfinished services should be counted by 

the reports.
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Generally, a service activity report counts every "started" service record, regardless of how 

many times an individual client is represented. Having said that, it is easy to create a report 

that will count the number of individuals if that is required.

System Administration

When do I reboot the Communicare server?

This may be required when, for example, electronic pathology results do not appear to be 

being processed.

How do I change a User’s password in Communicare?

Log on to Communicare as the Administrator and open File  > User Groups. Click on the 

user group that the user belongs to then double-click on the username. Enter and confirm a 

new password.

Note:

You are not able to see the user’s password, you are only able to CHANGE the 

password to a new one.

How do I install Communicare Client?

Browse the network to locate the Communicare Installation Files. Locate and double click 

on Setup.exe in the Installation Folder. Sites using an Appliance Server can navigate to 

Entire Network  > Microsoft Windows Network  > Communicare  > CCAREXYZ  > Install 

> CCare.

What should I do when a server’s name or database pathname is changed?

Reinstall Communicare on each workstation: see above.

What does this error message mean?

Cannot create file C:\\Program Files\\Communicare\\xxxxxxxxxxx  The most 

likely cause of this error is that Windows is denying the user access to create files. This is 

a configuration problem and not a Communicare issue. The Windows user needs rights to 

write files to the folder specified.
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Request Remote Assistance
Run Teamviewer for quick support or request remote assistance.

Requesting Remote Assistance will allow Communicare Support  to have a live view of your 

screen so we can help you better.

To run remote assistance, when instructed by Communicare Support, in Communicare, 

select Help  > Request Remote Assistance.

In order to invoke Request Remote Assistance, on your keyboard, press CTRL+F2.
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Glossary

Glossary

Active medication
For prescribed regular medications, medications that are not expired, stopped or 

deleted.

Administer
The act of applying a medication directly to a patient. For example, when a nurse gives 

a patient an injection.

Administrative Encounter Place
A group of encounter places defined for administrative or reporting purposes.

AIR Encounter
A visit to a vaccination provider where one or more episodes (vaccines) are 

administered to the patient.

AIR Episode
The actual immunisation provided to the patient, by the vaccination provider. An AIR 

Encounter must have a minimum of one episode, and a maximum of five episodes.

Biographics
General information about a patient, such as names, addresses, Medicare Number, and 

so on.

Class
A group of clinical item types that have common properties and attributes or data 

values.
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Clinical item

A record of any event on a patient record, either actual or a planned recall, such as a 

disease, immunisation, procedure, medication prescribed, and so on. Clinical Items in 

Communicare are coded according to ICPC-2 PLUS.

Clinical item keywords
Specific words that can be used to locate Clinical Item types.

Consolidated order
Groups of medication requests used to order medications from an external pharmacy 

and to manage patient-specific inventory.

DAA
Dose Administration Aid (DAA) is the term used for packaging that organises doses of 

medication according to when they should be taken.

Dataset
A collection of related clinical item types, qualifiers and recall types.

Encounter
A meeting between a health provider and a patient.

Encounter mode
Either the means of delivering a health service, for example Telephone; or the type of 

physical place at which a health service is delivered, for example, School.

Encounter place
Either a Service Encounter Place, where patient contacts occur; or an Administrative 

Encounter Place, a concept that defines a group of encounter places for administrative 

or reporting purposes. The Service Encounter Place is the physical place at which a 

service is delivered, or the physical place from which a service is delivered, for example, 

Millennium Health Service Clinic. Each place is categorised into one or more Modes.
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Episode
When a condition is diagnosed it may be classified as a FIRST, NEW, or ONGOING 

episode.

Health Centre Prescribing
Health Centre Prescribing (HCP) or Rural Prescribing is a workflow used in the NT, 

where instead of PBS scripts, a single consolidated script is printed for all regular 

medications for a patient.

Immunisation Provider
The provider who administered a vaccine to an individual.

Last consolidated order date
For the encounter place, the most recent date at which a consolidated order was 

ordered.

LEMI
From Active Ingredient Prescribing legislation, a list of excluded medicinal items 

(LEMI) for which Communicare does not include the generic components. The LEMI 

includes non-medicinal items such as bandages, or medications with four or more 

active ingredients.

LMBC
From Active Ingredient Prescribing legislation, a list of medicines for brand 

consideration (LMBC), for which providers should consider prescribing by brand. For 

example, medications that are not bioequivalent.

Locality
A list of places used in patient addresses. Initial localities are taken from Australia Post 

localities, but additional localities may be defined, for example, for a local community.

Locality group
Where several localities are combined for reporting purposes. For example, Northern 

Region, South of River, Inner City, and so on.
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Medication request
Medication requests combine a patient's medications into a bulk-order prescription for 

sending to a pharmacy for dispensing.

Medication summary
A list of a patient's currently active medications.

Mode
See Encounter mode  (on page 333).

National Cancer Screening Register
Communicare integrates with the National Cancer Screening Register (NCSR).

Once off medication
A medication typically prescribed for acute clinical presentations, which the patient 

will take until the course is complete. Once off medications are removed from the 

Medication Summary after their duration has elapsed. Once off medications may also 

be described as Short Course medications.

Place
See Encounter place  (on page 333).

Provider
Anyone who provides health care for a patient, such as a doctor, health worker, nurse, 

and so on.

Qualifier
A measurement associated with a Clinical Item

Query
An instruction to retrieve statistics from the database.
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Regular medication
A medication typically prescribed for a chronic disease, which the patient would be 

expected to take continually. Regular medications are displayed on the Medication 

Summary until they are explicitly stopped.

Report
The results of a query about data in the database.

Service recording
A record of a patient's services, such as clinic visits, home visits or other.

Supply
The act of providing medication to a patient or their carer.

Topic
A grouping of Clinical Items into health or medical-related categories.

Vaccine Provider
A medical practitioner or person who is recognised by Services Australia as being a 

provider of vaccinations to individuals, according to the Australian Immunisation 

Register Act 2015.

Walk-in patient
Patients who arrive without an appointment.
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Notices, acknowledgements and attributions
Notices

Words mentioned in this book that are known to be trademarks, whether registered or 

unregistered, have been capitalised or use initial capitals. Terms identified as trademarks 

include Microsoft®, Microsoft Windows®.

Approval  has been granted by the Tasmanian Government to use Communicare Version 22.1 

as an electronic prescription system in Tasmania.

If using the Australian Immunisation Register integration: Participating health professionals 

may utilise the services and information provided including personal information only 

in accordance with National (Privacy Act 1988, Health Insurance Act 1973, Australian 

Immunisation Register Act 2015 and other relevant legislation), State or Territory legislation, 

Policy and Guidelines.

In Communicare V21.3 and later, to support Services Australia interactions, your patients' 

relevant personal information is encrypted and sent from your Communicare server to 

Services Australia web services via Communicare Next Generation. The data is retained 

by Communicare Next Generation. Communicare Next Generation is hosted on Microsoft 

Azure cloud services, in highly secure data centres based in Australia (Sydney, Canberra, 

Melbourne) which meet the Australian Standards for Information Security. Microsoft has 

been awarded Certification for Protected data in Australia. For more information about how 

Telstra Health manages personal information, see our privacy policy.

In Communicare V22.1 and later, to support ePrescribing interactions, your patients' 

relevant personal information is encrypted and sent from your Communicare server to 

an ETP service, such as eRx, via Communicare Next Generation. The data is retained by 

Communicare Next Generation. Communicare Next Generation is hosted on Microsoft 

Azure cloud services, in highly secure data centres based in Australia (Sydney, Canberra, 

Melbourne) which meet the Australian Standards for Information Security. Microsoft has 

been awarded Certification for Protected data in Australia. For more information about how 

Telstra Health manages personal information, see our privacy policy.

In Communicare V22.1 and later, for printed PBS prescriptions, your patients' relevant 

personal information is encrypted and sent from your Communicare server to an 

ETP service, such as eRx, via Communicare Next Generation. The data is retained by 

Communicare Next Generation. Communicare Next Generation is hosted on Microsoft 
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Azure cloud services, in highly secure data centres based in Australia (Sydney, Canberra, 

Melbourne) which meet the Australian Standards for Information Security. Microsoft has 

been awarded Certification for Protected data in Australia. For more information about how 

Telstra Health manages personal information, see our privacy policy.
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